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Preface

Configuration Manual and Project

This configuration manual illustrates one way in which you can achieve the
optimum configuration for your plant with the PCS 7 process control system. The
manual guides you step by step through configuration based on an example of a
plant with a name "COLOR_PH" and explains how to structure the process control
configuration of a plant based on technological considerations and through various
phases. You are provided with an overview of the various views (component view
and plant view), the individual phases of configuration ranging from structuring
projects, creating models, creating an OS, configuring user data for the OS, and
transferring the PLC-OS connection data. There are no additional manuals dealing
with the following aspects that are covered in this configuration manual:

• Configuring a process control system

• Working with the plant hierarchy (PH)

• Working with the import / export assistant (IEA)

This configuration manual is intended to provide you with a comprehensive
overview of the steps involved in configuring a plant. Detailed explanations of the
contents and functions in dialog boxes have been deliberately left out. For more
detailed information in this case, please refer to the documentation or the online
help of the particular application. There is a ready-made project for the
Configuration Manual called "COLOR_PH". You can run this project on an existing
SIMATIC station. It may be necessary to adapt the project to your hardware.

The project contains a functioning sequential control system (SFC) to simulate a
dosing operation. It is assumed that you have established communication between
the SIMATIC station and the programming device/PC via the MPI interface. You
can use a CP 5611, a CP 5412 or other MPI-compliant communications processor
to handle this communication. You can make the necessary settings in the "Set
PG/PC Interface" program (see online help) that is available in the Control Panel of
Windows NT. Communication using Industrial Ethernet or PROFIBUS networks is,
of course, also possible. For information on installing and making settings for the
CPs, refer to this Configuration Manual or the online help.

The "Process Control System PCS 7 - Electronic Manuals" CD includes this
Configuration Manual in electronic form. You can read and print this using the
Acrobat Reader.

The contents of the electronic manuals are largely identical to those of the online
help. Due to technical reasons, there may nevertheless be minor differences
between the online help and the electronic manuals. If there are discrepancies, the
information in the online help can be considered more up to date.



Preface

Process Control System PCS 7, Configuration Manual
iv A5E00122418-01

When you install PCS 7, the COLOR_PH project and the PCS 7 Configuration
Manual  are copied to your programming device or PC. You can open the manual
with "Start > SIMATIC > S7 Manuals > PCS 7 Configuration Manual". You can
open the project in the SIMATIC Manager as follows:

1. Select the menu command "File > Open".

2. Click the"Sample Projects" tab.

3. Select the "COLOR_PH" project and click the "OK" button.

The COLOR_PH project also requires the COLOR_PL library containing the model
charts. You can open the library as follows:

1. Select the menu command "File > Open".

2. Click the "Libraries" tab.

3. Select the "COLOR_PL" library and click the "OK" button.

The "PCS 7 Configuration Manual" is included on the CD "Process Control System
PCS 7 Engineering Toolset V 5.0 + SP1" in "Manuals\English\" as the file "PCS 7
Configuration Manual.pdf".

Getting Started

In the PCS 7 "Getting Started" manual,  you will find the "COLOR_GS" project in a
form that will allow you to complete the project in approximately eight hours.

The "PCS 7 Getting Started" manual is on the CD "Process Control System PCS 7
Engineering Toolset V 5.2" in "Manuals\English\" as the file "PCS 7 Getting
Started.pdf".

Audience

This configuration manual is intended for personnel involved in configuring,
commissioning, and service.

Basic experience of working with the PC/programming device and working with
windows NT are assumed.

Validity

This Configuration manual is valid for the software on the CD

"Process Control System PCS 7 Engineering Toolset V 5.2".
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Readme File

You will find the latest information (that may be more up-to-date than the
information in the Configuration manual) in the readme file. The readme file is on
the CD "Process Control System PCS 7 Engineering Toolset V 5.0 + SP1" and
there are separate readmes for the Getting Started manual and Configuration
manual on the CD "Process Control System PCS 7 - Electronic Manuals".

Guide to the Manual

The configuration manual provides you with an overview of the essential functions
of PCS 7. It is structured in the order you would use to configure a project with the
process control aspects in the foreground.

You can use this configuration manual as a reference work and open it to the
specific information you require or you can work through the "COLOR_PH" sample
project step by step with the appropriate hardware. You then insert a plant
hierarchy with "hierarchy folders" and CFC/SFC charts in the project. Using the
import/export assistant, you create a model that you can import into the project.
The manual also explains how to organize the data exchange between
programmable controllers. You configure a process picture on the operator station
in which you can place dynamic objects and transfer the OS configuration data
from the engineering system (ES) to the OS.

Each chapter starts with an introduction to the specific topic followed by a
description of the most important aspects of the topic and is completed with the
topic-related steps required to create the "COLOR_PH" plant.

Requirements

To work through the example, you require a programming device/PC (Pentium II; ≥
266 MHz clock; ≥ 128 Mbytes of memory ; free hard disk space of > 2 Gbytes), a
programmable controller with CPU 414-2 / 416-2 or CPU 417-4, a communications
processor CP 443-1 (for the SIMATIC station), a communications processor
CP 1413 or CP 1613 (for the engineering station) and an ET 200M with one analog
input, analog output, digital input, and digital input module and a PCS 7 Installation
CD with the appropriate authorizations.

If you have questions relating to the installation of the PCS 7 Toolset, please read
the readme file on the installation CD or contact customer support (see below).
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Settings for Starting the "COLOR_PH" Project.

To start the "COLOR" project on your computer, you must make certain settings.

• If you require a link between the ES and PLC, you must activate the required
driver in the PG/PC interface (SIMATIC Manager: Options >Set PG/PC
Interface). If you require a link via MPI or PROFIBUS, adapt the
communication parameters in the PG/PC interface to the communication
parameters of the MPI interface or CPU or, for PROFIBUS, to the CP 443-5
and change the driver to MPI or PROFIBUS. You can find the communication
parameters in the hardware configuration in the object properties of the CP
443-5 (network settings). If you require a link via Industrial Ethernet, use a CP
1413 or CP 1613 on the PC and a CP 443-1 on the CPU. The settings for the
communication parameters can once again be found in the PG/PC interface
and in the hardware configuration.

• Transfer the PLC-OS connection data. If you have not already done so, set the
transfer options (step 5):

- Transfer tags

- Transfer messages

- Transfer SFC charts

- "All" with "Clear operator station(s)"

• After you have started the WinCC Explorer, you must enter the current
computer name in "Computer > Properties" in the WinCC Explorer. You can
find the current computer name in "Start > Settings > Control Panel >
Network" (Note: no blank is permitted in the computer name).

Conventions

All the required documents are on the "Electronic Manuals Process Control System
PCS 7" CD
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Further Support

If you have questions about the use of the products described in the manual, and
you cannot find the answers here, please contact your Siemens representative in
your local Siemens office.

http://www.ad.siemens.de/partner

Training Center
To familiarize you with the Process Control System PCS 7, we offer a range of
courses. Please contact your regional training center or the main training center in
D 90327 Nuremberg.

Phone:  +49 (911) 895–3200.

http://www.sitrain.com

SIMATIC Documentation on the Internet / Siemens Intranet

• You can obtain documentation free of charge on the Internet at:

http://www.ad.siemens.de/support

Use the Knowledge Manager to find the documentation you require quickly. If
you have questions or suggestions relating to the documentation, a
"Documentation" conference is available in the Internet forum.

• Look us up in the Siemens Intranet on the home page of SIMATIC
Documentation. Here, you can get information on new products and
developments, ask questions about the documentation, and let us know about
your personal wishes, suggestions, criticisms or even perhaps a word of
praise.

http://intra1.khe.siemens.de/e8_doku/index.htm

http://www.ad.siemens.de/partner
http://www.sitrain.com
http://www.ad.siemens.de/support
http://intra1.khe.siemens.de/e8_doku/index.htm
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Automation and Drives, Service & Support
Open round the clock, worldwide:

Johnson City

Nuremberg

Singapore

SIMATIC Hotline

Worldwide (Nuremberg)
Technical Support

Worldwide (Nuremberg)
Technical Support

(FreeContact)

Local time: Mo.-Fr. 7:00 to 17:00

Phone: +49 (180) 5050 222

Fax: +49 (180) 5050 223

E-mail: techsupport@
ad.siemens.de

GMT: +1:00

(charged, only with
SIMATIC Card)
Local time: Mo.-Fr. 0:00 to 24:00

Phone: +49 (911) 895-7777

Fax: +49 (911) 895-7001
GMT: +01:00

Europe / Africa (Nuremberg)
Authorization

America (Johnson City)
Technical Support and
Authorization

Asia / Australia (Singapore)

Technical Support and
Authorization

Local time: Mo.-Fr. 7:00 to 17:00

Phone: +49 (911) 895-7200

Fax: +49 (911) 895-7201

E-mail: authorization@
nbgm.siemens.de

GMT: +1:00

Local time: Mo.-Fr. 8:00 to 19:00

Phone: +1 423 461-2522

Fax: +1 423 461-2289

E-mail: simatic.hotline@
sea.siemens.com

GMT: -5:00

Local time: Mo.-Fr. 8:30 to 17:30

Phone: +65 740-7000

Fax: +65 740-7001

E-mail: simatic.hotline@
sae.siemens.com.sg

GMT: +8:00

English and German are spoken on all hotlines. On the authorization hotline, French, Italian and Spanish are also
spoken.
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Service & Support on the Internet
In addition to our documentation services, you can also make use of all our
knowledge on the Internet.

http://www.ad.siemens.de/support

Here, you will find:

• Current product information (product news), FAQs (Frequently Asked
Questions), Downloads, Tips and Tricks.

• The Newsletter keeps you constantly up to date with the latest information on
the products you use.

• The Knowledge Manager will find the documents you need.

• In the Forum, users and specialists exchange information and experience.

• You can find your local contact for Automation & Drives in our contacts
database:

• Information on local service, repair, spares and much more is available to you
under the rubric "Service".

http://www.ad.siemens.de/support
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1 Basics of PCS 7

Introduction

This chapter introduces you to the functions of PCS 7 and explains how they
interact. You will find information about engineering with PCS 7, the points in the
procedure at which PCS 7 expects input from you, and how PCS 7 supports you as
the user of the system.

1.1 Steps in Configuration

Creating a project often involves the same routines. These routines are outlined
below.

1.1.1 Phases in Configuration

The piping and instrumentation flow diagram, the process description, the tag list,
and hardware planning should be created before configuring the plant. These
phases are not described in any detail in this manual.

Piping and Instrumentation Flow Diagram

A piping and instrumentation flow diagram is created for the plantand specifies the
components of the plant, how they are arranged, and how they are interconnected.
The number and basic functions of the measuring points should already be
specified in the piping and instrumentation flow diagram.

Process Description

The process description contains the technological description of the process.

Tag List

The tag list is created based on the piping and instrumentation flow diagram and
the process description and contains all the relevant measuring points for the plant
to be configured along with the corresponding descriptions of the tags. A tag
identifies one actuator or sensor in a plant (for example valve, pump etc. ).
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Hardware Planning

The tag list is the basis for planning the hardware. Based on the tag list, the
number of SIMATIC stations (PLCs) and operator stations (OS) required can be
calculated. The plant requirements in terms of availability decide whether or not
redundant SIMATIC stations and/or redundant operator stations are necessary.

User Blocks

PCS 7 supplies block libraries with blocks for the most common automation tasks.
Users can, however, create blocks themselves tailored specifically to their own
requirements. User blocks are created in the SCL language (Structured Control
Language). It is, of course, possible to call STL programs from within SCL
programs.

Note
A manual containing programming instructions for PCS 7 user blocks is available that
explains the essentials of block configuration step-by-step and includes examples.
This manual is entitled "Programming Instructions - Creating Blocks for PCS 7" and is
available under order number 6ES7 653 0XL01-8YE1.

Libraries

With the user blocks and the blocks from the libraries supplied, the configuration
engineer can create a new library in which the blocks already have the attributes
required for the project. While creating the project, the engineer takes the required
blocks from this library and can continue to adapt the library to new requirements
or create further libraries for specialized requirements.

Models

To rationalize the engineering phase, model charts are created for identical or
similar measuring points. Model charts in conjunction with an import file (model)
allow the convenient duplication and editing of measuring points or entire plant
sections. The copies (replicas) can then be adapted quickly to the particular
measuring point.

PLC-PLC Communication

You configure connections in NetPro (refer to Chapter 5). While configuring the
connections, you decide which PLCs exchange data with which PLCs (for example,
the PLC with address 5 sends data to the PLC with address 7).

The values you want to send via the connections created in NetPro are
interconnected with the blocks integrated in the CFC charts (for example
FR_BSEND for sending values and FR_BRCV for receiving values). The send and
receive blocks are supplied with PCS 7.



Basics of PCS 7

Process Control System PCS 7, Configuration Manual
A5E00122418-01 1-3

1.1.2 Steps in Creating a Project

Overview

This section explains the basic steps required for efficient configuration of a project.

Planning Phase

Structure the project based on the tag list and the process description
(outline structure, number of PLCs and operator stations, units)

⇓
Select the number and type of I/O modules

⇓
Assign signals to channels and select the symbolic names

⇓
Plan the field wiring between the sensors/actuators and SIMATIC stations (PLCs)

⇓
Decide on the network type and network structure for communication between the

SIMATIC stations and between the SIMATIC stations and the process control system.

Implementing the Project

(the main topic of this configuration manual)

Create the project

⇓
Configure the hardware

⇓
Configure networks

⇓
Create the plant hierarchy

⇓
Program, test and document

user function blocks and corresponding faceplates *

⇓
Create CFC charts (model charts)

⇓
Use the Import/Export Assistant (IEA)

to create models as templates for measuring points
Testing and documenting models

Putting blocks and models together to create libraries

⇓
Create CFC charts with the IEA using the models,

compile and download to the PLC **

⇓
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Implementing the Project

(the main topic of this configuration manual)

Create and compile SFC charts (sequential control systems) and download them to the PLC **

⇓
Configure SIMATIC cross connections

⇓
Configure OS stations:

Configure operator pictures, message pictures, curves, archives

⇓
Transfer PLC-OS connection data

⇓
Copy OS-relevant data from the ES to the OS and start the OS run time

⇓

Loop Check

Test each function including sensors, processing, operator control and monitoring, and actuators.

* Programming user function blocks is not part of this configuration manual. For
information about creating user blocks, refer to the manual "Programming
Instructions - Creating Blocks for PCS 7".

** You do not need to work on the CFC and SFC charts separately. You can
compile and download CFC and SFC charts in one step. When you compile and
download, all the charts (CFC and SFC) of an S7 program are compiled and
downloaded.
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1.1.3 The Engineering System

SIMATIC PCS 7 provides a comprehensive engineering system for configuring
process control systems on the Windows NT platform that allows projects to be
worked on throughout a system and plant. The engineering system can be used for
the entire range of projects from small systems to large manufacturing complexes.

The same tools are used to work with and manipulate the project database from
the initial configuration of a plant through to the running of the plant. This means
that the project data are created and maintained with identical tools during the
entire life of a plant.

Open import/export mechanisms allow the engineering system to be integrated into
an existing infrastructure of an entire plant configuration.

The individual components of the engineering system are matched to each other.
The heart of the system is the engineering toolset consisting of STEP 7 and the
optional packages SCL, CFC, SFC and DOCPRO. The individual components of
PCS 7 and their applications are introduced and explained in this configuration
manual.

Note:
In practice, as described in Section 1.2 in detail, you use the multi-user mode for small to
medium sized plants and a mixture of Branch & Merge and the multi-user mode for large
plants involving greater numbers of configuration engineers.

Licensing

There are three different licenses available depending on the scale of operation:

• Up to 250 blocks with operator control and monitoring capability in one project

• Up to 3000 blocks with operator control and monitoring capability in one project

• More than 3000 blocks with operator control and monitoring capability in one
project

These limitations in terms of the number of blocks affect the CFC and SFC
applications. If you exceed the maximum number of blocks permitted by your
license, a message is displayed. You can nevertheless continue configuration.

The current number of blocks on all CPUs within the project is calculated. All
blocks with the header attribute "S7_m_c" are counted (meaning: the block can be
controlled and monitored at an OS). All CFC block instances and SFC charts are
checked.
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1.2 Distributed Engineering

1.2.1 Multiple Users in a Project

A project can be edited by more than one user. At any one time, however, only one
user is permitted per S7 program.

Branch & Merge (see Section 1.2.2)

We recommend that you create at least one S7 program per user. This allows
more than one user to create program sections at the same time that will then be
put together to form one program at a later point in the configuration phase.

If the situation demands that a project is created at different times or at different
locations, you can break down a master project into subsections. You could, for
example, assign a station or a program to each person involved. The procedure is
analogous for distributing work on several operator stations.

Configuring on local PCs (one configuration engineer works on one project located
on a local hard disk of a PC) is much faster than configuring in a network (several
configuration engineers working on one project located on a server).

Multi-user Mode (see Section 1.2.3)

In the multi-user mode, each engineer works via a network on a PC on which the
project is maintained centrally.

During configuration of the connections and when importing mass data into an
entire project (IEA), we recommend that the master project should be edited on a
local hard disk on a PC since this achieves much faster editing times.
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1.2.2 Branch & Merge

Initial situation: You have created the stations in the master project and there is at
least one hierarchy folder for each PLC with the appropriate PLC assignment that
also applies to all objects in the underlying hierarchy. The networks and required
connections between the SIMATIC stations have been created.

Divide the master project into several subprojects.

A subproject is created for each CPU that can be worked on and edited as a
"standalone" project at different workstations.

Engineering station 1

Sub-
project

B

Engineering station n

Master
project

Sub-
project

A

Figure 1-1 Dividing Master Projects into Subprojects

• Create a new, empty "subproject" for each configuration engineer (with File >
New).

• Copy the S7 program to the new project in the component view. The
corresponding part of the plant hierarchy is copied as well; in other words, all
the relevant sections of the plant hierarchy are created in the subprojects as
they were in the master project.

Caution:
 Copying units in the plant hierarchy is not recommended, since the resources (chart
folder) used are not copied. In the same way, the symbol table and hardware configuration
are also not included. You can copy individual charts or groups of charts, assuming these
need to be adapted in any case.

As a general rule, copying executable sections is only efficient in the component view.

Afterwards, it is possible to work in each subproject as if it were a separate project.



Basics of PCS 7

Process Control System PCS 7, Configuration Manual
1-8 A5E00122418-01

Merging Subprojects

Engineering station 1 Engineering station n

Master
project

Sub-
project

B

Sub-
project

A

Figure 1-2 Merging Subprojects

• Delete the original S7 program in the master project (recommended
procedure).

• Caution! If you delete the entire original PLC station, this also affects the
transfer of PLC-OS connection data (see Note in the section "Configuring in a
Network").

• Copy the S7 programs of the subprojects to the master project.

After copying, all the components and the entire plant hierarchy exist in the master
project.

Import/Export in Distributed Engineering

Two methods are possible for importing/exporting in distributed engineering:

• The models (see also Chapter 8) are stored in a library. When the master
project is broken into subprojects, the libraries are transferred along with the
subprojects. You can then import from the library into the subprojects. When
the subprojects are merged to recreate the master project, only the configured
data (replicas of the models and other charts, pictures and reports) are merged
and not the models.

• When the master project is divided up, the models are transferred to the
subprojects. The CFC charts are imported into the subprojects. When the
subprojects are merged to recreate the master project, only the configured
data (replicas of the models and other charts, pictures and reports) are merged
and not the models.
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Example of Branch & Merge Configuration

The following overview illustrates how Branch & Merge configuration can be
handled.

Master project
(at time t1)

Configuration steps:
1. Create the hardware configuration with the CPUs, the

central/distributed I/Os, and the SIMATIC PC stations (OS).
2. Create all the required networks in NetPro specifying the required

addresses.
3. Create all PLC-PLC connections.
4. Create the common user libraries for the PLCs and the operator

stations.
5. Insert existing model charts in the project.
6. Specify the plant hierarchy.
7. Make the required presettings (for example, PLC and OS

assignment)
8. Specify the range of numbers for the user FCs and FBs, any

existing shared DBs, the symbols, the variables tables etc.

Subproject
(PLC 3)

Subproject
(OS)

Configuration steps:
1. Program the user FBs / FCs.
2. Configure the model charts.
3. Create the specific user libraries for the PLCs.
4. Create the specific user libraries for the operator stations.
5. Configure the static parts of the process pictures.

Master project
(at time t2)

Subproject
(PLC 1)

Subproject
(PLC 2)

Configuration steps:
1. Merge the PLC libraries
2. Merge the OS libraries
3. Merge the model charts
4. If necessary, transfer the PLC-OS connection data.

Subproject
(PLC 3)

Subproject
(OS)

Configuration steps:
1. Import the model charts (create replicas).
2. Configure connections between the charts.
3. If necessary, adapt replicas.
4. Create the CFC and SFC charts.
5. Test the charts.
6. Create the first dynamic picture components on the OS

Master project
(at time t3)

Configuration steps:
1. Transfer the PLC-OS connection data.
2. Etc.

Subproject
(PLC 1)

Subproject
(PLC 2)

Figure 1-3 Access to a Project on the Network Server
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Message Numbers when Using Branch & Merge

When you create an S7 program or a PLC station with an S7 program in the
project, numbers are assigned automatically to the messages. This makes sure
that the message numbers are unique throughout the project. If you follow the
procedure described above, the message numbers are retained when you
subdivide and merge projects.

1.2.3 Multi-user Mode

The following section shows how several users can work on one project at the
same time. Figure 1-4 Shows an actual example of a plant configuration. Five
users (four users working on NT Clients and one user working on the NT Server)
can work on one project at the same time in the plant shown.

Configuration of the Computers

The NT Server should be configured as follows:

• Operating system
NT server

• NT Licensing
Microsoft Windows NT Server (contains either 5 or 10 connection licenses).
When you install the NT Server, make sure that the option "License Check at
Workplace" is set. The user must make sure that an adequate number of
licenses are available.

• NT User Rights
Administrator

• NT Optimization
Enter all the PCs used in the network in the "LMHOSTS" file. The LMHOSTS
file contains the assignment between the NT computer names and the IP
addresses. You will find an example in winnt/system32/ drivers/etc (file:
LmHosts.sam). You should also set "Optimized Network Activities" in the
properties of the server services (Start > Settings > Control Panel > Network
> Services).

• Programs
PCS 7 Toolset or alternatively only STEP 7 (see note below).
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Caution:

If neither the PCS 7 Toolset nor STEP 7 is installed on the server, the first client
to log in to the project (for example client 1) takes over the function of database
server . If this client fails (for example due to a network failure or the client is
turned off), no client that logged in after the failed client can access the project
any longer. In the worst case, the failure of the database server on the client can
lead to a loss of data since the data required for reorganization (for example
following a power outage) are no longer available to the server. This data is only
maintained locally on the client on which the database server is active.

An NT Client should be configured as follows:

• Operating system
NT workstation

• NT Licensing
Microsoft Windows NT Workstation

• NT User Rights
Administrator or Power User

• NT Optimization
Enter all the PCs used in the network in the "LMHOSTS" file.

• Programs
PCS 7 Toolset

Extra notes on the computers:

• If individual users want to compile charts while other users continue to work on
the project it is advisable to have not more than three to four NT Clients
connected to one NT server, otherwise a loss of performance will result.

• Data should be archived at least once a day maintaining at least five older
copies.

Editing the Project

The following work can be done both on the Server or on the Client. It is,
nevertheless, necessary for all users currently working on the project to stop
configuration and to exit the project. You will achieve far greater performance by
performing these tasks on the server and not on a client:

• Importing or exporting mass data with the Import/Export Assistant (IEA).
The activities of the IEA relate to the plant hierarchy (PH). The PH contains the
entire project with all SIMATIC stations. As a result, you do not work CPU by
CPU when creating the mass data and, in fact, this is often not wanted.

• Editing mass data with the instance editor (Options > Charts > ...Edit).
Just like the IEA, the activities of the instance editor are also based on the
plant hierarchy of the project. This means that you can use the instance editor
to edit in the entire project or within one SIMATIC station. If you want to edit
the data for the entire project, select the server.
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• Configuring connections between programmable controllers in NetPro. Before
you make the first change in NetPro, first update the project with "View Update"
to make sure that changes made by other users are displayed.

• Compiling and downloading several SIMATIC stations automatically.
This function could also be performed on a client. Once again, however, you
achieve a far higher performance by doing this on the server.

• Transferring PLC-OS connection data.
In the "Transfer PLC data to operator station" wizard, set the number of
SIMATIC stations and operator stations (OS) you want to transfer at the
current stage. If you transfer only the SIMATIC station you are currently editing
on the PLC and if the configuration engineer responsible for the target OS is
informed, it is possible to make the transfer locally on a client. If you want to
transfer several SIMATIC stations or want to transfer to several operator
stations, make the transfer on the server.

• Reorganizing the project (File > Save As >  with/or without the
"Reorganization" option).
This function affects the database of the project. When using this function, it is
absolutely essential that all users currently working on the project stop
configuration and exit the project.

• Archiving the project.
This function affects the database of the project. When using this function, it is
absolutely essential that all users currently working on the project stop
configuration and exit the project.

The following tasks must always be performed separately for each PLC. This
means that two users must not be allowed to configure within one S7 program
within a SIMATIC station at the same time. In particular, two users must not edit
the CFC/SFC charts of a SIMATIC station at the same time.

• Creating or changing the hardware configuration.
All users can configure separate PLCs in HW Config at the same time.

• Editing mass data with the instance editor (Options > Charts > ...Edit).
All users can edit data with the instance editor for separate PLCs at the same
time.

• Compiling and downloading an S7 program.
All users can compile and download for separate PLCs at the same time. You
achieve a considerable increase in performance, however, by compiling a
program on the server rather than compiling on a client. This affects not only
the client on which you compile but all other clients involved in the same
project.
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• Tables that can contain data from different SIMATIC stations.

- Menu command: Options > Charts > Edit
Parameters/Interconnections...

- Menu command: Options > Charts > Edit Messages...

- Menu command: Options > Charts > Edit Chart Name...

• Configuring the Operator Station (OS)
All users can configure the data of an OS for separate operator stations at the
same time.

Fast Ethernet
(100 MB full duplex)

NT client 4

Project

NT server

NT client 3NT client 2NT client 1

3 COM

Optical Switch Module

3 COM
CP1613

CP 443-1

CP1613
Alternative to

downloading PLC
systems from the

server

Figure 1-4 Configuring a Plant for Multi-users (example)
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Caution:
It is essential to make a backup of the project several times a day. You should keep at least
five older backup copies of the project. If there is a network failure or hard disk crash, you
can then revert to a backup copy. You can create a backup copy in the SIMATIC Manager
(File > Archive) using the supplied "PKZIP" program (refer to the online help).

Note:
If you copy one or more stations within a project or across project boundaries, you may
need to reassign the connection partners to the local node. You can recognize that the
partner is missing for a connection when the line is displayed in bold face in the connection
table.

We recommend that all required stations are created in a master project and that the
connections are configured in this project. For distributed engineering, you should only
copy the S7 programs that you can return to the master project as described in the section
"Branch & Merge - Merging Subprojects".

Caution:
Connections between stations copied across project boundaries are retained and are
consistent if the relevant subnets between the stations are also copied.

You should also note the information in the section "Notes on the Multi-user Mode
and on Using Network Drives" in the readme file on the "Process Control System
PCS 7 Toolset V5.0" CD.
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1.3 Architecture of the System

Overview

This section contains an example to illustrate the principle of the structuring
of several PLC/OS stations and includes information about the PCS 7 structures.

1.3.1 Single Workstation System

The engineering station (ES) and the operator station (OS) are connected to the
PROFIBUS, Industrial Ethernet or Fast Ethernet system bus using a
communications processor. The project is normally configured on the engineering
station (ES) and the process is controlled and monitored at the operator station
during run time. To allow control in run time, the data relevant to the OS must be
transferred from the engineering station to the operator station.

Engineering station (ES)

SIMATIC S7 400 SIMATIC S7 400

Single workstation system
(OS)

Figure 1-5 Single Workstation System with an Engineering Station on the System Bus
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1.3.2 Multiple Workstation System

A multiple workstation system has several clients and an OS server that all work
with the same project. Up to 16 clients can be connected. The configuration is
normally created on the engineering station. The attachment to the process bus,
data storage and the processing of process data is implemented by the OS server.
All the project data such as pictures, tags and archives are provided to the clients
by the OS server. During the run time, the plant is operated from the client stations.

Client 3Client 2Client 1

Terminal bus

   Engineering station

Server

SIMATIC S7 400 SIMATIC S7 400

Figure 1-6 PCS 7 Multiple Workstation System with Engineering Station

Note:
If no configuration work is currently necessary, it is also possible to use the engineering
station as an operator station (single workstation system).

Storing the process pictures locally on the clients optimizes the picture selection times
(refer to the online help in the WinCC Explorer).
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1.3.3 Principle of a System Configuration with Multiple
PLC/OS Stations

The following diagram shows a possible PCS 7 system configuration with a
redundant OS server and operator station as a single workstation system (for
example as a distributed station).

 ET 200M

 ET 200M

Field devices

 ET 200M

 ET 200M

Field devices

 ET 200M

Field devices

P
R
O
F
I
B
U
S

D
P

Client 3Client 2Client 1

Terminal bus (TCP/IP protocol)

Server 2

Single workstation system

Industrial Ethernet,  Fast Ethernet         or PROFIBUS

Engineering system

SIMATIC S7 400SIMATIC S7 400 SIMATIC S7 400

Plant bus

Server 1

Field devices

Field devices

 DP/PA-Link

Figure 1-7 Example of a PCS 7 Configuration
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The Tasks of the Components

• Terminal bus (TCP/IP protocol)
The data prepared by the OS servers are transferred to the terminals via the
terminal bus.

• Plant bus (PROFIBUS, Industrial Ethernet or Fast Ethernet).
The plant bus is used for the cross connections between the PLC
systems and the transfer of the process values acquired in the PLC systems to
the operator stations.

• Fieldbus (PROFIBUS DP, PROFIBUS PA)
This transfers the process values acquired by the distributed peripheral
devices to the PLC systems. Certain field devices can also have parameters
assigned via this bus.

• Engineering system
This is used to configure the PLC and OS user data. It can be connected to the
terminal bus and the plant bus. It is possible to set parameters for specific field
devices using the "Process Device Manager (SIMATIC PDM)" application (see
also Section 1.5.3).

• Operator station
Here, the operator operates and monitors the plant (single workstation
system).

• OS server
This is used to operate and monitor the plant in conjunction with the
OS terminals (multiple workstation system). To improve performance, there are
no monitors on the OS servers.

Caution:
The engineering system supports upwards configuration. Program modifications must not
be made in the SIMATIC stations using the STL or FDB programming languages.

Since negative influences (for example by allocating and no longer releasing memory
areas) on the engineering system or the operator station cannot be excluded, no screen
savers or games must be started on these PCs.

SIMATIC S7-400 (PLC)

The PLC acquires the process values, processes the data as specified by the user
software, outputs control information and setpoints to the process, provides data
for the single workstation system or server allowing visualization and detects input
made by the operator and passes it on to the process.
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1.4 Using the Bus System

Overview

The SIMATIC networks allow comprehensive communication from the
management level down to the field level. The name SIMATIC NET stands for an
entire family of networks.

• PROFIBUS (EN 50170)
The international standard for the cell and field area.

• Industrial Ethernet/Fast Ethernet (IEEE 802-3)
The international standard for area and cell networking.

• AS-Interface
For communication with sensors and actuators.

• MPI – Multi-Point-Interface
For testing and diagnostics.

• Point-to-point link
For communication between two nodes using special protocols.

The following sections provide a general overview of the different networks.

1.4.1 PROFIBUS Network

PROFIBUS is fully standardized in the European standard EN 50170. Siemens
offers a complete range of products with the required network components. Due to
the "openness" of PROFIBUS, standard-compliant components of other
manufacturers can also be connected to the network. Configuration, startup and
troubleshooting can be performed at any point.

PROFIBUS is used as the system bus. The system bus connects all the
components of the process control system (programmable controllers, engineering
stations, and operator stations) that can communicate with each other via the bus.
PROFIBUS should not be used as the control system bus for new installations.
Otherwise, it should only be used in systems with less than 10 nodes.

PROFIBUS DP/PROFIBUS PA

Using PROFIBUS DP/PA, field devices, such as distributed peripheral devices or
drives can be connected to a controller. Using PROFIBUS standardized in
compliance with EN 50170, you have a powerful, open and resilient field bus
system with short reaction times.

PROFIBUS DP is used to connect distributed peripherals,
for example the SIMATIC ET 200M with extremely fast reaction times.

PROFIBUS PA extends PROFIBUS DP with the addition of intrinsically safe
transmission technology complying with the international standard IEC 1158-2.
PROFIBUS DP/PA is used when several field devices (SIMOVERT, SIMOCODE
etc.) and/or distributed stations (for example ET 200) need to be connected to one
or more SIMATIC stations.
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Transmission Media

PROFIBUS DP can be operated on various transmission media and combinations
of these transmission media and can therefore be adapted to a wide variety of
applications.

• Electrical data transmission

• Optical data transmission

• Wireless data transmission

Recommendation: Over longer distances and when connecting between buildings
optical transmission on fiber-optic cables should be the preferred solution.

Diagnostic Repeater for PROFIBUS DP

The Diagnostic Repeater is a repeater that is capable of monitoring a segment of
an RS-485 PROFIBUS subnet (copper cable) during operation and to report line
faults to the DP master in a diagnostic frame. The location of the fault and the
cause of the fault can then be displayed on the operator control and monitoring
system.

With its line diagnostics during operation, the diagnostic repeater allows early
detection and localization of line faults. This reduces the duration of plant
downtimes.

To be able to localize a problem in the network, the diagnostic repeater must know
the topology of the PROFIBUS subnet to which it is attached. With the "prepare
cable diagnostics" function, the diagnostic repeater measures the distances to all
nodes.

The diagnostic repeater stores the distances to the nodes in an internal table. The
diagnostic repeater also records the segment on which it detected the node.

By calculating the distance to a line fault, the repeater can then identify the nodes
between which the fault is located based on the table.

Note:
For more detailed information on the functionality and commissioning of the diagnostic
repeater, please refer to the online help in the SIMATIC Manager under "Repeater >
Configuring and Commissioning the Diagnostic Repeater".
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1.4.2 Industrial Ethernet/Fast Ethernet

With Industrial Ethernet, you have a powerful cell network complying with the IEEE
802.3 standard (ETHERNET). Ethernet with more than 70% of the network market
is the leading LAN worldwide. The opportunities opened up by intranets and the
Internet that are already common in an office environment can now be used in
manufacturing and process automation. In PCS 7, Industrial Ethernet is used as
the system bus and, within a multiple workstation system, as a terminal bus
between clients and servers.

Transmission Media

Industrial Ethernet can be operated on various transmission media and
combinations of these transmission media and can therefore be adapted to a wide
variety of applications.

• Coaxial technology
For low cabling costs and simple expandability. Here, a coaxial cable with
additional shielding (triaxial cable) is used as the electrical transmission
medium and guarantees high immunity to noise.

• Twisted Pair
Here, twisted pair cables with solid copper conductors and double foil and
braided shields ensure reliable data transmission. Twisted pair is simple to
install and allows flexible expansion.

• Glass fibers
These are used whenever electrical isolation and EMC play an important role.
To achieve high availability, it is possible to create rings (see Section 1.7.2).
The transmission medium is fiber-optic cable that is completely immune to
electromagnetic interference. A further benefit is that these cables are in no
way affected by potential differences. This means that no extra cost is involved
in measures for equipotential bonding.
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Fast Ethernet

Fast Ethernet differs from Industrial Ethernet in the following ways:

• Enhanced performance on the network

- 100 Mbps optical ports for connecting modules

- 100/10 Mbps ITP ports with autosensing for attachment of DTEs (OS, PLC
etc.)

• Increased number of nodes per ring

• Simplified configuration rules
(maximum number of modules, maximum distance between modules)

• Simple expansion of the ring: modules, span
The span of the switch structure is practically unlimited

• Network reconfiguration in the case of faults in less than 0.3 seconds

• Fast redundancy in both small and large rings and across different segments

1.4.3 Which Network is Most Suitable?

Deciding on a Network

The decision whether to use the system bus PROFIBUS, Industrial Ethernet or
Fast Ethernet for data communication depends largely on the required network
span, the amount of data, the number of nodes, and possible future expansions
(see Table 1-1).

For the system bus (connection between PLC and OS systems), you can decide
between PROFIBUS, Industrial Ethernet and Fast Ethernet. At the field level, you
communicate via PROFIBUS DP and, if you have field devices in hazardous areas
where there is a risk of explosion, you communicate via PROFIBUS PA.
Attachment of the AS-i bus is also supported by PCS 7.

PROFIBUS is flexible in terms of transmission times. With suitable settings (for
example transmission rate, monitoring times, transmission media etc.) it can be
adapted to the required network span, the attached devices and the necessary
real-time response.

Industrial Ethernet/Fast Ethernet is flexible in terms of the number of nodes. A
major feature is that it is easy to expand. There is no need to set bus parameters.
The flexibility is achieved by using appropriate network components.

The following table provides you with an overview of the most important criteria on
which to base a decision.
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Table 1-1 Overview of Criteria for Deciding on a Bus System

 Criterion  PROFIBUS  Industrial Ethernet  Fast Ethernet
No. of nodes   typ.

 max.
2-9
126

2 to 100
more than 1000

2 to several 100
almost unlimited

Network span electrical:
up to 9.6 km

optical:
up to 90 km

electrical:
up to 1.5 km

optical:
up to 200 km

worldwide:
with TCP/IP

electrical:
2 x 100 m

optical:
up to 50 OSMs and
up to 150 km ring
length with
single mode;
more OSMs or > 150
km with
hierarchical rings;
max. 3 km distance
between two
neighboring OSMs

worldwide:
with TCP/IP

Topology Bus, tree, star,
redundant ring

Bus, tree, star,
redundant ring

Bus, star,
redundant ring,
hierarchical
redundant ring

Data throughput 1.5 Mbps 10 Mbps 100 Mbps

Manuals

For detailed information on the bus systems, refer to the following manuals:

Table 1-2 Overview of the Manuals

Title Content
Manual
Communication with SIMATIC

Communication networks,
communication services, etc.

Manual
ITP Networks for Industrial Ethernet

Network architecture, components,
configurations

Manual
Triaxial Networks for Ind. Ethernet

Aids to configuration, installation
instructions

SIMATIC NET  PROFIBUS Networks Network architecture, components,
aids to configuration, installation
instructions
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1.4.4 Attaching the ES and OS to the Bus

The engineering station and operator stations are attached to the bus system by
communications processors (CPs). These communications processors  occupy a
slot in the PC/programming device. You have the option of choosing between
HardNet (CPs with their own processor) and SoftNet (CPs without their own
processor).

ES/OS on Industrial Ethernet
(Fast Ethernet)

SIMATIC S7 400

CP 443-1

ES/OS on PROFIBUS

CP 443-5

CP 5412 (A2)CP 1613

PROFIBUSIndustrial Ethernet

Figure 1-8 "HardNet" Communications Processors

HardNet

In the HardNet solution, communication is handled by the processor of the CP. The
processor of the PG/PC is relieved of communication tasks and does not need to
reserve computing power for handling communication. HardNet provides high-
performance communication. Time-of-day synchronization is supported by both
Industrial Ethernet (Fast Ethernet) and by PROFIBUS.

The following CPs are available:

• CP 1613
PCI card for attachment to Industrial Ethernet (Fast Ethernet), with AUI/ITP
and RJ-45 ports. The CP 1613 supports 10 Mbps and 100 Mbps.

• CP 5412 (A2) communications processor for attachment of a PG/PC to
PROFIBUS

To commission these modules, you insert the required CP in a free slot of the
PG/PC and install the CP using the "Set PG/PC Interface" configuration tool
(Windows NT Taskbar > Settings > Control Panel > Set PG/PC Interface).
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SoftNet

The term SoftNet means a software solution in which communication is handled via
a CP without its own processor. The major advantage is the lower price. The
disadvantages are the restricted performance and the additional computing load on
the processor of the PG/PC due to the absence of a processor on the CP.

In SoftNet, the entire protocol stack is handled on the PC. With this architecture, in
contrast to the CP 1413/1613 products (Industrial Ethernet, Fast Ethernet) and CP
5412 A2 (PROFIBUS), the performance of the SoftNet packages depends on the
configuration and load of the PCs being used. As an example, SoftNet for Industrial
Ethernet permits only a maximum of 8 connections. Communication can be based
either on the ISO protocol or the TCP/IP protocol.

The following adapters are available for Industrial Ethernet:

• CP 1411 (ISA card)

• CP 1511 (PCMCIA card)

• Commercially available Ethernet cards (NE 2000 compatible)

With BCE (instead of SoftNet IE), time-of-day synchronization is possible via
SoftNet. Time-of-day frames can be both sent (time master) and received. If there
is a high network load, a synchronization interval of 1 second is recommended.

The following adapters are available for PROFIBUS:

• CP 5511 (PCMCIA card)

• CP 5611 (PCI card)

• Integrated PROFIBUS ports in the SIMATIC PGs/PCs

The adapters are installed using the "Set PG/PC Interface" configuration tool
(Windows NT Taskbar Start > Settings > Control Panel > Set PG/PC Interface).
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1.5 Structure of the Peripherals

Overview

There are various ways in which you can connect the process signals to the CPU
of your programmable controller:

• Using S7-400 I/O modules in the central rack

• Using S7-400 I/O modules in an expansion rack

• Using S7-300 I/O modules in the distributed I/O system ET 200M

• Using the ET 200X

• Using the ET 200 iS

• Using PROFIBUS DP or PROFIBUS PA slaves

• Using AS-interface components (Actuator-Sensor interface)

You can, of course, combine these options as required!

The basics of PROFIBUS DP and PROFIBUS PA are explained in Section 1.4.

Caution:
If a module or rack fails, a special OB is called. If the special OB is not present on the
PLC, the PLC changes to "STOP".

Generating the module drivers (see also Section 1.6) inserts an OB_BEGIN and an
OB_END block in a chart in the relevant S7 program. By including OB_BEGIN, all the
required acyclic OBs  (OBs 70, 72, 80, 81, 82, 83, 84, 85, 86, 121, 122, and 100) are
generated by CFC and transferred to the PLC when you download. If an OB is then called
(for example due to a rack or DP slave failure), the PLC does not change to "STOP" and
OB_BEGIN sends a corresponding message to the relevant OS.
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1.5.1 Connecting the Process Signals to the PLC

The following diagrams are examples illustrating how process signals can be
connected to the PLC.

I/O Modules in a Central/Expansion Rack

There are numerous S7-400 I/O modules available that you can use in a central
rack (the rack containing your CPU) or in an expansion rack. These modules are
connected to the peripheral transducers using conventional cabling. The process
signals are transferred between the I/O modules and the CPU using driver blocks
supplied with the modules.

SIMATIC S7 400
Central rackI/

O
-
M
O
D

I/
O
-
M
O
D

I/
O
-
M
O
D

I/
O
-
M
O
D

TransducerConventional
  cabling

CPU

Figure 1-9 Example of a Structure: The Use of I/O Modules in the Central Rack

I/O Modules in the Distributed I/O System ET 200M

The ET 200M is a modular I/O system with degree of protection IP 20 that can be
operated redundantly (see also Section 0). As an option, it allows modules to be
removed and plugged in while your plant is in operation naturally without
interrupting the automation tasks being handled by the CPU and without
influencing the other modules.

Apart from the numerous conventional I/O modules that you can operate in the
ET 200M, modules with intrinsically safe signals and HART-compliant modules are
also available. HART is a registered trademark of the "HART Communication
Foundation" (HCF) and is a widespread standard protocol. With HART modules
(Highway Addressable Remote Transducer), two frequency signals are modulated
on to the 20 mA DC signal. Using these additional signals, information can be
exchanged with the field device.

The I/O modules used in the ET 200M are connected to the transducers using
conventional cabling.

The ET 200M is operated as a slave on the PROFIBUS DP fieldbus. This results in
extreme flexibility in the structuring of the I/O peripherals both centrally in
electronics rooms and distributed in switching closets.

The ET 200M can also be installed in cabinets.
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ET 200M

PROFIBUS DP

SIMATIC S7 400
central rackI

M

4
6
7

  Transducer
Conventional

cabling

CPU

ET 200M

PROFIBUS DP

ET 200M

ET 200M (distributed station
with peripherals of the S7-
300)

PROFIBUS DP with additional IM 467 field
devices on an additional chain

PROFIBUS DP
integrated in the
CPU

Figure 1-10 Example of a Configuration: Use of the ET 200M Distributed I/O Station

Note:
For the 10 ms time stamp, PROFIBUS DP must be connected to the SIMATIC station via a
CP 443-5 (see also Section 1.8).

If you have several PROFIBUS DP chains in your application that must be supplied
by a central CPU, this is possible by inserting up to three (H systems) and seven
(standard systems) additional IM 467/CP 443-5 Ext. modules in the central rack.

When using the CPU 417-4, an "MPI/DP interface" is also available in addition to
the DP interfaces. You can use this interface either as an MPI interface or as a
PROFIBUS DP interface with up to 32 DP slaves. There are also two further slots
for interface modules on the CPU 417-4. You can insert an interface module in
these slots (for example IF modules for further DP chains).
In the CPU 417-H these two slots are used by the H-Sync modules
(synchronization of the two CPUs). You should bear in mind the question of
availability. If a CPU fails, all the DP chains and the attached slaves of the failed
CPU can no longer be addressed. To increase availability, it is advisable to
distribute the DP chains on several CPUs.

Note:
For more detailed information on the ET 200M, refer to the manual "ET 200M Distributed
I/O Station".
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ET 200X Distributed I/O Station

SIMATIC ET 200X is a distributed I/O station with degree of protection IP 65/IP 67.

With its high degree of protection and rugged design, it is particularly suitable for
use in the immediate vicinity of machines. Its modular design in conjunction with
the high degree of protection, its plug-in connections system and the inclusion of
pneumatics allow fast and optimum adaptation to the functional unit of a machine.
Even when the requirements change often, exchanging and recombining a variety
of basic and expansion modules significantly reduces setting-up times.

With a transmission rate up to 12 Mbps on PROFIBUS-DP, the  ET 200X is also
ideally suited for use in extremely time-critical applications.

By connecting separate auxiliary power supplies (load power supply) to the power
module, individual modules or groups of modules can be turned off. This makes it
easy to implement staged emergency STOP concepts.

The ET 200X distributed I/O station consists of the following:

• One basic module optionally with

- digital inputs

- digital outputs

- DESINA-compliant with settable inputs and outputs

• Max. 7 expansion modules.

The following expansion modules are available:

• Digital inputs/outputs

• Digital DESINA-compliant inputs/outputs

• Analog inputs/outputs

• CP 142-2 communications processor for attachment to AS-Interface

• Pneumatic module with integrated valves

• Pneumatic interface for a CPV valve island (manufacturer FESTO); max. 6
interfaces per ET 200X station

• Motor starter (electromechanical or electronic) for controlling any three-phase
current consumer (max. 5.5 kW at 400 V AC); max. 6 motor starters per ET
200X station

• Frequency converter (max. 0.75 kW, 380 V AC);

• Max. 6 motor starters or frequency convertors per ET 200X station

• SITOP power supply (DC 24 V/10 A), optional

The expansion modules are installed side by side using integrated plug-in
connectors. All necessary signal lines and auxiliary voltages for inputs and outputs
are looped through.
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Note:
For more detailed information on the ET 200X, refer to the manual "SIMATIC ET 200X
Distributed I/O Station".

ET 200iS Distributed I/O Station

The ET 200iS has the following special features:

• Intrinsically safe and modular I/O system

• For distributed automation in hazardous areas: Can be used directly in
hazardous zone 1 (FM: class 1 div. 2 or class 1 zone 1)

• Permanent wiring , module exchange during operation

Caution:
If more than one submodule is removed from the ET 200iS, the IM 151-2 changes to a
safe status. In this case, all the submodules of the station affected are signaled as having
problems.

• Transmission rate up to 1.5 Mbps (PROFIBUS-DP with isolating transformer)

• Degree of protection IP 20

• Modular, function-oriented station structure

• With a wide range of diagnostic options

An ET 200iS station consists of:

• Power supply unit in degree of protection EX d (pressure enclosure) with
terminal module

• PROFIBUS interface module IM 151-2 with terminal module

• Max. 32 digital and analog electronic modules with terminal modules

• Terminator module (supplied with the IM 151-2)

• The SIMATIC ET 200iS can be mounted on a standard rail practically without
any tools.

The stations are included in PCS 7 using PDM (see 1.5.3) in the hardware
configuration (see Chapter 4).
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PROFIBUS DP and PROFIBUS PA Slaves

Another possible method of reading in process signals is to use field devices
(sensors/actuators) that are designed as PROFIBUS slaves. The following table
lists the field devices for which blocks are available in the "PCS 7 Fielddevices"
library:

Table 1-3 Blocks in the "PCS 7 Fielddevices" Library

Block Type Functionality

SIMOVERT AC frequency converter for variable-speed AC motors

SIPOS 3MC/P Power reversal for actuators

SIPART 19
SIPART 21

Digital controller that can be used as a continuous controller,
two-step, and three-step controller.

SIMOCODE SIMOCODE-DP 3UF5 motor protection and control device
system with communication capability (basic type 1,2,3). The
block can only be used for SIMOCODE DP- 3UF5001-3AN00-
1 delivery stage E003.

The link between PROFIBUS PA and PROFIBUS DP is achieved using a DP/PA
coupler or a DP/PA link. When using the DP/PA, the field devices are addressed
directly by the programmable controller; in other words the DP/PA coupler is
transparent. The DP/PA link is a slave on PROFIBUS DP and a master on
PROFIBUS PA. The programmable controller addresses the field devices via the
DP/PA link; in other words, indirectly. When few slaves are involved and when the
real-time requirements are not important, the DP/PA coupler is used and where lots
of slaves are involved and the real-time requirements are high, the DP/PA link is
used.

The "PCS 7 Drivers" library contains five blocks for connecting PROFIBUS PA field
devices (PA_AI, PA_DI, PA_AO, PA_DO, PA_TOT). These blocks support the
cyclic services of the PA profile. Using these blocks, all the field devices of different
manufacturers that meet the requirements of the PA profile can be connected (this
includes, for example, the Siemens SITRANS P field device).

The requirements made of DP devices (DPV0 devices) in terms of data exchange
and diagnostic functions are continuously increasing. The basis for DPV1 devices
was created with the DPV1 expansion of the PROFIBUS standard allowing these
requirements to be met.

In terms of PCS 7, DP masters and DP slaves that support DPV1 provide the
following additional functions compared with the older generation of devices (often
known as standard masters or standard slaves):

• Acyclic data exchange between master and slave is supported (read/write data
record, for example, to make new parameter settings for a slave during
operation). The data records of a module and the structure of these data
records are described in the documentation for the relevant module or
submodule.
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• A DPV1 slave can send interrupts that guarantee a reaction to the interrupt-
triggering event on the master CPU. The interrupt data are evaluated on the
CPU even in the STOP mode (updating of the diagnostic buffer and the
module status); no OB is, however, executed in the STOP mode. Alongside the
interrupts known from SIMATIC (for example diagnostic interrupts with the ET
200M), the new interrupts status interrupt, update interrupt, and vendor-specific
interrupt are also supported.

PROFIBUS DP

SIMATIC S7 400

I
M

4
6
7

CPU PROFIBUS DP

By using an IM 467, further field devices can be used on
an additional chain.

PROFIBUS DP
Integrated in the
CPU

SIMOVERT

SIMOCODE

SIMOVERT

PROFIBUS PA

DP/PA Link

Number of devices
maximum 5 DP/PA couplers per DP/PA link
maximum 31 field devices per DP/PA link

DP/PA coupler

Maximum devices:
10 field devices per
DP/PA coupler

IM 157

DP/PA
coupler

Optionally also
CP 443-5 Ext.

PROFIBUS PA

Figure 1-11 Example of a Structure: Use of Field Devices with PROFIBUS



Basics of PCS 7

Process Control System PCS 7, Configuration Manual
A5E00122418-01 1-33

AS-Interface

The AS-Interface is a heterogeneous network system for simple, usually binary
actuators and sensors at the lowest field level. With AS-Interface, it is possible to
address all connected sensors and actuators on a common 2-wire cable while at
the same time providing them with the required power supply. This system is
connected to PCS 7 via the DP/AS-I link.

PROFIBUS DP

SIMOVERT

DP/AS-I Link

AS-I

Actuator Actuator Sensor Sensor

Figure 1-12 Example of a Structure: Use of the AS Interface

1.5.2 I/O Modules for Use in the ET 200M

Overview

Only module types belonging to the SIMATIC S7-300 rack system can be used in
the ET 200M distributed I/O systems.

The following module types can be used:

• Standard signal modules belonging to the S7-300 rack system

• Special Class B process control, I/O modules with enhanced diagnostic
capabilities

• Ex I/O modules for connecting signals from the hazardous area (the ET 200M
must be installed outside the hazardous area)

For an overview of the available module types, refer to the current PCS 7 catalog
(ST PCS 7).

Control System I/O Modules

The control system I/O modules have enhanced functionality in terms of diagnostic
capabilities, channel-related error indication, diagnostic alarms, internal module
monitoring, retention of the last value or use of a substitute value if the CPU or
power supply fails.
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Control System Modules for Hazardous Areas

Ex (EEx ib) modules are available with electrically isolated channels for binary and
analog input and output signals.

Using Other Module Types

A homogeneous integration in SIMATIC PCS 7 is guaranteed for the modules
listed in the PCS 7 catalog. PCS 7 supplies corresponding driver blocks that also
include integrated control system monitoring.

All other module types from the S7-300 rack system can also be used and can be
integrated using STEP 7 basic mechanisms at a lower conformity level. In this
case, for example, the modules might not be integrated automatically in the
SIMATIC PCS 7 message system.

1.5.3 SIMATIC Process Device Manager (SIMATIC PDM)

Overview

SIMATIC PDM is a complete and heterogeneous tool for configuration, parameter
assignment, commissioning, and diagnostics in conjunction with intelligent process
devices. Yo can use SIMATIC PDM during all phases of a project (engineering,
commissioning, and runtime). SIMATIC PDM allows a large number of process
devices to be configured with one software package using a uniform user interface.

You can use SIMATIC PDM as an integrated tool in the SIMATIC Manager
(network and plant view) and in PCS 7 hardware configuration (HW Config). This
makes SIMATIC PDM a component of the PCS 7 Engineering Station.

The integration in HW Config allows you to edit devices attached to PROFIBUS
DP. All other devices are edited in the process device network and plant view.

The display of device parameters and functions is uniform for all supported process
devices and does not depend on their communications attachment, for example
whether they use PROFIBUS DP/PA or the HART protocol.

The main functions that have advantages particularly for testing and
commissioning are as follows:

• setting,

• modifying,

• checking plausibility,

• management and

• simulation

of process device data.

You can also display selected values, alarms and status signals from the device on
the screen and effectively implement process monitoring. Using simulation or in the
manual mode of the devices, process-relevant values can be manipulated.
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User Interface of the Process Device Manager

The user interface supports several views:

• View in hardware configuration
Process devices are configured in HW Config within the SIMATIC Manager
and displayed graphically or in the form of tables.

• Process device network view within the SIMATIC Manager
Here, you configure the hierarchical structure of networks, communication
components down to the process devices. When integrated in PCS 7, this
configuration data can also taken from here.

• Process device plant view within the SIMATIC Manager
The devices configured in HW Config or in the process device network view
are automatically entered in the process device plant view. Functions allowing
these devices to be grouped are in preparation; you will then be able to
arrange the process devices hierarchically in a tree structure. In this view,
devices can be configured without a network assignment.

• Parameter assignment, commissioning, and run-time view
Here, you can display, modify, and save parameters of a selected process
device. Communication with the device is also established here.

Within the user interface, the devices with differing communications interfaces are
displayed homogeneously making the user interface extremely user friendly.

Note:
The limits set in PA field devices do not necessarily need to match the settings in the
corresponding driver. For example, you could set the limits in the field device to the
physical measuring range of the sensor and the limits in the corresponding driver to the
limits required by the process.

The input and output scaling must then be set according to the device description. The
default value 0 to 100 corresponds to a 1:1 transfer of the measured value from the sensor
to the output of the field device.

In normal operation, all the modes for the field devices should be set to "Auto" or
"Simulation Off/Disabled".

Caution:
Make sure that the measuring range set in HART field devices matches the settings in the
corresponding driver. Only then can process data from the field device be correctly
interpreted and output with the driver.
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Communication

SIMATIC PDM supports several communications protocols and components for
communication with the following devices:

• Devices with PROFIBUS DP communication
These are attached directly to PROFIBUS DP. One example of such devices is
the SIPART DR20 compact controller.

• Devices with a PROFIBUS PA communication
PROFIBUS PA devices with PA profiles for pressure and differential pressure
transducers, electromagnetic positioning controllers and discrete input and
outputs can be configured. It is also possible to configure devices with
PROFIBUS PA profiles temperature, pressure, flow measurement and
hydrostatic level measurement.

• HART devices
These devices can be attached in various ways. The following basic forms can
be distinguished:

- HART devices connected to PROFIBUS PA

- HART devices connected to ET 200 via PROFIBUS DP

- HART devices connected to HART Multiplexers (in preparation) or the
HART interface
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Combinations of these basic forms are of course also possible.

RS-485

HART field
devices

RS-232

PROFIBUS DP

HART field devices

ET 200M

HART field
devices

DP/PA-Link

PROFIBUS
PA

I/O
module

PA
coupler

Engineering station

Ethernet

Service bus

SIMATIC S7 station

HART field devices

PROFIBUS
DP

field devices

ET 200M

HART
module

HART/interface
multiplexer

HART/interface
multiplexer

HART/interface
multiplexer

RS-232 / RS-485 SIPART DR network

SIPART
DR

HART modem

HART field
devices

Figure 1-13 Attaching HART Field Devices

Table 1-4 Configuring the Actuators/Sensors in the Network View or in HW Config

Master DP station Network
view

HW Config

SIMATIC station ET 200 M can* must

SIMATIC station Multiplexer** / interface with
attachment to PROFIBUS DP

must* must

SIMATIC station Multiplexer** / interface without
attachment to PROFIBUS DP

must -

SIMATIC station DP/PA Link can* must

SIMATIC station DP/PA coupler can* must

other ET 200 M must -

other Multiplexer** / interface with
attachment to PROFIBUS DP

must -
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Master DP station Network
view

HW Config

other Multiplexer** / interface without
attachment to PROFIBUS DP

must -

other DP/PA Link must -

other DP/PA coupler must -

SIMATIC station
or other

HART modem must -

SIMATIC station
or other

SIPART DR network must -

* Double input required

** Support of the HART Multiplexer is in preparation

Diagnostics (in preparation)

The diagnostics of SIMATIC PDM checks the devices in the project in a selectable
cycle. The diagnostic results are displayed in the process device plant view.

Configuring Diagnostics

In the process device plant view, you can insert, edit, or delete "diagnostic objects".
You add the diagnostic objects to a device. You can create several diagnostic
objects for one device.

A diagnostic object consists of the diagnostic rules with a message text and
schedule and the status variables for the result of the check.

The diagnostic rule is a logic operation made up of device variables. It is
formulated in the device description language and compiled with the device
description compiler/interpreter integrated in SIMATIC PDM. Using the variable
browser, the user selects the device variables to be evaluated in the diagnostic
rule. Only variables visible to the user in the parameter assignment user interface,
in the menu bar in dialogs, or in the parameter assignment table are available.

The following types of diagnostic rule can be used:

• Standard diagnostics: A diagnostic rule predefined by SIMATIC PDM for
checking the general diagnostic parameters. This diagnostic rule is not
displayed.

• Device type diagnostics: A diagnostic rule predefined by the manufacturer
including all the device-specific diagnostic possibilities. This diagnostic rule is
not displayed.

• User-defined diagnostics: Logic operation on device variables for individual
monitoring of the process. With this type, variables of different devices can be
included in the logic operation.

Regardless of the type of diagnostic rule, the accessibility of all components is
checked by the diagnostic agent. At the same time, the correct configuration of the
network topology and addresses as well as the correct functioning of the
communication is also checked.
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The parameter settings for a diagnostic object are made in the properties dialog of
the diagnostic object.

Each diagnostic object has status variables for returning the diagnostic result:

• Communication:
Status for accessibility of the device. Provided by the diagnostic agent.

• Diagnostics:
Result of the diagnostic rule. Set in the diagnostic rule (method).

• Message:
Status indicating whether a message has arrived or gone and whether the
event was acknowledged by the user.

• Last check:
Time stamp of the last execution of the diagnostic rule.

Diagnostics During Run Time

A diagnostic agent integrated in SIMATIC PDM executes the diagnostic rules
according to a selected schedule. It checks whether or not a device is capable of
communication and evaluates diagnostic rules set by the user.

The result of the check is displayed in the plant view of the SIMATIC Manager and
stored in the status variables of the relevant device.

The diagnostic agent can run on the engineering station, on the operator station, or
on a diagnostic station (DS). A DS is a separate PC on which SIMATIC PDM is
installed and where the diagnostic agent is run.
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1.6 Attachment to the I/Os (Driver Blocks)

Introduction

The connection to the I/Os described below was developed to ensure high
performance even in large systems. Care was taken to ensure that configuration
was both fast and simple.

Why Use Driver Blocks?

In process control systems, signal processing must meet certain requirements.
This includes the reading in of a hardware signal to the CPU and also the test
information relating to the hardware signals, for example module/channel fault.

To allow this, driver blocks are available in the library that implement the interface
to the hardware including test functions.

When process signals are read in, the drivers access the process image input
table (PII) and when they output process signals, they access the process image
output table (PIQ).

The drivers are assigned to the channels of the modules using a symbolic name. In
the hardware configuration, you assign a symbolic name to a module for each
channel (see also Chapter 4 "Configuring the Distributed I/O System ET 200M".
The drivers have a block I/O labeled "VALUE". You specify the symbolic name of
the module channel at this I/O (select the I/O in CFC > press the right mouse
button > Interconnection to Address...).

Principle

Drivers in PCS 7 have two tasks: On the one hand, modules, racks and DP master
systems must be monitored for failures and on the other hand, signals from the
process must be made available to the PLC for further processing.

These tasks are handled by various blocks:

Table 1-5 Division of Tasks Among the Driver Blocks

 Responsibility  Block name  Task

CPU OB_BEGIN; OB_END CPU and connection diagnostics

SUBNET SUBNET Monitoring a DP master system

RACK RACK Monitoring the rack and DP slaves

MODUL MOD_1; MOD_2; MOD_D1;
MOD_D2

Monitoring I/O modules

Slaves PADP_L00; PADP_L01;
PADP_L02

Monitoring DP/PA field devices (DP-V0 or
DP-V1 slaves) on the other side of a
DP/PA or Y link operated as a DP-V0
slave.

CHANNEL CH_AI; CH_AO; CH_DI;
CH_DO

Reading in or outputting process signals

LINK DPAY_V0 Monitoring DP/PA and Y-Link as V0 slave

PA_AI; PA_AO; PA_DI;
PA_DO; PA_TOT

Processing modules with PA profile and
HART
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The schematic below illustrates the relationships between the components to be
monitored and the corresponding block types. If no monitoring is required, the
relevant blocks are not used.

ET 200M

SIMATIC S7-
400

Industrial Ethernet

Operator station (OS)

Process control

PROFIBUS DP

SUBNET

SUBN1_I
DSUBN2_I
D

RACK

RACK_N
O

CHANNEL

VALUE

MODE

MODUL

LADDR

OMODE_x

 ET 200 M

Monitoring and message:
• Chain failure
• DP master failure
Number: 1 x per DP chain

Monitoring and message:
• Rack failure
Number: 1 x per rack

Monitoring and message:
• Insert/remove module
• I/O failure
• Module fault

(for example wire break)
Number: 1 x per I/O mod.

Reading in/outputting process
signals
Number: 1 per mod. channel

Message

Message

Message

Task Mod type

Figure 1-14 Overview: Blocks and Components to be Monitored
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Time-Optimized Processing

To allow time-optimized processing during run time, the organization blocks (the
order in which the user program is executed is specified in organization blocks) for
error handling (for example OB85, OB86 etc.) are automatically divided into run-
time groups and the module blocks installed in the run-time groups.

If an error or fault occurs, the SUBNET block activates the relevant run-time group,
the RACK block and the module blocks contained in the run-time group identify the
problem, evaluate it and output a control system message to the OS.

The diagnostic information of the module block is also transferred (output
OMODE_xx) to the corresponding CHANNEL block (input MODE). If necessary,
this information can be displayed in a process picture (color of the measured value
changes or flashing display etc.) by a PCS 7 block that can be operated and
monitored on the OS or by a user block.

Drivers for Peripheral Devices or I/O Modules not Released for Use in PCS 7

The driver concept described is characterized by the separation of user data
processing (channel blocks) and diagnostic processing (module blocks), the
symbolic addressing of I/O signals and the automatic generation of module blocks
by CFC. This driver concept covers the I/O modules currently released for use in
PCS 7. You will find the approved I/O modules in the hardware list
"PCS7_HW_V52.pdf" on the "Process Control System PCS 7 Software" CD. If you
want to connect other peripheral devices or I/O modules to the PLC in a concrete
configuration, the driver blocks must be created using the driver concept explained
above (one block per device with user data and diagnostic data processing).

Note:
A manual with guidelines on how to develop your own driver blocks is currently in
preparation. Check the information published on the Internet at the addresses listed in the
Preface.
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The following schematic shows the structure of the run-time groups:

Organization block, for example OB86

SUBNET

 EN_R2

RT gr. for
2nd rack

 EN_R127

RACK block

Module blk.
for module 1

Module blk.
for module 2

Module blk. for
module n

 SUBN1TYP

 SUBN2_ID

 SUBN2TYP

SUBN1_ID

 EN_R1

 EN_R0

 EN RT gr. for
central rack

 EN RT gr. for 1st
rack

 EN

Figure 1-15 Structure of the Organization Blocks for Error Handling
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Generating Module Drivers

You can have the required module drivers and corresponding interconnections of
the signal-processing blocks of a selected chart folder generated automatically.
The procedure for this is as follows:

1. Open the SIMATIC Manager and the project in which you want to generate the
drivers.

2. Select the chart folder of an S7 program in the component view (make sure no
charts are selected in this chart folder).

3. Select the menu command Options > Charts > Generate Module Drivers...

Caution:
If modifications are made to the driver blocks during configuration (for example extension
of existing blocks or installation of new blocks etc.), the menu command "Generate Module
Drivers..." must be activated again at the latest on completion of the configuration.

Note:
As an alternative, you can select the option "Generate module drivers" when you compile
the CFC/SFC charts (Compile Chart > Charts as Program > Generate Module Drivers).
Each time you recompile, the required module drivers will be generated or updated.

How the Function Works

The "Generate Module Drivers" function generates new system charts (with names
specified by the system "@...") in which only OB_BEGIN, OB_END, MODUL,
RACK, and SUBNET blocks along with the PO_UPDATE block are inserted by the
driver generator. Each system chart can contain a maximum of 52 blocks.

If changes are made in the configuration (hardware or software), the changes must
be processed using the “Generate Module Drivers" function. The existing driver
blocks are not deleted and recreated but simply have parameters reassigned.
Blocks that are no longer required are deleted (except for those included by the
user) and additional required blocks are created. If block types have already been
imported those from the CFC data management are used and not those from the
library.

The OB_BEGIN-/OB_END blocks each for one CPU, RACK blocks for one rack
and the MODUL blocks are installed in run-time groups. The run-time groups
created by the driver generator are assigned an ID, so that, for example, they can
be deleted automatically again when they no longer contain blocks. Run-time
groups without this ID are not processed by the driver generator. If
RACK/MODULE blocks are installed in a different run-time group by the user, they
are moved to the run-time groups with the relevant ID by the driver generator.
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1.7 Fault-Tolerant Components

The aim of using fault-tolerant components is to reduce production downtimes.
Regardless of whether the downtimes result from faults or are due to maintenance
work.

The higher the costs resulting from a loss in production, the more advisable the use
of a fault-tolerant system. The higher costs generally involved in installing a fault-
tolerant system are soon compensated by the avoidance of production downtimes.

Active redundancy means that all the redundant equipment is permanently in
operation and also takes part in the execution of the control task.

Using the components of the PCS 7 control system, you can implement a degree
of redundancy to suit your needs at all levels of automation ranging from the
operator station, to the bus system, the PLC, and the distributed I/Os.

The following sections describe how you can increase the availability of your plant.

1.7.1 Redundant Server Pair

The redundant server pair guarantees that the operator remains informed about
the state of the plant and can intervene in the process even if a server fails.

Fast Ethernet

Client 4Client 3Client 2

Terminal bus

OS server 1-2

Industrial Ethernet / Fast EthernetPlant bus

OS server 1-1

Client 1

Figure 1-16 Redundancy in Multiple Workstation Configurations (Structured with OSM)
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Up to 16 clients or multiclients can be connected to one server (in V5.0 with
Service Pack 1, this mixed configuration is not possible). The total number of
monitors in connection with one multi VGA card (max. 4 monitors per PC) is 20
monitors. If a process terminal fails, operator input is redistributed on the terminals
that are still available. If a server fails, the terminals are linked to the server that is
still available. When the server returns, the archives are compared so that the data
are available again on all servers. To allow for this comparison of the archive data,
the user structure on both servers must be identical (redundant servers). If the user
structures on the servers are different (parallel servers), the data in the archives
are, of course, different and no comparison is possible.

Permanent Operability

You can distribute the clients/multiclients of a redundant multiple workstation
configuration on a preferred server (master server or standby server) (see also
Chapter 11; Configuring a Multiclient).

If you have six multiclients and one redundant server in your system, you can
declare the master server as the preferred server for three multiclients and the
standby server as the preferred server for the remaining multiclients. If the master
server fails (for example due to a hard disk defect), you can monitor and control the
process permanently at the multiclients of the standby server.

The multiclients of the defective server fail over to the standby server after a certain
time and are therefore once again available so that monitoring control is possible
again at all clients.
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1.7.2 Redundancy of the Bus System

Industrial Ethernet or Fast Ethernet can be used as a redundant medium for
transferring data in PCS 7. Each of the network types has a wide range of electrical
and optical network components available.

With the Optical Redundancy Manager (ORM) and the Optical Switch Modules
(OSM) of Fast Ethernet, you can create an optical ring with a transmission rate of
100 Mbps. In such a ring, a cable fault or the failure of a switch is detected and
signaled. Transmission is continued automatically on the remaining intact part of
the optical ring. The network is reconfigured in less than 0.2 seconds. The DTEs of
a failed OSM cannot be addressed.

OSM

ORM

OSM

OSM

Fast Ethernet
100 Mbit/s

OSM

OSM

OSM

Figure 1-17 Optical Ring with Fast Ethernet

Note:
It is possible to design the terminal bus (TCP/IP) and the plant bus as an optical ring with
Fast Ethernet. This means that in many configurations, the optimum number and
combination of DTEs can be connected to the OSMs.

For more detailed information, refer to the Industrial Ethernet manual and the S7-400
manual (the chapter dealing with communication).
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1.7.3 Redundancy of the PLCs

The S7-400H allows a redundant system to be implemented. This means that all
essential components exist twice. The CPU, the power supply, and the hardware
for linking the two CPUs are always doubled. Which other components are
duplicated to increase availability is left to the user to decide based on the
particular process being automated. The user program on the two CPUs is identical
and is executed by both CPUs at the same time (synchronized).

Figure 1-18 Structure of the S7-400H

Event-driven Synchronization

Event-driven synchronization means that whenever events occur that could lead to
a different internal state in the subsystems, the master and standby data are
synchronized. Subsystems are synchronized in the following situations:

• Direct access to the I/Os

• Interrupts, alarms

• Updating user times

• Modification of data by communication functions
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Uninterrupted Continuation Even if a CPU Drops Out

The principle of event-driven synchronization means that even if the master CPU
fails, the standby CPU can take over at any time without interrupting operation.

The following schematic is an example of a configuration with an S7-400 H,
common distributed I/Os, and an attachment to a redundant plant bus.

SIMATIC S7 400 H
central rack

Redundant plant bus (Industrial Ethernet or Fast Ethernet)

DP/PA Link (with up to
5 DP/PA couplers)
with 2 x IM 157

Distributed I/Os
ET 200 M
with 2 x IM 153-2

PROFIBUS PA
PROFIBUS DP

PROFIBUS DP

Y-Link for attaching a single
DP master system to a
redundant DP master system

Underlying DP master
system

PROFIBUS DP

Figure 1-19 S7-400 H with Shared Distributed I/Os

Note:
For more detailed information, refer to the S7-400 H manual, “Fault-tolerant Systems”.

Remember the special features of organization blocks in conjunction with the S7-400H as
explained in Chapter 4 (Configuring Hardware).
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System Modifications During Operation

With the CPU 417-4H, firmware Version V2.0.0 or higher, you can make system
modifications  without interrupting the active program. This option is also known as
HCIR (H Configuration in run).

As long as the hardware components involved are suitable for removal or insertion
when the power supply is on, the hardware can be modified in the redundant
system state. Since, downloading a modified hardware configuration in the
redundant system state would also lead to a stop in an H system, the system must
be temporarily changed to the solo mode. In the solo mode, the process can only
be controlled by one CPU while the required configuration changes are made on
the other CPU.

 During operation, the following modifications can be made:

• Adding or removing modules in the central or expansion racks (for example
one-way I/O module).

• Adding or removing components of the distributed I/Os, such as

- DP slaves with redundant interface module (for example ET 200M or PA
link)

- One-way DP slaves (in any DP master system)

- Modules in modular DP slaves

- PA coupler

- PA devices

• Use of a free channel on an existing module

• Modification of certain CPU parameters (for details refer to the H manual)

• Modifications to the memory configuration of the CPU

• Modification to the user program (restrictions see below)

• Modifications to the connection configuration (for example connections
between SIMATIC stations)

The following modifications cannot be made during operation:

• Addition or removal of interface modules IM460 and IM461

• Addition of the external DP master communications processor CP 443-5
Extended and the corresponding connecting cables

• Certain CPU parameters (for details refer to the H manual)

• The transmission rate of redundant DP master systems

• S7 and S7 H connections

• The following modifications to the user program are not possible in the
redundant system state

- Structural changes to an FB interface or FB instance data.

- Structural changes to shared DBs.

- Compression of the CFC user program.
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For more detailed information about making system changes during operation,
refer to the manual S7-400H Programmable Controller, Fault-Tolerant Systems

Attaching to a Redundant System with S7 REDCONNECT

The S7-REDCONNECT software package connects the fault-tolerant S7-400 H
with the OS. This allows two communications processors (CPs) to be used in the
PC (either both for Ethernet or both for PROFIBUS). Mixed operation of redundant
and single systems is also possible.

Figure 1-20 Example: Mixed Configuration of Redundant and Single Systems

1.7.4 Y-Link and Y-Adapter

The Y-Link implements a gateway between a redundant DP master system and a
single DP master system. This allows all standard slaves with only one PROFIBUS
DP interface to be connected as switched I/Os to a redundant DP master system.

From the perspective of the programmable controller, the Y-Link is a DP slave, and
from the perspective of the underlying DP master system, it is a DP master. Figure
1-19 shows how the Y-Link is included in an PCS 7 system.

The Y-Link consists of two IM 157 modules, a Y-adapter and an RS-485 repeater.

OS server 2

PROFIBUS/ Industrial Ethernet

Plant bus (redundant)

OS server 1

to the clients

2 CPs in one
server

SIMATIC S7-400 H SIMATIC S7-400
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Properties of the Y-Link

The Y-Link has the following features:

• Modular design mounted on an S7-300 rail with an active backplane bus

• All transmission rates from 9.6 Kbps to 12 Mbps for the redundant DP master
system

• Bumpless switchover of the active channel of the redundant master system

• Support of system modifications during operation with an S7-400H

• Diagnostics with LEDs and in the user program

Properties of the Y-Adapter

The Y-Adapter has the following features:

• Transmission rates of 187.5 Kbps to 1.5 Mbps for the underlying DP master
system (independent of the redundant master system)

• Isolation between the underlying DP master system and power supply over the
RS-485 repeater

• Degree of protection IP 20

How It Works

• The Y-Link maps the underlying DP master system as a switched DP slave on
the redundant master system.

• The Y-adapter and the underlying DP master system form a separate bus
system isolated from the redundant bus system.

• In terms of data, the Y-Link in the role of DP slave in the redundant DP master
system acts as a substitute for participation in the underlying DP master
system.

Note:
For more detailed information, refer to the product information "Y-Link Bus Coupler". You
will find this on the Internet at the address listed in the Preface.

1.7.5 Fail-safe Systems

Plants that represent a danger to people, machines, production and the
environment must meet ever stricter safety requirements. Fail-safe systems are
suitable to meet these requirements. Fail-safe systems, however, do not
automatically increase availability since these systems change to the fail-safe state
if a component fails.

For more detailed information on fail-safe systems, refer to the manual S7-
400F/S7-400FH Programmable Controllers, Fail-Safe Systems.
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1.8 Generating Messages

Overview

The message system of the SIMATIC PCS 7 control system helps the operator to
keep track of and control of sporadic events. Such events can result from normal,
exceptional, or unwanted states in the process and control system and are
signaled to the operator individually in an overview line (not operator input
messages) and in various message pages in the run-time system of the OS. In
addition to these events, operator intervention is also fully incorporated in the
message system and is entered in existing message lists and archives in the same
way as process messages.

Messages can be divided into three classes:

• Process messages
signal process events of the automated process such as limit value violations
of measured values and operating messages.

• Control system messages
are caused by faults or errors occurring in the control system components and
detected and signaled by SIMATIC PCS 7. These errors range from the failure
of a component to the wire break message of a connected I/O signal.

• Operator input messages   
are generated when process values are manipulated, for example as occurs
when a controller changes to a different mode. If the picture blocks provided in
the libraries are used, the operator input messages are generated
automatically.

Assignment of Messages to an Area

With the plant hierarchy available in the ES, plants, units and technological
functions are assigned to areas by the user and are reflected in the process control
on the operator stations. The area names assigned by the user in the plant
hierarchy then apply to all messages from all blocks of all charts in this hierarchy
branch. The message texts are transferred to the OS data using the "Transfer
PLC-OS Connection Data" function. Messages arriving at the operator station
during run time are entered in the message lists and allow an area-related view.

Error Location in Message Texts

If an error occurs, the module blocks (see also Section 1.6) send a message with
the following information about the location of the error to the operator station:

• Number of the DP master system to which the module is attached

• Rack in which the module is installed or station number

• Slot number of the module in the rack

• Message text from the text library MOD_D1_TXT or MOD_D2_TXT
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Loop-in-Alarm Function

Process and control system messages from technological blocks that are
visualized on the OS include the loop-in-alarm function. This function allows direct
selection of the standard faceplate for this measuring point in the loop display (see
also "Configuring Operator Stations") from the message list in the run-time system.
The function is provided automatically by the system and no extra configuration is
necessary for the PCS 7 blocks.

Origin of a Message

Depending on the configuration, messages can originate at various locations within
PCS 7. The origin of the message influences the time stamp of the message.
Regardless of their origin, all messages are treated in the same way in terms of
display and archiving.

Figure 1-21 Origin of Messages

Events occurring on the PLC or in the ET 200M are sent as single messages via
the system bus to the relevant OS. The corresponding time stamp is also
transferred with the message. Messages are displayed in the message lists of the
OS in chronological order along with the time at which a message was generated.
The following table shows the locations where a message occurs and the time
stamp it receives.

ET 200M

SIMATIC S7-400

PROFIBUS DP

Industrial Ethernet

Operator station (OS)

1. Origin of the message in
    the operator station

2. Origin of the message in
    the PLC

3. Origin of the message in the
    IM 153-2 (ET 200 M)
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Table 1-6 Configuring and Time Stamping Messages

 Origin  Where the
message

is configured

 Where the time
stamp

is added

 Meaning for
PCS 7

Operator station In the "Alarm
Logging" editor on
the operator station

On the operator
station

Control system message
of the OS, attachment of
non-S7 systems

Programmable
controller (PLC)

In the instances of
the blocks (for
example
"CTRL_PID" or
„MEAS_MON" etc.)
in the CFC charts

On the
programmable
controller

Process and control
system messages from
the SIMATIC stations

Distributed I/O
station (ET 200M)

In the instances of
the "IM_DRV" block
in the CFC charts

In the ET 200M by
the IM 153-2

Selected events for the
first-up signal in the event
of plant failure
(10 ms accuracy)

Time Stamp with 10 ms Accuracy

This method allows extremely accurate time stamping of an incoming event. If two
sensors on two stations on different PROFIBUS DP chains on different PLCs are
activated simultaneously, the time stamps of these signal changes must not differ
by more than 10 ms. This is only possible when there is time-of-day
synchronization of all the devices attached to the system bus (see Section 1.10
and 4.5).

Reading in events with this high degree of time accuracy is often necessary when
acquiring the first-up value after the failure of a unit and the resulting flurry of
messages. From the large number of messages, the message that led to the failure
of the unit (first-up value) must be recognizable.

Note:
For information on structuring the hardware, refer to Section 4.5 (Configuring Hardware).
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1.8.1 Configuring and Triggering a Message

Origin Operator Station

The configuration engineer adds new messages and the corresponding message
text in the "Alarm Logging" editor (WinCC Control Center). The event (binary value,
bit within an integer etc.) that will trigger the message is also specified here.

If the event occurs during run time, the message is displayed on the monitor.

Origin Programmable Controller

The configuration engineer enters the message texts directly in a block in the CFC
chart. The algorithm of the block already knows the event that will trigger the
message (for example "Alarm High" or "Motor Protection Responded" etc.). The
PLC/OS engineering makes sure that the texts specified in the CFC chart are
entered in the alarm logging of the operator station with a message number that is
unique throughout the system. This means that duplication on the programmable
controller or operator station is not possible.

If the event occurs during run time, this event is time stamped on the PLC.
Following this, a frame containing the time stamp and message number information
is sent to the relevant OS stations. Here, the frame is evaluated and the message
along with its message text is displayed and archived chronologically.

Note:
The standard/daylight saving time conversion is made on the OS. The local standard time
must always be set on the PLC. The system message block "Daylight saving/standard
time" (Alarm Logging > Message Blocks > System Blocks > Context-Sensitive Menu
"Add/Remove") contains an identifier indicating whether the displayed message time is
standard or daylight saving time.

Origin Distributed I/Os

The configuration engineer enters the message texts directly in the "IM_DRV"
block in the CFC chart. Assigning the message to a slot and channel identifies the
input that will trigger the message (see also the online help on the IM_DRV block).
The PLC/OS engineering makes sure that the texts specified in the CFC chart are
entered in the alarm logging of the operator station with a message number that is
unique throughout the system. This means that duplication on the programmable
controller or operator station is not possible.

If the state of the input changes during run time, the event is time stamped on the
IM 153-2. The IM 153-2 indicates that it has time-stamped events to transfer by
triggering a hardware interrupt on the corresponding PLC. Using the DP service
"Read Data Record", the PLC then fetches a list with time-stamped change
messages and sends this in the form of a frame including the time stamp and
message number information to the relevant OS stations. Here, the frames are
evaluated and the messages along with their message texts are displayed and
archived chronologically.
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1.8.2 Acknowledgment Concept

SIMATIC PCS 7 uses a central acknowledgment concept. If a message is
acknowledged on an OS, the signaling block on the PLC is informed of the
acknowledgment. From here, it is passed on to all relevant OS stations as an
acknowledged message.

1.8.3 Acoustic Signaling

Problems in the process or in the process control are signaled to the operator both
in the message lists (see also Section 1.8.4) as well as acoustically via a signal
module.

The signal module can activate up to three different lamps or three horns for
different message classes. The message classes are assigned to the channels of
the signal modules by the configuration engineer in the alarm Logging Wizard (see
Chapter 11). An external hardware acknowledgment button can also be connected.
The signal module includes a watchdog that can indicate the failure of an operator
station.

The signal module is installed in a single workplace system or on the operator
terminals of a multiple workplace system and requires one PCI slot in the operator
station.

1.8.4 Message Lists in PCS 7

PCS 7 enters incoming messages in message lists according to their state and
type. The following message lists are available in PCS  7. The configuration
engineer can also create further message lists or modify the existing message list.

• New list
All unacknowledged messages are listed here.

• Old list
All acknowledged and still active messages from the process are listed here.

• Left state list
All messages marked as "left state" are listed here (special message property)

• Operating message list
All the operator input messages are listed here (for example the setpoint of a
controller is set to 5 bar)

• Control system list
All control system messages are listed here (for example rack failure)

• History
The history contains all messages (entering state, acknowledged, and left
state)

In the standard messages, each process message displayed on the operator
station includes the date, time, origin, event and message class. It is, however,
possible to modify the appearance of messages and to select the message
information displayed in the Alarm Logging editor.
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Overflow of the Message Buffer

Each component of the entire PCS 7 system can only process a limited message
load. If more messages occur on a component (for example on a PLC) than can be
processed by the component within a time window, messages are lost. In this case,
a PLC then sets an overflow indicator that is signaled on the OS as event "NRMS7
message loss".
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1.9 Control System Monitoring and Diagnostics

Introduction

Control system monitoring is an integral part of SIMATIC PCS 7 and is available
without requiring additional configuration simply by using the components. It is
used to generate control system messages to provide the user with understandable
information about the error state of a control system component. Control system
components range from sensors, transducers and all system components to
modules and the power supply. The functional interaction of these components is
also monitored for problems.

Control system monitoring and diagnostics serve to minimize the time required to
identify a problem if faults occur in components of the control system or in field
components (sensors, actuators, switchgear). This increases the availability of the
control system.

The aim is the automatic output of important information from the control system to
the operator and technicians that allows the source of a problem to be identified.

1.9.1 Control System Monitoring

Control system monitoring is an integrated system function that involves all
hardware and software components and that runs permanently in the background
parallel to user functions. Special user programming for this monitoring is therefore
not normally necessary.

Control system messages are handled on the OS in the same way as process
messages. They must be acknowledged and, if required, can also be transferred to
the external archive. With the help of the control system monitoring and with
appropriate configuration, it is possible to predefine the behavior of the control
system if component fails (for example adopting a safe state).

Connection Diagnostics

Connection diagnostics (for example, monitoring a connnection between two PLC
systems or PLC and an OS) can be implemented using the OB_BEGIN block. Up
to 64 connections are monitored.

In H systems, the current state of the two H CPUs can be obtained by reading the
partial system status list 71 (SZL71). You will find a detailed description of the
significance of SZL71 in the reference manual "System Software for S7-300/400
System and Standard Functions".

Note:
The messages "failure or loss of redundancy connection ID" are generated by every CPU
of the connected PLCs. Only the failure of the CPU (or both H CPUs) of a PLC is an
exception.



Basics of PCS 7

Process Control System PCS 7, Configuration Manual
1-60 A5E00122418-01

1.9.2 Control System Diagnostics

In SIMATIC PCS 7, the control system diagnostics is a three-level concept:

Level 1
The operator is informed of a disturbed function by control system messages in the
plant overview and in the message lists. All incoming control system messages are
displayed and archived. If applicable, the operator is guided to the process picture
(loop display) in which the affected part of the process is visualized. Here, the
operator can check the effects of the problem on the process. The configured
reactions are started automatically.

Level 2
The operator informs the control technician about the problem. The control
technician has access to all control system messages and can display an overview
of all pending control system messages at any time. The displayed messages
already contain information about the cause and location of the problem such as
rack and slot of the relevant module or node number of the relevant station.

Using the engineering system, the control technician can output the diagnostic
buffer of the affected station. The diagnostic messages contain further details
about the error messages that have occurred. At the click of a button, the control
technician can display additional tools relevant to the listed diagnostic messages
(error descriptions and possible causes).

The location of a problem in the distributed I/Os can be identified extremely quickly
with an online view of the attached slaves. In the online view, the cause of the
problem on the affected slave is also displayed (for example wire break).

Faults are also indicated by red LEDs on the modules of the stations and the
distributed I/Os. A quick look in the cabinet in which the components are installed
and the location of the problem can be identified immediately.
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Level 3
If the problem cannot be eliminated (for example, by replacing a module), the
control technician calls in a system specialist from Siemens. With know-how and
using the system diagnostic and test functions, the specialist can access all parts
of the system and eliminate the problem. If required, fast help can also be obtained
using the Teleservice (see 1.9.4).

 ET 200M

SIMATIC S7 400

PROFIBUS DP

Industrial Ethernet

Operator station (OS)

Proc. control mess.

S

Figure 1-22 Control System Monitoring: Visualization of the Location of a Problem
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1.9.3 Quality Code

Introduction

Another method of detecting problems is to evaluate the quality code on an OS
and to indicate the information to the operator by a display in the process picture.

Quality Code

The path of a process value is monitored from the field device to the operator
station. Problems occurring on this path (for example module fault,
communications problem etc.) are detected on the stations (field device, SIMATIC
station, operator station) and encoded in a quality code.

 Field device

PROFIBUS DP

Operator Station (OS)

Quality Code

CP
44
3

CP
44
3

SIMATIC S7

Quality Code

Quality Code

Figure 1-23 Formation of the Quality Code

The quality code of a process value is processed and passed on at every level
from the field device, via the SIMATIC station to the operator station. The poorest
quality code from the various processing levels (field device, CPU, OS) is always
the value that is passed on.

In the block configuration on the ES, a parameter with quality code is indicated by
the attribute S7_qc = ’TRUE’. In the data manager in the WinCC Explorer, you can
recognize a tag with quality code by the "QC" extension following the address
parameter (for example DB75. DW18, QC). When the PLC-OS connection data are
transferred, a corresponding variable for the quality code is created on the OS for
every block parameter with the attribute S7_qc = ’TRUE’.
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Possible information for the entry in the quality code could be, for example:

• Fault in the field device

• Device not connected

• Configured lower or upper limit of the value violated

• Access to the variable not permitted

• Variable does not exist

• Communication not established

• Module fault etc.

1.9.4 Keep Last Value if Hardware Faults Occur

If a CPU, an I/O module, or a DP/PA slave fails, certain mechanisms are started
that influence the values read from or output to the process. These are explained
below.

Keep last value if the CPU fails

For certain S7-300 modules (ET 200M) and S7-400 modules (central rack), you
can decide how the outputs of the analog module react to a CPU stoppage (some
modules do not have the full range of options!):

• Substitute a value (SV) The default substitute value is "0"; in other words, all
outputs off. You can set the substitute values for each individual output.
Substitute values must be within the rated range.

• Keep last value (KLV)
The module will retain the last value output before STOP.

• Outputs have no current or voltage (OCV) The module turns off the outputs
when the CPU changes to STOP (U/I = 0 V/mA).

Caution:
If you decide to output substitute values, make sure that the plant is in a safe state!

PA devices have their own configurable response to CPU failure. The configuration
decides which value is output by the device. PA devices accept a value from the
CPU again only when:

• Communication is reestablished with the CPU.

• The quality code of the variable sent by the CPU does not contain the value
"0".

The ET 200M  HART modules have a fixed response that cannot be changed by
setting parameters.

• The substitute value "0" is output when the CPU stops.
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Keep last value when an I/O module fails

If an input module fails, the response of the input driver can be set so that the
process bases all following calculations and functions on the last valid process
value that was read in.

The response of the input drivers of the ET 200M digital input modules (CH_DI) is
as follows:

• Substitute value
If the input parameter is SUBS_ON = TRUE, the value of the input parameter
SUBS_I is output at output parameter Q with quality code QUALITY = 16#48
and QBAD = 1 if the digital value of the process image partition is invalid.

• Keep last value
If the input parameter is SUBS_ON = FALSE, the last valid output value is
output when the raw value is invalid. The quality code is set to QUALITY =
16#44 and QBAD = 1.

• 

The response of the input drivers of the ET 200M analog input modules (CH_AI) is
as follows:

• Substitute value
If the input parameter is SUBS_ON = TRUE, the value of the input parameter
SUBS_V is output as the value if the raw value is invalid. The quality code is
set to QUALITY = 16#48 and QBAD = 1.

• Keep last value
The quality code is set to QUALITY = 16#44 and QBAD = 1. If the input
parameter is SUBS_ON = FALSE, the last valid output value (V_LAST) is
output if the raw value is invalid. If V_DELTA > 0, the following condition
applies:

- ABS (V - V_LAST) > V_DELTA: V =  V_LAST1 (second last valid output
value)

- ABS (V - V_LAST) ≤  V_DELTA: V =  V_LAST (last valid output value)

- 

The response of the input drivers of the PA devices (PA_AI) is as follows:

• Substitute value
If the input parameter is SUBS_ON = TRUE, the value of the input parameter
SUBS_V is output as the value if the values are invalid. The quality code is set
to (STATUS =) 16#48 and QBAD = 1.

• Keep last value
If the input parameter is SUBS_ON = FALSE, the last valid output value is
output when the values are invalid. The quality code is set to (STATUS =)
16#44 and QBAD = 1.

During the startup of a transducer in the process, values are often sent to the
programmable controller that do not correspond the correct process values. To
avoid this causing problems, you can set a value acceptance delay in the CH_AI
driver. The following responses apply only if "H_PA_ON = FALSE" (not a HART or
PA device):
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• After a restart or when the quality code changes from "BAD" to "GOOD", the
quality code and value are not updated until the CNT_LIM cycles have
elapsed.

• If CNT_LIM = 0 (default), the function is disabled.

• During the value acceptance delay, the quality code is = 16#00 and QBAD = 1.

• The last value is retained during the value acceptance delay.

1.9.5 Teleservice

With Teleservice, it is possible to check, modify or remotely control the operator
station directly via a modem and using special software (for example PC-
Anywhere, Laplink etc.). The schematic below illustrates the principle:

 Modem

Operator stationPC Software
PC-Anywhere

 Modem

 Phone line

Customer Support Customer

Software
PC-Anywhere

Figure 1-24 Teleservice
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1.9.6 Monitoring the Connected PLCs and Operator Stations

Introduction

With the OS function "Life Beat monitoring", it is possible to monitor the functions of
the PLCs and operator stations connected to the system bus in the SIMATIC
PCS 7 control system. This means that you always have an up-to-date overview of
the state of your plant.

The monitoring function is executed by the operator station with each operator
station monitoring all other PLCs and operator stations to which there is a
communications connection.

Activating Life Beat Monitoring

The Life Beat Monitoring is configured on the operator station (single workplace or
multiple workplace system) and then activated automatically when the OS starts
up. The monitoring time can be set and is normally selected in cycles between ten
seconds (default) and one minute.

The life beat monitoring reads the operating state from the PLCs. If a mode change
is detected (for example from RUN to STOP), a control system message is
generated by the OS.

If a system does not react to the monitoring, for example because the power supply
of a PLC has failed, a control system message is also generated.

The entire state of the plant can be visualized by the OS. By pressing the
appropriate function key on the OS, a plant configuration picture is created without
any additional configuration being necessary and the monitored components and
their current states are displayed.

Signaling Failed Components

Failed PLC and OS systems are indicated as follows:

• A control system message is generated indicating that the system has failed
and

• A cross indicates the failed station in the plant configuration picture

In the graphics, the values and state displays whose source is a failed PLC are
displayed on a gray background.
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1.10 Synchronizing the Time of Day

Introduction

To synchronize the time of day centrally in SIMATIC PCS 7, a single workstation
system or a server can synchronize the time of day of all the devices connected to
the system bus. In Industrial Ethernet or Fast Ethernet, the SINEC real-time
transmitter or the SICLOCK TM can be used as the master.

Figure 1-25 Principle of Time Synchronization over Industrial Ethernet (Fast Ethernet)

Note:
The operator station functioning as the time master on Industrial Ethernet or Fast
Ethernet must have the CP 1613 as its communications processor or BCE. If you use the
CP 1413, the time master can only be a "real-time transmitter for Industrial Ethernet" or a
"SICLOCK".

Caution:
If the time stamp accurate to 10 ms is required in ET 200M, the time master must be a
"real-time transmitter for Industrial Ethernet" or a "SICLOCK". Only these time masters are
capable of distributing an extremely accurate time-of-day required for the 10 ms resolution.

Single workstation system (OS) Single workstation system (OS)

SIMATIC S7-400 SIMATIC S7-400 SIMATIC S7-400

Time
slave

Time
master

DCF 77 or GPS
receiver

Time slave Time slave Time slave

SIMATIC S7-400

Time slave

Industrial Ethernet

Optional time master:

Real-time transmitter for
Industrial Ethernet or
SICLOCK TM
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It is also possible to declare two operator stations (single workplace systems or
server) as the time master in the system network. These then coordinate
themselves so that only one time master is active on the system bus and send the
time-of-day synchronization signals. If the active time master fails, the other can
then automatically take over the synchronization function.

1.10.1 Options For Time-of-Day Synchronization

The operator station as the active time master can be synchronized externally
using the following:

• The DCF 77 receiver or

• The GPS receiver

As a somewhat less accurate but also less expensive option, the operator stations
own PC time can be used as the master time.

DCF 77 and GPS receivers are connected to the serial COM port of the operator
station as separate devices and allow synchronization beyond the limits of a single
plant.

1.10.2 DCF 77 receiver or GPS receiver

The DCF 77 receiver as a radio-controlled model, receives the official German time
up to the limits of Europe (with certain restrictions in Norway). This is a cost-
effective solution for time-of-day synchronization within Europe.

GPS Receiver
GPS (Global Positioning System) operates worldwide and is not dependent on
national time transmitters since the system is based on 24 satellites that use the
time of onboard clocks. Due to the regional installation of Windows on the operator
station, the transmitted time-of-day is converted to the current time in the particular
country.

The GPS module therefore allows worldwide use of SIMATIC PCS 7 and time-of-
day synchronization beyond the limits of any one plant.

Accuracy of Time-of-Day Synchronization

Which time master is used depends mainly on the accuracy required of the
reference time.

• The time master is an operator station without "DCF 77" or "GPS"
Due to fluctuations (ports, bus etc.), time differences of 20 to 30 ms can occur
between the slaves and the time master. There is no synchronization with
official time.

• The time master is an operator station with "DCF 77" or "GPS"
Due to fluctuations (ports, bus etc.), time differences of 20 to 30 ms can occur
between the slaves and the time master. The time master is synchronized with
official time.

• The time master is a "real-time transmitter for Industrial Ethernet" or a
"SICLOCK"
(only for Industrial Ethernet or Fast Ethernet)
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Due to fluctuations (on the bus) time differences of 1 ms can occur between
the slaves and the time master. If a DCF 77 receiver is used on the time
master, the time-of-day is synchronized with the official time.

Note:
If you use PROFIBUS as the plant bus, it is only possible to use an operator station as the
time master (optionally with "DCF 77" or "GPS").

1.11 CPU Clocks

As of  STEP 7 V5.1, Service Pack 2, the following settings can be made and
evaluated on new CPUs (firmware version 3 and higher) in addition to the time of
day/date:

• Daylight-saving/standard time

• Correction factor for time zones

Representation of Time Zones

Throughout the plant, there is only one continuous uninterrupted time of day, the
module time.

On the programmable controller, an additional local time can be calculated that
differs from the module time and that can be used by user programs. The local time
is not enter directly but is calculated from the module time by adding or subtracting
a time to/from the module time .

Daylight-saving/Standard Time

When you set the time and data, you can also set daylight-saving  or standard
time. When the time changes from daylight-saving to standard time, for example by
the user program, the change is made only relative to the module time. You can
implement the time change using a block that you can obtain from the Internet.

Reading and Setting the Time of Day and the Time Status

The daylight-saving/standard time identifier and the time difference compared with
the module time are contained in the time status.

You can read and set the time of day and time status as follows:

• With STEP 7 (online)

- Using the menu command PLC > Set Time and Date (read and set)

- In the "Module Information" dialog box, "Time System" tab (read only)

• In the user program

- SFC 100 "SET_CLKS" (read and set)

- SFC 51 "RDSYSST" with SZL 132, index 8 (read only)
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Time Stamp in the Diagnostic Buffer, in Messages, and OB Startup Information

The time stamps are generated using the module time.

Time-of-Day Interrupts

If time-of-day interrupts are skipped due to the change from standard time to
daylight-saving time, OB80 is called.

When the time changes from daylight-saving time to standard time, the periodicity
of time-of-day interrupts whose periodicity is every minute or every hour is retained.

Time-of-day synchronization.

A CPU that is set as the time master (the example in the CPU tab
"Diagnostics/Clock") synchronizes other clocks with the module time and its current
time status.

1.12 Acquiring and Archiving Measured Values

Introduction

It is often necessary to transfer process values on the PLC to the measured value
archive on the OS where they can be stored and accessed for longer periods.
Process values are normally transferred to a process value archive by reading the
required values from the PLC. If, however, a large number of values needs to be
archived in extremely fast cycles, the technique of "data blocking" in conjunction
with the AR_SEND block should be used. This mechanism is described in greater
detail in Chapter 11 (Using AR_SEND in PCS 7).

The capacity of hard disks has increased constantly in the last few years. Even
hard disks with an extremely high capacity can, however, become full after a few
months if large amounts of data are stored in measured value or message
archives. It is therefore essential that every configuration engineer estimates the
amount of data to be archived (number of measured values * number of tags per
measuring point * 31 bytes). Data that must be retained over a long period, for
example, as proof of quality, are stored using the "Storage" archive function on a
different storage medium. For more detailed information about the archive function
refer to Section 1.12.2.



Basics of PCS 7

Process Control System PCS 7, Configuration Manual
A5E00122418-01 1-71

1.12.1 Measured Value Archiving (standard procedure)

Overview

You can store measured values for the blocks of a PLC in process value archives
on the OS. You configure the archive on the OS, for example, by specifying the
archive type, setting the archiving cycle for each tag and specifying which tags you
want to log in the archive (refer to the online help of Tag Logging on the OS). The
values are then requested from the PLC and entered in the archive (in the run-time
mode on the OS).

Figure 1-26  Archiving Measured Values

1.12.2 Archiving and Exporting Archived Data

Overview

During process automation, process values, messages or logs continuously accrue
and, depending on the user software, some of this data must be stored in archives.
The operator station (single workplace system/server) has the following archives:

• Ring buffers
The size of the archive is fixed. Once the end of the archive is reached, newly
arriving data records overwrite the oldest data records.

• Sequence archives
The size of the archive is determined only by the free hard disk space.

The configuration engineer decides which archive will be used in the user software
depending on the required performance, the amount of data to be handled and the
optional use of Storage.
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Archiving Data on other Media with Storage (only for sequence archives)

The archive functions (Storage) of the OS support automatic archiving of data
(DBase archives are not supported) from the hard disk to long-term data storage
(other hard disks, zip diskettes etc.) and deleting of data on the hard disk. The
"Storage" editor displays a dialog box in which you can select the settings you
require.

Automatic storage can be controlled by two factors:

• Time-driven storage
triggered by date or time information. If you select this type of storage, you
must specify the start time and the repetition time.

• Fill level-driven storage
triggered by the amount of data on the storage medium. If you select this type
of storage, you must specify the maximum "fill level". The storage function is
triggered when the amount of data on the monitored hard disk exceeds the
specified percentage. The amount of data currently on the disk is displayed as
user information.

Caution:
Fill level-driven storage is unsuitable for long-term archiving since the data in the archives
is not deleted when data is exported but simply given a delete ID. The size of the archive
is therefore not changed. As a result, the storage function attempts to export cyclically
once the specified level has been reached.

Archive Server of Storage

When automatic archiving is selected, an archive server monitors the current data
states. These states (for example "Ready" => the archive server is running and
monitors the automatic archiving or "Wait for retry" => an error occurred during the
last archive access etc.) are displayed in a dialog box.

Ring Buffer

Data contained in the ring buffers cannot be managed by the Storage function! You
can, however, access the data in process value archives using an action (C script).
This C script must be formulated according to the customer’s requirements.

dBase Format for Tag Logging Archive

You can also store your data in the dBase-III format. This data format is particularly
suitable for storing large amounts of data. You can specify this format in the
"Project Properties" dialog box in Tag Logging.

An archive in the dBase format is always created as a ring buffer. It is therefore not
possible to export the data with the Storage function.
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Exporting/Importing Messages

With the "Messages" "Import Single Messages" menu command in Tag Logging,
you can import files with message texts into Alarm Logging or using "Export Single
Messages", you can export message texts from Alarm Logging to files. Use this
function only for messages created in WinCC (see Section 1.8.1). All PCS 7
message texts from the ES are overwritten on the OS when you transfer the PLC-
OS connection data.
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1.13 Using Multiclient Functionality on the Operator Station

Overview

In a multiclient project , there is a client that can access the data of more than one
server. Each multiclient and each server has its own project. Within a multiple
workplace system, you can create a mixed configuration with clients and
multiclients. Pictures from a server that are intended to be displayed on a
multiclient must be suitably configured (refer to the online help). Pictures from a
multiclient project contained on the multiclient can only access the tag
management of the server projects. Linking to pictures of the server projects is not
possible.

Caution:
If an OS server is controlled by a multiclient, the names of the operator stations (not the
computer names) must be different within different PCS 7 projects
(for example OS(1), OS(2) etc.).

The mixed configuration with a multiclient and client on one server/server pair is not yet
permitted in PCS 7 Version 5.0 Service Pack 1.

The attachment to the system bus, data storage and the processing of process
data is implemented by the server. All the project data such as pictures, tags and
archives are provided to the clients by the server.
A redundant server pair can also be used for a server.

A maximum of 16 clients including multiclients can be connected to a server. If you
use multi-VGA cards (up to four monitors on one PC), a maximum of 20 monitors
can be served by one server. The advantages of the multiclient are that it can
access up to 6 servers at the same time during run time. This means, for example,
that the data of six different servers can be visualized in one picture of the
multiclient. The project can also be distributed on several servers.

Configuration of a project takes place in the engineering system or on the server.
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Plant Distribution

The various servers perform the same tasks, such as message archiving,
measured value archiving, and process data updating. Each server, however, is
responsible for a different logical part of the plant or process. If the application is
structured in units, the servers are connected to different controls independent of
each other. PCS 7 was conceived for this form of logical distribution. The
distribution is structured according to the plant hierarchy.

Configuring the Multiclient

A multiclient has its own local configuration data such as pictures, scripts, and
internal variables. The multiclient can only modify the data of the multiclient project
and not the server project. The projects of the server can be accessed using
references to variables (tags), messages, archives, and pictures. The multiclient
therefore provides a view of the data of one or more servers.

Note
Actions (scripts) must be defined project-related on each multiclient. For further
information, refer to the online help "Multiclient: Configuring Pictures > Picture
Configuration on the Server" and "Multiclient: Configuring Pictures > Picture
Configuration on the Multiclient". Note also the link "Configuring Distributed
Systems" in the help topics listed above.
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1.14 Project Documentation

Overview

Once you have created a project, the entire mass of project data must be
documented clearly to allow an overview of the whole system. Clearly structured
documentation makes both future development of the project and service and
maintenance much easier.

DOCPRO is a tool that can be used for effective creation and management of plant
documentation . It allows the project data to be structured flexibly in standardized
technical documentation that can then be printed in a uniform format.

1.14.1 DOCPRO in Detail

Central Control of Printing

During the configuration of your plant, you work with various applications that
produce files with widely differing functions. Printing project data as it occurs in the
individual applications is a time-consuming and complicated process.

DOCPRO allows you to control the printing of your data centrally. You can print
individual parts of the project or the entire project as required.

When you print with DOCPRO, the applications access the current project data
directly. This ensures that your documentation is always up to date.

Which Data is Included in the Documentation?

You can include all the data you created with the configuration tool in your
documentation. The data is then available in a clearly structured form and can be
maintained and printed centrally.

Your documentation can, for example, contain the following data:

• Blocks (program code, written with SCL etc.)

• Symbol tables with the symbolic names of absolute addresses

• Reference data including cross-reference lists, I/Q/M assignment lists, program
structure tables etc.

• Hardware configuration tables with the arrangement of the modules in the
programmable controller and the module parameters

• Variable tables with status formats and status and control values

• Shared data tables

• CFC and SFC charts

• Connection tables

• S7 GRAPH, sequences, steps, transitions
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• S7 SCL source code

• WinCC, OS, reports, pictures

What Functions Does DOCPRO Provide?

DOCPRO supports you in all phases of document creation and has convenient
options for adapting the appearance of the documents to your specific
requirements.

The major features of DOCPRO are as follows:

• Creation and management of standards-compliant technical documents

• Use of supplied standards-compliant layout templates in various formats and
languages

• Central editing and management of headers and footers

• Integration of cover sheets

• Automatic creation of documentation lists

• Automatic and manual assignment of drawing numbers

• Import of user-defined layouts and cover sheets

• Integration of graphics (for example company logos) in layouts

• Convenient print management
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1.14.2 Creating Circuit Documentation with the DOCPRO Wizard

DOCPRO Wizard

Using the DOCPRO Wizard, you can create a new wiring manual (contains the job
lists) including a new job list (contains the print jobs).

Settings Prior to Creating New Documentation

Before you create new documentation with wiring manuals, job lists, and objects
make the following settings:

• Check whether the existing print layout (DOCPRO: Edit > Layout List) is
suitable for your requirements. In this dialog, you can see all the layouts
supplied by the system. If you require a modified layout, you can export it,
adapt it to your requirements with a graphic tool and import it again.

• Edit the required global texts (valid for the entire project) in the text fields of the
layout (Options > Customize > Global Settings).

• Make the specific settings you require for each of the object types you are
using (DOCPRO: Options > Customize > Print Object Types). Here you can set
the layout, the drawing number schemes, and for most objects also the view to
be printed (depending on the object type) separately for all the object types (for
example CFC, SCL source file, SIMATIC 400 station etc.).

Note
It is important to make these settings before you create the documentation so that all the
objects you are including in your documentation already have the correct settings and do
not need to be revised.

Starting the Wizard (Page 1/5)

You can start the DOCPRO Wizard to create a new wiring manual in existing
documentation. Follow the steps outlined below:

4. Select the "Documentation" object in the required project.

5. Select the menu command Insert > Wizard ’New Wiring Manual’

The start page (page 1/5) of the DOCPRO Wizard is started. This dialog also
includes a check box that you can click so that the DOCPRO Wizard is always
displayed.

Navigating in the Wizard

With the "Next" and "Back" buttons, you can move forwards and backwards in the
five pages of the Wizard if you want to change or check your settings. The "Make"
button is only active on the last page (5/5) of the Wizard. This button closes the
Wizard and creates the wiring manual according to the settings you have made.



Basics of PCS 7

Process Control System PCS 7, Configuration Manual
A5E00122418-01 1-79

Selecting Objects to Print (page 2/5)

On page 2/5 of the Wizard, you can see the structure of the project resembling the
structure in the SIMATIC Manager. The check boxes of the individual objects are
activated as default;in other words, the objects are selected for printing. Follow the
steps outlined below:

If you do not want to print a folder or subfolder, deactivate its check box by clicking
it. The check mark in the parent object or folder is displayed in gray when any of its
nested objects is deactivated.

Our advice is to simply make a general selection here of the objects you want to
print. You can make a detailed selection on the next page of the Wizard.

Overview of the Objects for Printing (page 3/5)

Page 3/5 of the Wizard provides two functions. Here you can do the following:

• make a detailed selection of the objects you want to print based on the list on
the left hand and

• assign a layout, reference number system and, if applicable, a view to the
objects you want to print on the right hand side.

How to make these selections is described in the following sections.

Detailed Selection of Objects for Printing (page 3/5)

Page 3/5 of the Wizard displays the individual object types on the left hand side. As
default, all object types are activated for printing.

Deselect the check boxes of the object types you do not want to print.

Example:

On the previous page 2/5, the "Blocks" folder is active as a print object. All the
blocks in your project would be printed if this setting is left as it is. If you only want
to print function blocks, deselect the check boxes of all other block types here on
page 3/5 (data blocks, functions etc.). If, on the other hand, you only want to print
some of the function blocks, go back to page 2/5 with the "Back" button. In this
page, open the project hierarchy by clicking the plus character until the individual
blocks are displayed. Deselect the function blocks you do not want to print.

Assigning Print Settings for the Object Types (page 3/5)

On page 3/5 of the Wizard, you can also assign a layout, a reference number
system, and, if applicable, a view to the individual object types. Follow the steps
outlined below:

• Select the line with the object type for which you want to make the print
settings.

• Open the tabs one after the other and select the print options you require.
Please remember that you use the "?" as the placeholder in the reference
number system.

• Confirm your selections with the "Enter" button.
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Defining Global Footer Data (page 4/5)

On page 4/5 of the Wizard, you can define global footer data that are used
throughout the project for all jobs. Follow the steps outlined below:

Define the standard-compliant footer data in tabs "Part 1" to "Part 4". Complete the
other tabs to meet to suit your requirements.

Naming and Printing the Wiring Manual (page 5/5)

On page 5/5 of the Wizard, you enter the name for the wiring diagram you want to
create. Please note that a new wiring manual is created and existing wiring
manuals cannot be overwritten.

You can also select a check box if you want the new wiring diagram printing out
immediately after you have created it.

Editing the Wiring Manual

If you have created a wiring manual with the DOCPRO Wizard, this is displayed on
the left hand side of the DOCPRO window below your "Documentation". You can
edit this wiring manual, for example, as follows:

• to create more job lists,

• to insert more print jobs,

• to change the order of the print jobs in the job list,

• to insert print objects in various views or

• to change the object properties of existing print jobs.

1.14.3 Converting Documentation to a PDF File

This section explains how you can convert documentation created with DOCPRO
into a manual (PDF format). There is no automatic conversion function in PCS 7!

To convert your documentation, you require a full license for the Adobe Acrobat
program (Acrobat Distiller, Acrobat Exchange and Acrobat Catalog) from Adobe
Systems Incorporated.

Siemens accepts no liability for the programs offered by Adobe Systems
Incorporated. For detailed information on using the Acrobat Reader, refer to the
Acrobat Online manual located in the READER.PDF file in the "Help" folder (as an
alternative you can also select the "Help > ...Online Manual" menu command in
reader).

The procedure for this is as follows:

1. Create the documentation for a project in DOCPRO, for example with the aid of
the DOCPRO wizard.

2. Print the documentation from DOCPRO to a file using the print to file option in
the Windows NT Print dialog.
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Each object from DOCPRO (CFC, SFC, block etc.) is saved as a consecutively
numbered file "DP<number>.PRN". The standard path is the temp folder on C:.
If you do not know which path will be used for the files on your computer, you
can search for the stored files with the Windows NT Explorer.

3. Open the Acrobat Distiller and drag all the files created by DOCPRO from the
Explorer to the Distiller.

The Distiller then creates a PDF file for each individual file.

4. To manage the PDF files, you could, for example, create a cross-reference list
(contents of all PDF files to allow you to navigate in the files). This cross-
reference list contains, for example, the plain text names of the charts, blocks,
and all other objects, and the corresponding PDF file call. You create the
cross-reference list with the Acrobat Exchange program.

5. You can create an index of all the words occurring in the files using the Acrobat
Catalog program.

6. To be able to use the index, it must be inserted in the Acrobat Reader. Open
the Acrobat Reader and select Edit > Search > Select Indexes > "Add"
button.

After inserting the index folder, you can then search for any text (for example a
measuring point name) in the Acrobat Reader using "Edit > Search". All the
positions at which the text appears are listed. You can then select and open
the required documents.
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1.15 BATCH flexible

With the SIMATIC PCS 7 process control system, you can automate both
continuous and discontinuous processes (batch processes) flexibly. Batch
processes are run in the form of sequential or recipe controls.

The creation and processing of control sequences that always remain the same; in
other words, fixed sequential and parameter controls are implemented in the
engineering system by the SFC charts.

Complex tasks with changing control sequences are edited with the BATCH flexible
program package. This supports recipe controls in both small and large
applications but is intended mainly for medium-sized batch processes.

BATCH flexible consists of four interrelated sub-packages:

• Recipe system
Recipe creation and management for any number of recipes (basic package)

• Batch Control
Batch processing (including several parallel batches) and visualization of the
execution of the batch and unit allocation (basic package).

• Batch Data Management
Acquisition, storage, logging and export of batch data (option)

• Batch Scheduling
Planning batches and production orders in the form of lists (option)

These sub-packages can be run on operator stations under Windows NT. The
individual processing functions can be installed more than once in the network and
operate together as clients with a central batch server.

BATCH flexible is based on the ISA standard S88.01 and supports amount-
normalized, unit-specific recipes with a one-level hierarchy of flexible equipment
procedural elements corresponding to the basic functions but that can cover the
entire range from the single control element to the entire unit control.

BATCH flexible has the following outstanding features:

• Simple and convenient graphic recipe creation in SFC representation

• Control and monitoring of recipe execution in the same graphic representation
as used in recipe creation

• Control recipes can be modified online during execution

• Output of operator instructions and operator dialogs with the display of actual
values and entry of setpoints

• End-to-end logging of all events (including manual intervention) for
comprehensive production documentation

• Full batch data acquisition with export and logging functionality

• Simple and clear batch scheduling with the option of linking to higher-level
production planning and control systems.

• Multiple PLC operation

• Modular expandability
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Linking to higher control levels

To link BATCH flexible to higher control levels, the user has two options:

• Data can be exported directly from the data bank of BATCH flexible via open,
standard interfaces.

• To link to SAP/R3, an SAP-certified interface is available that establishes the
link from BATCH flexible to the PP-PI module of SAP.

Application of the Sub-Packages

If you order the BATCH flexible recipe system, you receive a CD ROM with the
complete PCS 7 software including all four batch BATCH flexible software
packages. Each individual software package has an authorization diskette to
authorize the software package on the CD ROM.

The recipe system and batch control make up the basic system and must exist at
least once per process cell.

For single workstation systems, batch data management and batch scheduling can
be ordered as options.

In multiple workstation systems, the batch data management is required only once
per process cell!

For additional work places on which the recipe system, batch scheduling, and
batch control are required, these packages must be ordered in the required
numbers.
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1.16 Connection to the Works Management Level

Overview

The SIMATIC PCS 7 control system covers the tasks required at the process
control level and is responsible for implementing the production process in the
individual plants. New data of relevance to the works and enterprise management
levels is constantly being produced. You can access this data using the @PCS 7
software package. This package allows you to use the data from the higher control
levels and create your own statistical information and evaluations. The necessary
adaptations are made in the interface between the control system and the works
management level on a flexible and open base, changing neither the target
application nor the control system.

The @PCS 7 interface software brings all the required process data from the
factory directly to the desktop. Here, the data can be analyzed, processed and
examined using tools such as Excel or VBA to solve problems and to improve the
process – or even revolutionize it. Many software products found worldwide are
already capable of such functions.
@PCS 7(@aGlance/IT) is interface software (middleware) with an Internet
attachment. This software can be used to provide communication between
commonly found client applications (Web Browser, Excel, Lotus etc.) or even
technological packages and the server that provides the process data.

Properties

@PCS 7 provides not only online access to process data of PCS 7 but also access
to the measured values and message archives. Access rights for the use of
@PCS 7 can be configured.

@PCS 7 also provides server to server communication required for the attachment
of other control systems (for example when linking PCS 7 with an existing PCS
V 3.1 system). This allows configurable data transfer between PCS 7 and any
@aGlance servers (in both directions).

These functions therefore permit a considerable expansion compared with OPC
(OPC is also supported by PCS 7).
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Integration of @aGlance/IT in PCS 7

The integration of @aGlance in PCS 7 provides not only interfaces to the works
and enterprise management levels but also powerful interfaces to allow office
integration (Excel, Word, etc.) and use via intranets and the Internet.

The following diagram illustrates the principle:

Figure 1-27Principle of Access to Process Data of PCS 7
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@PCS 7 Products

The basis for PCS 7 - @aGlance integration is @PCS 7 that processes all the
requests coming from @aGlance clients. @PCS 7 is a component of the PCS 7
optional package Basic Process Control. @PCS 7 is available in the following
packages:

Package 1: PCS 7 access with an Internet/Intranet Browser using
Web@aGlance. This interface allows read access to PCS 7 data without an
authorization. (Part of PCS 7 OS (Basic Process Control)). For this, the software
Web@aGlance is necessary.

 Package 2: Web@PCS 7, that allows PCS 7-compliant with web browsing.
This add-on package for Web@aGlance consists of Java libraries and has an
order number and authorization with which read and write access to PCS data is
permitted.

Package 3: Professional@PCS 7 opens @PCS 7 completely to the BLE
world.
The package consists solely of an enable key permitting read and write access to
@PCS 7 for all @aGlance clients and has its own order number and authorization.

The following schematic illustrates the packages from a product point of view:

Figure 1-28 Packaging from a Product Point of View
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The integration of @aGlance in PCS 7 as a software package "@PCS 7" provides
a high degree of system openness in data exchange for the PCS 7 user:

• Hardware platform (INTEL. IBM, HP, DEC APX/VAX)

• Operating system (Microsoft, UNIX VMS)

• The technical features: @PCS 7 (@aGlance/IT) is

- not operating system dependent

- not application dependent

- not interface dependent

- not vendor dependent

• @aGlance/IT provides the following:

- Development tools for DDE, C/C++, NetOLE, VBX, OCX and
Visual Basic API

- Add-ins for Lotus 1-2-3 and Excel with Wizard

- Plug and Play access for the @aGlance/IT applications to existing servers

- Communication via the Web (Internet/Intranet)

- Immediate access to live current data, history data
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Sample Configuration with PCS 7 and @PCS 7

The schematic below shows a possible project configuration that allows data to be
written from the works management level in the direction of PCS 7 or to be read
from PCS 7.

Figure 1-29 Example: @PCS 7 Server on a Computer at the Works Control Level
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The @PCS 7 server fits into the PCS 7 world as a homogeneous component. You
can structure it as shown in Figure 1-29 as a standalone server. It is, however, also
possible to integrate the @PCS 7 server on an OS server as a single or multiple
workstation system (and also redundantly).

The @PCS 7 server as an independent server always consists of a PCS 7 OS.
The @PCS 7 server has access to the data of all the PCS 7 OS systems within the
system. Access with redundant PCS 7 OS servers is also guaranteed.

In this configuration, access to individual servers can be configured by assigning
access permissions.
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2 Plant Description

Introduction

This chapter contains the description of the sample plant "COLOR_PH" and a
section of the plant in the form of the "Raw material containers" unit. Working
through the manual, you will configure the described unit in various phases.

You are provided with the piping and instrumentation flow diagram of the
"COLOR_PH" plant and a brief technological description, the description of the unit
to be configured and the corresponding piping and instrumentation flow diagram as
well as the tag list that can be created from it.

2.1 Technological Function

General

The plant produces paint. The various paint products differ from each other
essentially in terms of color, consistency and quantity. Paint production is a batch
process controlled by a recipe management program.

Raw Materials

The liquid raw materials required for the product are stored in two tanks and are
pumped from these tanks to the reactors. The solid raw materials are stored in
three silos. Three feed screws leading from the silos transport the solid raw
materials to a weighing hopper where they are weighed. Once the correct mixture
has been obtained, a further feed screw and a blower transport the raw materials to
one of the two mixing containers preceding the reactors.

Production

The required quantities of liquid material are fed to either reactor 1 or reactor 2 via
valves. The solid materials from the mixing containers are transported to the
reactors by feed screws and mixed by an agitator. The product is produced in the
reactors by agitating, heating and cooling the raw materials along with the
additives. The temperature in the reactors is controlled by a controller in conjuction
with valves and actuators. When necessary, water can be let in to the reactors
flow-controlled from a filtering unit.
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Holding Phase

The finished product is then pumped to a holding tank. Here it is stirred slowly and
kept at a constant temperature.

Filling

Following the holding phase, the product is briefly stored in a filling tank from which
it can then be filled into tankers or small drums.

Cleaning

The reactors, piping, valves, actuators, holding tank, and filling tank can then be
cleaned by a cleaning system (CIP). The resulting effluent is then collected in a
separate effluent tank for disposal.

2.2 Piping and Instrumentation  Diagrams

2.2.1 Liquid Raw Material Store
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Figure 2-1 Piping and Instrumentation Flow Diagram: Liquid Raw Materials Store
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Description

The liquid raw materials are stored in the two raw material tanks and the level of
the tanks is monitored by the level measuring points (tags) "LI111" and "LI 121".

"NK 111", "NK 121",  "NK 112" and "NK 122" are stop valves. These valves are
always open during operation.

Opening valves "NK113" and "NK 123" allows a controlled amount of raw material
into reactor 1, opening valves "NK 114" and "NK 124" allows a controlled amount
of raw material into reactor 2. The valves are interlocked so that either reactor 1 or
reactor 2 is filled.

The pumps "NP 111" and "NP121" provide the pressure required to transport the
raw materials to the reactors. "FC 111" and "FC 121" are control valves with which
exact quantities can be measured.

The numbers "1" and "2" indicate that the destination is reactor 1 and the numbers
"3" and "4" indicate that the destination is reactor 2.

2.2.2 Solid Raw Materials Store
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Figure 2-2 Piping and Instrumentation Flow Diagram: Solid Raw Materials Store
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Description

The solid raw materials are stored in silos 1 to 3 and the level of the silos is
monitored by the three level tags "LI 211", "LI 221" and "LI 231".

The feed screws "NH 211", "NH 221" and "NH231" transport the raw materials from
their silos to the weighing hopper. Here, the raw materials are weighed (pressure
tag "WI 201"). The level tag "LI 201" is intended to prevent the weighing hopper
from overflowing.

The feed screw "NH 201" transports the weighed solids to the pipe in which the
blower "NH 202" then takes over transportation of the materials to the mixing
container.

The three-way valve "NK 201" decides whether the solids are routed to the mixing
container of reactor 1 or to the mixing container of reactor 2.

The number "5" indicates that the destination is the mixing container of reactor 1
and the number "6" indicates that the destination is the mixing container of
reactor 2.

2.2.3 Reactors
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Figure 2-3 Piping and Instrumentation Flow Diagram: Reactor 1
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Figure 2-4 Piping and Instrumentation Flow Diagram: Reactor 2

Description

Reactors 1 and 2 are identical so that the description of reactor 1 serves for both.

The weighed solids in the mixing container are thoroughly blended and transported
to the reactor by feed screw "NH 311". The level tag "LI 312" is intended to prevent
the mixing container from overflowing.

The stop valves "NK 311" and "NK 312" are always open during operation. Liquid
raw materials are fed to the reactor via these valves.

Before the measured amounts of solid and liquid raw materials are fed into the
reactor, the agitator "NR 311" is started. This ensures immediate blending of all the
raw materials.

Water is added from the filtering unit "EU 310". Valve "NK 310" is also a stop valve
that is always open when the reactor is in operation. The volume of water is
controlled by valve "FC 310".

The level tag "LI 311" monitors the level of the reactor.
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The control valve "TC 311" feeds hot water into a heat exchanger for the tank to
ensure the correct production temperature. If the production temperature is too
high, the cooling circulation is activated automatically. Valves "NK 313" and
"NK 314" are stop valves that are always open when the reactor is in operation.

Controlled by valve "NK 316", the finished product is pumped to the holding tank by
pump "NP 311" via the stop valve "NK 315" (always open during operation).

2.2.4 Holding Tank and Filling Tank

Figure 2-5 Piping and Instrumentation Flow Diagram: Holding Tank and Filling
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Description

Reactor 1 empties via valve "NK 411" and reactor 2 via valve "NK 412". If the
product is substandard, it is channeled via valve "NK 415" to a waste container and
reprocessed. Otherwise it is fed to the holding tank via valve "NK 413".

In the holding tank, it is stirred evenly and slowly by motor "NR 411".

The level in the tank is monitored by tag "LI 411".

The control valve "TC 411" ensures slow cooling of the product. Stop valve
"NK 414" is always open during operation.

The finished product is pumped from holding tank 1 to the filling tank by pump
"NP 411" and is controlled by valve "NK 417". The stop valves "NK 416" and "NK
511" are always open during operation.

The level of the filling tank is checked constantly by the level monitoring "LI 511".

Tankers are filled from the filling tank controlled by valve "NK 512".
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2.3 Unit

Overview

In the course of this manual, you will configure the tanks along with the relevant
actuators and sensors for the liquid raw material store.

2.3.1 Piping and Instrumentation Flow Diagram with Technological
Description

In the first phase, you will configure a raw material tank. Following this, you will be
shown how to modify your charts for a further tank.
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Figure 2-6 Piping and Instrumentation Flow Diagram: Raw Material Tank Unit
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Description

The operator is informed of the current level of the raw material tank by the value of
"LI 111".

"NK 111" and "NK 112" are stop valves that must always be open when dosing raw
materials.

Pump "NP 111" transports the raw material to reactor 1 or reactor 2 depending on
valve "NK 113" or "NK 114" (only one can be open).

The quantity of raw material is controlled by the dosing "FC 111" and the
corresponding actuator.

The current states of valves "NK 111" to "NK 114" and pump "NP 111" are
visualized on the operator’s monitor.

The operator can also intervene in the dosing at "FC 111" from the operator
station.

2.3.2 Tag List

The piping and instrumentation  diagram provides you with information about the
number and type of measuring points (tags). Based on the diagram you can create
a tag list. The list shown here is simply an example. The type and contents of the
tag lists differ from project to project.

From the flow diagram above, you can see the tags and can assign the number of
required inputs and outputs to them.

Table 2-1 Required Number of Inputs and Outputs

 NK 111  NK 112  NK 113  NK 114  NP 111  LI 111  FC 111

2 x DI

1 x DO

2 x DI

1 x DO

2 x DI

1 x DO

2 x DI

1 x DO

1 x DI

1 x DO

1 x AI 1 x AI

1 x AO

DI = Digital Input, DO = Digital Output, AI = Analog Input, AO = Analog Output

To read in and output the process signals, you will use an ET 200M.

You can make the assignment of the inputs and outputs to modules, slots, and
addresses within the ET 200, for example, using the following table.
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Table 2-2 Tag List

 EMSR
Name
PCS 7

 Type  ET 200 M  Slot
no.

 Slot
addr.
dec.

 Chan  Meas.
range

 Unit  Signal  Comment

NK 111 DI 3 3 4 0 FB CLSD Stop valve 1 output raw m. tank 1

NK 111 1 FB OPEN Stop valve 1 output raw m. tank 1

NK 112 2 FB CLSD Stop valve 2 output raw m. tank 1

NK 112 3 FB OPEN Stop valve 2 output raw m. tank 1

NK 113 4 FB CLSD Stop valve 3 Tank 1 input reactor 1

NK 113 5 FB OPEN Stop valve 3 Tank 1 input reactor 1

NK 114 6 FB CLSD Stop valve 4 tank 1 input reactor 2

NK 114 7 FB OPEN Stop valve 4 tank 1 input reactor 2

NP 111 8 FB RUN Pump raw m. tank 1

9

10

11

12

13

14

15

NK 111 DO 3 4 5 0 OUTPUT Stop valve 1 output raw m. tank 1

NK 112 1 OUTPUT Stop valve 2 output raw m. tank 1

NK 113 2 OUTPUT Stop valve 3 Tank 1 input reactor 1

NK 114 3 OUTPUT Stop valve 4 tank 1 input reactor 2

NP 111 4 OUTPUT Pump raw m. tank 1

5

6

7

8

9

10

11

12

13

14

15

LI 111 AI 3 5 6 0 0-10000 m3 INPUT Level meas. raw m. tank 1

FC 111 1 0-1000 liter

s

INPUT_U Quantity control/dosing raw m. tank 1

2

3

4

5

6

7

FC 111 AO 3 6 7 0 0-100 % OUTPUT

LMN

Quantity control/dosing raw m. tank 1

1

2

3
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EMSR Standard Names (Elektro Mess- Steuer- und Regelungstechnik)

The tag list shown should also be considered under the aspect of standard
designations and alarm triggering. To keep the table clearer, this information is
shown in a new table. The relationship between the tables is established by the
"EMSR name PCS 7".

Table 2-3 EMSR Standard Designations

 EMSR name
PCS 7

 EMSR
Designat
ions

 A-  A+  Meas.
range

 Unit  Comment

NK 111 - - - - Stop valve  1 raw m. tank
1

NK 112 - - - - Stop valve  2 raw m. tank
1

NK 113 - - - - Stop valve  3  input
reactor 1

NK 114 - - - - Stop valve  4 input
reactor 2

NP 111 - - - - Pump raw m. tank 1

LI 111 LIRA+- 200 9500 0-10000 m3 Level meas.
raw m. tank 1

FC 111 FIRCA+ - 500 0-1000 liters Quantity control/dosing
raw m. tank 1

Example: FIRCA+ means a flow control with indication and registration of the
measured value and alarm triggering if an upper limit is exceeded.

F > Flow

I > Indication

R > Registration

C > Control

A > Alarm triggering

+ > Upper alarm
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3 Creating a Project

Introduction

This chapter explains the basic features and the possible applications of the
Engineering System (ES) with its software components "Plant Hierarchy" (PH) and
"Import/Export Assistant" (IEA) and the relationship between these components in
the ES.

In this chapter, you will create the "COLOR_PH" project in the SIMATIC Manager
and at the same time learn the most important points during this phase.

3.1 ES Software in SIMATIC PCS 7

With the components of the Engineering System (ES) in the SIMATIC Process
Control System 7 (PCS 7), you have tools with which you can create a
comprehensive plant configuration. The components are made up of the following
software packages:

• STEP 7 standard software
includes the SIMATIC Manager that represents the platform for all the ES
components and manages them centrally. This is a graphic user interface
under Windows NT used to manage STEP 7 projects.

• You configure the hardware; in other words the arrangement of racks, modules
and interface modules in the application "Hardware Configuration" (HW
Config).

• PH (Plant Hierarchy) and IEA (Import/Export Assistant)
"PH" and "IEA" are PCS 7 packages that are not in themselves separate
applications but rather extensions of the SIMATIC Manager. You activate the
functions using menu commands in the SIMATIC Manager.

PH and IEA support plant-wide configuration of process and manufacturing
plants (creation of mass data) through several configuration phases.

This engineering is based primarily on technological aspects.

• CFC (Continuous Function Chart)
is a software package for plant-oriented, graphic configuration of the
automation task. Using CFC, entire software structures are created from ready-
made blocks.

The blocks are organized according to their functionality and grouped in
libraries. You can insert the blocks you require into the CFC chart by dragging
them from the library using a mouse.
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• SFC (Sequential Function Chart)
is a software package with which sequential control systems can be
configured.

With a sequential control system, basic automation functions (typically created
with CFC) are controlled based on state changes and can be selectively
processed.

• Configuration software for the OS station
WinCC for configuring the operator control and monitoring system (Windows
Control Center) in PCS 7.

With the configuration software, you can create process pictures and reports,
and can also configure the message system and the archive for the process
data.

• SCL (Structured Control Language) is a programming language resembling
Pascal for programming complex automation tasks.

In the ES, it is used among other things for creating blocks and is required for
compiling CFC/SFC charts.

Note
For more detailed information about the individual applications, refer to the manuals on the
"Electronic Manuals for Process Control System PCS 7" CD.

Plant-Wide Engineering

Plant-wide engineering has the following advantages:

• You work with objects that are of technological significance (units, functions
etc.) independent of the component view.

• You arrange objects in a plant hierarchy and therefore structure the plant
according to technological aspects (refer to the section on the plant hierarchy).

• Objects are named uniquely throughout the project using the higher level
designation HID (path in the plant view).

• Data from previous planning and configuration phases can be incorporated and
further processed (multi-phase engineering with IEA by importing data; refer to
the section on the Import/Export Assistant).

• To match up the plant documentation, data can be returned to previous
planning and configuration tools (by exporting with the IEA).
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3.2 Engineering Procedures

General

The engineering of a process control system is part of the configuration of a
process or manufacturing plant. Data that has already been acquired or created
with other tools can be further processed using the engineering procedures. These
procedures take place in various phases.

Outline
planning

Specifications
Regulations
Standards
Laws

Basic planning

Basic flow diagram
Process flow
diagram
Piping and
Instrumentation
Diagram

Detailed planning

PC point charts
PC point fct. charts
PC point description
Field and signal levels
Cabinet planning

Plant Engineering

Library

PLC objects
OS objects

Control System
Engineering

PCS project

Plant Hierarchy
PLC functions
OCM functions
Recipes (Batch)
PCS hardware

Models

PC points
Units
. . . .

Control system (runtime)

PLC functions
Field devices
OCM functions
Production recipes (BATCH)

HID
Material and PCS
hardware data

Process control points
PC point names
Function data
Measuring ranges
Signal names
Message, operator and unit
texts

Figure 3-1 Interplay Between Plant and Control System Engineering
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3.2.1 Plant Engineering

In plant engineering, the planning of the plant is not usually carried out in an ES but
with one of the other planning tools. A typical approach might be as follows:

• Use the library with function units (application standards) for example binary
input with message, fixed setpoint control with measured value acquisition,
ratio control, two-speed motor control, valve open/close etc.

The functions of the plant are implemented by function units for which each
has its own data sheet (process control point description).

• The function units are given concrete values.

3.2.2 Control System Engineering with the Import/Export Assistant
(IEA)

• Control system engineering is done in the ES. During the creation of
automation solutions in medium and large projects, a wide variety of process
control points are used. Despite their variety and the large numbers required,
these process control points actually consist of only a few basic types. These
basic types recur time and again in the plant and differ from each other only by
a few parameters such as process value links, limit values, units and message
texts.

• With the ES, you can generate models for each basic type and put them in a
library for further use (see also "What is a Model?", Chapter 8).

Figure 3-2 Correspondence of Application Standards to Models

The procedure for control system engineering with the IEA is as follows:

• Creation of the library of models for automation and for operator control and
monitoring, suitable for the function units of the plant planning.

• Importing the data from the plant planning.
During the planning phase of the plant, you create tag lists with the specific
data of the measuring points. You then assign this data to the structure of a
model. During import, the models are then copied automatically and assigned
parameters.

Chapter 8 contains detailed information about handling the Import/Export Assistant
(IEA).

Plant Engineering

Function unit
(application standard)

e.g. ratio control

Control System
Engineering

Model
CFC with ratio control



Creating a Project

Process Control System PCS 7, Configuration Manual
A5E00122418-01 3-5

3.3 Interaction of the Components

This section provides you with an overview of the interaction of the configuration of
the plant hierarchy, the CFC chart, the Import/Export Assistant and the SFC chart
with the configuration on the OS. The sections following describe the individual
components and their applications in detail.

Plant Hierarchy

The path of the plant hierarchy with the chart name and the block name is
transferred to the user text block "origin" with the transfer of the PLC-OS
connection data. From here, it appears in the message line in the OS run time.

The tag name in the tag management of the WinCC Explorer is made up of the
path of the plant hierarchy, the chart name, the block name, and the parameter
name. If you want to connect an object with a tag in a process picture or in an
archive, you specify the tag name from the tag management.

CFC

The individual block types (for example the controller CTRL_PID) are stored in a
library or in the S7 program. In the CFC chart , you place block instances. Each
instance is a copy of a block type and is given its own name.

In the object properties of an instance in the CFC chart, you specify the message
texts of blocks with message capability after clicking the "Messages" button. These
are transferred to the appropriate user text blocks by transferring the PLC-OS
connection data and are displayed in the message line on the OS during run time.

If the option "Operator C and M possible" is selected in the object properties in
CFC, all the parameters that can be controlled and monitored by the operator are
transferred to the tag management of the OS during the transfer of the PLC-OS
connection data. You can obtain an overview of the relevant parameters in the
object properties by clicking the "Operator C and M" button.

The controllable parameters of a block have operator texts and a unit. When you
transfer the PLC-OS connection data, these parameters are stored as internal tags
in the data management of the OS. This means that the texts can be modified
without a transfer and displayed in the process picture.

For each instance in the CFC chart, there is an instance data block that manages
the current values of the instance. In the tag management of the OS (for example
SIMATIC S7 PROTOCOL SUITE > Industrial Ethernet > S7 Program(1)), the
instance data block is displayed in the "Parameters" column following each tag
name.  In the CFC chart, you can see the instance data block in the object
properties of the instances.
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Import/Export Assistant

With the Import/Export Assistant, you automatically create charts and the block
instances they contain (generating mass data). You have the option of specifying
the message texts when you create the data for import. These message texts then
appear at the relevant points in the instances of the blocks and are transferred to
the OS as described for "CFC".

SFC

In the SFC chart, you reference the parameters of the previously configured CFC
charts. The configuration engineer creates the required steps and transitions and
assigns a technologically oriented name to these objects. The structure of the SFC
chart with the steps (actions) and transitions is mapped on the OS by the transfer
of the PLC-OS connection data (SFC Visualization). The operator has two possible
views on the OS:

• Overview
The operator sees the complete structure of the sequential control system. The
current step is highlighted in green. The names of the steps and the transitions
are not visible.

• Details
The operator sees a section of the sequential control system. The current step
is highlighted in green. The names of the steps and transitions can also be
seen.

As an option, the individual lines of the steps can also be displayed on the OS (by
selecting the appropriate option during SFC configuration). As default, each line of
a transition (condition query) is visible to the operator on the OS. It is, however
possible to replace the normally highly technical condition queries with a text that is
easier for the operator to understand. The operator can view the steps and actions
by clicking on a step or on an action during run time on the OS.

Transferring PLC-OS Connection Data

The transfer of the PLC-OS connection data  is explained in greater detail in
Chapter 12. This section will simply clarify when a transfer is necessary. Based on
the brief explanation above, the PLC-OS connection data must be transferred in
the following situations:

• After changing the plant hierarchy

• After modifying the names of CFC charts or adding new charts

• After adding new block instances or changing block names

• After changing operator and physical unit texts

• After changing the operator control and monitoring attributes of an instance

• After changing message texts

• After adding sequential control systems (SFC charts) or changing existing
sequential control systems.
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3.4 Estimating the Plant Component Requirements

Introduction

One important factor in the planning of a system is calculating the required
components. The operator stations, the SIMATIC stations, the plant bus and the
distributed/central I/Os must be taken into account.

How many stations, which plant bus, and which I/Os you intend to use in your
project depends on the size of the project, on the requirements of the customer in
terms of availability, and on the conditions on site.

Operator station (stands for single workstation system, server, or redundant
server)

To estimate the operator stations required in your project, you will find information
in the following:

- PCS 7 catalog, section "Operator Control and Monitoring"
Table: Numbers of tags for an operator station

- PCS 7 catalog, section "Operator Control and Monitoring"
Table: Typical picture activation times on an operator station

- Chapter 1, section "System Structure"

- Chapter 1, section "Fault Tolerance"

SIMATIC Stations

To estimate the number of SIMATIC stations required in your project, you will find
information in the following:

- PCS 7 catalog, section "Programmable Controllers"
Table: Typical numeric data for programmable controllers

- Interactive catalog CA01, menu command "Selection aids => SIMATIC"

- Chapter 1, section "Fault Tolerance"

Bus System

To help you select the suitable bus system, you will find information in the
following:

- SIMATIC NET catalog IK 10

- Chapter 1, section "Bus System"

I/Os

To help you select suitable I/O components, you will find information in the
following:

- SIMATIC catalog ST 70 in the section on configuration aids

- Chapter 1, section "I/Os"
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3.5 Project Requirements

When you first begin configuring, you should first analyze the project requirements
particularly in large projects to make sure that all aspects and conditions are
considered to allow rational and efficient configuration. Clarify, for example, the
following:

Branch & Merge: Will the project need to be broken down into different parts and
then put back together again to allow distributed development because it will be
created at different times and at different locations (for example by more than one
supplier)? If this is the case, work with Branch & Merge (see Chapter 1).

Multi-user: Will there be more than one engineer involved in configuration in a
project located on one data server that can be accessed by everyone? If this is the
case, work with the multi-user scheme
(see Chapter 1).

Copying objects: Will several PLC and OS target systems be involved and do
these systems include similar plant sections? If this is the case, you can copy these
sections of plant (see Chapter 6).

Project-specific block library: Will blocks from several libraries be used in a
project and adapted to the project? If this is the case, it is advisable to create a
project-specific block library (refer to the sections below).

3.5.1 Creating a Project-Specific Block Library

During configuration, it is more efficient to have all the block types used in the
project in their own library. This means, for example, that you can be sure that only
one version of a particular block type is used throughout the entire project. Different
block types in different programs can lead to conflicts if the programs are to be
controlled and monitored on one OS. The reason for this is that variables of the
same block type (same type name) must also have the same structure.

Copy all the block types you require in the project into the library. This may be a
collection from PCS 7 libraries, libraries of suppliers, or blocks you have written
yourself.

Planning at this stage should be thorough and blocks should be adapted, when
necessary, to the project requirements at this stage rather than later. Subsequent
modification of block types (after block instances have been created) is supported
by the system, but means more time and effort, for example to make a central
block type modification or to repeat the PLC-OS transfer to provide WinCC with the
modified data.

Note:
Remember that if you create your own library containing among other things blocks from
the PCS 7 library, the blocks you have taken from the PCS 7 library may need to be
updated if the version of the PCS 7 block library is changed.
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Creating a Library and Inserting Blocks

You create a library for the project in the SIMATIC Manager.

• Select File > New and then select the "New  Library" option in the dialog and
enter a library name (ideally the project name) and, if applicable, the path.

• With Insert > Program > S7 Program, create an S7 program including a
blocks folder.

• The next step is to open the library from which you want to copy the blocks
(File > Open > Library ) and drag the required blocks to the block folder of
your project library.

Notes on Copying

If you copy blocks from different libraries it is possible that blocks could have
different names (and functions) but the  same block numbers. When you copy the
blocks you will see a warning to this effect. You can modify a block number with
Options > Rewire... . In the dialog that is then opened, enter the old and new
"free" block number in "Old Address" / "New Address". This renaming (rewiring)
functions only with unprotected blocks.

Caution

If you copy blocks with different block numbers but the same block names, the
blocks are copied without any warning and the blocks lose their names. This does
not lead to any further conflicts if you then enter the new name in the symbol
table.

The symbolic name is copied when you copy the blocks from a library. If you do not
copy from a library, but from an S7 program, the symbolic name is lost and must be
entered later in the symbol table.

Notes on Multiple Instance Blocks

If blocks contain code that calls further blocks (multiple instance blocks), the
suitable version of these called blocks must also be copied. Missing FBs called by
other blocks can be identified later by the engineering system but missing FCs
cannot (neither during compilation nor downloading). Remember that the CPU
changes to STOP if FCs are missing.

Remember also that the block numbers of the blocks it calls are entered in the
code of the multiple instance block. If you change these numbers and the numbers
in the code, it is possible to rewire in the SIMATIC Manager (Options > Rewire... ).
Exception: with protected blocks.

No symbolic names are necessary for the blocks called by the multiple instance
block.
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3.5.2 Adapting Blocks to Project Requirements

The blocks from the PCS 7 libraries are suitable for most situations encountered
during configuration and can usually be used unchanged. If you do need to adapt
blocks to the special requirements of a specific project, make these modifications
as soon as possible; in other words, before you use the blocks in your project.

Modifying the Attributes of Block I/Os

Select the block to be modified in the block folder of the library:

• Select Open Object using the right mouse button.

• Confirm the message "Block is protected" with OK.

LAD/STL/FBD is started and the table displayed with all the I/Os of the block. I/Os
with attributes are indicated by a flag symbol at the end of the "Name" column.

• I/O with attribute: Click the flag for the required I/O.

• I/O without attribute: Select the line of the required I/O and then select
"Object Properties" with the right mouse button.

The "Parameter Properties" dialog box is opened with the table of the attributes.
Here, you can modify or enter the attributes and their values.

You can modify attributes without any great difficulty, since there is a syntax check
when you enter attributes and you will be informed of errors or missing information.

Note:
You will find descriptions of the attributes and their use in the online help under "System
Attributes".

Note the following special situations:

• You should configure the texts for the attributes "S7_string_0", "S7_string_1",
"S7_unit" and "S7_shortcut" in the language that will be used by the operator
on the OS. If you want these texts to be available in other languages on the
OS, you must translate them in the text library of the OS.

• If you modify attributes that involve the faceplates or the block structure on the
OS (for example S7_m_c), errors may occur when you interconnect the
faceplates or when you transfer to the OS.



Creating a Project

Process Control System PCS 7, Configuration Manual
A5E00122418-01 3-11

• The attributes are divided into attributes with "type character" (property relates
to the block type) and "instance character" (property relates to a single
instance), a distinction that is not immediately apparent.

- Changes to attributes with type character (for example S7_link), also apply
to all existing block instances.

- If the attributes have the character of an instance (for example S7_visible),
a modification does not affect existing block instances and simply
becomes the default.

Exception: With the attributes "S7_string_0", "S7_string_1", "S7_unit" and
"S7_shortcut", CFC adopts the modification if the user has not changed the
value in the block instance.

Locking Message Attributes Against Changes in Block Instances

Select the block to be modified in the block folder of the library:

• Select Special Object Properties > Message with the right mouse button.

• In the "Message Configuration" dialog, you can do the following:

- Click the "Disable" button for a selected object (for example message
class) in the "Attributes" tab. A "Key Symbol" beside the object indicates
that the object is locked.

- Click the "Disabled" column of a selected line (for example Event Text
$$AKZ$$) in the "Text" tab. A cross is entered in the box.

Translating Message Texts

You can enter message texts in more than one language. The PCS 7 library blocks
already have message texts in three languages (German, English, French).

If you require a language that is not currently available for the message texts of
blocks, you can set the language and translate the texts.

• Select Options > Language for Display Devices

• From the list of "Available Languages", select the language to be displayed in
WinCC. Click " Å " to transfer the selected language to the list of "Installed
Languages in Project".

• Select the language and click the "As Standard" button.

• Open the message configuration dialog (Special Object Properties >
Message) and translate the texts.
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3.5.3 Maintenance of the Project

At regular intervals, you should run the "Reorganize" or "Save As" functions. The
significance of the functions and their advantages for the project are explained in
sections below.

Reorganization

If unexplained problems occur when working with STEP 7, it is often helpful to
reorganize the data management of the project or the library. You start this function
with the File > Reorganize function. During the reorganization, gaps resulting from
deleting are eliminated; in other words, the memory requirements of the
project/library data are reduced.

The function optimizes the data storage for the project or the library in much the
same way, for example, as a program that defragments your hard disk.

The time required for the reorganization depends on the data movements
necessary and can take some time. For this reason, the function is not run
automatically (for example, when you close a project).

Save As

You can save a project or a library under a new name. This function also provides
the option "With Reorganization (slow)".

If you select this option, the project is copied and stored under a new name and, at
the same time, it is checked and reorganized. If an object cannot be copied and
saved (for example, because an optional package is missing or because the data
of the object are defective), a message to this effect is displayed. During the
reorganization, gaps resulting from deleting are eliminated so that the memory
requirements of the project data are reduced.

The "Save As" function has more radical effects on the project structure than the
"Reorganize" function.If, for example, you encounter problems with the project
database following a hardware problem on the PC, you should run the "Save As"
function.

Caution:
Configuration files for a SIMATIC PC station can be accidentally overwritten!

If you save the project without reorganization, the path set for the storage location of the
configuration file is retained. As a result, using the NetPro function "Save and Compile" in
the copied project, would overwrite the configuration file of the original project!

Remedy: Use the "With Reorganization (slow)" option.In this case, all paths are changed.
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3.6 Creating the "COLOR_PH" Project

Introduction

Projects represent all the data and programs of an automation solution. They are
used to order the data and programs resulting from the creation of an automation
solution.

General

In the SIMATIC Manager, you create a project either guided by the "New Project"
assistant or by explicitly inserting components in the individual views.

With "New Project" assistant, you create the project by creating the objects in
both the component view and the plant view. You are guided through the individual
configuration steps in which you can select a CPU or simply insert an S7 program
without reference to hardware. You then decide the number of hierarchy levels and
the PLC objects (CFC/SFC charts) and OS objects (pictures, reports) to be
created. A maximum of 5 hierarchy levels are possible for which there are default
technological names: plant, unit, function, location and element. These
technological names are only intended to help in orientation. Due to their length,
you should not retain these names but rename them with technological names that
relate directly to your plant.

Please note the information in Chapter 6 (Section: "Plant Hierarchy of the
COLOR_PH Plant") regarding the maximum transferable text lengths when
transferring data to the OS.

You then assign a project name (the existing names are displayed) and then allow
the wizard to complete the project after checking the created components and the
structure in the preview. The project is created with default settings that you can
modify later (settings: see Section 2.3).

When creating a new project without the "New Project" assistant, you generally
first create the objects (PLC, operator stations etc.) in the component view using
menu commands. Settings such as the "Assignment to the PLC" must then be
made manually.

Note:
You work without the "New Project" assistant if you do not want to use the PCS 7 standard
components. You cannot, for example, select a power supply if you use the assistant. As
default, a "PS 407 10 A" is then used.

It is, however also possible to start configuration in the plant hierarchy and then
create the objects at a later point in time. In this case, the required objects are
created automatically (disguised from the user).

An S7 program includes source files (source codes for the user blocks), symbols
(connection list between symbolic names and blocks or addresses), blocks
(compiled source files) and charts. An S7 station has the same components,
however it is also linked to hardware.
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Once you have created the S7 program and chart folder, you have all that is
necessary, for example, to insert further CFC charts in the plant hierarchy. From
this point on, you should only work in the plant view.

You require the component view to add additional hardware components (PLC,
OS), to configure the hardware of the PLC (modules, communication etc.), and if
you want to branch and merge your project (refer to Chapter 1, Section "Distributed
Configuration".

Additional Documents in the Project

In addition to the objects (CFC/SFC charts, pictures/reports) required for
automation and for operating and monitoring the plant, you can also insert
additional documents in a hierarchy folder. Additional documents can be unit
descriptions, tag sheets, planning documents etc. From a technical point of view,
the additional document is a document that can be edited with an application
installed on your PC/programming device.

Documents are accepted only if there is an application installed to edit them. This
application is then entered in the "Registered Applications" window of the dialog.
You can, for example, insert an Excel table or a Word document in a hierarchy
folder.

Additional documents are treated like all other objects. If you copy or delete a
hierarchy folder, the additional documents it contains are also copied or deleted.

If you insert existing documents as additional documents in your project, these
documents are copied to the project folder.

Customizing in the SIMATIC Manager

Initially, you make settings in the SIMATIC Manager so that you can customize the
SIMATIC workplace to your personal requirements.

1. Select the menu command Options > Customize...

2. In the "Language" tab, set the language and the mnemonics with which you
want to work (Default: German and SIMATIC mnemonics).

Mnemonics:
Specifying the mnemonics relates to the mnemonics used to identify shared
data; memory bits (M), timers (T), counters (Z or C), inputs (E or I) and outputs
(A or Q) and the commands used in the STL programming language.

Example:
The AND query of input 1.0 and setting output 4.0 is as follows:

German Mnemonics English Mnemonics
U  E 1.0 A   I 1.0
S  A 4.0 S  Q 4.0

3. In the "General" tab, you select the location for storing your projects and
libraries and can make other settings for the SIMATIC Manager.

4. In the "Archive" tab, you can select the archiving program you want to use (for
example PKZIP) and the paths for archiving/dearchiving.
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Creating the "COLOR_PH" Project

To familiarize yourself with the steps involved, create the "COLOR_PH" project
without using the "New Project" assistant. Follow the steps outlined below:

1. Start the SIMATIC Manager START (in the Windows NT task bar) > SIMATIC
> SIMATIC Manager.
If the "PCS 7 New Project" assistant is displayed, click the "Cancel" button in
the dialog box (you can also disable the PCS 7 wizard with the check box in
the dialog below the graphic).

2. Select the menu command File > New and enter the project name
"COLOR_PH". Confirm your entry with the "OK" button. The project is created
and the component view of the project is displayed.

Figure 3-3 "COLOR_PH" Project in the SIMATIC Manager

Set the Block Language

• Select the menu command Options > Language for Display Devices...
and set the language for  PCS 7 blocks (for the "COLOR_PH" project: English
(United States) and click the "As Standard" button).
The block language is relevant for transferring messages from the ES to the
OS. If you select the wrong language, the message texts are transferred to the
wrong text library and do not appear during run time.
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3.6.1 Translating and Editing Operator-Relevant Texts

Introduction

Texts that are displayed during processing on the OS are normally entered in the
language in which the PLC was programmed. Quite often, however, the operator
who is expected to react to the messages does not speak this language. The
operator requires the texts in his own language. Otherwise, lack of comprehension
may mean that an operator does not react quickly enough to displayed messages.

With STEP 7, you can store all the operator-relevant texts in any language. The
only requirement is that you have already installed the language in your project
(menu command in the SIMATIC Manager: Options > Language for Display
Devices). The number of languages available is decided when you install Windows
95/98/NT (system property).

Lists of Operator-Relevant Texts

You can create lists of operator-relevant texts for an entire project, for S7
programs, the block folder, for individual blocks, and for the symbol table providing
messages are configured in these objects. You obtain all the texts and messages,
for example, that can be displayed on display units. There may be several lists of
operator-relevant texts for a project and you can translate them into the languages
required.

You can select the languages available in a project  (menu command: Options >
Language for Display Devices). You can also add or delete languages later.

When you open a list of operator-relevant texts (menu command: Options >
Translate Texts) a table is displayed and each column contains one language.
The default language is always displayed in the first column.

Exporting and Importing Operator-Relevant Texts

You can translate or edit operator-relevant texts created in STEP 7 outside
STEP 7. To do this, you export the displayed list of operator-relevant texts to a text
file that you can then edit with an ASCII editor or with a table editing tool, for
example the Microsoft application EXCEL. You can select the file formats *.TXT or
*.CSV. Afterwards, you can then import the texts back into STEP 7.

Operator-relevant texts can only be imported back into the project section from
which they were exported.

Note:
When editing exported texts, make sure that you do not overwrite any management
information (language IDs or path information).

With the ASCII editor, you edit only lines that begin with "T-ID=".
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Caution
If you edit with a table editing tool never edit the first column or the first two rows and do
not delete any semicolons.

Online Help

If you require further information about individual tabs, click the "Help" button in the
tabs. You will then obtain further information from the online help system.
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4 Configuring Hardware

Introduction

The station configuration (HW Config) shows the hardware structure of a station.
With the hardware configuration, you specify the racks and their slot assignments
according to the actual structure of the station, you configure and assign
parameters to the modules, and configure the distributed I/Os. When the
programmable controller starts up, the CPU compares this desired configuration
with the actual configuration. Discrepancies are therefore detected immediately
and signaled.

For more information about possible redundancy in a PLC, the client/server mode
on operator stations, or selecting a network (PROFIBUS or Industrial Ethernet),
refer to Chapter 1 in the section "Fault Tolerant Components".

Note
For further information about hardware configuration, refer to the manual "S7-400, M7-400,
Installation and Hardware".
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4.1 Configuration of a Station

Configuration Concept

Before you can start with the configuration, first create a concept for assigning
addresses. The networks are independent of each other and have their own range
of numbers for addresses.

The schematic below shows an overview of a possible project configuration.

DP chain 1:  DP master system (1)

Profile: Standardmax. 12 Mbps max. 126 nodes

CP
443-5
Basic

CPU
416 2
DP

PS
407
10A

PROF
IBUS

DP

IM
467

DP

MPI

ES/OS
AS 4xx-2DP

MPI

PG/PC CP 5412 A2

max. 31 nodes187.5 Kbps

Profile: DPmax. 12 Mbps max. 126 nodes

PS IM
153

ET 200 M
Adr. 26 I/O modules

PS IM

153

ET 200 M
Adr. 24 I/O modules

DP chain 2:  DP Master system (2) Profile: DPmax. 12 Mbps max. 126 nodes

PS IM
153

ET 200 M
Adr. 26 I/O modules

DP slave
Adr. 24

SIMOCODE

DP slave
Adr. 28

SIMOVERT

CP 1613

max. 100 Mbps max. 1024
nodes

CP
443-1

Ind.
Ether

Figure 4-1 System Configuration (Example)

Note:
One of the criteria for deciding whether to use a PROFIBUS network or an Industrial
Ethernet (Fast Ethernet) network is the number of nodes:

Rule of thumb: ≤ 9 nodes on the bus Í PROFIBUS network
> 9 nodes on the bus Í Industrial Ethernet

An exception to the rule is BCE with which a maximum of 8 nodes can be used.

You use the MPI network, for example, in the laboratory for test purposes.

To allow the 10 ms time stamping, PROFIBUS DP must be connected to the SIMATIC
station over a CP 443-5 Extended (see Chapter 1 "Creating Messages)".
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4.1.1 Steps in Configuration

Hardware Configuration for the "COLOR_PH" Project

If you want to create and work through the "COLOR_PH" project, you require a
SIMATIC 400 station with a power supply, a CPU and a communications
processor. The following sections explain how to insert the individual components
in the "COLOR_PH" project.

Inserting the Station in Your Project

Before you can start to configure and assign parameters, you require a station in
your project. This station can only be inserted at the level directly below the project.

• Using the menu command Insert > Station > SIMATIC 400 Station in the
SIMATIC Manager, insert a new station (you can change the name "SIMATIC
400(1) to meet your own requirements) and then double click the station.

Figure 4-2 SIMATIC 400 Station in the Project

• Open HW Config by double-clicking the Hardware icon (right-hand window).

Figure 4-3 Window for Hardware Configuration
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Inserting Hardware Components

Once you have created the station, you put together the required hardware
components from the hardware catalog. The hardware catalog is normally
displayed automatically. If this is not the case, open the catalog with the menu
command View > Catalog.

Note:
In the hardware catalog, you can select various profiles (Standard, PCS 7, PCS 7 H etc.).
All the profiles are based on the "Standard" profile and represent a subset of this profile.
The "PCS 7" profile is displayed as default when you first start hardware configuration. In
this profile, you will see the modules and devices currently approved for PCS 7. If you
cannot find the module you require in this profile (for example an older CPU that is
nevertheless approved for PCS 7), select the "Standard" profile where you will find the
required module.

You can also create your own personal profile with the modules and devices you require
often (creating a personal profile is described in the online help).

In the lower third of the catalog you can see the order number and a brief
description of the currently selected component. Compare the order number with
the actual physical component. This allows you to check that you have selected the
correct component.

1. Double-click on the “SIMATIC 400” and insert the rack (Rack-400) UR2, the
power supply (PS-400) PS 407-10A and the CPU 416-2XK02 (or the hardware
components that are available) by dragging them from the hardware catalog.
In the dialog box that appears, you can then set the properties of the "DP
master".

Figure 4-4 DP Master System in the SIMATIC Station

2. Assign the required PROFIBUS address for the
DP master ("Parameters" tab, combo box: "Address:"; e.g. 12).

Note:
The addresses 1 and 126 are default addresses for PROFIBUS slaves. Do not use these
in the project.

DP chain 1: DP master system (1)

SIMATIC S7-400
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3. Create a new network (" New" button) and instead of the name
"PROFIBUS(1)" select a meaningful name that you can interpret uniquely later
(for example DP chain 1).

4. Change to the "Network Settings" tab and set the transmission rate "1.5
Mbps" and the profile "DP".

On completion of the properties dialog, you have a DP master system (1) for
the DP master. If the master system does not appear, select the menu
command Insert > DP Master System.

5. Now call up the object properties of the MPI/DP interface on the CPU and click
the "Properties" button in the Interface box.

6. You can now network the MPI interface with an MPI network by selecting the
MPI network and assigning the required address (combo box "Address:", for
example, 12). You require the MPI network with PROFIBUS to be able to set
the communications parameters (PROFIBUS address, transmission rate and
transmission profile) of the CP 443-5 Basic (initial installation).

Note:
The address 0 is reserved for a service programming device/PC, the address 1 for a
service OP, and the address 2 for the default address of a CPU. Do not use these
addresses in your project.

Figure 4-5 MPI Network Within a SIMATIC Station

7. Close the Properties dialog of the MPI/DP interface on the CPU.

After downloading the configuration to the CPU it is configured so that data can be
exchanged with the operator station via the MPI network.

If you do not want to insert any further communications processors (further CPs are
not necessary for the "COLOR_PH" sample project), skip the next section and go
on to Section 4.3.

MPI network to further PLC, ES or OS stations

SIMATIC S7-400
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4.1.2 Special Features of Organization Blocks

How Often does OB85 Start (I/O Access Error (PZF))?

In addition to the selected reaction to PZF (entering/leaving state or for each I/O
access) the address space of a module also influences how often OB85 starts:

For a module with an address space up to a double word, OB85 starts once, for
example, for a digital module with up to 32 inputs or outputs, or for an analog
module with two channels.

For modules with a larger address space, OB85 starts as often as the number of
double word commands required to access it, for example twice for a four-channel
analog channel.

In the object properties of the CPU (tab: "Cycle/Clock Memory") set the option
"Only for incoming and outgoing errors" for the OB85 call. This is the only way
to be sure that an I/O access error (output parameter QPERAF) is correctly
evaluated. This setting also saves cycle time, since the cycle time can be
increased by repeatedly calling OB85.

Special OBs on the S7 400H

When used with the S7-400H, the organization blocks OB70, OB72, OB82, OB83,
OB85, and OB86 must have the same priority class (for example 26). You make
this setting in HW Config in the properties of the CPU ("Interrupts" tab).
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4.1.3 CPU Startup within a PCS 7 Project

The CPU is capable of the following types of startup:

• Cold restart

• Hot restart

• Warm restart

You select the startup using an option button in the object properties of the CPU
(HW Config > "Startup" tab). Within a PCS 7 project, only the warm restart is
permitted for a CPU.  

When you restart an S7 CPU (for example by changing the mode selector from
STOP to RUN or by turning the power ON) organization block OB100 is processed
before cyclic program execution begins (OB1). As default, all the PCS 7 blocks that
have a special startup behavior are installed in OB100.

Assuming that the CPU is battery backed, a warm restart means the following:

• All data blocks and their contents are retained

• Retentive timers, counters, and memory bits are retained; non-retentive timers,
counters, and memory bits are reset.

During a warm restart, the process image input table is read and the STEP 7 user
program is executed starting at the first instruction in OB1.
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4.2 Inserting Communications Processors

Note
To configure the CP 443-5 Basic, you require the software package
"NCM S7 PROFIBUS" and to configure the CP 443-1, the software package
"NCM S7 Industrial Ethernet".

CP 443-5 Basic

The CP 443-5 Basic communications processor is required for communication
between programmable controllers, the engineering system or operator station via
PROFIBUS.

1. Select the CP 443-5 Basic from the hardware catalog (folder "SIMATIC 400/CP
400/CP 443-5 Basic") and drag it to a free position below the CPU.

Figure 4-6 PROFIBUS Network Within the SIMATIC Station

2. Assign the required PROFIBUS address to the PROFIBUS master (for
example, 12)  and click the "New" button and instead of the name
"PROFIBUS(1)" select a name that will be meaningful to you later (for example,
control system network).

3. Change to the "Network Settings" tab and set the transmission rate "1.5
Mbps" and the profile "Standard".

If you adapt the highest PROFIBUS address (Default 126) to the addresses of
the PROFIBUS masters being used (for example 15), this improves the speed
of data transmission.

4. Close the Properties dialog of the CP 443-5 Basic.

PROFIBUS network to further PLC, ES or OS stations

SIMATIC S7-400
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CP 443-1

You require the CP 443-1 communications processor for the connection between
programmable controllers, the engineering system or operator station via Industrial
Ethernet.

1. Select the CP 443-1 in the hardware catalog (folder "SIMATIC 400/CP-400/CP
443-1") and drag it to a free location.

Assign the required addresses (for example 08.00.06.01.00.12) or use the
default addresses. Make sure that the address is unique on the bus.

Figure 4-7 Industrial Ethernet within a SIMATIC Station

2. Click the "New" button and instead of the name "Ethernet(1)" select a name
that will be meaningful and that you can interpret uniquely later (for example,
control system bus).

3. Close the Properties dialog of the CP 443-1.

IM 467 / CP 443-5 Extended
With the interface module IM 467 or the CP 443-5 Extended communications
processor, you can insert further DP chains in addition to the integrated DP and
therefore theoretically address a further 126 DP slaves. The steps involved are
essentially the same as those in the dialog for the DP master on the CPU (see
above). The CP 443-5 Extended must be used if you require the 10 ms time
stamping in conjunction with the IM 153-2 or routing (setting parameters for the
DP/PA slaves via the engineering station and system bus).

Figure 4-8 Additional DP Master system within the SIMATIC Station

SIMATIC S7-400

CP

Industrial Ethernet to further PLC, ES or OS stations

DP chain 2:  DP Master system (2)

IM or CPSIMATIC S7-400
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4.3 Configuring the Distributed I/O System ET 200M

Overview
PROFIBUS DP is the most widely used fieldbus system in Europe (master/slave
bus system). The technical properties of this bus allow its use in almost all areas of
industrial automation.

Apart from its extremely simple installation (twisted pair cable), its extremely high
transmission rate (up to 12 Mbps), the flexible network structures possible (bus,
star, ring) and the option of redundancy with a fiber-optic double ring are its major
features.

Note:
The distributed peripheral I/Os are described in the "ET 200M Distributed I/O Station"
manual.

Inserting a DP Slave
In the "COLOR_PH" project, you require one analog input module and one analog
output module as well as one digital input module and digital output module for the
raw material tank. You can insert the required components by dragging them from
the hardware catalog to your project. Follow the steps outlined below:

1. Select an IM 153-2  (module exchange in operation) in the "PROFIBUS
DP/ET 200M" folder and drag this module to the "DP Master System(1).

The "Properties – PROFIBUS node ET 200 IM 153-2" dialog is displayed.

Note:
From the hardware catalog, select the IM 153 that matches the backplane bus you are
using (passive or active backplane bus) and the product version marked on the actual IM
153 module you intend to use. In PCS 7, the active backplane bus is used.

2. For the "PROFIBUS Address", select an address for the DP slave that is
unique in your DP network (for example 7). You must also set this address
using a DIL switch (hardware switch) on the IM 153-2 module.

Close the dialog with the "OK" button. If you have inserted all the
communications processors, your screen appears as shown below:
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Figure 4-9 ET 200 Within the SIMATIC Station

3. In the upper half of HW Config, you can select objects (racks, DP slaves) that
then appear in detail in the bottom half (see Figure 4-10).

4. Open the Object Properties dialog of the ET 200 M module again and click the
check box "Module exchange in operation" in the "Special"  tab and then
close the Object Properties dialog of the ET 200 M ("OK" button).

Caution:
If you do not select this option and the module fails, the PLC interprets the module failure
as a failure of the ET 200M.
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Inserting Inputs and Outputs

1. Select the ET 200 M and insert the input and output modules you require (refer
to the tag list in Chapter 2) in the table displaying the slots of the ET 200 M
(lower window of the hardware configuration) by dragging the modules from
the hardware catalog (PROFIBUS DP/ET 200M/IM 153-2 folder).

Figure 4-10 Input and Output Modules in Hardware Configuration

2. Now select the options you require for the modules (diagnostic interrupt,
hardware interrupt, measuring ranges etc.) in the Object Properties of the
individual modules.

Note:

The channel specific setting "Reaction to CPU-STOP" (OCV, KLV, SV) of a module (for
example analog output module with four channels) within the ET 200M distributed I/O
station must be set identically for all channels.

The CPUs supplied prior to April 1999 can read a maximum of 122 bytes of process data
of an ET 200 M. If you access an ET 200M via the DP interface of one of these CPUs, you
cannot address 8 analog modules each with 8 channels
( 8 modules x 8 channels x 2 bytes per input = 128 bytes). The CPUs supplied after this
date have an address area of 244 bytes, so that this problem is no longer relevant.
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Assigning Symbolic Names to the Channels

You assign drivers to the channels on the modules using symbolic names listed in
the symbol table. You declare the symbol names in hardware configuration. Follow
the steps outlined below:

1. Select the first module in the ET 200M (Slot 4), press the right mouse button
and then select "Edit Symbolic Names...".

2. Enter the symbolic names to reflect the technological significance of the value
being read in. Use the tag list of the "COLOR_PH" project (Chapter 2).

Figure 4-11 Symbolic Names of the Digital Inputs

3. Now enter the symbolic names for all further required process values following
the same procedure as outlined above. Base the names on the tag list in
Chapter 2.

Note:
Remember that the measuring range for the analog input module must also be set on the
module itself using a coding key. You can find the code letter for setting the measuring
range selection module in the object properties of the module in the "Inputs" tab to the
right beside "Position of Measuring Range Selection Module".

If you are using an ET 200M (IM 153-x), you must insert at least one input/output module
in the ET 200 M to avoid a consistency error occurring when you save and compile the
hardware configuration.

You have now inserted all the new components required.
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4.3.1 Local Data

The standard setting for the local data (for temporary variables) must be adapted in
certain situations. How to calculate the local data requirements and, if necessary,
adapt them, is explained in the manual SIMATIC PCS 7 Tips and Tricks.

4.3.2 Size of the Process Image

When addressing the inputs and outputs of the signal modules from the user
program, it is not the signal states of the digital signal modules themselves that are
queried but rather a memory area in the system memory of the CPU and the
distributed I/Os that is accessed. This memory area is known as the process
image.

For PCS 7, the size of the process image must be set equal to or greater than
the number of inputs and outputs used.  As default, the first analog output
module has the base address 512 in the process image. For the "COLOR_PH"
sample, set the size of the process image input and output table to "1024". This
means that you have space available for further analog modules. Follow the steps
outlined below:

1. Open the hardware configuration and the Object Properties of the CPU.

2. Select the "Cycle/Clock Memory" tab and set the size of the process image to
"1024".

Figure 4-12 Size of the Process Image
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4.3.3 Process Image Input/Output Tables

The drivers of the PCS 7 library in Version V5 do not access the I/Os directly to
query the current signal states as was usual up to now but access the process
image input (I) and output (Q) tables. This process image includes both the digital
inputs and outputs as well as the analog inputs and outputs.

The process image begins at I/O address 0 and ends at the upper limit stipulated in
Figure 4-12.

Updating the Process Image

The process image is updated cyclically. The time at which the update takes place
depends, however, on the CPU. The CPUs can be grouped as follows:

Table 4-1: Processing of the Process Image Tables up to 10/98

Processing of the process image tables for CPUs supplied up to 10/98

Ä Start of current

Ä cyclic processing

Ä Start of next

Ä cyclic processing

Ä    Current cycle time of OB1    Å

Update of
the PII

Execution of OB1
or cyclic
interrupts

Output of the
PIQ

Updating
of the PII

Execution of OB1
or cyclic
interrupts

Output of
the PIQ
etc. Å

Table 4-2: Processing of the Process Image Tables Since 10/98

Processing of the process image tables for CPUs supplied after 10/98

Ä Start of current

Ä cyclic processing

Ä Start of next

Ä cyclic processing

Ä     Current cycle time of OB1    Å

Output of the
PIQ

Update of
the PII

Execution of OB1
or cyclic
interrupts

Output
of the
PIQ

Update of
the PII

Execution of OB1
or cyclic interrupts

etc. Å
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Advantages of the Process Image

Compared with direct access to the input/output modules, the main advantage of
accessing the process image is that the CPU has a consistent image of the
process signals for the duration of one program cycle. If a signal state on an input
module changes while the program is being executed, the signal state in the
process image is retained until the process image is updated again in the next
cycle.

Access to the process image also requires far less time than direct access to the
signal modules since the process image is located in the internal memory of the
CPU.

4.4 Process Image Partitions

 In the newer CPUs, you can create up to 15 process image partitions
(numbered 1 to 15; depending on the CPU type).

Each peripheral input or output address that you assign to a process image
partition no longer belongs to the OB1 process image (number 0) input/output
tables.

You assign input and output addresses to the process images during hardware
configuration of the I/O modules (see Figure 4-13).

Figure 4-13: Assignment of the Process Image Partition
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Updating the Process Image or a Process Image Partition

The process image is updated as described above. You can also disable this
updating, as was generally necessary in PCS 7 Version 4 in the CPU properties
(see Figure 4-12).

A process image partition is updated either using system functions (SFCs) or by
the system by calling an OB.

System Update of Process Image Partitions

If you link the updating of a process image partition to an OB, the partition is
updated automatically by the operating system when the OB is called. This strategy
similar to the updating of the (total) process image that is updated cyclically or after
OB1 has been executed. This function can only be set for certain CPUs.

During operation, the assigned process image partition is then updated
automatically as follows:

• The process image inputs partition before the OB is executed

• The process image outputs partition after the OB is executed

Table 4-3: Linking a Process Image Partition to a Cyclic Interrupt (OB).

Processing a process image partition when linked to an OB

Ä Start of the current

Ä cyclic interrupt (OB) execution

Ä Start of the next cyclic

Ä interrupt (OB) execution

Ä      Current cycle time of the OB    Å

Updating
of the PII
partition

Execution of the
cyclic interrupt

Output of the
PIQ partition

Updating
of the PII
partition

Execution of the
cyclic interrupt

Output of
the PIQ
partition
etc. Å

You can specify which process image partition is assigned to which OB when you
assign parameters to the CPU and the priority of the OB (see Figure 4-14).
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Figure 4-14: Assigning a Process Image Partition to an OB

Updating a Process Image Partition with an SFC

You can use SFCs to update the entire process image or a process image partition
from your user program.

Requirement: The selected process image partition is not updated by the system.

For the process image input partition, you use SFC26 UPDAT_PI and for the
process image output partition, you use SFC27 UPDAT_PO. You can see the
transfer parameters for the SFCs in Table 4-4 .

Table 4-4: Transfer Parameters of the SFCs for Updating the Process Image (Partition)

 Parameter
Name

 in SFC  Declaration  Data type  Assignment, Description

PART 26 27 INPUT Byte Number of the process image (0) or
the process image partition (1 to 15)

RET_VAL 26 27 OUTPUT Integer Error information

FLADDR 26 27 OUTPUT Word If an access error occurs: Address of
the first byte causing the error
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 I/O Access Errors (PZF) and Process Image (Partition) Updating

If an error occurs during updating of a process image (partition) (for example a
module can no longer be accessed), a diagnostic buffer entry is made each time
the process image is updated and OB85 "Program Sequence Error" is called. The
input and output bytes involved are set to 0. If OB85 does not exist, the CPU
changes to STOP. The MSG_CSF block creates this OB. In PCS 7, it must exist
once in each CPU (must be checked by the user).

In new CPUs (from 4/99 onwards), you can change the reaction to I/O access
errors so that the CPU

• creates a diagnostic buffer entry and starts OB85 only when PZF errors enter
and leave the state or

• the default response of the S7-400 (OB85 is called with each access)
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4.5 Downloading the Hardware Configuration to a CPU

Downloading the Configuration

The hardware configuration of the SIMATIC station is completed.

You must first save and compile the hardware configuration you have created and
then pass on the information to the CPU. Follow the steps outlined below:

1. Select the menu command Station > Save and Compile.

If consistency errors are detected, these are indicated now and you can find
out more information about them with the menu command  Station >
Consistency Check.

2. To download the configuration (you require a functioning data connection from
the ES to the SIMATIC station), select the menu command PLC > Download.

You can only download the hardware configuration when the CPU is in
the STOP mode.

A dialog box is displayed in which the destination modules are listed.

Here, you select the modules you want to download to. When you first
download, you must download to all modules and then later only the modules
in which you have made changes.

When you download, the CPU of the SIMATIC station and any
communications processors are set to the "STOP" mode following a prompt.

Note:
If you are using PROFIBUS, the first download to a CPU is possible only via the MPI
interface of the CPU. The CPs are supplied with communications parameters at the same
time (transmission rate, profile etc.). All further downloads can be made directly via
PROFIBUS. Make sure that the correct module and correct access point is set in the
"Setting the PG/PC Interface" application (Windows Control Panel).
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3. Close hardware configuration with the menu command "Station > Exit".

Your project has now been created with the following structure in the component
view.

Figure 4-15 Project Structure with a SIMATIC Station

Source Files and Blocks

The source texts of the user blocks and the SCL source files generated by
CFC/SFC are stored in the "Sources"folder. Standard and user blocks and blocks
generated by CFC/SFC (for example instances) are stored in the blocks" folder.
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4.6 Hardware Configuration of the 10 ms Time Stamp

Requirements

To achieve highly accurate time stamping, you currently require the following
components:

• Time master for maintaining a highly accurate timebase (see Figure 4-19)

• An operator station to display the message

• A PLC with the CPU 414, CPU 416 or CPU 417 for processing the message
and passing it on to the OS

• CP 443-1 (6GK7 443-1BX01-0XE0; in the PLC) for connecting the PLC to
Industrial Ethernet/Fast Ethernet

• CP 443-5 Extended (6GK7 443-5DX02-0XE0; in the PLC) to pass on the time-
of-day and to link up with the ET 200 M

• ET 200 M to accommodate and supply the input modules

• IM 153-2 (6ES7 153-2AA02-0XB0; in the ET 200 M) to preprocess the time-
accurate messages

• SM 321 (order number see Figure 4-19) module for acquiring the process
signal.

• Driver IM_DRV (in a CFC chart) for processing the process signal and the
message
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Settings

Make the following settings if you require the 10 ms time stamp:

1. Make the settings for time-of-day synchronization.

2. Set the "DP Master" mode in the "Operating Mode" tab in the object properties
of the CP 443-5 Extended in hardware configuration.

Figure 4-16 Object Properties of the CP 443-5 Extended

3. In the "Time-of-Day Stamp" tab of the object properties of the IM 153-2
(appears only after configuration of the corresponding input module (for
example SM 312)) select the option "Time Stamp" as "Default of the Inputs".
Depending on the edge you want to evaluate click the option "Falling edge" or
"Rising edge". (The settings in this dialog box create the same parameters for
all channels of all binary input modules of this ET 200M that support time
stamping)
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Figure 4-17 Object Properties of the IM 153-2

4. Select the "Time stamp" check box in the "Time-of-Day Stamp" tab as the
default in the object properties of the digital input module (creates the
parameters for all channels of this module). You can also make the time stamp
setting separately for each input in "Individual assignment for inputs" (creates
the parameters for a specific digital input channel).
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Figure 4-18 Object Properties of the Digital Input Module

5. Insert an IM_DRV block in a CFC chart. Assign the logical address of the IM
153-2 (for example address 1) at the "LADDR" input. At the inputs "S_CHx" (x
= {0 thru 127} ), specify the slot number and bit number of the hardware signal
that will trigger a message on the OS.

Note:
How to create a SFC chart, insert blocks, and make parameter settings for the blocks is
described in detail in Chapter 7 (Creating SFC Charts).

Example:
In an ET 200 M, the 3rd bit of the module in slot 4 must trigger a message on
the OS:
Assign the value "43" at an input "S_CHx" (for example S_CH000).

6. Specify the message text in the object properties of the IM_DRV block
"General" tab using the "Messages" button.
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Time Stamp of Signal Changes

You can monitor the digital inputs of a module used in the ET 200M distributed I/O
station for signal changes. Depending on the configuration, the signal entering
and/or leaving the state (rising or falling edge) can be monitored.

The IM 153-2 adds the time stamp of the current time-of-day to the input signals
and saves them as a message list on the IM 153-2.

A message list is a data record with a maximum of 20 messages about time-
stamped signal changes. The IM 153-2 can store up to 15 data records. If a data
record on the IM 153-2 is full of messages, or if there is at least one message in a
data record after one second, the IM 153-2 triggers a hardware interrupt on the DP
master (S7-400). The CPU then reads the data record and passes on the message
list to the operator station using the "IM_DRV" driver block.

The time master for the time-of-day synchronization required for 10 ms message
stamping can either be a "real-time transmitter for Industrial Ethernet" or
"SICLOCK".

Figure 4-19 Example of Configuring Time Stamping for Signal Changes

SIMATIC S7-400
as DP master

PROFIBUS DP

Industrial Ethernet/Fast Ethernet

Distributed I/O system
ET 200M with IM 153-2

At present, the following digital input
modules are approved for time stamping:

- SM321-7BH00-0AB0
- SM321-7TH00-0AB0

Operator station 1 Operator station 2
SICLOCK

Time master, either:

CP
44
3-5

Real-time
transmitter for
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Note on Avoiding Message Buffer Overload
If "exceptional" events occur in a plant (for example failure of a section of plant) this
can lead to a flurry of signals; in other words the signal changes are practically
simultaneous. This response is explained by the technological relationships of the
individual signals.

Based on projections, the following is known about the signal change frequency in
a plant:

• On average, 2% of the signals change per second

• In the worst case (for example failure of a plant section) 30% of the signals
change per second.

If all the signals requiring time stamps are on one ET 200 M, messages can be lost
on the corresponding IM153-2 if "exceptional" events occur.

Example:

The finalized "COLOR_PH" plant has 1500 digital signals. In the worst case,
according to the above projection, 450 signals could change. If 128 signals of these
(maximum 8 x DI 16 module SM321) in one ET 200 M, messages can be lost since
further system internal messages are generated along with the process messages
and the subsequent processing stages (IM 153-2, IM_DRV blocks, PLC message
processing, OS message processing) require time to evaluate the process
messages.

Remedy:

The signals requiring a time stamp are distributed evenly on the ET 200 M systems
in the plant. This minimizes the danger that messages are lost in a buffer overflow.

When planning and configuring the plant, make sure that such signals are
distributed uniformly throughout the system.
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4.7 Hardware Configuration for PA Devices

Communication with PA field devices takes place via a PA-Coupler or a PA-Link.
When configuring field devices for PROFIBUS-PA (PROFIBUS for Process
Automation), note the following points:

DP/PA-Link

The DP/PA-Link is a gateway between PROFIBUS-DP and PROFIBUS-PA. It
consists of the IM 157 interface module and a maximum of 5 DP/PA couplers that
are all interconnected over backplane connectors.

The device must be arranged in a DP master system as a DP slave taken from the
“Hardware Catalog”.

The display of the DP/PA link includes not only the icon for the device itself but also
an icon for the "DP/PA system” similar to that of the DP master system. The PA
field devices must be arranged at this icon.

PROFIBUS-PA must operate at a fixed transmission rate of 31.25 Kbps to allow
the attachment of PA devices.

Note
Operating PA devices directly attached to a DP/PA coupler (without a DP/PA-Link) is not
supported in PCS 7 Version 5.2.

The procedure for configuring a DP-Link is described in the online help of the SIMATIC
Manager under "DP/PA-Link".

The configuration of the field devices is explained in the following manuals and
FAQs. You can view of these documents on the Internet at the address listed in the
Preface.

 Topic  Entry ID

Configuration of PA Field Devices with PDM over Industrial Ethernet 2253966

Attachment of a SITRANS P (Series DS) to PCS 7 using PROFIBUS PA
Communication

766281

DP/PA Bus Coupler (Manual) 1142696
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4.8 Importing and Exporting a Configuration

Introduction

You can work on station configurations not only within the entire project (for
example saving or opening), but also independent of the project by exporting it to a
text file (ASCII file), editing it, and then importing it again. The symbolic names of
the inputs and outputs are also exported and imported again.

Applications

• Data import of hardware planning tools

• Can be distributed using electronic media (for example E-mail)

• Reading into future STEP 7 versions

• An export file can be printed out with word processing systems or can be
edited for documentation purposes.

What is Exported/Imported?

When you configure the hardware, the only data that can be exported or imported
are those necessary for the configuration and parameter assignment of modules.

The following are not included:

• Data managed by other applications (for example programs, connections,
shared data)

• A selected CPU password

• Network configuration (for example assignment to subnets, bus parameters)

• Data involving more than one station (for example the linking of intelligent DP
slaves or cross-communication relations)

Note:
If your configuration contains modules from older optional packages, it is possible that not
all the data of the module will be included with the "Export Station" function. In this case,
check whether the module data are complete following import.
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Export File

You can select what is included in the exported text file and in what form it is stored
when you export (menu command Station > Export):

• Legible or compact form

• Name of the file (*.cfg) freely selectable

• Default values for module parameters can be omitted as an option (STEP 7
knows the default values and supplies them internally when you import the file
again).

Importing to an Existing Station

You can also import a station into an open station configuration (Station > Import).
During the import step STEP 7 asks whether you want modules/interface modules
that have already been configured to be overwritten. For each component, you can
decide whether you want to retain it or overwrite it.

If a component is overwritten, all the settings (parameters) contained in the import
file become valid. Settings that are not included in the import file are retained in the
station configuration.
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5 Configuring Networks

Introduction
With NetPro you can take all the network objects, such as subnets or stations
(SIMATIC station, PG/PC stations etc.) from a catalog and drag them to the
network view and document the network configuration graphically.

After inserting the network objects from the catalog, you must then do the following:

• Double-click the objects to specify their properties

or with newly inserted stations:

• Double-click the station to start hardware configuration and insert the modules.
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5.1 Configuring Networks with NetPro

Overview
Using NetPro, you can configure, make parameter assignments, and document the
network configuration for your plant extremely simply and clearly.

With NetPro you can do the following:

• Create a graphic view of your network

• Specify the properties and parameters for each subnet

• Specify the node properties for each networked module

• Document your network configuration

Requirement
Before you can create a new network configuration with NetPro, you must first
create a project and open it in the SIMATIC Manager.

There may already be stations created in the SIMATIC Manager and modules
configured and assigned parameters in hardware configuration. This is, however,
not absolutely necessary.

During network configuration, you can also create stations and DP slaves and
change to hardware configuration by double-clicking a station/DP slave.

Note
For complete documentation and to avoid duplicate assignment of addresses on subnets,
you also add all other stations (for example WinCC as a SIMATIC PC station) in NetPro.
If an address is not unique, NetPro displays a message box.
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5.1.1 Starting Network Configuration

Opening the Graphic Network View (Starting NetPro)

You can start the user interface for network configuration in the following ways:

• Within the SIMATIC manager

- Open the project

- Double-click on a subnet symbol (if no network exists, you must first create
the subnet with the menu command Insert > Subnet >...).

As an alternative, you can also double-click the "Connections" object (this symbol
is located, for example, under a module that represents a connection end point,
such as a CPU). In this case, when you start NetPro, the connection table of the
module is open for editing.

• Within HW Config

- Menu command Options > Configure Network

Note
You can only ever network within a project, however you can create several subnets within
one project.

With smaller projects, you can create the network configuration more quickly in hardware
configuration without using NetPro.

5.1.2 Graphic Network View

After opening the user interface for network configuration, the window for the
graphic view of the network is displayed. When you first open this window, the
following objects are visible:

• All subnets previously created in the project

• All stations previously configured in the project (for example, SIMATIC station
or PG/PC station)

Catalog of Network Objects

The catalog of network objects is displayed automatically. You can close the
catalog and open it again at any time with the menu command View > Catalog.
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View of the DP Slaves

If you want to display DP slaves that have already been configured or want to
network DP slaves, you can display the DP slaves in the network view with the
menu command View > DP Slaves.

All DP slaves are displayed (networked or not networked). This allows you to view
existing, unconnected slaves without a bus attachment (that can occur, for
example, after deleting a CPU) and network them again.

Inserting New Network Components

You insert new network components in the network view by selecting network
objects (a subnet, a DP slave or a station) and then dragging them to the network
view.

If you click the icon for the interface of a node and then drag the mouse pointer
(holding down the mouse button) to the subnet, you connect the network object
with the subnet.

After creating a new station, you must assign the hardware configuration of the
station (CPU, possibly FM and CPs) in HW Config. You can start HW Config by
double-clicking the station.

5.1.3 Access Path

General

To access PLCs (for example an S7-400) from your engineering station (ES),
configure a PG/PC as a substitute for the engineering station in NetPro. Follow the
steps outlined below:

1. Open the project in the SIMATIC Manager.

2. Open NetPro.

3. Select the component "PG/PC" from the "Stations" in the catalog of network
objects and drag this to your graphic network view.

The station is created in the network view.

4. Right-click on the PG/PC station and select "Object Properties" in the
context-sensitive menu.

5. Click "New" in the "Interfaces" tab and select the required interface (for
example, Ethernet interface).

6. In the "Properties – Ethernet Interface " dialog, enter the required address
and network you require (for example, control system bus).

The interface is created in the "Properties - PG/PC" dialog.

7. Select the required interface in the "Assignment " tab (for example, Ethernet
interface (1)) and the required interface parameter assignment in the PG/PC.
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8. Click the "Assign" button.

Result: The assigned interfaces appear next to each other in the "Assigned" list
box. After you click "OK", the assignment takes effect, is marked yellow in NetPro,
and the settings specified in the configuration are transferred to the installed
interfaces of your ES (interfaces = "module parameter assignments in the PG/PC").

Note:

If you select another configured interface in "Not Assigned", an interface suitable
for your PG/PC will be proposed.

The "Assign" button is then only available when the selected configured interface
is networked, the selected parameter assignment matches the configured
interface, and the interface parameter assignment can go online. If the network is
missing, you can assign the interface to a subnet in the "Interfaces" tab
("Properties" button).

A modified assignment is adopted in the "Set PG/PC Interface" dialog only when
STEP 7 has attempted to go online.

Advantage

The interfaces in your ES are adapted to match the configured settings. If you
change the settings (for example change the transmission rate network property),
the interface on your ES is adapted automatically. Without this function, you would
have to start the "Set PG/PC Interface" program and adapt the settings of the
interface of your programming device/PC to the configured settings yourself.

Note
Please note that within a project, you can assign a maximum of one configured
programming device or one configured PC to your ES. If you do not make any
assignments in the "Access Path" tab and you exit the tab with "OK", these settings take
effect; in other words, there are no assignments.
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5.2 Named Connection

Overview

As an option, you can assign a symbolic name instead of network parameters to a
CPU with which you want to establish a connection. If you then transfer the PLC-
OS connection data, you will find the corresponding S7 program in the Control
Center of the OS in the "Named Connection" unit after opening the "SIMATIC S7
Protocol Suite" (see also "Configuring Operator Stations").

You can assign a symbolic name as follows:

9. Open the project in the SIMATIC Manager

10. Open NetPro.

11. Select the component "SIMATIC PC Station" from the "Stations" in the
catalog of network objects and drag this to your graphic network view.

The station is created in the network view.

12.  Save the configuration (Network > Save)

13. Click on the newly created station with the right mouse button and select
"Open Object".

Hardware configuration is opened and the SIMATIC PC station is displayed.

14. Open the SIMATIC PC station in the hardware catalog  (click the "+"). If you
cannot see the hardware catalog, select "View > Catalog".

15. Open the "CP Industrial Ethernet" folder in the SIMATIC Station in the
Hardware Catalog and drag the required CP (for example, click the  "+" in front
of CP 1613 > Software V2.1 or for BCE > IE General) to a free location in the
SIMATIC PC station.

16. The "Properties – Ethernet Interface communications card ) is opened and
you can select the required address (node address of the OS on Ethernet or
Fast Ethernet) and select a subnet or create a new one.
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Figure 5-1    Assigning the Address and the Subnet

17. Exit the CP properties dialog with the "OK" button.

The "Properties – Industrial Ethernet Module" dialog box is opened. The valid
parameter setting can be recognized based on the entries in the module
catalog.

18. Close the dialog box (OK button).

The CP appears in the SIMATIC PC station.

19. Open the "HMI" folder in the SIMATIC Station in the hardware catalog and
drag "WinCC Application" to a free location in the SIMATIC PC station.

The WinCC Application is displayed in the SIMATIC PC station. The
configuration of the station is completed.

20. Save the station "Station > Save " and close hardware configuration with
"Station > Exit".

With the entries you have made, the SIMATIC PC station is already connected
to the "Process Control Net". See Figure 5-6 .

21. Select the label "WinCC Application" in the icon of the "SIMATIC PC
Station".

A connection table is opened below the NetPro window.
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Figure 5-2    Connection Table in NetPro

22. Insert a new connection in the connection table (by double-clicking a row).

The "New Connection" dialog box is displayed.

Figure 5-3    "New Connection" Dialog Box

23. For the "Station", select the PLC to be linked to the OS and make sure that the
option "Show Properties dialog box" is selected. Then click the "Apply"
button.

The following Properties dialog is then displayed:
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Figure 5-4    Properties Dialog of the Connection

24. In "Local ID:", a default connection name was entered (S7 connection_1). You
can adapt this name to the requirements of your project.

You will also see the connection name in the connection table. When you
transfer PLC-OS connection data, the appropriate S7 program is transferred to
the OS.

25. Complete the connection configuration (Network > Save and Compile).

If you use the function "Named Connection", a PC station containing an OS is
created in your project.
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5.3 Creating an OS for the "COLOR_PH" Project

You have already created the hardware for the "COLOR_PH" project in HW Config.
Now start  NetPro as described in Section 5.1.1. The following graphic network
view is displayed.

Figure 5-5    Graphic Network View of the "COLOR_PH" Project Without a Programming
Device/PC

Note
If the ET 200M does not appear on your monitor, select the menu command "View > DP
Slaves".

Create the OS for the "COLOR_PH" Project

Now create the PC in the graphic network view. Follow the steps outlined below:

1. Select the component "SIMATIC PC Station" from the "Stations" in the
catalog of network objects and drag this to your graphic network view.

The station is created in the network view.

2. Save the configuration (Network > Save)

3. Click on the newly created station with the right mouse button and select
"Open Object".

Hardware configuration is opened and the SIMATIC PC station is displayed.

4. Open the "SIMATIC PC station" in the hardware catalog  (click the "+"). If you
cannot see the hardware catalog, select "View > Catalog".
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5. Open the "CP Industrial Ethernet" folder in the SIMATIC Station in the
Hardware Catalog and drag the required CP (for example, click the  "+" in front
of CP 1613 > Software V2.1 or for BCE > IE General) to a free location in the
SIMATIC PC station.

6. The "Properties – Ethernet Interface communications card ) is opened and
you can select the required address (node address of the OS on Ethernet or
Fast Ethernet) and select a subnet or create a new one.

7. Exit the CP properties dialog with the "OK" button.

The "Properties – Industrial Ethernet Module" dialog box is opened.  The valid
parameter setting can be recognized based on the entries in the module
catalog.

8. Close the dialog box (OK button).

The CP appears in the SIMATIC PC station.

Note
You do not require a CP for a multiclient.

9. Open the "HMI" folder in the SIMATIC Station in the hardware catalog and
drag "WinCC Application" to a free location in the SIMATIC PC station.

The WinCC Application is displayed in the SIMATIC PC station. The
configuration of the station is completed.

Note
For single/multiple workstation projects and master server (redundant server structure),
use the "WinCC Application". For the standby server in a redundant server structure, use
the "WinCC Application (stby)" and for a multiclient the "WinCC Application MC".

10. Save the station "Station > Save" (this takes some time because the OS is
created in the background) and close hardware configuration "Station > Exit".

With the entries you have made, the SIMATIC PC station is already connected to
the "Process Control Net". See Figure 5-6 .
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Figure 5-6    Graphic Network View of the "COLOR_PH" Project with an OS Station
(here: SIMATIC PC Station(1))

11. Now save and compile your network configuration (Network > Save and
Compile).

Close network configuration with NetPro (Network > Exit).
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5.4 Creating and Downloading a Redundant OS

The following section explains the steps required to create a redundant project and
to download the part relevant to the OS.

1. Create a SIMATIC PC station for the OS server 1-1 (master server) in the
SIMATIC Manager and a SIMATIC station for OS server 1-2 (standby server)
(see also Section 5.3).

A SIMATIC PC station consists of a WinCC Application and a communications
module (for example a CP 1613). Multiclients are an exception since they do
not require a CP in the SIMATIC PC station (as an option, you can also create
a project with redundant operator stations using the "New Project Assistant"
(SIMATIC Manager > File > New Project Wizard)).

When creating the SIMATIC PC stations use the following HMI applications:

• WinCC Application (name in the SIMATIC PC station: WinCC Application) for a
single workstation system or the master server in a multiple work system
project.

• WinCC Application red. OS (name in the SIMATIC PC station: WinCC
Application (stby)) for the standby server in the multiple workstation project.

• WinCC Application Multiclient (name in the SIMATIC PC station: WinCC
Application MC) for the multiclients in the project.

Figure 5-7    Redundant Project in the SIMATIC Manager
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2. Open the object properties of the OS and set the path to the OS server 1-1
(master server) in the "Target OS and standby OS" in "Path to Target OS
Computer". For "Standby OS" select the redundant OS (OS server 1-2,
standby server). Close the Object Properties.

Figure 5-8    Path to the Target OS in the Object Properties of the Master OS

The name of the redundant OS is automatically changed to "Master OS
Name_STBY".

3. Open the object properties of OS_Stby and set the path to the OS server 1-2
(standby server) in the "Target OS and Master OS" tab in "Path to Target OS
Computer". The OS server 1-2 (master server) has already been entered in
"Master OS". Close the Object Properties.
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Figure 5-9    Path to the Target OS in the Object Properties of the Standby OS

4. Create the connections required for a redundant OS in NetPro.

5. Transfer the PLC/OS connection data (see Chapter 12).

6. Configure the "Redundancy" application in the WinCC Explorer of the master
OS.

7. If you are using a multiclient project: Create the packages for the multiclients
on the master OS in the WinCC Explorer in "Serverdata", enter the physical
computer name of the master OS in the properties of the package and, if
necessary, change the symbolic computer name (see Chapter 11).

8. If you are using a multiclient project: Download the packages in the WinCC
Explorer on the multiclients in "Serverdata" and set the standard server and the
preferred server (see Chapter 11).

9. Select the master OS in the SIMATIC PC station in the SIMATIC Manager and
select "PLC > Download".

10. Select the standby OS in the SIMATIC PC station in the SIMATIC Manager
and select "PLC > Download".

11. If you are using a multiclient project: Select each multiclient individually in the
SIMATIC Manager and select "PLC > Download".

You have now created a redundant project within the SIMATIC Manager and
downloaded the operator stations with the relevant program.
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6 Creating the Plant Hierarchy

Introduction

This chapter explains how the plant hierarchy (PH) functions, how to work with
the plant hierarchy, and the difference between the component view and the plant
view.

You will also learn how to edit charts in the PH without opening them. This function
is particularly useful when you want to edit larger amounts of data (I/Os, message
texts, chart names).

You will create the plant hierarchy for the entire "COLOR_PH" project.

6.1 Component View and Plant View

The objects of the control system can be displayed in different views for different
purposes. The installation engineer, for example, wants to know which functions
run on the CPU and technicians need to know which units belong to a plant.

When configuring an automation solution, you have the component view and the
plant view available in the ES. In the component view, you can also switch
between the online and offline view. To change the view, select the "View" menu in
the SIMATIC Manager.

One major feature of these views is that the objects they contain exist only once
but appear in the various views where they can be manipulated. The component
view, for example represents the physical storage location of the charts and the
technological view shows the technological arrangement of the charts.

You create the hierarchy folders in a tree structure in the plant view (these can also
be nested), for example plants/process cells, units, functions, process control
points1 and elements. These folders can contain the following:

• CFC and SFC charts

• OS pictures and OS reports

• Additional documents (from WORD, EXCEL, ...)

                                                     

1 A process control point can be a measuring point, a device (valve, motor, pump etc.), a tag, or an object.
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Component View

In the component view, you configure the hardware of your project (control system
hardware such as PLCs and operator stations). The objects are known as
components according to their importance (for example S7 program, station, OS,
PLC/AS(CPU), chart folder, ...).

Figure 6-1 Component View with the Hardware Components and the S7 Program

Plant View

In the plant view, you can structure a project according to technological aspects; in
other words, you structure automation and operator control and monitoring
functions hierarchically. This structuring, provides greater clarity and allows you to
handle technological objects (plants, units, functions, ...) as one entity.

In the plant view, you can handle objects regardless of any concrete assignment to
devices. You can name these objects, meaning the hierarchy folders, according to
their technological meaning. The resulting project structure is the plant hierarchy.

Remember that no two pictures with the same name are permitted on the OS.
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Figure 6-2 Plant Hierarchy with 5 Hierarchy Levels

Using the hierarchy folders of the plant hierarchy, you can create a naming scheme
according to functional criteria. This hierarchy path forms the higher level
designation (HID). In a dialog, you can decide which folders of the hierarchy levels
are included in the naming scheme (Options > Plant Hierarchy > Customize...).

Note

As default, the naming scheme is deactivated. This means that no hierarchy folder is
included in the name.

Working with Both Views at the Same Time

The component view and the plant view can be displayed at the same time in the
project window (set with: Options > Customize -> View tab, option: "Open new
window automatically on changing view").

Relationships between the Views

Since the component view and the plant view represent different aspects of the
same objects, certain functions affect these objects in both views:

Deleting objects deletes them in both views.

Creating new objects in the plant view also creates them in the PLC / OS
assigned to the hierarchy folder.

Creating new objects in the component view has no effect on the plant
hierarchy.
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The individual objects (charts, pictures etc.) exist only once in the component view.
The plant view "hides" this component view and displays the objects arranged
according to the technology.

In PCS 7, working in the plant view is more efficient (for example you have the
automatic assignment of objects to certain plant areas. Creating charts, pictures, or
reports in the component view is therefore not recommended.

COLOR
SIMATIC 400(1)

CPU 416-2DP

S7-Program(1)
Charts

OS(1)

    :
    :

Component view

Pic(1)    Report(1)
Pic(2)    Report(2)
Pic(3)    Report(3)

Plant view

COLOR

Plant1
    :
    :

Fill

Hold

REAK1

 CFC1  Pic(1)  Report(1)

 CFC2  Pic(2)  Report(2)

 CFC3  Pic(3)  Report(3)
CFC1     CFC2
CFC3

assigned to

Charts and pictures
sorted technologically

Charts and pictures
stored physically

Figure 6-3 Relationship Between the Component and Plant View
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6.2 Extending the Plant Hierarchy

With the assistant, you can create a maximum of 5 hierarchy levels without further
nesting of hierarchy folders. You can extend this basic structure by adding more
hierarchy folders and/or technological objects.

Assigning Technological Names

After you insert a hierarchy folder, this is displayed in the right hand window. It is
prepared for a name change: The name field with the name assigned by the
system is selected and the cursor is located after the last character of the folder
name. You can now enter the required technological name at the keyboard (delete
and edit).

Copying / Moving / Deleting Hierarchy Folders

If you copy or delete hierarchy folders, , all the objects it contains are copied or
deleted. By copying, you can copy, for example, an entire unit at once. You then
only need to modify the copied unit (for example link to process signals).

If the destination hierarchy folder to which you want to copy / move has no
assignment to a chart folder, this is automatically made by the system.

This means that within a project the same assignment is made for the copied target
hierarchy folder as the source hierarchy had. If there are multilevel hierarchy
branches with different assignments, the different assignments are retained.

When more than one project is involved, every PLC and OS in the destination
environment is identified. If an assignment cannot be made unequivocally, (no or
only one PLC or OS), a list of the possible alternatives is displayed for selection.
Once again, if hierarchy branches have different assignments, they are also
different in the destination as specified in the source hierarchy branch.

If the destination hierarchy folder to which you want to copy / move already has an
assignment to a PLC and/or to an OS, this assignment is passed on to all copied
objects.

You can copy, move and delete a hierarchy folder containing objects with different
assignments. A warning is displayed asking you whether you really want to copy
or move the folder. If you click "Yes", all objects are copied to the PLC (or OS) to
which the destination hierarchy folder is assigned; if you click "No", the old
structure is retained unchanged.
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Note:
The rule of thumb for copying and moving to a different project or S7 program is as
follows:

If there is exactly one resource (PLC and/or OS) in the target project or the target S7
program, this is assigned to the copied objects.

If there are several resources in the target project or target S7 program, you will be asked
to decide the resources to which the copied objects should be assigned.

If there are no resources in the target project or target S7 program, a resource is created
automatically and the objects assigned to this resource.

If the hierarchy folders you want to copy/move are models or their replicas, there
are several special points to remember. For further information, refer to Section
8.1.4.

6.2.1 Assignment of Objects in the PH

Assigning Objects of the Plant View

You can also assign objects from the component view, for example a CFC chart or
SFC chart, to the plant hierarchy later. This is always the case when, for example,
charts are inserted directly in the component view and you then create a plant
hierarchy later. If you always create the charts and pictures in the plant view, these
assignments are made automatically.

With drag-and-drop while holding down the shift key (move), you can drag the
object from the component view to the required hierarchy folder in the PH. The
hierarchy folder must have the same PLC or OS assignment as the assigned
object. If the destination hierarchy folder has a different PLC/OS assignment, the
assigned object is also moved to this PLC/OS in the component view.

Note:
If you have created pictures/reports directly in the OS and want to make these objects
known in the plant hierarchy later, follow the steps outlined below:

• Select the OS in the component view of your project

• Select the menu command Options > Import WinCC Objects

• With drag-and-drop while holding down the shift key (move), you can drag the object
from the component view to the required hierarchy folder in the PH (as described
above).
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Assignment after Copying / Moving

When you copy / move a hierarchy folder to a hierarchy folder that is assigned to a
different PLC or OS, the copied/moved hierarchy folder also receives the
assignment of the destination folder.

When you copy / move objects (such as CFC charts, OS pictures/reports) to a
hierarchy folder assigned to a different PLC/OS, these objects are also copied /
moved to the other PLC or OS.

When you copy / move hierarchy folders with CFC charts and OS pictures, the
references of the dynamic objects from OS pictures to CFC blocks are included in
the destination hierarchy folder.

Caution:
If you copy or move the charts and pictures separate from the hierarchy folder; in other
words only selected contents, the references of the dynamic objects are lost and must
be linked to the blocks again in the pictures.

Interconnections after Copying / Moving

When you copy / move CFC charts, the interconnections to shared addresses are
automatically copied or deleted. You can make this setting either in CFC or in the
SIMATIC Manager. With the menu command Options > Customize >
Copy/Move... (CFC) or Options > Charts > Settings for Copying/Moving...
(SIMATIC Manager) you display a dialog box; the default is "Include connections
with addresses".

Interconnections Between Charts and Pictures (CFC-CFC, CFC-SFC and CFC
Pictures)

When you copy / move individual charts, the interconnections to other charts or to
pictures are deleted. If, however, you move related charts with the corresponding
pictures together, the interconnections between the charts and pictures are
retained.
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6.3 Settings and Properties of the PH

If you create a new project with the PCS 7 assistant, certain defaults or parameter
settings are made in the dialogs (for example the number of hierarchy levels,
assignment to PLC etc.). You can also change these settings (or the properties of
the objects) later.

6.3.1 Customizing the Plant Hierarchy

The HID

You define the naming scheme for the plant hierarchy of the project.

The higher level designation (HID) is formed from the names of the hierarchy
folders along with the names of the charts. The chart and block name is always
part of the HID, the names of the hierarchy folders are not included as default but
can be included if required (see below "Settings per Level").

Example: Plant\Unit\CFC1

Caution:
Note that the HID is stored on the OS when you transfer the PLC-OS connection data.
Tags in the process pictures and archives reference this HID. If you change the "Include in
Designation" setting (hierarchy folders are included (or not included) in the name of the
HID), this also affects the process pictures. If you require a purely "Tag oriented naming
scheme " (the names of the hierarchy folders are not included in the HID), select "Included
in Designation > No" for all hierarchy levels.

Customizing the Plant Hierarchy

Once you have created the first hierarchy folder, you can set the plant hierarchy.
This means that you make the settings for the higher-level designation and for the
individual levels for the hierarchy folders yet to be created.

With a hierarchy folder selected or open, select the "Options" menu (or the context-
sensitive menu) and then select the function Plant Hierarchy > Customize and
the dialog box with the same name is opened (Figure 6-4).

Higher Level Designation

With the following options, you can select the appearance of the PH:
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Number of Hierarchy Levels

A maximum of 5 hierarchy levels can be set. For the "COLOR_PH" project, set 3
hierarchy levels.

Documentation Prefix

Here, you can enter up to 24 characters.

This prefix is only relevant for documentation and is not visible in the HID. Using
the documentation prefix, you can, for example, include information about a factory
or plant complex before the project.

The documentation prefix is currently not evaluated and does not appear in the
documentation.

In the "Preview" box, the prefix is shown in brackets.
(Not displayed in Figure 6-4).

Figure 6-4 "Customize Plant Hierarchy" Dialog box (Default)
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Level Settings

In this group, you can specify whether or not the individual hierarchy levels are
included in the designation, the maximum number of  that can be used for the
names, whether or not separator should follow the designation, and which level
will be defined as the OS area (appears in the overview display of the OS plant
area) (default: 1st level).

The length of the names of the individual hierarchy levels can be limited. You make
this entry in Max. number of characters. The selected name length of the
hierarchy folder is displayed in the "Preview" box as a corresponding number of
digits (and separators if selected). Hierarchy folders that are part of the
designation, enter their names in the HID.

Note:
The maximum length of the HID should not be more than 32 or 48 characters. For further
information, refer to Section 6.5

You can use folders that are not included in the designation to create further "drawers" (for
example to further subdivide functions that you do not want to appear in the HID). You can
also decide whether the name is part of the HID later when you actually have a hierarchy
folder using the "Object Properties" or change the setting made here (see Section 6.3.3).

The names of the hierarchy folders within a hierarchy folder that forms part of the
designation must be unique (unique HID within the entire project).

Note:
Remember when assigning names that the data manager tag name must not be longer
than 128 characters for transfer to the OS. This name is made up of the name of the folder
in the hierarchy path, the chart name, the block name, the separator (dot) and the I/O
name.

Picture Hierarchy

If the option "Base picture hierarchy on the plant hierarchy" is set, the OS
picture hierarchy is derived completely from the configured data of the PH. When
the picture hierarchy is transferred to the OS, any picture hierarchy configured in
WinCC with the Picture Tree Manager is deleted and overwritten by the data
created in the SIMATIC Manager.

This option is active as default. To allow you to continue using the Picture Tree
Manager, this function can be deselected.

Below, you will see three possible scenarios in conjunction with deriving the picture
hierarchy from the plant hierarchy:

• Scenario 1:
The picture hierarchy in the OS is structured completely differently from the
plant hierarchy.

Procedure: Options > Plant Hierarchy > Customize, deactivate the "Base
Picture Hierarchy on the Plant Hierarchy" option. Configure the picture
hierarchy on the OS manually using the Picture Tree Manager. Note: The
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areas created in the PH are also used for messages. Therefore: Enter the area
names on the OS exactly as in the PH.

Result: The areas match (user administration, messages, ...), the picture
hierarchy is separate.

• Scenario 2:
The picture hierarchy matches the plant hierarchy completely.

Procedure: Activate the option above and insert a picture in every hierarchy
folder.

Result: The picture hierarchy is identical to the plant hierarchy.

• Scenario 3:
The picture hierarchy matches parts of the plant hierarchy.

Procedure: Activate the option above and insert a picture in every hierarchy
folder in the "Area" level. Only insert pictures at lower levels where they are
necessary.

Result: The picture hierarchy is a subset of the plant hierarchy. The areas
match those of the plant hierarchy.

With Options > Plant Hierarchy > Customize, you can select the level at which the
OS areas are arranged (as default, this is the top layer of the hierarchy folder). If
you select, for example, a lower level, you do not need to insert pictures in the
higher level.

Caution:
If the picture hierarchy is based on the plant hierarchy, an OS area identifier (messages
are displayed filtered according to the OS area identifier during run time on the OS) must
be entered in the properties of the hierarchy folder.

BATCH flexible Configuration

With the BATCH flexible software package that must be installed extra in addition
to PCS 7, you can automate discontinuous processes (batch processes). These
operate as sequential control or recipe controls. If the "Base BATCH flexible
configuration on the plant hierarchy" option is set, you can configure a BATCH
flexible hierarchy in the plant hierarchy according to the specifications of IEC
standard S88.01.

If the "BATCH flexible" software package is installed, this option is set as default.

For more detailed information, refer to the online help.
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6.3.2 Checking Consistency

Violations of the consistency  can, for example, occur when you change settings
later or copy/move folders to other levels. The system tolerates these violations to
avoid unnecessary error messages while you are working.

With the "Check Consistency" function (menu command Options > Plant
Hierarchy > Check Consistency) you can check whether the settings you made
in the "Customize Plant Hierarchy" dialog box have been kept to in the project
(number of hierarchy levels, maximum number of characters per level). When the
check is complete, the log is displayed.

You can also display the log later without running the check again with the menu
command Options > Plant Hierarchy > Display Log. The dialog box contains the
tabs "Naming Conflicts", "Names with Parentheses", "Name Length", "Number of
Levels", "Error in Picture Name for OS",  and "PLC Assignment Conflict" if errors
have occurred in these categories.

The "Print" button starts the printout of the currently selected tab.

6.3.3 Properties for Hierarchy Folders

You can assign certain properties to the hierarchy folders by opening the
Properties dialog for the selected folder. With the menu command Edit > Object
Properties..., you can open the dialog box with its tabs:

• General (contains all the valid attributes for SIMATIC objects)

• Control and Monitoring Attributes (contains all the attributes valid for operator
control and monitoring)

• PLC-OS Assignment (displays all the available PLC resources (chart folder) or
OS in various combination lists)

• Model (visible only if the selected hierarchy folder is a model or a replica of a
model; displays the models or replicas of the hierarchy folder)

• BATCH Attributes (visible only if BATCH flexible is installed and the option
"Base BATCH flexible hierarchy on the plant hierarchy" is set; contains the
attributes relevant to the Batch flexible configuration)

"General" Tab

In the "General" tab, you can set or display the general properties of the hierarchy
folder. You can enter or modify the name, author and comment. You can see the
project path, the storage location of the project and the date the folder was created
and last modified (contents or properties).
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"Control and Monitoring Attributes" Tab"

Here, you can see the Plant designation (HID) of the selected hierarchy folder
(the path of hierarchy folder from the highest level to the selected hierarchy folder).
The HID contains only the name components of the hierarchy folder of the levels
whose option "Include in designation" was selected in the "Customize Plant
Hierarchy" dialog box.

With the option"Name of hierarchy folder is part of the plant designation", you
can specify whether or not the name of this hierarchy folder is included in the HID.
You can select the default that the hierarchy folders of the entire level are included
in the designation in the "Customize Plant Hierarchy" dialog box (menu command
Options > Plant Hierarchy > Customize...).

If there is an OS assignment and the OS picture name is based on the plant
hierarchy, the box "Picture name for OS" and the "Order" button are active. The
default for the name of the picture is the name of the hierarchy folder. This is the
name seen by the operator in the picture hierarchy of WinCC.

If you rename the hierarchy folder, this name is also changed. This takes place
until you change the picture name explicitly in this Properties dialog. The
modification is registered by the system and interpreted so that this name is no
longer changed automatically if the hierarchy folder is renamed.

The order of all pictures of one hierarchy level can be changed (important for the
order of selection using the key set of the OS). With the "Order" button, you open a
further dialog in which all the folders of the hierarchy level assigned to the same
OS are listed in which the currently selected hierarchy folder is located. Using the
arrow buttons beside the list, you can move a selected entry up or down.

"PLC and OS Assignment" tab

In the "PLC and OS assignment", you can assign a PLC (chart folder) and an OS
to the hierarchy folder. This decides in which chart folder the CFC/SFC charts and
in which OS (WinCC station) the pictures and reports are stored that you insert in
the hierarchy folder.

The names of the chart folder or OS for this assignment are available for selection
in the drop-down list box. The drop-down list box lists all PLCs or operator stations
that exist in this project.

For the PLC or OS assignment, you obtain information about the underlying objects
such as: "All lower-level objects have the selected assignment", "There are lower-
level objects with different or missing assignments", "There are no lower-level
objects".
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"Model" Tab

The "Model" tab exists only when the selected hierarchy folder is a model or the
replica of a model.

For more information on models and replicas, refer to Chapter 8 "What is a
Model?".

The tab displays the model and all the replicas of this model that exist in the project
(hierarchy path).

If you no longer want a model to be available for import / export, in other words,
you want to make a normal hierarchy folder from this model, you can select it and
change the property with the "Clear" button. The assignment to the Import/Export
file is deleted. This means that all existing replicas of the model are also converted
to normal hierarchy folders.

In the same way, you can also convert individual replicas of models into normal
hierarchy folders without affecting the originally assigned model.

"BATCH Attributes" Tab"

The "BATCH Attributes" tab exists only when the "Base BATCH flexible
configuration on the plant hierarchy" option is selected in the "Customize" dialog. If
this option is set, the BATCH flexible hierarchy is created automatically when the
plant hierarchy is created.

The hierarchy folders for the BATCH flexible hierarchy are displayed in the
SIMATIC Manager (with the default names) as shown below:

PCell Unit Phase

Note:
Note: The default name of the hierarchy folder corresponds to the object type. Exception:
With the "equipment module" object type, the name "Phase" is used as the default for the
hierarchy folder.

You can change the properties for the BATCH applications for the selected
hierarchy folder, such as the object type for the BATCH flexible hierarchy (process
cell, unit, equipment module ...) or deactivate this BATCH flexible hierarchy again
(object type:neutral). The lower-level BATCH flexible hierarchy folders retain their
object type but are no longer relevant for the BATCH flexible configuration.

For the "process cell" hierarchy level, you can click the "Extend" button to open a
further dialog in which you can define and modify the plant.

For the "Unit" hierarchy level, you can enter the "Unit Class (UC)" (for example
"Reactor") and then enter values for the corresponding attributes (for example for
"Reactor": "Jacket material = stainless steel", "Volume = 500 liters"). With the
"Extend" button, you open a dialog box in which you can modify the definition of
the selected unit. If <no> unit class is selected, a new UC is created.

The name of the UC is unique within the plant.
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6.4 Editing Charts of the Hierarchy Folders

Editing Charts

With the menu commands

• Options > Charts > Edit Parameters/Interconnections..., you can set
parameters for the block or chart I/Os of the CFC charts and/or interconnect
them and modify the block comments.

• Options > Charts > Edit Messages... you can modify message texts of the
blocks contained in the charts.

• Options > Charts > Edit Chart name... you can modify chart names and chart
comments of the CFC charts.

These functions are particularly useful when you want to edit larger amounts of
data. To edit I/Os, you do not need to open individual charts with the CFC editor,
since the I/Os of all charts of the hierarchy folder are read in automatically.

The charts located in the selected hierarchy folder and all those it contains are
edited. A hierarchy folder can contain several CFC charts (in the IEA a maximum of
1 CFC chart per folder). The selected folder can also be empty if the folders it
contains have charts.

If you double-click a table row in the dialog box or click the "Open Chart" button
with a row selected, the CFC chart is opened (after a prompt for confirmation) and
the relevant block is displayed as selected.

Printing Tables

You can print the currently displayed tables of all dialogs. The columns are printed
in the same width as shown on the screen. If columns are of no interest, you can
push them together before printing out.
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6.4.1 Enter the Parameter/Interconnection Description

With the menu command Options > Charts > Edit
Parameters/Interconnections..., you open a dialog in which you can modify the
I/O comment and the value of the parameters or names of interconnections of the
block I/Os read in.

Opening the Dialog

After activating this function, the "Parameters/Interconnections" tab is opened in
the dialog. If no I/Os are selected for editing, a message is displayed asking
whether you want to select I/Os. With "Yes", you change to the "Input/Output" tab.

Note:
You can prepare the block I/Os now so that they are automatically selected for editing
when you call the dialog. Here, there are two possible methods:

In the library (before starting the project) assign the parameter attribute "S7_edit" to the
block I/Os you want to assign parameters for (S7_edit = ’para’) or interconnect (S7_edit =
’signal’) without opening the CFC chart.

If you work with the Import/Export Assistant, open the "Edit Parameters/Interconnections"
dialog when working with the model chart and decide which block I/Os will later have
parameters assigned or be interconnected in the "Inputs/Outputs" tab. When you import
the charts, this selection is retained and passed on to all replicas.

Inputs/Outputs Tab

In this tab, you can select the parameters and interconnections of the block I/Os
and chart interface in the "Parameter" or "Interconnection" column with a mouse
click for the parameter or interconnection description you want to change. A "X" is
set in the list box, the text in the row is displayed in color (for parameters "blue", for
interconnections "green").

After making your selection, click "Apply" or change directly to the
"Parameters/Interconnections" tab. With "OK", you enter the selection and close
the dialog.
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Parameters/Interconnections Tab

In the "Parameters/Interconnections" tab, you can see only the chart/block I/Os
selected in the "Inputs/Outputs" tab.
You can edit the boxes shown on a white background:

• Value or Interconnection

• I/O (with chart I/Os)

• I/O comment

• ID

• Unit

• Text 0

• Text 1

Symbol table: By clicking the icon for the symbol table, you can also enter the
description of the interconnection in the symbol table, use the entry from the
symbol table or modify the entries in the symbol table.

Note:
If you delete an interconnection name (empty string), the interconnection to the shared
address is deleted.

If you insert a new name, a new interconnection to a shared address is created.

6.4.2 Entering Message Texts

Blocks with message capability have the typical message texts for this block as
default. You can extend or modify these message texts. You do not need to edit
each relevant block CFC individually, but can collect all the blocks with messages
of all charts in a hierarchy folder and in the folders it contains using the function
Options > Charts > Edit Messages...  and edit the texts.

Calling the Dialog and Editing Messages

After activating this function, the "Messages" tab is opened in the dialog. Here, you
can edit the texts of the messages of all selected blocks. If no messages are found
when the blocks are read in a message to this effect is displayed. In this case, you
can change to the "Blocks" tab and select the blocks there.
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6.4.3 Editing CFC Chart Names

With the function Options > Charts > Edit Chart Name... , you can assign names
unique in the plant for the CFC charts of a project or modify the chart names and
chart comments. The display of the chart names in a table provides you with a
clear overview and is convenient for editing names and comments.

The charts located in the selected hierarchy folder and all those it contains are
listed.

CFC Chart Names Unique Throughout the Plant
To give names to the CFC charts that are unique throughout the plant, you can
assign the names based on the hierarchy. Follow the steps below:

Create the plant hierarchy with the required names for the individual hierarchy
folders and decide which hierarchy levels are not included in the designation in the
"Customize" dialog (see Section 6.3.1).

Following this, select the menu command Options > Charts > Edit Chart Name...
in the SIMATIC Manager. All the CFC charts found are displayed in the dialog box
in a table and you can now edit their chart names and comments.

Further possibilities: You can assign the hierarchy path from the gray box in the
"Hierarchy" column to the relevant chart name.

Accept the names with the menu command Use hierarchy as chart name in the
context menu:
The path name from the selected hierarchy field overwrites the previous chart
name in this line.

Copy and paste with CTRL + C and CTRL + V:
The path name copied from the hierarchy field now precedes the chart name.

The "\" character is automatically converted to the "/" character even when the "\"
character was entered manually.
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6.5 Creating Block Icons for OS Pictures

General

To allow operator control and monitoring of units or blocks, symbolic representation
is used in the process pictures per measuring point on the OS. For example, in the
block icon for a controller, you see the process value (PV), the setpoint (SP) and
the manipulated value (OUT).

The technological relationships between the CFC charts and the process pictures
on the OS are known when you create the process pictures in the plant hierarchy.
This information can be used in the plant hierarchy to place and interconnect
ready-made block icons (from a template in the OS data) in selected OS pictures.
In the same way, the block icons can be updated following a change.

Procedure

1. In the plant hierarchy, select the pictures for which you want the block icons to
be created or updated automatically.

- In the properties dialog of the pictures set the option "Base Block Icons
on the Plant Hierarchy" (default: no) in the "Block Icons" tab.

- Select the hierarchy folder from which you want to collect the pictures
further down in the hierarchy.

2. Select the menu command Options > Plant Hierarchy > Create/Update
Block Icons.

This opens a dialog box with the list of pictures found (including the paths to
the pictures).

3. In the drop-down list box below the listed pictures, select the components to be
included in the name of the tag (default: chart).

4. With "OK", you start the function to create or update the block symbols.

Note:
You must have already run the Split Screen Wizard (see Chapter 11) before you can
create the picture objects automatically.
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Sequence

• All the CFC charts at the same hierarchical level as the picture and in the next
lower hierarchy level are found. The charts are searched for the blocks with the
attribute "S7_m_c:=true"; in other words, intended for operator control and
monitoring.

• A temporary file is created containing one line per block found. The line
contains all the information required for further processing in the OS.

• The file is transferred to the OS.
Further processing is then handled by the "Master Graphics" wizard (see
Chapter 11); in other words, all the functions for placing, deleting, and
interconnecting the block icons on the OS are executed.

Figure 6-5 Illustrates the block icon of a controller in the process picture as an
example.

Figure 6-5 Block Icon of a Controller

Caution
If the tag name is changed later on the OS, this change is lost if the "Create/Update Block
Icons" function is activated again unless the same tag name is entered in this dialog.
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6.6 Plant Hierarchy of the "COLOR_PH" Plant

"COLOR_PH" Project

Before you can carry out these steps illustrated in the next section to create the
raw material tank unit, you require the plant hierarchy shown below (see Figure
6-8).

Considerations

Before creating the plant hierarchy, you should consider carefully how the structure
of your plant will appear, even after it has been expanded at a later point in time.
Keep the following points in mind:

• The following special characters must not be used in the name of a hierarchy
folder [ . ] [ % ] [ / ] [ \ ] [ " ].

Note:
The characters [ ’ ] [ . ] [ % ] [ \ ] [ * ] [ ? ] [ : ] [ blank ] within a name are converted to the
substitute character $ when the PLC-OS connection data are transferred. The ES
separator [ \ ] is converted to the [ / ] character. If, for example, you assign the name
"TICA:1" for a CFC chart (this becomes "TICA$1" on the OS) and the name "TICA*1" for
another CFC chart, (also becomes "TICA$1"), you will receive an error message when you
transfer the second chart because the chart name already exists.

• The maximum length of a tag name  is 128 characters. Remember, however,
that many of the editing windows on the operator station cannot display 128
characters in their entirety. Whenever possible, you should therefore restrict
your selection to a maximum 48 character long HID.

In future versions, to maintain consistency, the maximum length of name-
relevant texts will be limited to 40 characters. Texts that are not name relevant
must then not exceed a maximum of 24 characters.

• Remember that the length of texts transferred depends on the maximum text
length of the destination field in the operator station.

Example:
The user text block "Origin" has a default length of
32 characters. The HID of a block is transferred to this field (hierarchy
folder...chart name...block name). If the HID is longer than 32 characters, it is
restricted to 32 characters when it is transferred (the first characters of the HID
are omitted).
Remedy:   
Increase the maximum character length of the user text field or select a shorter
HID.

• Structure the plant hierarchy so that for each SIMATIC station there is a
hierarchy folder as the highest hierarchy node below the project.

• The message texts of the transferred messages consist of the hierarchy path,
chart name and block name together.
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Create the Plant Hierarchy for the "COLOR_PH" Plant

This section outlines a possible structure for the plant hierarchy of the entire
"COLOR_PH" plant.

You require model charts for the Import/Export Assistant. After you have created
the model charts (CFC charts) you can copy them to a library and then import them
from the library (see also Chapter 8, the section "Importing Models from a Library").
The project then only contains objects that will actually downloaded to the CPU.

Based on the considerations listed above, the names of the hierarchy folders have
deliberately been kept short.

The following parts of the plant (for the piping and instrumentation flow diagram
refer to Chapter 2) correspond to the following hierarchy folders:

Table 6-1 Assignment of Plant Areas

 Hierarchy folder  Technological assignment

FILL Filling

HOLD Holding tank

CONN Connections to other CPUs

MODELS Model charts

REAC1 Reactor 1

REAC2 Reactor 2

RMT1 Raw material Tank 1

RMT2 Raw material Tank 2

WEIGHT Weighing hopper

Each technological area has its own hierarchy folder that can then be further
subdivided by nesting hierarchy folders within it (tree structure).

The sequences (SFC charts) are assigned to the technological areas.

1. Open the plant hierarchy in the SIMATIC Manager (menu command "View >
Plant View").

2. Select the project in the plant hierarchy and create the plant hierarchy as
explained in the example (see Figure 6-8) (menu command Insert >
Technological Objects > Hierarchy Folder).

3. Select the Plant1 hierarchy folder and select the menu command "Options >
Plant Hierarchy > Customize...". Make the following settings for the
"COLOR_PH" project.
(see also Section 6.3).
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Figure 6-6 Settings for the Plant Hierarchy

The number of hierarchy levels (here: 3) depend on the requirements of the
project. If you have several SIMATIC stations in a project units are processed
in the individual stations. This means that it is advisable to create a hierarchy
folder at the top level (here: plant 1) per station. The further technological
division within a SIMATIC station is then implemented with the second level
etc.

With "Include in Identifier", you decide which level names are included in the
higher level designation (naming scheme). The naming scheme means that the
names included in the designation are entered in the origin of the message
(OS) and in the variable names on the OS (measuring point) (here: level 1 and
2 (plant/process cell and unit)).

If you set the option "Base picture hierarchy on the plant hierarchy", the
OS picture hierarchy is derived completely from the configured data of the PH.
When you later transfer to the OS, any picture hierarchy configured on the
operator station using the Picture Tree Manager will be deleted and overwritten
by the data created in the SIMATIC Manager. Select the second level as the
relevant level (OS area) on which the OS picture hierarchy will be based.
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Complete the settings for the plant hierarchy by clicking the "OK" button.

4. In the next dialog box, specify that the settings should also apply to hierarchy
folders you have already created.

5. Select hierarchy folder plant 1, open the object properties (menu command:
Edit > Object Properties...) and select the PLC-OS assignment tab.

6. Assign your S7 program to the plant hierarchy (see also Section 6.3.3).

Figure 6-7 Assignment of the PLC to the Plant Hierarchy

7. Click the check box "Pass on selected assignment to the lower level
objects".  This means that all the lower-level hierarchy folders have the
assignment to the S7 program you selected.

8. In assigned OS, enter the OS you have created in the SIMATIC PC station
(selection in the combo box). Once again, select the option "Pass on selected
assignment to the lower level objects".

9. Complete your input with "OK".
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Example of the Structure

Project

Level 1

Level 2

Level 3

Figure 6-8 Plant Hierarchy of the "COLOR_PH" Project
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7 Creating CFC Charts

Introduction

This chapter explains the basics of the CFC editor.

You will learn the significance of CFC model charts and will create the model
charts for the "COLOR_PH" project. You will find model charts prepared for you in
PCS 7 in the "CFC_Templates" library. You will copy these to the "COLOR_PH"
project and adapt them to suit the requirements there.

Note
For detailed information about the CFC editor and the programming languages, refer to the
online help or the appropriate manuals (refer to the references section at the end of this
manual).

7.1 The CFC Editor

Overview

CFC (Continuous Function Chart) is a graphical editor that runs in conjunction with
the STEP 7 software package. It is used to create the entire software structure of
the CPU from ready-made blocks. When working with the editor, you place blocks
on function charts, assign parameters to them and interconnect them.

Interconnecting

Interconnecting means that connections are created between blocks or shared
addresses, so that values can be transferred from an output to one or more inputs.

How the Editor Works

In the CFC Editor, you work with graphic tools: You select "off-the-peg" blocks from
the block libraries and drag them to your chart, a sort of drawing board where you
can then interconnect the blocks. You do not need to be aware of details such as
algorithms or the assignment of machine resources but can concentrate solely on
the technological aspects of your configuration.
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Run-Time Properties

The run-time properties (see also Section 7.1.1) of the blocks have default settings
that can, however, be adapted for each block. Since individual blocks or whole
groups of blocks can be copied or moved from chart to chart, you can save a
considerable amount of time. Interconnections between the blocks are retained.

Executable Machine Code

Once you have created all the functions you require, you can create executable
machine code with a simple mouse click, download the code to the PLC (SIMATIC
station) and test it with the CFC test functions.

Block Pool

You can take the blocks you require in CFC from block libraries or other projects or
you can write them yourself using STL, LAD, FBD or using the higher-level
programming language SCL. PCS 7 provides you with special PCS 7 libraries and
standard S7 libraries.

In the "ELEM_300" folder in the "CFCLIBS" library, there are blocks for the CPU
3xx. These blocks must not be used for the CPU 4xx. Instead of these, take blocks
from the "ELEM_400" folder.

Note
Forwards configuration: None of the blocks generated by CFC during compilation
(recognizable by the name ES_MAP in the "Author" column in the detailed view of the
block folder) may be modified. An exception to this is the "Compile Chart as Block"
function (see Section 7.3).

Overview of the Steps

This section explains the steps required when configuring for your PLC:

• Insert blocks

• Assign parameters to blocks and interconnect them

• Adapt the run-time properties

• Compile the CFC charts

• Download the CFC program

• Test the CFC program
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7.1.1 Run-Time Properties of the Blocks

Overview

The run-time properties of a  block determine how the block is executed in the run
sequence of the entire structure of the PLC. These properties are vital to the
performance of the PLC in terms of reaction times, dead times, or the stability of
time-dependent structures, for example control loops.

When it is inserted, each block is assigned default run-time properties. To achieve
this, it is arranged within the run sequence of a task (for example OB100, OB35
etc.). Each task has a "Task FC" in which the task assignment made by the user is
installed.

If necessary, blocks in a task can also be installed in run-time groups. The blocks
assigned to a run-time group by the user are located in their own "Run-time group
FCs" that are in turn called by the corresponding "Task FC".

Run-time Groups

Run-time groups (refer to the online help under "Tasks and Run-Time Groups") are
optional. They are used to structure tasks (OBs). The blocks are installed
sequentially in the run-time groups.

Using run-time groups, you can do the following:

• Deactivate or reactivate selected blocks within an OB. (Run-time groups can
be activated and deactivated via a block output of the "BOOL" data type).

• Execute selected blocks with a specific scan rate (every nth number of cycles)
and/or with a phase offset to achieve better load balance on the CPU.

• If OBs have a large number of blocks installed, these can be put together in
smaller groups.

Advantage:  Instead of creating one "large" FC for an OB when you compile,
"smaller" FCs are created according to the number of run-time groups.

If you subsequently make changes to the program, the run-time groups/FCs
are given a "modification ID" only if they actually contain modified blocks. This
saves considerable time if you later compile the changes and download
them online.

Note
For the reasons listed above, make sure that you do not install too many blocks in one OB
or in one run-time group. You will then considerably improve performance by compiling the
changes only and downloading the changes compared with compiling and downloading
the entire program. In this context, do not forget the startup OB (OB100), the error OBs
(OB8x) and any special OBs you may use.
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Run-Time Properties of Single Blocks

The run-time properties of each block are shown in the part of the block header
displayed on a colored background.

• Top line: Name of the task in which the block is installed.

• Bottom line (to the left of the slash): Position of the block or the run-time group
in the task.

• Bottom line (to the right of the slash): If the block is installed in a run-time
group, position of the block in the run-time group; otherwise "-"

If a block is installed more than once, information is displayed for only one location
of this block; this is the block in the task located first alphabetically.

Double-clicking the field shown above displays the sequence in which the blocks
are executed on the monitor. The block that you double-clicked is selected. In the
execution sequence, you can influence the run-time properties of the blocks
directly.

Run-time Properties of all Blocks on a CPU

You can obtain a complete overview of the run sequence with Edit > Run
Sequence... (in this window you can also edit the run sequence) or with Options >
Reference Data... in the "Run Sequence" window.



Creating CFC Charts

Process Control System PCS 7, Configuration Manual
A5E00122418-01 7-5

7.2 Creating a Chart with Chart I/Os

Overview

You can provide a chart with I/Os to extend your options such as

• inserting the chart in a different chart (nested chart) and interconnecting it with
other charts or blocks

• or to compile it as a block type.

Procedure

There are two ways of giving I/Os to a chart:

• Creating chart I/Os without an assignment

• Creating the chart I/Os along with the interconnection

7.2.1 Creating Chart I/Os without an Assignment

In the first step, you create the I/Os for a chart without reference to any
parameters (for example because the chart does not yet contain blocks and/or
further nested charts, see below). You assign the names, attributes, and defaults to
the chart I/Os.

In the second step, you place the blocks/charts in the chart, interconnect them
and then assign the I/Os of the objects in the chart to the chart I/Os.

Creating Chart I/Os (1st step)

• Click the  button in the toolbar or select View > Chart Inputs/Outputs.

The dialog for editing chart I/Os is opened and "docked" to the upper part of
the chart window.

• In the hierarchy window on the left, select the required I/O type (IN, OUT or
IN_OUT).

• In the detailed window on the right, edit the empty declaration line for the
particular I/O type (name, data type, initial value, comment). You can select the
data type from a combo box.

Assign the I/Os (2nd step) by Dragging with the Mouse

• Drag an I/O of the block/chart contained in the chart to one of the chart I/Os
with a compatible data type.
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7.2.2 Creating Chart I/Os with the Interconnection

The first step is to create the chart itself; in other words you insert blocks/charts
and interconnect them.

In the second step, you open the window of the chart inputs/outputs and define the
chart I/Os by connecting them to block/chart I/Os. A new line is always created and
all the properties of the connected I/O are adopted, such as name, attribute, and
initial value. (There are certain restrictions with the attributes S7_param and
S7_link: if the values cannot be adopted, only the interconnection is created; you
can see the meaning of the attributes in the online help under "System Attributes:
Reference Help")

If naming conflicts occur, for example because the same names are used in
different blocks, the name is made unique in the chart I/O by exponents.

Creating Chart I/Os by Connecting with Ctrl + Drag and Drop

• Click the  button in the toolbar or select View > Chart Inputs/Outputs.

The dialog for editing chart I/Os is opened and "docked" to the upper part of
the chart window.

• In the hierarchy window on the left, click the I/O type you require (IN, OUT or
INOUT). The lines with I/Os are displayed in the detailed window on the right
(this still empty if you are creating new chart I/Os).

• In the working field of the chart, select the required I/O on the block, press and
hold down the CTRL key and drag the I/O to the right-hand window of the chart
I/Os to the "Name" box. The I/O is then adopted with all its properties.
Exception: No new assignment is made for interconnected I/Os.

• Follow the same procedure for all the other I/Os of the internal blocks/charts
you want to interconnect with the chart inputs/outputs.

Drag an already assigned I/O while holding down CTRL to another empty line in
the Chart I/Os window; the name automatically has a number added to it so that
the I/O name is unique.

Drag an internally interconnected I/O while holding down CTRL to a new line. A
copy is made and no interconnection to the internal I/O is made.
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7.2.3 System Attributes for Chart I/Os

Just like the block I/Os, you can also assign system attributes to the individual
chart I/Os. The following rules apply:

If an I/O of a block/chart contained in the chart is connected to a chart I/O,

• the attribute of the block/chart is adopted by the chart I/O if no attribute has
been configured for this up to now

• the chart I/O retains an attribute that has already been entered (within certain
restrictions, for example if text attributes are retained then an attempt is made
to adopt these values for S7_link and S7_param). Exception: The value of
S7_visible is always adopted.

A chart with chart I/Os itself does not have system attributes (apart from those of
the I/Os). The attributes can be assigned when the chart is compiled as a block
type (see Section 7.3).

Note
The inputs of blocks that are connected to a chart I/O cannot be inverted. You cannot set
parameters for the chart outputs.

Remedy: You can assign parameters to the output of the block and this value is then
entered for the corresponding chart output.
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7.3 Compiling CFC Charts as a Block Type

Overview

You can create block types from existing CFC charts that will be used more than
once and that have the required chart I/Os. You can assign system attributes to
these block types.

In this case, you start the compiler with the Chart > Compile > Chart as Block...
menu command ; A dialog box with the tabs "General" and "Attributes" is then
displayed.

Block Properties

In the "General" tab, you can specify the properties of the block type before you
compile (FB number, name, family, author, and version) and specify the PLC on
which the block will be used. This information (S7-300/S7-400) is relevant for
blocks that involve a startup, since the SCL compiler must create a different code
for individual PLCs.

Certain code sequences ensure that all the blocks contained in the chart to be
compiled are called according to their entry in the S7_tasklist attribute (this attribute
specifies the OBs in which the block will be installed as default).

Caution! Only OB100 is possible on an S7-300; all other OBs from the task list are
illegal and an error message is displayed.

Optional Settings

You can start a code optimization that affects the local data requirements (refer to
the online help "Local Data Stack") or online delta downloads.

• Local requirements:
With this type of optimization, a change in the chart does not increase the local
data requirements, since all temporary variables are stored in the instance DB
(VAR area). This does, however, lead to a change in the structure of the
instance DB and to a change in its interface time stamp. In this case, no online
download of changes is possible.

• Downloading changes in RUN:
With this type of optimization, if there is a change in the chart, the temporary
variables are stored (as far as possible) in the VAR_TEMP area. As far as
possible means that all interim results in the data flow are stored here. Only the
interim results that are not in the data flow (for example in feedback loops)
continue to be stored in the VAR area (instance DB). The advantage of this
optimization is that not all changes lead to a change in the interface time stamp
of the instance DB, so that in most cases the changes can be downloaded
online. One disadvantage is that the local data requirements are increased.

As an option, you can also activate the know-how protection. As a result of this, the
algorithm of the block can be seen but only modified when the suitable SCL source
files exist.

In the "Attributes" tab, you can enter the system attributes for this block type.
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Caution
If you change the interface of a block by adding or deleting an input/output or you change
the name, the interface time stamp of the corresponding instance DB is also changed. No
online download of changes is then possible. This applies both to the function "Compile
CFC charts as block" as well as to blocks written in the SCL language. In such cases,
delete all the blocks on the CPU and download the entire program.
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7.4 Nested Charts

A CFC chart can be nested in another CFC chart (chart-in-chart technique). This
allows hierarchical structures to be created. Each nested chart can be opened just
like any other chart, edited and individually modified. The objects are placed on the
working areas of the sheets.

A chart can be encapsulated for further use; in other words it is given chart I/Os.
For each chart, you can decide which block I/Os are available at the chart I/Os.

Nested charts are displayed in the chart as graphic objects that resemble the
blocks. The chart symbol is displayed in the header of the chart.

The chart name and any comment are also shown.

Nested charts can also be created without chart I/Os. In this case, only the header
and an empty body are displayed.

Creating Nested Charts

You can insert a CFC chart in another CFC chart. This allows you to create a
program structured according to your technological requirements using
standardized sections that can be used again and again.

The charts nested in the top chart can be opened and modified in the Edit mode
and can be operated and monitored in the Test mode.

The chart containing further charts is the top chart. In the SIMATIC Manager, you
can only see the top chart in the chart folder. The maximum nesting depth for
nested charts is 8 (top chart + 7 levels of nested charts).

Inserting a Chart in a Chart

To allow charts to be used like blocks in CFC, they are displayed in the chart
catalog in a tree structure. From here, you can drag a chart to the currently open
chart. When you insert the chart, it is copied to the chart folder along with its own
nested charts (if it is a parent chart).

You can also move parent charts to the chart by dragging them with the mouse
while holding down the Shift key. In this case, they are not copied but moved. In
the catalog, the chart is now no longer at its previous location but is shown in the
hierarchy of the active chart.



Creating CFC Charts

Process Control System PCS 7, Configuration Manual
A5E00122418-01 7-11

Interconnecting

You can interconnect nested charts with other nested charts in the chart (If they
have chart I/Os), with blocks or with shared addresses.

Navigating in a Chart

To open a nested chart, select the chart within its parent chart and select the Open
Chart menu command with the right mouse button or in the "Edit" menu. By
repeating this, you can work down to the lowest chart nested in the hierarchy.

To move up through the hierarchy (as far as the model chart), select the nested
chart and then select the Open Parent Chart menu command with the right mouse
button or in the "Chart" menu.

You can also open a chart in the chart catalog. Select a chart and then select the
Open Chart menu command with the right mouse button.
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7.5 Creating the CFC Model Charts for the "COLOR_PH"
Project

CFC Model Chart

A process control project involves large amounts of data. The large amount of data
is, however, often the result of structures that are repeated many times. You might,
for example design the CFC model chart for a motor control with interlock. This
type of motor control is used many times within the plant with different parameters.
A further example might be reading in a measured value from the plant with
additional limit value monitoring and a message to the operator. This model chart
will occur often although the message text, the monitored limits and the location at
which the value is acquired will always be different.

CFC Templates for Tags

PCS 7 provides you with a library (PCS 7 Library / Templates) containing CFC
templates. You can add to and extend these templates (model charts) to meet your
requirements. In the "COLOR_PH" project, you use both model charts from the
"PCS 7 Library / Templates" library as well as model charts you create yourself.

Using CFC Templates in the Project

1. You have already created the "COLOR_PH" project and the plant hierarchy.

2. Open the library PCS 7 Library/Templates in the SIMATIC Manager (File >
Open > Library ...) and select the plant view (View > Plant View).

3. Navigate to the required CFC chart.

4. Select the CFC chart you require and drag this to the required location in the
plant hierarchy of the COLOR_PH project.

Editing Copies of the CFC Templates in the Project

• Select the copied template or the hierarchy folder in which it is located.

• Select the menu command "Options > Charts > Edit
Parameters/Interconnections...".

Here, you can see the most important I/Os and can edit parameter values and
signal interconnections without opening the CFC chart. You can also make
further copies of copied templates in the project. The I/Os selected for editing
remain selected in the copies.
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Creating your Own CFC Templates in the "PCS 7 Library/Templates" Library

• Create a CFC chart in the project and then configure, compile, and test it.

• Create a new hierarchy folder in the library and give it a name.

• Drag the CFC chart you have created from the project to the library.

• Select the hierarchy folder and then the menu command "Options > Charts >
Edit Parameters/Interconnections...".

• In the "Inputs/Outputs" tab, select the block I/Os you want to edit in the table.

• Change to the "Parameters/Interconnections" tab and then set make the
settings you require for the parameter/interconnection.

Duplicating CFC Model Charts

You can create the CFC model charts "typical" for your plant (or copy them from
the CFC templates library) and record the differing parameters such as limit values,
control parameters, messages etc. in a tag list (CSV file). You can create the tag
list, for example using the integrated IEA editor or with Excel. Using the
Import/Export Assistant, you can duplicate your CFC model charts and
automatically supply the parameters from the tag list.

Creating CFC Model Charts for the "COLOR_PH" Project

In this section, you will create your own CFC model charts and copy CFC model
charts from PCS 7 Library/Templates for the raw material tank of the "COLOR_PH"
plant. To learn the procedure, insert the blocks (2 x OP_A_LIM and OP_D)
required for entering the dose parameters in a new CFC chart. Follow the steps
outlined below:

1. Go to "Plant1" in the plant hierarchy and create a CFC chart called
"DOSE_PARA" (right mouse button > Insert New Object> CFC).

2. Open the CFC chart by double-clicking it, change to the block libraries and
insert an analog input block with limit value monitoring (OP_A_LIM) by
dragging it from the PCS 7 Library/Technological Blocks library to the chart.
You can locate the block quickly by entering the name OP_A_LIM in the
search box and then clicking the button with the "binoculars" with the block tab
selected (see Figure 7-1).
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Note
You can display information about the functionality of a block already installed in the CFC
chart by selecting the header of the block and pressing the F1 key. In a library, you simply
select the block and press the F1 key.

Figure 7-1 View of the Block Libraries in CFC

Figure 7-2 OP_A_LIM Block Inserted in the CFC Chart
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Note
When you select blocks, remember the run sequence of the blocks. As default, blocks are
installed in OB35 (processing every 100 ms). You can see the calling OB to the right in the
block header of a block within the green field.

You can also insert overlapping blocks in the CFC chart. You can then move them to a
free location in the chart later. This possibility is extremely helpful especially when
inserting blocks from a library. Blocks that overlap in the CFC chart cannot be
interconnected or have parameters assigned to them until they have been moved to a free
location. If blocks become overlapping blocks later after they have been interconnected or
had parameters assigned to them, their settings are retained but they cannot be modified
while the block is overlapping.

Creating Run-Time Groups

Per CFC chart, you should create a separate run-time group  and install all the
blocks of a chart in the run-time group. This procedure speeds up the compilation
of changes to the CFC charts. Follow the steps below for the COLOR_PH project:

1. With the chart open, select Edit > Run Sequence.

2. Select the required execution cycle (for example OB32).

3. Click on the OB with the right mouse button and select Insert Run-Time Group

4. In the Insert Run-Time Group dialog, enter the name you require (for example
the name of the CFC chart whose blocks are located in the run-time group; here
DOSE_PARA).

5. Leave all the other parameters unchanged and complete editing of the run-time
group with OK.

6. Double-click on OB32 to display the new run-time group.

7. Click on OB35 (the OP_A_LIM block is installed here as default) and in the
right-hand window (content of ...) select all blocks to be inserted in this OB (in
this case only OP_A_LIM).

8. Now drag these blocks to the run-time group in OB32 (OB32 must be open in
the left-hand window) and click Yes when you are asked whether you want to
install within the group.

If you want to insert further blocks in this run-time group, right click on OP_A_LIM
within the run-time group and select "Predecessor for Installation" in the context
menu. All the blocks that you then insert in the chart will be positioned after this
block in the run-time group.

Close the run sequence Edit > Run Sequence.
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Basic Parameters Specified by the Operator

As already explained in Section 2.3, the liquid components from raw material tank
1 are dosed into reactor 1 or 2. The amount to be dosed, the dosing rate (FC111)
and the destination reactor are decided by the operator in the plant picture RMT1.

In this example, assume that the quantity specified by the operator will be stored in
the OP_A_LIM block with the name PARA_DOS_RM1_QTY, the dosing rate will
be stored in the OP_A_LIM block with the name PARA_DOS_ RM1_VOL and the
destination reactor will be stored in the OP_D block with the name
PARA_DOS_RM 1_SEL.

Adapt the name of the OP_A_LIM block that is already installed
(PARA_DOS_RM1_QTY) and insert DOSE_PARA, the second OP_A_LIM block
and the OP_D block in the chart.

In the object properties of the OP_A_LIM blocks, set the parameter "U" to visible
and in the object properties of the OP_D block the parameter "IO" visible (see
below: visible/invisible parameters).

Set the following values in the blocks:

Table 7-1 Values for Simulation

 Block name  Parameter  Value  Technological significance

PARA_DOS_RM1_QTY U 50 Setpoint for flow control 50 liters/Min

PARA_DOS_RM1_VOL U 5000 Setpoint for dosing 5000 liters

PARA_DOS_RM1_VOL U_HL 10000 Limit value of the entry for the U
parameter

PARA_DOS_RM1_SEL IO ON The target reactor is reactor 1

Figure 7-3 CFC Chart "DOSE_PARA" for Specifying the Dosing Parameters
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Visible/Invisible Parameters

Remember that not all the parameters of a block are visible immediately. Some
parameters are set only once or not at all during creation of the project. These
parameters are generally not visible making your charts easier to read. The
function of the parameter is in no way influenced.

If you want to make parameters of a selected block visible, follow the steps outlined
below:

- Select the menu command "Edit > Object Properties and change to the
"Inputs/Outputs" tab.

- Remove the "X" from the "Not displayed" option box.

Figure 7-4 Inputs/Outputs Tab in the Block Properties of a MEAS_MON

Inserting Model Charts from "PCS 7 Library/Templates"

Now insert the model charts listed below that you will require for your project in the
appropriate path of the plant hierarchy:

- Motor control

- Valve

- Dose

- Measuring
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Note
In the PH, you can edit CFC charts without opening them. These functions are particularly
useful when you want to edit larger amounts of data (I/Os, message texts, chart names).
See also Section 6.4, "Editing Charts of the Hierarchy Folder".

"Motor" Model Chart"

You take the "MOTOR" CFC chart of the "Motor Control" technological function
from the "PCS 7 Library / Templates" library  (Templates/MOTORS/MOTOR) as
described in Section 7.5 "Using CFC Templates in the Project" and drag it to the
"Plant1/MODELS/Motor" hierarchy folder.

The "Motor" model chart will be used for motors, pumps and feed screws.

Technological significance

The CH_DI block supplies the current state of the pump (on or off) at output "Q".
This value is connected to the "FB_ON" input (feedback ON) of the MOTOR block
where it is evaluated. The operator or a higher level controller controls the MOTOR
block. The CH_DO block takes the control command from the "QSTART" output of
the MOTOR block and outputs this to the pump in the process.

Figure 7-5 "Motor" Model Chart
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"Valve" Model Chart"

You take the "VALVE" CFC chart of the "Valve Control" technological function from
the "PCS 7 Library / Templates" library (Templates/VALVES/ VALVE) as described
in Section 7.5 "Using CFC Templates in the Project" and drag it to the
"Plant1/MODELS/Valve" hierarchy folder.

The "Valve" model chart will be used for valves preceded by an interlock.

Technological significance

The CH_DI blocks provide the return message (open and closed) of the valve to
the value control block "VALVE". The operator or a higher level controller switch
this valve using its block and the control command is sent from the output
"QCONTROL" via the output driver "CH_DO" to the valve in the process. Any fault
messages from the input or output modules are ORed (OR block) and passed on to
the operator station by the valve control block so that they can be displayed to the
operator.

Figure 7-6 "Valve" Model Chart
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"Dose Model Chart"

You will configure the CFC chart DOSE that you create in the technological
hierarchy "MODELS/DOSING. This chart contains two technological functions. In
the upper part is the controller with "flow control, measured value adaptation
(MUL_R) and interlock", and in the lower part the dosing with quantity summation.
The interconnection between the controller and the dosing function is implemented
by a sequential control system (SFC). Move the blocks of the chart to a new run-
time group (DOSE) of OB32. Follow the steps as explained in "Creating Run-Time
Groups" (in this chapter).

Technological significance

The CH_AI block provides the currently dosed volume at the "V" output and
transfers this measured value to the "PV_IN" (process value) input of the DOSE
block. The INT_P block is used in this case for simulation of the dosed volume. The
speed of the dosing is controlled by a flow control with the CTRL_PID block. The
block receives the setpoints via the step control in conjunction with the OP_A_LIM
block PARA_DOS_RM1_VOL. The manipulated variable for the valve is output at
the "LMN" output and is fed directly to the CTRL_PID block at input "LMNR_IN" in
the absence of feedback from the process. The CH_AO block outputs the
manipulated variable to the valve.

Model Chart (see also Table 7-2):

Table 7-2 "Dose" Block Names

 Block type  Name  Block type  Name

DOSE DOSE INT_P INT_P

CTRL_PID CTRL_PID CH_AI INPUT_U

CH_AO OUTPUT_LMN MUL_R MUL_R

Set the parameters for the blocks as shown in Table 7-3.

Table 7-3 Parameter Settings in the DOSE Chart

 Parameter flagged I/Os:
MUL_R IN2 1 Adaptation of the input value
INT_P V_HL 10000 Upper limit quantity summation 10000 Liters

SP_HLM* 10000 Upper limit of the setpoint for the dosing volume
MO_PVHR* 10000 Upper limit of the process value for the dosing

volume

DOSE

SPEXON_L 1 Interconnection for internal/external switchover
active

SIM_ON* 1 Switch simulation activeINPUT_U
VHRANGE 100 Set upper measuring range
LIOP_MAN_SE
L

1 Interconnection automatic/manual active

LIOP_INT_SEL 1 Interconnection for internal/external switchover
active

SPEXON_L 1 Switch controller to external setpoint

CTRL_PID

Gain 0.5 Set the gain of the controller to 0.5
* As default, the parameter is invisible
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Figure 7-7 "Dosing" Model Chart
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"Measurement" Model Chart

You take the "MESS" CFC chart of the "Measurement" technological function from
the "PCS 7 Library / Templates" library
(Templates/Monitoring/ANAMON/ANAMON) as described in Section 7.5 "Using
CFC Templates in the Project" and drag it to the "Plant1/Models/MEASURE"
hierarchy folder.

You extend the inserted chart by adding a INT_P block with the name INT_P (see
Figure 7-7).

Technological significance

The CH_AI block reads in the process value (fill level of the raw material tank) and
outputs the current value at output "V". As default, this output is connected to the
input "U" of the MEAS_MON block and then passed on by the MEAS_MON block
for display on the OS. The INT_P block included here is used to simulate the fill
level.

Figure 7-8 "Measurement" Model Chart
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7.6 Placing the Model Charts of the "COLOR_PH" Project in
a Library

General

You have the option of placing the model charts from the project in a library. In this
case, you would then only need to manage the objects in your project that will later
actually be downloaded to the CPU. You would then import (duplicate) the charts
from the library using the Import/Export Assistant.

Creating a New Library

To create a new library, follow the steps outlined below:

1. Select the menu command "File > New" in the SIMATIC Manager

2. In the dialog box that is opened, select the  "Libraries" tab and enter the
name "COLOR_LIP".

The new library is displayed in the "Component View".

Placing Model Charts in the Library

The next step is to copy the model charts to the library. Since you have only
created model charts up to now in the "COLOR_PH" project (except for the
DOSE_PARA chart),  you can move the entire S7 program to the library. Follow the
steps outlined below:

1. Select the component view of the COLOR_PH project.

2. Select the S7 program(1) in your SIMATIC 400(1)/CPU4xx and copy it (right
mouse button > Copy).

3. Now select the library "COLOR_LIP" (component view) and the folder
"COLOR_LIP" in the library. Insert the S7 program in the folder (right mouse
button > Paste).

The S7 program is created without any reference to hardware (without a CPU)
in the library. All the blocks and charts of the original program are included.

You can, of course, also copy individual charts or hierarchy folders from a
project to a library if you do not want to copy an entire S7 program. In this
case, you should first create a plant hierarchy in the library and copy the
required sections of the original program to this hierarchy.
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4. Now select the plant view of the library "COLOR_LIP" (View > Plant View")
and check whether the plant hierarchy was created correctly with the model
charts. Only the parts of the plant hierarchy are created that already contain
CFC charts.

Figure 7-9 Library with Model Charts

5. In the "COLOR_PH" project, you must delete the hierarchy folder MODELS
(right click on the folder and then delete in the context-sensitive menu)
otherwise you will not be able to import the model charts from the library. You
import the models (model charts with an assigned import file) in Chapter 8
(Using the Import/Export Assistant).

Figure 7-10 "COLOR_PH" Project without Model Charts

Note
In the "COLOR_PH" example, the model charts were deliberately created in the project to
illustrate how charts can be transferred from a project to a library. It is of course perfectly
possible to create the plant hierarchy along with the model charts directly in a library.
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7.6.1 Compiling Charts

CFC charts must be compiled into a code that the CPU of the PLC can understand.
In Chapter 8, you will create the replicas (CFC charts) from the models and in
Chapter 9, you will create the chart (SFC) for the sequential control system. Since
compiling always involves all charts of an S7 program, you should only start
compilation at the end of Chapter 9 where you will find the necessary information.

7.6.2 Downloading Charts

After compiling the charts, you download them to the CPU and you can then follow
the current process state in the test mode. For the same reasons as explained in
Section 7.6.1, the charts will only be downloaded at the end of Chapter 9.
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8 Using the Import/Export Assistant

Introduction

This chapter describes the functions of the Import/Export Assistant (IEA) and how
to work with it. It explains how to create, modify, and import/export a model from a
model chart.

To make the situation clearer, the basic scenarios "top down" and "bottom up" that
must be considered in conjunction with the IEA will be explained.

Top down
You first configure the technological functions without bothering about the structure
of the hardware and the distribution of the charts on the individual PLCs.

• You import the models (refer to the section below) in a project in which there is
only one S7 program (even this S7 program is not absolutely necessary).

Result: All the imported replicas of the model are stored in the plant hierarchy
created by the import. This entire hierarchy is assigned to the chart folder of an S7
folder.

• You now create the PLCs of the project and insert an S7 program with a chart
folder for each PLC.

• You then select the hierarchy folder in the plant hierarchy that will run
completely with all nested hierarchy folders on a PLC and change the PLC
assignment to the required PLC. Make sure that you select the "Pass on
selected assignment to the lower-level objects" option.

Result: All the replicas of the model are in the required PLC.

Bottom up
You already know the hardware structure of the project and have already decided
which units will be configured in which PLCs. You create the hardware in HW
Config accordingly and set up the plant hierarchy so that one hierarchy folder is
assigned to one PLC.

• You import into the project with the prepared hierarchy and assigned PLCs.

Result: All the replicas of the models are created in the required PLC since the
hierarchy with the assignment to the PLCs already existed before you started
the import.

In this Configuration manual, you have already created the hardware and the plant
hierarchy; in other words, you have been working according to the "bottom up"
scenario.
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8.1 General Information about the Import/Export Assistant
(IEA)

When Do I Work with the IEA?

During the planning of a plant, a wide variety  of data are created, often at a point
in time at which no concrete decision has been made about the details of the
control system. By using the import function, this data can be made available to the
control system engineering.

Figure 8-1 Data Exchange Between a Planning and Engineering System

You use the Import/Export Assistant when you require one or more models often in
a project (processing mass data) and want to modify the parameter descriptions of
the blocks.
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Functional Units of a Plant

Generally a plant is structured by dividing it into smaller functional units that can be
classified, for example fixed setpoint controls, motor controllers etc.

Instead of implementing new functional units each time they are required, you can
create a pool of ready-made functional units that you then only need to copy and
modify for the new situation. In the ES, models are configured to match the
functional units.

8.1.1 What is a Model?

Each functional unit used in a plant requires a suitable model in the ES, for
example a hierarchy folder with a CFC chart containing the fixed setpoint control
with the corresponding interlock blocks.

A model is a hierarchy folder that can contain a maximum of one CFC chart (or
none) and/or other hierarchy folders with CFC charts and a connection to a CSV
file (IEA file). The blocks for import/export of parameter descriptions (value and
texts), interconnection descriptions (name, comment, texts), and messages are
prepared in the CFC charts. After linking such a prepared model with an import file,
the model can be imported and the replicas that are generated during import can
be assigned parameters, interconnections and messages.

The model and replicas of the model are represented by different icons in the
SIMATIC Manager:

Original model replica of the model

One import file (IEA file) is required for each model created (original). For
information about the structure of the import file, refer to Section 8.5.

Several CFC Charts in a Model

If you want a model to contain more than one CFC chart (once again only one
chart is permitted per hierarchy folder), the following procedure is recommended in
the IEA:

Starting with the hierarchy folder that represents the model  and that is used
to form the designation, you can include further hierarchy folders (in other words
insert them in the hierarchy folder of the model; tree structure) and each of these
inserted folders can contain a CFC chart.

If the names of the nested hierarchy folders  do not form part of the
designation, in other words do not appear in the hierarchy, you can disable the
designation function for these folders. To do this, select the relevant hierarchy
folder and then select the "Object Properties..." menu command. In the "Control
and Monitoring Attributes" tab, deactivate the "Name of hierarchy folder is part
of the plant designation" option.

Tip:It may not be necessary to use a model that consists of several CFC charts.
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In CFC, you can create charts that consist of up to 26 chart partitions. You can also
use the "chart-in-chart" technique in CFC to insert further nested charts in a top
chart (up to a nesting depth of 8 charts). Remember that the nested charts are not
displayed in the SIMATIC Manager but only the top chart.

What is a Parameter?

A parameter consists of the data

• entered for a block/chart I/O (such as value, unit, text for state, designation,
comment) and that can be imported with the IEA.

In the import file, the parameter is identified by "P".

What is an Interconnection?

An interconnection is

• the name of the shared address as it is entered in the symbol table. The
interconnection to a chart I/O.

• The textual interconnection to a block/chart I/O (also in different charts)

In the import file, the interconnection is indicated by the symbol ("S").

Using textual interconnections, you can make interconnections with the
Import/Export Assistant within a chart or between charts. You can, for example,
interconnect the external setpoint of a controller in the chart FC111 with the output
value (reference setpoint) of a block in chart FC112. Follow the steps outlined
below:

1. When you create the import file (see also Section 8.7), click the option "Textual
interconnection (TextRef)" when selecting the columns to be displayed in the
import file.

2. In the corresponding column in the import file, you then specify the block
parameter to be interconnected. Whether or not you specify the path of the
plant hierarchy is optional. The entry could appear as follows:
FC111\CTRL_PID.LMN (chart\block.parameter).

If the I/O parameter exists when you import, the interconnection is made or an
existing interconnection is modified. If the parameter does not exist or its data type
is not suitable, an error message is entered in the import log and the chart remains
unchanged.

A textual interconnection is possible both at inputs (to an output) and at outputs (to
an input). When you create the model, select only one interconnection parameter
as "Signal" (input or output) and not the source and destination at the same time.
The CFC chart allows multiple interconnections at an output but not at an input. If
you select an output, you can only make a simple interconnection to an input. You
can however select any number of inputs and interconnect them with one output.

To maintain consistency during export, only one interconnection can originate at an
output during import since export can only enter one interconnection in the export
file. For this reason, multiple output interconnections must be implemented by
textual interconnections originating at the inputs.
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Table 8-1 Rules for Interconnecting Outputs

Existing
interconnections to
shared addresses

Existing block
interconnectio

ns

SymbolName TextRef

0 0 permitted permitted

0 1 permitted permitted**

0 > 1 permitted error

1 0 permitted** permitted*

1 1 permitted** permitted****

1 > 1 permitted** error

> 1 0 error permitted*

> 1 1 error permitted****

> 1 > 1 error Error

Table 8-2 Rules for Interconnecting Inputs

Existing
interconnections to
shared addresses

Existing block
interconnectio

ns
SymbolName TextRef

0 0 permitted permitted

0 1 permitted*** permitted**

1 0 permitted** permitted***

* not recommended
** existing interconnection is deleted (replaced by the new interconnection), this

is reported in the log (which interconnection replaced which)
*** existing connection is deleted (replaced by the new one), the information in

the log is classed as a "Warning"
**** not recommended; otherwise as for **

The following recommendations can be made:

• Textual interconnections should only originate at inputs.

• Outputs should only be connected to shared addresses.

• Exception: Textual interconnections should only originate at outputs when they
lead to a CFC chart that is not part of a model.

Note:
With the "Create Template File" function, the interconnection partner is entered in the
"TextRef" column for "textual interconnection" according to the interconnection in the
model. During import, this would cause an interconnection in the model. To prevent an
accidental modification to the model, the interconnection partner in the "TextRef" column is
preceded by a question mark ("?"). The user can then search for "?" with the IEA editor
and modify these cells accordingly. An unmodified cell causes an error message during
import.
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What is a Message?

A message consists of a group of message texts that can be imported by the IEA.
The number of message texts of a group depends on the block. All the message
texts of a block are always shown in a group (for example, for the controller block:
Alarm high/low, warning high/low and control system errors). In the import file, the
message is identified by "M".

What is a Description?

When you create the models, the I/Os of blocks and charts contained in the model
are given specific descriptions. For the I/Os used as parameters these are the
parameter descriptions, such as values and texts.

Figure 8-2 Example of the Description of an Analog Parameter

Figure 8-3 Example of the Description of a Binary Parameter

With interconnections, an interconnection description specifies the name, the
comment, and the text.

Figure 8-4 Example of the Description of an Interconnection

For more detailed information about parameters and interconnections, refer to
Section 6.4.1.

What is an Import/Export File?

Import/export data  take the form of text files in the CSV format.
The CSV format is supported by many applications (Excel, Access, ...) and is
therefore suitable as a general data interface between any planning tool and the
ES. In the IEA, these files are expected with the extension ".IEA"; in other words,
you may need to modify this extension.
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CSV stands for "Comma Separated Value" and is an ASCII text format in which
tabular data are saved. The separator for the cells is the semicolon.

You can create and edit a CSV file with a text editor or with table programs (for
example Excel) or as an export file from a database (dBase, Access, ...). You can
edit the file (with the extension .IEA) conveniently using the IEA file editor (see
Section 8.6).

For a detailed description of the structure of the import/export file, refer to Section
8.5 and the online help of the IEA.

Note:
When creating a model, you can generate a template (IEA file). Using the IEA editor, you
then only need to insert one further line in the template per replica of the model (see
Section 8.2).

Functions of the IEA

The Import/Export Assistant (IEA) allows you to work with models and their replicas
(process control points). The IEA provides functions for reusing and adapting the
models.

Creating/Modifying Models

You specify the I/Os of the blocks or charts to which you want to assign parameters
or interconnect. If necessary, you can now create a template of the IEA file and edit
it. When you create the template, you decide which file information will be
contained in the columns of the IEA file. You then select the import file and assign
the import data structures to the selected I/Os (titles of the column groups).

Importing Data of the Plant Planning

Each functional unit in the plant generates a line in the import file. The IEA copies
the suitable model (and generates replicas) for each functional unit and then
modifies the interconnection descriptions, parameter descriptions, and message
texts according to the content of the line in the import file.

Exporting Data for the Control System Engineering

The replicas of the models are modified in the control system engineering, for
example during test and project startup. This also involves data that were
configured with other tools during plant planning and imported for the control
system engineering. The following applications are possible:

• If you want to match the plant documentation to the current configured status,
export the current data of the models created previously during import in the
same form as when you imported them.

• You can export the data of the plant configured with replicas and models, edit
the data again with other tools (for example Excel or Access) and then import
them again. You can make modifications to the project simply and quickly.
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Note:
To be able to work with the "Import/Export" functions of the Import/Export Assistant, the
model can contain further hierarchy folders, SFC charts, pictures and reports, however
there must not be more than one CFC chart in each hierarchy folder.

Caution:
The block names used in a model must not be modified. The IEA flags in the replicas of
the model must not be modified in the CFC chart and blocks with this flag must not be
removed.
With nested charts, the chart names must not be modified. If the model contains nested
hierarchy folders, these must not be renamed.
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8.1.2 Preparing to Create Models

For your model, use a CFC chart that has already been created and that is suitable
for the functional unit from the plant planning (top chart). You can then edit this
chart according to your requirements.

You can already make preparations in CFC , if you prefer a graphic
representation of the blocks and I/Os or directly in the IEA if you want to
represent all the I/Os in table form.

Preparations in the CFC Chart

For the IEA, you can select the parameters, interconnections and messages for
each block directly in the CFC chart. You can select the
parameters/interconnections

• for the entire block:
Double-click the block: Object Properties > tab: Inputs/Outputs > select the
check box in the columns "IEA parameter" or "IEA interconnection".

• or for each individual I/O:
Double-click the I/O: Properties - Input/Output > "Import/Export Assistant"
box > select the check box "Parameter" or "Interconnection".

You select the messages

• for the entire block:
Double-click the block: Object Properties > tab: General > "Import/Export
Assistant" box > select the check box "Messages".

Note:
If you edit later in the IEA, you will see the selections set in the CFC in the list box and
can, if necessary, correct them.

Selection in IEA

You select the hierarchy folder containing the CFC chart for the model and then
select the function "Options > Import/Export Assistant > Create/Modify
Model..." in the SIMATIC Manager.

The assistant then guides you with on-screen instructions. You select the I/Os of
chart/block I/Os intended for import/export, those you want to assign parameters to
or interconnect and the blocks of messages (or enter/modify the selection already
made in CFC).

The selected hierarchy folder becomes a model if you have assigned an IEA file for
the import (see Section 8.2, Creating a Model) and click the "Finish" button.
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8.1.3 Constellations for Import/Export

You can assign import/export files to the models. This assignment is entered in the
relevant hierarchy folder. If you copy models and/or replicas of the models, the
assignments are also copied. Such activities can result in constellations that may
lead to conflicts.

The possible constellations and their effects are described in detail in the online
help of the IEA.

Note:
The blocks and I/Os selected for the IEA can be modified both in the CFC editor and using
the IEA function "Create/Modify Model". Make sure that you do not accidentally change
the selection when this is already a model or a replica of a model. In this case, a warning
is displayed in the IEA; the CFC editor, however, does not have the information required to
be able to react with a warning.

8.1.4 Restrictions with the IEA

Modifications to Parameters/Interconnections of Charts with Chart I/Os

The following modifications must not be made to charts/chart I/Os with IEA
attributes in CFC since these would prevent import or export. In the following
situations, the log contains appropriate error messages:

• Renaming/deleting nested charts (charts with chart I/Os nested in the chart of
a model) or modification of the block names.

• Modifying (setting or resetting) IEA flags or interconnecting a chart input.

• Modifying the data type of a chart I/O or the relative order of chart I/Os with IEA
flags, for example by inserting or deleting chart I/Os (without IEA flag).

• If the model contains nested hierarchy folders, the names of the nested folders
must not be modified.
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8.1.5 Handling Models in the SIMATIC Manager

Copying Models

You can copy models to a different project (or to a different library) using the
SIMATIC Manager.

Note:
You can also create copies of models by importing models from a library using the IEA.

If you copy a model with the SIMATIC Manager

• within the same project, the copy becomes a replica with identical contents.

• to another project, the model remains a model; in other words, no replica is
created. When the model is copied, a check is made to determine whether the
project or library already contains a model of the same type. If this already
exists, a message is displayed asking whether you want to overwrite the
existing model. If you select "Yes", the model is replaced without existing
replicas being modified; if you select "No" the model is not copied.

Copying Replicas of the Model

If you copy a replica of the model using the SIMATIC Manager  within the same
project, the new hierarchy folder is also assigned to the original of the model; in
other words, the copy is just like all other replicas created with the IEA and does
not have its own assignment to the import file; in other words, it behaves just like a
replica created by importing with the IEA.

If you copy a replica to a different project, it has no assignment there as long as
there is no copy of the corresponding model. The replica receives its assignment
again if it is copied back to the original project (for example Branch&Merge).

Removing Models

If you no longer want a model to be available for import/export, in other words you
want to change a model to a normal hierarchy folder, you can select it, call the
Object Properties dialog (Edit > Object Properties... ) and modify the property in
the "Models" tab with the "Clear" button. The assignment to the import file is then
deleted. This also means that all existing replicas of the model are changed to
normal hierarchy folders.
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Removing Replicas

The replicas of a model can be removed in the same way as models; in other
words, you can make them normal hierarchy folders, as follows:

• select one of the replicas,

• call the Object Properties dialog,

• select the replicas in the "Models" tab

• and click the "Clear" button.

Deleting Models with Replicas

If you delete a model of which replicas already exist, all the replicas are retained
unchanged but they lose their assignment to the model.

If you then replace the deleted model with the same model (for example with
Branch&Merge), the assignment of the replicas is established again.

If you do not want to retain them as replicas, but want to change them back to
normal hierarchy folders, use the procedure described above ("Removing
Replicas").

8.1.6 Assigning a Replica to a Model Later

With the IEA, you can assign replicas that do not belong to the model or neutral
hierarchy folders with CFC charts as replicas of an existing model if the structure of
the replicas is identical to that of the model.

The following applications are conceivable:

• You imported into a project and then adapted the replicas locally. A handling
error (for example in distributed engineering the model was forgotten after
branching and merging) replicas exist but the corresponding model is missing.

• You want to continue working with the IEA in a project after several measuring
points have already been created and adapted locally. You want to assign
these measuring points to a model as replicas.

In the situations described above, you can follow the steps outlined below:

Recreating the Lost Model

If replicas no longer have a model, a suitable model can be created.

• Copy one of the replicas in the project.

• Make a neutral hierarchy folder from the copied replica, in other words, you
open the object properties for the copied replica, select the "Model" tab, select
the replica in this tab and then click the "Clear" button. As an alternative, you
can also copy the CFC chart from the replica to a new hierarchy folder.
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• Create a new model by selecting the neutral hierarchy folder and then
selecting Options > Import/Export Assistant > Create Model.... In the next
dialog steps, you select the previous import file and assign this import data to
the model data.

• Start import (Options > Import/Export Assistant > Import...).

Assigning New Replicas to a Model

The CFC charts from which the replicas for a model will be created must have the
same IEA flags as the model.

• Open the CFC chart of the existing measuring point.

• Select the block I/Os that will be identified as parameters or interconnections
and the blocks whose messages will be used by selecting the relevant blocks
in the chart and then selecting Edit > Object Properties.

• Set the "IEA Message" identifier for the relevant block in the "General" tab.

• In the "Input/Outputs" tab, set the IEA flag in the "IEA Parameters" or "IEA
Interconnection" column for the required I/Os.

Tip: First select all required blocks and then open the object properties. All the
dialog boxes are then opened that you can then work through one after another.

• Prior to import, check whether the hierarchy folder (column: hierarchy) that will
be assigned to the model as the new replica is entered in the import file.

• Start import (Options > Import/Export Assistant > Import...).

8.1.7 Starting the IEA

You start the Import/Export Assistant in the SIMATIC Manager in the plant view
with a hierarchy folder selected (or with the project icon selected).

In the "Options" menu, you select the "Import/Export Assistant" function and the
required dialog in the submenu;

• Create/Modify Model (see Section 8.2)

• Import (see Section 8.3)

• Export (see Section 8.4)
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8.2 Creating a Model

Using the Assistant, you link block/chart I/Os and messages of blocks with the
columns of an import file.

If you are creating a new model, follow the steps outlined below:

To create a new model:

Select the hierarchy folder that contains the CFC chart required for the model (or a
hierarchy folder containing a nested hierarchy folder with a CFC chart). Using the
"Options > Import/Export Assistant > Create/Modify Model..." menu command,
start the IEA and make the selection shown below in the following dialog steps:

• Select the chart/block I/Os to which you want to assign descriptions for
parameters or interconnections.

• Select the blocks with messages to which you want to assign message texts.

• Select the import file and the columns of the import file you want to assign to
the selected I/Os and messages of the blocks.

In the "Which import data do you want to assign to which model data?", the text
<no import file assigned> is initially entered in the "Import file" input box. With the
"Other File..." button, you can browse and enter an import file.

Generating an Import File

If no import file yet exists, you can create an import file from the model data
selected up to now using the "Create Template File..." button.

In a dialog box, you can select or deselect the optional columns you do not require
(for example FID, LID). The column titles are generated provisionally; in other
words, you can modify the default texts to the actual meaning of the columns.

You can edit the file with the IEA editor by opening it with the "Open File" button.
Here you can modify the titles and remove individual unnecessary columns and
duplicate rows and edit the data in the rows. You can then use the modified data
for import.

After saving the file, the IEA displays the new titles that you must then assign.
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Completing a Model

Once you have assigned the import data to the model data, click the "Finish"
button.

You then have a model available with an assignment to a column of the import file
for each selected I/O and each selected message; in other words every column of
the import file has been used
(1:1 assignment).

In the SIMATIC Manager, the hierarchy folder  is displayed as a

model  .

Modifying a Model

You can modify a model that does not have replicas at any time. If you modify
models that already have replicas, a message is displayed since the import data no
longer match the model data.

If you modify the flagged I/Os (IEA flag) of a model that already has replicas, a
message is displayed and the dialog is extended by an additional step. All the
modifications that have been made are logged in this additional dialog box. The
modifications are then made in all replicas.

Caution:
Once a model or a replica of a model has been created, the names of the blocks, the
charts it contains and the nested hierarchy folders may no longer be changed.
Import/export would otherwise be impossible.

Removing a Model

See also Section 8.1.5, Handling Models in the SIMATIC Manager.
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8.3 Importing

Using the IEA Assistant, you import the data of the model. If you import within a
project, only replicas are created. If the model is located in a library, the model is
copied to the destination project after which the replicas are created.

You can decide whether or not the imported interconnections are entered in the
symbol table. If an entry is made in the symbol table, the replicas of the models
created during import are linked immediately with the matching inputs and outputs.
You have the following options:

• You can select a hierarchy folder that is a model and import only  this model.

• You can select a parent hierarchy folder or the project to select and import all
underlying models.

As the result of the import, a replica of the model is created for each line of the
import file according to the information in the hierarchy path in the destination
project.

The replica of a model is displayed as shown below in the SIMATIC Manager:

The structure of an IEA file is described in Section 8.5.

Caution:
Before importing, check the language set for display devices. If you created the model in
German and if the current setting of the SIMATIC Manager is in "English", the German
message texts will be written into the English text file.

Starting the Import Dialog

• Select the required hierarchy folder or the project.

• Select the menu command Options > Import/Export Assistant > Import.

After starting the function, the IEA searches for the models and corresponding
import files (in all hierarchy subfolders as well) and displays them. The import
function will include all listed import files. If you do not want to import certain files,
you can select them and remove them from the list with the "Remove" button. With
the "Other File" button, you can browse for a different import file and select it
instead of the selected file. If you select a different file, the IEA checks whether the
number of columns and the column titles match those specified in the
"Create/Modify Model" dialog.

If you import from a library, an additional page is displayed in the dialog in which
you can select the destination project (see below: Importing a Model from a
Library).

You start the actual import with the "Finish" button. Depending on the options
selected, the complete list of import activities or only the errors that occurred are
displayed in the log window.

The log is saved in a log file and the name and path of the file are displayed below
the log window. You can modify this setting with the "Browse" button.
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Deleting Replicas During Import

You can decide whether existing replicas of a model are deleted or overwritten
during import. With an additional column in the import file containing the hierarchy
path and the "Delete" keyword, you can delete the replica of the model. On
completion of the import function, a message is displayed to indicate whether the
replica was deleted or not found.

Reimporting Models

If you import, the data in all existing replicas will be overwritten without deleting the
replicas. This means that local adaptations are retained. Which replicas are
affected depends on the hierarchy specified in the first column of the import file.

Figure 8-5 Result after Importing: Models_

Figure 8-6 Result after Importing: Replicas
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Constellations when Importing

There are no replicas in the hierarchy specified in the import file:
The entire model (hierarchy folder with all the charts, pictures,... it contains) is
copied.

There are replicas in the hierarchy specified in the import file:
Objects are not copied, only the descriptions of the parameters and
interconnections are entered. This means that changes in the model that are not
relevant for the IEA (for example a block added to the chart without an IEA flag) do
not have effects on the replica of the model. If you want to replace the replicas, you
must enter the "Delete" keyword in the import file for the relevant hierarchy.
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8.3.1 Importing a Model from a Library

You can copy a model by importing the model from a library

If you copy a model with the SIMATIC Manager

• into the project or into a library, the copy becomes a replica with identical
contents.

• into a different project, the model remains a model

If you copy models to a different project/a library, you make sure that the model
remains "unique" (there are no two identical models in one project). This ensures
that each replica of a model only has one model as its template.

Import Sequence

During the import, the IEA checks whether a model already exists in the destination
project.

1. An identical model exists. In this case, the existing model is deleted (in other
words it is overwritten by the new model).

2. Some other model exists. In this case, the model to be imported is copied from
the library to the same hierarchy folder as the existing models (and also
assigned to the same program to which the existing model is assigned).

3. There is no model. In this case, a new S7 program (including the chart folder)
with the name "S7 Models"" is created and the copied model is assigned to the
program folder. The PH is created as it was structured in the library.

Creating a new S7 program means that the charts of the models are separate
from those of the project.

After copying, the replicas for the model are created according to the entries in the
import file.

Procedure

Open the required library in the SIMATIC Manager. In the plant view, select the
model to be imported and then select: Import/Export Assistant > Import... .

The import dialog is started. In the second page, "To which project do you want to
import the model?", specify the destination project. You can select the project
directly in the drop-down list box that lists the last four projects used. If the project
you require is not listed here, you can select the project using the "Find Target
Project..." button.

After selecting the target project, the IEA checks whether the model already exists
in the project and the relevant message is displayed in the log window.

In the next step (model does not exist), the IEA searches for the import file and
recognizes that the file found is the import file from the library. This is indicated in
the log window by three question marks "???" in front of the path entry. Confirm
the message with OK.

You now have two options as to how you continue:
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1. You open the import file with the "Open File" button, make the changes to suit
your requirements (for example making further entries so that replicas are
created of this model) and then save it under a new name in the project (Save
As...). You can then select this file with the "Other File..." button.

2. You have already created an import file or can access an existing import file.
You can then select the "Other File..." button and browse for the required
import file.

You start the actual import with the "Finish" button. The model is copied to your
target project and the replicas created according to the entries in the import file.

The log of the import is entered in the log file and displayed in the log window.

If the import was successful, you close the dialog with the "Exit" button. If an error
occurred, you can return step-by-step to the relevant point with the "< Back"
button.

8.3.2 What Happens During Import?

After you have configured a model and have assigned an import file to it, you can
start the import. If you do this directly with this model, the following steps are
handled automatically.

1. The hierarchy path from the "Hierarchy" column of the first row of data in the
import file is read and checked to see whether the path already exists.
Result of the check:

• Yes:
Check the hierarchy folder to see whether it is a suitable replica. If

- yes: replica is assigned parameters according to the import file

- no: IEA queries all the I/Os and checks whether they match the model
completely. If

- yes: the hierarchy folder with its CFC chart is made into a replica of the
model and assigned parameters according to the import file.

- no: the hierarchy folder is not accepted as a replica of the model.

• No:
Create the hierarchy folders required for this hierarchy and copy the model to
the appropriate position as a replica and then give it the required hierarchy
name.

2. Function identifier (FID), location identifier (LID), CFC chart name and chart
comment are inserted in the documentation field of the charts (optional if the
columns exist).

3. Texts and values of the parameter descriptions and the interconnection
descriptions are written to the corresponding block or chart I/Os of the model of
the hierarchy.

4. The data types of the I/Os for interconnections are determined, the
interconnections are assigned and the names in the symbol table of the
resource of the model are located (optional, if the option "Include
interconnection in the symbol table" was selected.

Result of the search:



Using the Import/Export Assistant

Process Control System PCS 7, Configuration Manual
A5E00122418-01 8-21

Symbol name exists: data type is set according to the block/chart I/O, the
absolute address and symbol comment (if they exist in the import file) are
entered for the symbol.

Symbol name does not yet exist: interconnection is created and data type
set according to the I/O, the absolute address and symbol comment (if they
exist in the import file) are entered for the symbol.

5. The message text is imported for each message.

6. Points 1 to 5 are repeated for each line in the import file.

If you have selected a hierarchy folder that contains more than one model, the
import files appear in the list along with the model. You can still edit the list.
Following this, the import is started for all models in the list as described above.

You will receive error messages in the import log in the following situations:

• There is a replica in the hierarchy path that does not belong to the model.

• There is a model in the hierarchy path

• The model to be imported is incorrect

• There are too many or missing flagged I/Os in the replica

• The settings in the plant hierarchy do not match the imported hierarchy path

• The constellations of the models are illegal (for example model in the model)

• Interconnections in the symbol table are not unique or will be written with
incorrect data types.

Note:
If no interconnection name is specified for an interconnection in an import file (cell empty),
an existing interconnection in the replica remains unchanged. If this cell, however,
contains the code word "---", an existing interconnection is deleted.
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8.4 Exporting

Using the Assistant, you can export data for models. The following options are
available:

• You can select a hierarchy folder that is a model and export only the replicas
of this model.

• You can select a top hierarchy folder or the project node to select and export
all nested models (replicas).

As the result, a line is created in the relevant export file for each replica of a model
found.

The structure of the export file corresponds to that of the import file (see Section
8.5).

Starting the Export Dialog

To export, select the hierarchy folder of the required model and then select:
Options > Import/Export Assistant > Export.

The models are now searched for and listed.

In the next step in the dialog, you can assign the export files to the displayed
models or modify an existing assignment. You can change the names of the
assigned files in a dialog box displayed with the "Other File..." button in which you
can select a different file or enter a new file name.

In the final step of the dialog, you can select the log file, activate or deactivate the
filter so that you only log error messages and the finished message and you can
then "Finish" the export.

Note:
The selected export files are completely overwritten during the export or are newly created
if they do not yet exist.

Exporting More than Once

By exporting the model(s) more than once, you can create several export files
(copies). Each time you export, you must modify the file name of the assigned
export file (see above). If you do not change the file names, the export file is
overwritten.
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What happens during Export?

Once you have created replicas of the models by importing or copying in the
SIMATIC Manager and, for example, have edited various values of the parameters
and interconnections during test and startup, you can export the current data in the
same form as they were imported. If you start the export function for a model or a
replica directly, the following steps are run through automatically:

1. All the replicas of this model are identified. A data line is created in the export
file for each replica found.

2. The parameter descriptions and interconnection descriptions (per model found)
are written to the corresponding cells of the file.

3. The LID, FID and chart name are entered in the export file.

4. Interconnection descriptions based on the interconnection names (symbol
names) are identified in the symbol tables of the resources of the replicas and
written to the corresponding cells of the file.

5. The messages of the blocks are identified and written to the appropriate cells
of the file.

If you have selected a hierarchy folder that contains more than one model, the
export files appear in the list along with the model found. If required, you can still
edit the list. Finally, the export is started (as described above) for all models in the
list.

The export log contains error messages in the following situations:

• A replica to be exported is incorrect (for example according to the export file
not all interconnections and parameters of the chart/block I/Os exist, the data
types are wrong, block I/Os are interconnected...)

• The constellations of the models are illegal (for example model in the model)

Note:
If an interconnection exists at a signal connection point in a replica, the interconnection
name is entered in the export file. If no interconnection exists, the code word "---" is
entered.

Normally, the type of interconnection (textual or to a shared address) is recognized based
on the import file. If, however, no import file exists, the IEA always enters the
"SymbolName" column (in other words interconnection to a shared address) in the export
file if the "IEA interconnection" bit is set.
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8.5 Structure of the Import/Export File (IEA File)

The Import/Export file (IEA file) is structured as follows:

• Each row (after the three header lines) corresponds to a process control point,
for example for controlling the pressure of a tank.

• The columns (after the columns for the hierarchy, FID, LID and chart)
correspond to the various parameters, interconnections and messages.
There must be a column for each I/O and message.

8.5.1 File Structure

The IEA export file is an ASCII text file in CSV format.

There can be a comment line before the first header row (starting with "#" or "//")
containing for example the version number.

The first header row  contains the titles of the column groups. The names for the
hierarchy, FID and LID differ in the various language versions:

The second  header row contains information for the Import/Export Assistant about
how to interpret the columns.
Table 8-3 IEA File: Interpretation of the Columns

H Hierarchy

F FID

L LID

C Chart

P Parameter

S Interconnection

M Message texts

\ Hierarchy separator

; CSV separator between individual columns

| Pipe character between individual entries of the description

The third  header row contains the keywords for the relevant flagged I/O. This
decides which data will be imported for this I/O. Not all the keywords need to be
entered. They can be entered in any order.

The next rows  contain the data. There is one row per hierarchy. Each hierarchy
creates a replica of the model during import.

in the following example, the IEA file is shown as a table to make it easier to read
and the text in the three header rows is shown in "bold" print. The quotation marks
are also missing at the start and end of each column entry.

Since this is pure ASCII text, you must not format an original file (for example,
insert blanks or tabs or use bold print etc.).

The IEA file can be displayed and edited as a table formatted with the IEA Editor
(supplied utility).

Table 8-4 Example: Import File for Measured Value Acquisition
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 #Version = 5.0 --- Import/Export Assistant 10.09.98 13:51:03 ---

Hierarchy; FID; LID; Chart; Upper limit; Meas value; Alarm high;

H\; F; O; C|; P|; S|; M|

; ;  ; ChName|
ChComment;

Value|

ConComment|
S7_shortcut|
S7_unit;

SymbolName|
SymbolComment|
ConComment|
S7_shortcut|
S7_unit;

MsgText3

Plant1\Reac1\
LICA1410;

;  ; P01|Internal
pressure;

90|Com.| UL| mbar; Tpress|ComS.|
ComA.|PT|mbar;

Int. pressure
too high

Plant1\Reac1\
LICA1411;

;  ; P02|External
pressure;

8|Com.| UL| bar; Epress|ComS.|
ComA.|PE|bar;

Ext. pressure
too high

Plant1\Reac2\
LICA2410;

;  ; T01|Temp
contr;

90|Com.| UL| degC; Mtemp.|ComS.|
ComA.|MT|degC;

Temperature
exceeded

V12\RA2\T01; Delete

Explanation of the Table Columns

The column group "Hierarchy contains the complete hierarchy path even if
individual hierarchy folders do not contribute to the name.

During import the hierarchy folders (replicas of the models) are created from this
and the contents of the model (charts etc.) are copied into this new hierarchy folder
if it does not yet exist. During export, all existing replicas of the model are entered.

The hierarchy levels are separated by "\", and the IEA is informed of this in the third
row. Here, "\" must be used as the separator.

The column group "FID" is optional but always follows the "Hierarchy" column
group. It contains the function designation. The data of the FIDs are missing in the
example. The ";" must nevertheless be included so that the number of column
groups remains the same. The text is entered in the CFC chart in the Headers and
Footers, "Part 3" tab: "Description".

The column group "LID" is optional but always follows the "Hierarchy" column
group or, if it exists, the "FID". It contains the location designation. The data of the
LIDs are missing in the example. The ";" must nevertheless be included so that the
number of columns remains the same. The text is entered in the Headers and
Footers dialog, "Part 3" tab in  "Code field according to location:". The FID and LID
are entered in the text fields of all top charts of the replicas.

The column group "Chart" is optional but always follows the "Hierarchy", "FID"
or "LID" column group. Any name can be used for the title. The column group
contains the name and comment of the CFC chart. The name of the CFC chart in
the replica of the model is changes with the keyword "ChName". The chart
comment is changed with the keyword "ChComment".

The following column groups identify the I/Os to be imported. Each of these I/Os
is described by a text string (in quotation marks) separated by ";" (semicolon) from
the next I/O. Within the text string, the individual data are separated by "|" (pipe
character).
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Note:
In REAL numbers, the "comma must not be used as the decimal separator, only the
"period" is accepted (in compliance with IEC-1131).

Handling Special Characters

Comment fields, in particular, can contain special characters that are used as
separators in the IEA file.  For this reason, all column entries are defined as text
and start and end with quotation marks (").

If the text contains quotation marks ("), these are represented in the text by two
sets of quotation marks one after the other (""). If the text itself contains a pipe
character (|), this is enclosed in quotation marks ("|").

A line break within a chart comment in the CFC chart is represented in Windows by
the special character "CR LF" (hex. 0D0A), in the IEA file, these characters are
replaced by the special characters "Bell Bell" (hex. 0707). During import, these
characters are changed over again.
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8.5.2 Columns Permitted in the Column Groups

Within a column group, certain columns are permitted that are distinguished based
on keywords:

Table 8-5 Columns Permitted in the Column Group

  Hierarchy  FID  LID  Chart  Parameter  Signal  Message

Hierarchy X - - - - - -

FID - X - - - - -

LID - - X - - - -

Chart name - - - X - - -

Chart comment - - - X - - -

Block comment - - - - X X X

I/O name - - - - X - -

I/O comment - - - - X X -

Value - - - - X - -

Signal *) - - - - - X -

Te
xt attribute **)

- - - - X X -

Infotext - - - - - - X

Message texts - - - - - - X

*) Signal = signal name, symbol comment, and absolute address
**) Text attribute = S7_shortcut, S7_unit, S7_string_0, S7_string_1
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8.5.3 Keywords

The table contains the keywords that decide which data of the relevant I/O will be
imported.
Table 8-6 Keywords for Selecting the Data to Import

AbsAddr Absolute address, optional for symbols entered in the symbol
table.

BlockComment Comment on the block; with charts within charts, the comment
on the nested chart.

ChName Entry in the chart column: Name of the CFC chart to be
renamed.

ChComment Entry in the chart column: Comment for the CFC chart.

ConComment Comment on block I/O.

Delete Deletes the hierarchy folder with all objects it contains. It is
entered in the first column after the hierarchy to be deleted.

MsgTextn Message text, that is entered in the nth field of the message
texts (MsgText1 ... MsgText10).

InfoText Message text that is entered in the field for message texts.

SymbolName Name of the symbol. With shared addresses, you can select
whether or not the symbol name is entered in the symbol table
during import.

SymbolComment Comment for the symbol that will be entered in the symbol
table).

RefName Name of the chart I/O.

Value Value for the I/O of a chart or block (for example: 8.5).

S7_shortcut Identifier for the I/O when not BOOL (for example: UL).

S7_unit Unit for the I/O when not BOOL (for example: degC ).

S7_string_0 Text for state 0 (false) when BOOL (for example: Motor off).

S7_string_1 Text for state 1 (true) when BOOL (for example: Motor on).



Using the Import/Export Assistant

Process Control System PCS 7, Configuration Manual
A5E00122418-01 8-29

8.5.4 Example of the Structure with Keywords

Parameters at block I/O
Value | ConComment { | S7_shortcut | S7_unit } .. { | S7_string_0 | S7_string_1 }

Parameters at chart I/O
Value | RefName | ConComment { | S7_shortcut | S7_unit }
... { | S7_string_0 | S7_string_1 }

Symbol at block or chart I/O
SymbolName | SymbolComment | ConComment { | S7_shortcut | S7_unit }
... { | S7_string_0 | S7_string_1 }

Message at block I/O
MsgText3 { | MsgText1 .. MsgText10 } .. { MsgInfoText }

Rules for Assigning Keywords:

• Only the keywords valid for the column type are permitted (for example with
messages, the keyword "S7_shortcut" is not permitted).

• A permitted keyword must not occur twice in a column.

8.5.5 Data of the IEA File in the ES

The figure shows the relationships between the objects of the project and the data
of the import file.

........ .... ........Hierarchy Parameter Interconnection Signal Message

Replica 1 Replica 2
P01 T01

RA1

V12

Project

CFC2CFC1

Alarm 1

Alarm 2

Valve open

Heating onV12\RA1\P01.V

90 | OG |

80 | OG |V12\RA1\T01

V12\RA1\P01

Plant
hierarchy

Import file

Valve open

Heating on

Symbols Messages

Alarm 1

Alarm 2

H\; P|; S|; M|S|;

Figure 8-7 IEA Editor: Editing IEA Files
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8.6 IEA Editor: Editing IEA Files

The Import/Export Assistant works with import/export files with a fixed format. A
plant planning tool such as SIGRAPH EMR supports this format.  To be able to
create or edit import files even if you do not have a plant planning tool available,
you can install the Import/Export Assistant, an application that keeps exactly to the
rules governing the structure of the import file.

The Application

The IEA Editor "s7jieaEx.exe" is a a separate application, in other words it can
also be used outside the PCS 7 installation. It can be copied and made available to
plant planners.

Where Can the Editor Be Used?

The IEA Editor is intended for the following situations:

You have created a model and created the import file with the IEA. Using this
import file, you want to create replicas of the model. The number of lines in the
import file must be increased according to the number of replicas you want to
create (for example by copying and editing).

You have created a model and created the import file with the IEA. You want to
change this model, for example by including further I/Os and need to extend the
import file by adding these columns.

You do not have a tool for creating an import file and want to use the IEA Editor as
a planning tool to structure the columns, column groups and lines of the import file
and the corresponding values.

You want to compare an import file with an export file (or vice versa). By opening
two windows and arranging them in the IEA Editor window, you will have no
difficulty in making the required comparison.

You want to use the IEA editor to edit an import file created with a planning tool.

Appearance of the IEA Editor

The IEA file is displayed as a table with columns and column titles. Certain
columns are put together to form column groups, for example, column group:
"CFC_Name" with the keywords of the columns: "ChName" and "ChComment".

You can change the name of the column group to correspond to the column title of
the import file. If you only want to use part of the full range of import options, you
can also delete columns within a column group. If you remove all the columns of a
column group, this flagged I/O is lost; in other words, the model is changed.

The row headers contain the number of the row. If you select a row header, the
entire row is selected (for example so that it can be copied).

The IEA Editor also provides all the normal functions of an editor (copy, paste,
save etc.).
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To allow you to insert column groups, all the column group types (chart, parameter,
interconnection, messages) are defined in a submenu and are also available as
buttons in the toolbar.

You can also add new columns to the column groups "parameter",
"interconnection" and "messages". In the dialog, you can only select the column
titles that do not yet exist in the relevant column group.

Context-sensitive menu commands activated with the right mouse button are not
available. You can select all the possible functions using the menu commands in
the menu bar or the buttons in the toolbar.

Otherwise, the structure of the editor corresponds to the structure of the
import/export file (IEA file), see Section 8.5.

Starting the IEA Editor

You start the editor by opening an IEA file or by double-clicking the icon of the
application.

Figure 8-8 The IEA Editor

Regional Settings

If you have set your PC to English in the "Regional Settings", you may find that
some tools insert a comma instead of the semicolon. The IEA can then no longer
correctly interpret the CSV file. You can change the regional settings with Start >
Settings > Control Panel > Regional Settings in Windows NT.

Analog parameter values (type REAL) must be represented with "." (restriction of
CFC and SFC).
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8.7 Creating Charts for the "COLOR_PH" Project

You have already created the model charts  for the "COLOR_PH" project in the
library "COLOR_PH_LIP". In this section, you will import the required number of
"VALVE" model charts as an example into the "liquid raw materials store" unit.

The following activities will be required:

• Select the import/export I/Os

• Link the import/export file with the import/export I/Os

• Edit the import/export file

• Assign the IEA file parameters to the model data

• Import the models into the project

Follow the steps outlined below:

1. Select the "VALVE" hierarchy folder in the "Models" folder in "COLOR_LIB"
within the plant hierarchy.

2. Select the menu command Options > Import/Export Assistant >
Create/Modify Model....

3. Follow the assistant, and in Step 2 (4), select the parameters to which you
want to assign descriptions for chart/block I/Os.

For the "liquid raw materials store" unit, set the following I/Os:
Table 8-7 I/Os for Importing the "Valve" Model

 Block name  I/O  Block type  Remarks

Signal I/O points (IEA interconnection):

FB_CLSD VALUE CH_DI

FB_OPEN VALUE CH_DI

OUTPUT VALUE CH_DO

Process I/O with a
symbolic name

Parameter I/O points (IEA parameters):

VALVE START_SS VALVE

VALVE MONITOR VALVE

Default values for
the COLOR_PH
project
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Figure 8-9 Setting the I/Os for Importing

Click the "Next" button.

4. In Step 3 (4), select the blocks from which you want to import messages (in
this case: VALVE block).

Click the "Next" button.

5. In Step 4 (4) you make the assignment to the IEA file. Since you have not yet
created an IEA file, select the
"Create Template File" button.

6. Select a file name (or enter the default name "VALVE_00.IEA") for the import
file that will be generated.

7. In the dialog box displayed, select the following columns. Each selection in
"For CFC Charts" creates a further column in the IEA file, each selection in
"For Parameters and Interconnections" creates a column in the IEA file for
each selected parameter and each selection in "For Messages" creates a
column in the IEA file for each message of the relevant block.
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Figure 8-10 Selection of the Columns Displayed in the Import File

After clicking the "OK" button, you have assigned the IEA file to your "Valve"
model chart and the parameters of the IEA file have been assigned to the
model data.

Figure 8-11 Assigned Parameters of the IEA File

8. Click the "Open File" button and enter the information shown in the following
table in the IEA file. Leave the operator texts (column: S7_string0, S7_string1)
and the standard message text (columns: MsgText3) unchanged.
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Table 8-8 I/Os for Importing the "Valve" Model

 Hierarchy  Ch

 Name

 Ch

 Comment

 Symbol

 Name

 Symbol

 Name

 Symbol

 Name

 Value  Value

Chart FB_CLS
D.

VALUE.

INOUT

FB_OPEN.
VALUE.

INOUT

OUTPUT.

VALUE.

OUT

VALVE.

START_SS.

IN

VALVE.

MONITOR.

IN

Plant1\

RMT1\

NK111\

NK 111 Valve 1
Tank 1

NK111_
FB_CLS
D

NK111_FB
_OPEN

NK111_O
UTPUT

0 0

Plant1\

RMT1\

NK112\

NK 112 Valve 2
Tank1

NK112_
FB_CLS
D

NK112_FB
_OPEN

NK112_O
UTPUT

0 0

Plant1\

RMT1\

NK113\

NK 113 Valve 3
Tank1

NK113_
FB_CLS
D

NK113_FB
_OPEN

NK113_O
UTPUT

1 0

Plant1\

RMT1\

NK114\

NK 114 Valve 4
Tank1

NK114_
FB_CLS
D

NK114_FB
_OPEN

NK114_O
UTPUT

1 0

9. As an option, you can adapt the column titles to your requirements. If you save
the file in the "COLOR_PH" project now (File > Save As...; folder: "Siemens
\Step7\S7proj\COLOR_PH"), you will find it easier to make the assignment of
the import file when you import. Close the file.

10. Close the dialog with the "Finish" button.

11. To create the charts, select the menu command Options > Import/Export
Assistant > Import with the "VALVE" hierarchy folder selected.

Since you have selected a model in a library, this must first be copied to the
target project and then imported.

12. In Step 2 (4) select the "Find Target Project" button and select the
"COLOR_PH" project. Confirm your selection with "OK".

This step is necessary to be able to copy the model to the target project.

13. In Step 3 (4), click the "Other File" button and select the import file
"Import00.IEA". The import file is then assigned to the model in the project.
Select the "Next" button.

14. In Step 4 (4) click the "Finish" button.

The import is started.

15. Quit import (button "Exit").
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Note:
If, during the import, a dialog box is displayed with the message "The hierarchy folder is
not yet assigned to a chart folder, do you want to make the assignment now?" then click
the "Yes" button in the dialog box and make the assignment to your chart folder (SIMATIC
400(1)\CPU416-2DP\S7 Program(1)\Charts).

When the import is completed, the "VALVE" hierarchy folder is displayed in the
plant hierarchy of the library with the icon of the model.

Figure 8-12 Library of the Model

Four new hierarchy folders with the names "NK111" to "NK114" have now been
created in the "RMT1" hierarchy folder of the "COLOR_PH" project and are
indicated as replicas of a model.

Figure 8-13 "COLOR_PH" Project with Replicas of the Model

In each of the new folders, a CFC chart has been created as a copy of the
"VALVE" top chart with the parameters and interconnections you specified.
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Importing the Other Models

Following the same procedure as described in steps 1 to 15, create the hierarchy
folder "LI 111" (model: MESS), "NP 111" (model: MOTOR) and "FC 111" (model:
DOSE) and the required CFC charts in the "RMT1" hierarchy folder using the
Import/Export Assistant.

Using the Import/Export Assistant set values for the following parameters in the
model charts.

Table 8-9 Flagged I/Os for the "DOSE" Model Chart
 Block name:  I/O

parameter
 IEA_values  Remarks

Signal flagged I/Os:
INPUT_U VALUE FC111_

INPUT_U
Symbolic name of the input channel

OUTPUT_L
MN

VALUE FC111_
OUTPUT_L
MN

Symbolic name of the output channel

Table 8-10 Flagged I/Os for the "MESS" Model Chart

 Block name:  I/O
parameter

 IEA_values  Remarks

 Parameter flagged I/Os
MO_PVHR 100 Upper limit of the process value in the

container 100 m3

U_AH 98 Upper alarm limit 98 m3

U_WL 7 Lower warning limit 7 m3

MEAS_MON

U_AL 5 Upper alarm limit 5 m3

INT_P U -0.4 Simulation of the raw material tank level
SIM_ON 1 Simulation value active
SIM_V 78 Raw material tank level 78%

INPUT

VHRANGE 100 Upper measuring range

Signal flagged I/Os:
INPUT VALUE LI111_

INPUT
Symbolic name of the input channel



Using the Import/Export Assistant

Process Control System PCS 7, Configuration Manual
8-38 A5E00122418-01

Table 8-11 Flagged I/Os for the "MOTOR" Model Chart

 Block
name

 I/O
parameter

 IEA_values  Remarks

 Parameter flagged I/Os
FB_RUN SIM_ON 1 Simulation setting for simulating the SFC

(Chapter 9)
MOTOR MONITOR 0 Monitoring deactivated

Signal flagged I/Os:
FB_RUN VALUE NP111_

FB_RUN
Symbolic name of the input channel

OUTPUT VALUE NP111_
OUTPUT

Symbolic name of the output channel
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8.8 Models with Flexible Interlocks

If you use a particular type of motor control regularly in the process, you can
implement this motor control as a model  and can import it elegantly using the IEA
editor.

In practice, it is often the case that the motor controls are identical but are
interlocked differently. For example, a motor must not be started when a
temperature is too high or when the power supply to the motor is too low. To allow
such interlocks, the motor block has several inputs available (LOCK, LOCK_ON,
MSS etc.).

You interconnect the various interlock connections to these inputs using an
INTERLOK block. The inputs of this block are put together in groups. For example,
the first five inputs form a group whose inputs can be logically ANDed or ORed
depending on an input. The parameter settings at other inputs can be used to
decide whether the signals influence a group directly or negated. The result of a
group can also be negated etc. depending on the parameter settings of an input.

Using this block, you can create models with flexible interlocks. In the IEA file
belonging to the model, you enter the information about how the INTERLOK will
implement its interlock logic for special motor controls.

Advantage: You require only one model for all motor controls and set the required
interlocks in the parameters of the inputs. To do this, you can configure the
INTERLOK inputs as IEA parameters for the type of logic operation and as IEA
flagged I/Os for interconnection of the interlock conditions in more than one chart.
In the import file, you can leave the cells of the "Interconnection" column empty if
no interconnection is required in certain replicas. If you enter the keyword
$DELETE in the "Interconnection" column, the corresponding interconnection is
deleted in this replica.
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Figure 8-14 Shows an example of a motor controller with an INTERLOK block.

Figure 8-14 Model with INTERLOK Block for Flexible Interlocks
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9 Creating SFC Charts

Introduction

This chapter explains the basics of the SFC editor. For further information, refer to
the  "SFC Sequential Function Chart" or the online help.

You will learn the meaning of a sequential control system and create a sequential
control system for the "COLOR_PH" project.

9.1 The SFC Editor

Overview

An SFC chart is a sequential control system. The SFC editor is a tool for creating a
sequential control system. An SFC chart is assigned uniquely to one S7 program
and is executed completely in it; it can, however, also reference automation
functions of other CPUs.

Sequential Control System

A sequential control system is a controller partitioned to ensure step-by-step
execution with control passing from one state to the next state dependent on the
conditions.

Sequential control systems can be used, for example, to describe the manufacture
of products as event-controlled processes (recipes). Functions from basic
automation (typically created with CFC) are controlled by operating and state
changes and executed selectively.

The typical applications of sequential control systems involve processes and plants
with discontinuous characteristics. Sequential control systems can, nevertheless,
also be used for continuous processes and plant, for example for approach and
withdrawal movements, operating point changes, and state changes due to faults
etc.

Such systems can be used at various levels of a process or plant:

• Device control level (open valve, start motor, .....)

• Group control level (proportioning, stirring, heating, filling, .....)

• Unit level ( tank, mixer, scales, reactor, .....)

• Plant level (synchronization of units and common resources, for example
routing)
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How does the editor work?

Using the SFC editor, you create your sequential function chart using graphic tools.
The SFC elements of the chart are positioned according to fixed rules. You do not
need to be aware of details such as algorithms or the assignment of machine
resources but can concentrate solely on the technological aspects of your
configuration.

Figure 9-1 Example of an SFC Chart

After creating the chart topology, you move on to configure the object properties
where you formulate the individual steps and transitions, in other words you
configure the actions and conditions.

Figure 9-2     Example of a Transition
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Figure 9-3     Example of a Step (Action)

Phases of a Step (Action)

The tabs for the processing phases (actions) "Initialization", "Processing" and
"Termination" all have the same structure. Here, you configure the statements that
control the process for initialization, normal processing and termination of the step.

Each step is divided into three phases:

• Initialization is the action for the initial processing after the step becomes active
(the preceding transition is satisfied). Initialization is run only once.

• Processing is the action for cyclic processing until the following transition is
satisfied. The processing cycle is determined by the installation of the SFC in
the run sequence (for example OB35 > as default every 100 ms).

• Termination is the action for the last processing when the following transition is
satisfied. Termination is run only once.

Note

The processing of "Termination" and "Initialization" of successive steps takes
place in the same cycle.
Exception: If the initialization branch in the next step is empty, in other words, it
contains no statements, the "Termination" of a step is processed with the first
cyclic processing of the following step in one cycle.

Executable Machine Code

After configuration, you compile the executable machine code with SFC, download
it to the PLC and test it with the SFC test functions.
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Overview of the Configuration Steps

This section explains the best order in which to configure sequential control
systems (SFC charts) for your PLC (the project structure already exists and a
created SFC chart is open):

Set chart properties: When you specify the chart properties, you can change the
chart name, add a comment, and specify the operating parameters.

By setting the operating parameters, you decide on the behavior of the sequential
control system, for example the mode (MANUAL, AUTO), the step control mode
(for example step control with transitions (T), step control operator controlled (C),
step group control (T/T and C) etc.) and other options (cyclic mode, monitoring,
autostart, ...).

Create the topology of the sequential control system: In SFC charts, you
configure sequential control systems starting with the insertion of structure
elements such as steps and transitions.

Configure steps (in the Object Properties dialog):
Actions are formulated in the steps. The actions include statements with which the
values of block inputs and shared addresses or run-time groups or other SFC
charts can be activated and deactivated.

Configure transitions (in the Object Properties dialog):
Conditions are formulated in the transitions. The conditions read the values of
block I/Os, of shared addresses or the state (active/inactive) of run-time groups or
other SFC charts. If the conditions following the specified logic operations are true,
the next step becomes active and its actions are executed.

Messages:If you require an operator to intervene before control passes to the next
step or when the timeout monitoring of a step responds, messages are generated.

Adapt run-time properties:The run-time properties of an SFC chart specify how
the SFC chart is included in the processing sequence within the entire structure of
the PLC. In the run sequence, you can remove the SFC charts from OBs or from
run-time groups and install them again in other OBs or run-time groups. This allows
you to adapt the processing cycle of SFC charts to your requirements. (Select the
menu command Edit > Run Sequence in the open SFC chart).

Compile the SFC chart:During compilation, the CFC and SFC charts of the active
chart folder are converted to an executable user program. Changing comments
(chart, step, step-OS, and transition-OS comments) does not require recompilation
of the charts.
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Whether or not you need to compile the entire program or only run a delta
compilation depends on the following factors:

• You modify, add, or remove "Assignments in Steps" or "Conditions in
Transitions"
Delta compilation followed by delta download in the "RUN" mode with the
sequential control system active on the PLC is possible.

• You add, delete, copy, or move steps or transitions
Delta compilation and delta download is possible. Prior to downloading,
however, the sequential control systems affected by the modification must be
deactivated on the PLC (caution: remember that this will have effects on the
process).

Before the modifications take effect in SFC Visualization on the OS, the PLC-OS
connection data must be transferred.

Download the program After compilation, you can download the program to the
PLC (CPU).

Test the program:After compiling and downloading the program you can test it.
Using the SFC test functions, you can run the sequential control system in various
operating modes and step control modes and monitor and modify the values of
addresses on the CPU. You can also influence the most important operating
modes (STOP, clear/reset, RUN, ...) on the CPU.

Note:

For further information about the SFC editor or the other programming languages,
refer to the online help or to the relevant manuals (refer to the references at the
end of this manual).
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9.1.1 The SFC Control Block

Purpose

With the control block, you can query the status of the SFC chart and influence its
execution (start, stop, hold etc.).  The control block is used in CFC like a basic
operation; in other words, you can insert it into the CFC chart from the block
catalog, interconnect it and assign parameters (family:  SFC_CTRL).

You can use the control block just like other CFC instances in the SFC chart at the
detailed level of the steps and transitions. This means that in one SFC chart, the
control block can be used to control the same chart or a different SFC chart. One
control block must be used per SFC chart.

An SFC chart can also be run without SFC_CTRL. In this case, the chart is
controlled solely by the operator (OS) or in the test mode of the SFC (ES).
Automatic execution in the background would also be possible (for example
starting after turning on the CPU).

Run-Time Properties

You install the control block and the SFC chart in one of the cyclic tasks (for
example OB32). When using SFC_CTRL, make sure that it is installed in the run
sequence directly before  the SFC chart.

Interface

The control block represents the interface of the SFC chart reduced to all inputs
that can have parameters assigned and be interconnected and all outputs that can
be interconnected. The control block also has an input (CHART of the data type
STRING) in which the chart name is stored.

Only the input "CMODINI" or "EN_OM" must be set. In the same way, only "SCT"
or "SGC" must be set. The inputs "OM_BY_LI" and "LM_BY_LI" must only be set
or reset by pulses, a permanent "1" signal is not permitted. The inputs
"T_OPRQCA" and "S_ERRCA" must also only be acknowledged as a pulse after
an error has occurred. To execute SFC steps, it is important that the "INSTOUT"
input is set, otherwise there is no command output.
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9.1.2 Notes on the Structure of Sequential Control Systems

When structuring sequential control systems, make sure that you take into account
any possible hardware faults in the process (faulty pump, valve failure message
etc.). The following solution has proved itself in practice:

Figure 9-4 SCF Structure

The "End" step of a sequential control system is always run through once (even if
the controller aborts). Here, it is important to bring all the actuators (pumps, valves
etc.) in the process and any flip-flops in the CFC back to a defined setting.

SFC

End

Loop for waiting until the problem is eliminated
"Pump OK". As an option, a Jump can also be
made to any other step (including forwards).Step to turn on a

pump "Pump On"

Transition queries
INTERLOK block output

Transition queries
INTERLOK block
output negated (and
possibly further
conditions)

INTERLOK block

Pump fault
Message absent
No 24V ps
Overpressure line
etc.
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9.2 Creating the Sequential Control System for the
"COLOR_PH" Project

In this chapter, you will create the sequential control system for the "raw material
tank 1" unit of the "COLOR_PH" project.

Sequence

The SFC chart for the "COLOR_PH" project has the following sequence:

START Defaults:
- set dosing controller to manual mode
- switch dosing controller to external
- stop dosing etc.

DOSE_REA1
DOSE_REA2

Query : - which reactor will be used
 (reactor 1 or 2)?

INIT_LINE1
INIT_LINE2

Controls: - open valves of the relevant chain
- turn on pump
- switch dosing controller to external setpoint

INIT_1_OK
INIT_2_OK

Query: - is the pump turned on?
- Is the controller set to "External Setpoint"?

INIT_DOSE Controls: - specify setpoint of dosing rate
- set dosing controller to automatic
- specify setpoint of dosing volume
- start dosing

INIT_OK Query: - dosing started?
- dosing volume (setpoint - actual value) < 500 Liters?

SLOW_DOWN Control: - reduction of the dosing rate shortly before 
 reaching the required dosing volume

END_DOSE Query: - dosing completed?

CLOSE_LINE Controls: - close all valves
- turn off pump
- switch dosing controller to manual
- set dosing rate to 0
- stop dosing

CLOSE_OK Query: - is the pump turned off?

END Reset: - switch dosing controller to internal
- close valves
- turn off motor

The chart you have created can be started, controlled and monitored on an
operator station.

Insert a new SFC chart with the name "SFC_RMT1" in the hierarchy folder
"RMT1". Open the chart and insert the SFC structure shown below.

SFC Structure
The SFC structure required for the "raw material tank" unit of the "COLOR_PH"
project is as follows:
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Figure 9-5 SFC Structure  Raw Material Tank Unit

Create the following actions and transitions as shown in Figure 9-5 (see Table 9-1):

Table 9-1 Actions and Transitions to be Created

 Action  Transition

START

DOSE_REA1

INIT_LINE1

INIT_1_OK

DOSE_REA2

INIT_LINE2

INIT_2_OK

INIT_DOSE

INIT_OK

SLOW_DOWN

END_DOSE

CLOSE_LINE

CLOSE_OK

END
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Actions and Transitions of the Sequential Control System

The following table shows you the contents of the actions and transitions. To save
cycle time, all the commands of the actions in the initialization branch
("Initialization" tab in the open action) can be executed. The individual lines of the
transitions are logically ANDed.

Table 9-2     Contents of the Actions and Transitions (Raw Material Tank Unit)

Action/
Transition

Address 1 Opera
tor

Address 2 Meaning

...\\FC111\CTRL_PID.LIOP_MAN_SEL := TRUE Interconnected input  AUT_L active

...\\FC111\CTRL_PID.AUT_L := FALSE Controller manual mode

...\\FC111\CTRL_PID.SP_EXT := ...\\DOSE_PARA\

PARA_DOS_RM1
_QTY.V

Setpoint flow control for display

...\\FC111\CTRL_PID.LMN_SEL := FALSE No correction of manipulated variable

...\\FC111\DOSE.L_START := FALSE Dosing stopped

...\\FC111\INT_P.TRACK := TRUE Correct integrator to input value 0

...\FC111\DOSE.SPEXTON_L := TRUE Setpoint external linking active

...\FC111\DOSE.SPEXT_ON := TRUE Setpoint external active

...\LI111\INT_P.TRACk := TRUE Track integrator

...\LI111\INT_P.HOLD := FALSE Hold output value

...\NK111\VALVE.AUT_ON_OP := AUTO Switch valve to automatic

...\NK112\VALVE.AUT_ON_OP := AUTO Switch valve to automatic

...\NK113\VALVE.AUT_ON_OP := AUTO Switch valve to automatic

...\NK114\VALVE.AUT_ON_OP := AUTO Switch valve to automatic

START

...\NP111\MOTOR.AUT_ON_OP := AUTO Switch motor to automatic

Action/
Transition

Address 1 Opera
tor

Address 2 Meaning

...\\DOSE_PARA\PARA_DOS_RM1_SEL.Q0 = TRUE Dosing reactor 1 ?

...\\DOSE_PARA\PARA_DOS_RM1_VOL.V > 0.0 Dosing volume higher than 0 ?

DOSE_REA1

...\\NK111\VALVE.AUTO_OC := TRUE Open valve

...\\NK112\VALVE.AUTO_OC := TRUE Open valve

...\\NK113\VALVE.AUTO_OC := TRUE Open valve

...\\NP111\MOTOR.AUTO_ON := TRUE Turn on motor

INIT_LINE_1

...\\NP111\MOTOR.QRUN = TRUE Is motor on?

...\\FC111\CTRL_PID.QSPEXTON = TRUE Is controller switched to external

setpoint

INIT_1_OK

PARA_DOS_RM1_SEL.Q0 = FALSE Dosing reactor 2 ?

PARA_DOS_RM1_VOL.V > 0.0 Dosing volume higher than 0 ?

DOSE_REA2

...\\NK111\VALVE.AUTO_OC := TRUE Open valve

...\\NK112\VALVE.AUTO_OC := TRUE Open valve

INIT_LINE_2

...\\NK114\VALVE.AUTO_OC := TRUE Open valve
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Action/
Transition

Address 1 Opera
tor

Address 2 Meaning

...\\NP111\MOTOR.AUTO_ON := TRUE Turn on motor

...\\NP111\MOTOR.QRUN = TRUE Is motor on?

...\\FC111\CTRL_PID.QSPEXTON = TRUE Is controller switched to external
setpoint

INIT_2_OK

...\\FC111\CTRL_PID.SP_EXT := ...\\DOSE_PARA\

PARA_DOS_RM1
_QTY.V

Active setpoint for flow control

...\\FC111\CTRL_PID.AUT_L := TRUE Controller to automatic

...\\FC111\DOSE.SP_EXT := ...\\DOSE_PARA\
PARA_DOS_RM1

_VOL.V

Active setpoint for dosing volume

...\\FC111\DOSE.L_START := TRUE Start dosing

...\\FC111\INT_P.TRACK := FALSE No correction for integrator

...\\FC111\INPUT_U.SIM_V := ...\\DOSE_PARA\

PARA_DOS_RM1
_QTY.V

Simulation2): Flow 50 liters/ min

simulated!

Set the minimum run time of this step to "8s" (Properties/General)

INIT_DOSE

...\\FC111\DOSE.QSTRTDOS = TRUE Dosing started ?INIT_OK

...\\FC111\DOSE.ER < 500.0 Dosing volume: setpoint – actual
value

< 500 liters?

...\\FC111\CTRL_PID.SP_EXT := 10.0 Reduction of setpoint for flowSLOW_DOWN

...\\FC111\INPUT_U.SIM_V := 10.0 Simulation2): Flow 10 liters/ min
simulated!

END_DOSE ...\\FC111\DOSE.QEND_DOS = TRUE Dosing ended ?

Action/
Transition

Address 1 Opera
tor

Address 2 Meaning

...\\NK111\VALVE.AUTO_OC := FALSE Close valve

...\\NK112\VALVE.AUTO_OC := FALSE Close valve

...\\NK113\VALVE.AUTO_OC := FALSE Close valve

...\\NK114\VALVE.AUTO_OC := FALSE Close valve

...\\NP111\MOTOR.AUTO_ON := FALSE Turn off motor

...\\FC111\CTRL_PID.LMN_SEL := TRUE Correct manipulated variable to 0

(close valve)

...\\FC111\CTRL_PID.SP_EXT := 0.0 Active setpoint for flow control

...\\FC111\CTRL_PID.AUT_L := FALSE Controller to manual

...\\FC111\DOSE.L_START := FALSE Dosing stopped

CLOSE_LINE

...\\FC111\ INPUT_U.SIM_V := 0.0 Simulation2): Flow 0 liters/ min
simulated!

...\\LI111\INT_P.HOLD := FALSE Control integrator
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Action/
Transition

Address 1 Opera
tor

Address 2 Meaning

...\\NP111\MOTOR.QRUN = FALSE Is motor off?CLOSE-OK

...\\FC111\CTRL_PID.AUT_L := FALSE Reset input

...\\FC111\CTRL_PID.LMN_SEL := FALSE No correction of manipulated variable

...\\NK111\VALVE.AUTO_OC := FALSE Close valve

...\\NK112\VALVE.AUTO_OC := FALSE Close valve

...\\NK113\VALVE.AUTO_OC := FALSE Close valve

...\\NK114\VALVE.AUTO_OC := FALSE Close valve

...\\NP111\MOTOR.AUTO_ON := FALSE Turn off motor

END1)

1) If the sequential control system aborts, the "END" action is always executed. For this reason, the
block inputs modified by the sequential control system are reset again in the "END" action.

2) These command lines are only necessary if you want to check the sequential control system in the
test mode (see Section 9.2.1).
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9.2.1 Simulating the Sequential Control System

With a few extra measures, you can also check your configured sequential control
system in the test mode. If you want to try this, read the section below. Otherwise,
you can skip to the next chapter.

Compiling the Programs

The program you have created must now be compiled into a machine language
that can be executed on a CPU. Follow the steps outlined below:

1. With the SFC editor open, click "Compile" 

2. Click the "Generate Module Drivers" option.

To detect and signal errors on the I/O modules, you require additional module
drivers. These module drivers are created automatically by the "Generate
Module Drivers" function and stored in the charts generated by CFC (@...).

Note:

In addition to the module drivers, an instance of the "OB_BEGIN", "OB_END" and
"PO_UPDAT" blocks is created.

The process control message concept includes the signaling of rack failure,
failure of a local module, battery failure, and errors occurring when the operating
system accesses blocks or when OBs are not loaded. OB_BEGIN generates
messages in response to these events. The "OB_BEGIN" block must exist once
in your project and in conjunction with CFC creates all the acyclic OBs you
require (for example OB80, OB81 etc.). "OB_END" resets the stack pointer of
"OB_BEGIN". These are transferred to the PLC during the download. If an acyclic
OB is now called (for example as a result of a rack or DP slave failure),
OB_BEGIN sends a message to this effect to the relevant OS. If the acyclic OB
does not exist on the PLC, and there is, for example, a rack or DP slave failure,
the PLC changes to STOP.

The "PO_UPDAT" block is responsible for the functions "Hold last value" and
"Use substitute value" on the output modules when a CPU goes through a warm
restart (OB100).

For more information on the assistant and the module drivers, refer to Chapter 1,
section "Attachment to the I/Os" or to the online help of the blocks listed above.

3. Click the "Update the sampling time" option.

The sampling times are then updated automatically in blocks with an input for
the sampling time (SAMPLE_T). When you set this option, the system checks
to find out which OB contains the block involved and makes the relevant entry
prior to compilation. "Sample_T" corresponds to the sampling time in seconds.

4. Click the "Delete empty run-time groups" option.

By setting this option, all empty run-time groups in the S7 program are deleted.

5. When you click the OK button, the compiler is started.
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The compiler starts to compile the program (all CFC/SFC charts of the current
S7 program). If you compile again, you only need to compile the changes
("Changes" option).

If compilation is completed and error-free, the following message is displayed:

Code generation: 0 error(s) and 0 warning(s) found

Figure 9-6   Dialog for Setting Compilation Options

6. Confirm this message with the OK button.

Note:
If a log window is displayed containing the warning "Empty OB1 was deleted",
close the window by clicking the "Close" button.
Meaning of the message:

In the "COLOR_GS" project, no blocks are installed in OB1. An empty OB is, however,
pointless on a PLC and is therefore deleted by the CFC compiler.

You have compiled the program and you must now download it to the CPU before
you can run it in the test mode.
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Downloading the programs

A program can only be downloaded to the CPU when the keyswitch on the CPU is
set to STOP or RUN-P. To make sure that there are no blocks on the CPU when
you download an entire program, the CPU is set to STOP before the download and
all the user blocks are deleted.

7. Set your CPU to RUN-P (if this is not already set).

8. Click "Download" 

You open the S7 Download dialog box. In the "Download" box, the "Entire
program" option is set.

9. Select OK

The following dialog box is opened:

Figure 9-7 "Stopping the CPU" Message Box

This dialog box informs you that you can only download the entire program to the
CPU when the CPU is in the STOP mode and that all blocks will be deleted on the
CPU before the download. If the CPU is already in the STOP mode, the dialog box
simply informs you that all blocks will be deleted.

10. Click the YES button.

The program is downloaded to the CPU.

After the download, you will see a further dialog box asking you whether or not
you want to start the CPU.

11. Click the YES button.

In subsequent download, a download of changes is adequate. This means that you
only download the changes to the CPU. A delta download is possible in the RUN-P
mode of the CPU.
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Comparing PLC Resources prior to Downloading

Prior to downloading to the PLC, the ES makes certain checks. These relate to:

• Local data
When you compile the charts, the local data requirements of the user program
are compared with the requirements configured offline.

• Nesting depth
When you compile, a check is made to ascertain whether the maximum
permitted nesting depth (nested program or block calls) are exceeded in the
individual OBs.

• Memory requirements
When you download the program, the free memory on the CPU (online) is read
and compared with the memory requirements calculated for the program.

• Communication resources (communication-related blocks)
When you download, the communication resources required for the program
are compared with those that exist on the PLC.

Warnings when Resource Limits Are Exceeded

In CFC (Options > Customize > Compile), you can set warning limits  that will tell
you when resources are starting to be used up.

The purpose of the warning limits is to inform you during compilation or at the latest
when you download that the load limits of the local stack, load/work memory, and
communication blocks will be exceeded.

You can set the limit values as percentages that apply both for compilation and
downloading. The following warning limits can be set:

• Local data

• The number of communication block instances

• The load memory  / work memory (checked only when downloading)

Note

You can also compile and download in one action by simply selecting download
(PLC Download). A dialog box is then opened - "The program was modified and
must first be compiled. Do you want to compile it now and then download it?" If
you click the "Yes" button, the program is first compiled and then downloaded to
the CPU.
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Simulating the Sequential Control System

The valves and motor must be in the "Automatic" mode.
Otherwise, the sequential control system cannot activate and deactivate the
actuators. The operator can control the modes using the operator control and
monitoring system. Here, the automatic mode was set in the initial step of the
sequential control system.

Testing in SFC

You will now change to the test mode to check how the simulated values behave
and whether they behave correctly.

1. Click the "Test Mode On/Off"  button in the SFC editor.

An extra bar is then displayed. In this bar, you can control the test. Below the
chart, there are four new options of which
"Command Output" is already activated.

2. Switch the sequential control system to "CONTINUE"
(menu command Debug > Start/Resume).

The SFC chart is activated. The steps that are currently being executed are
displayed in bright green and a small green arrow at the side of the step points
down.
Transitions that are not yet satisfied are shown on a brown background.

During the test, you can monitor all the steps and transitions. Double-click the
transition that is currently being executed to see how the values of the production
system change.

Testing in CFC

During the test, you can also view the blocks in the CFC charts. Follow the steps
outlined below:

1. Change to the SIMATIC Manager using the task bar of Windows NT and open
the CFC chart "FC111".

The CFC editor is started and the "FC111" chart is opened.

2. Click the "Test Mode On/Off"  button in the CFC editor.

In the sheet view of the corresponding blocks, you can see the current values of
various dosing functions at the outputs, for example on the CTRL_PID or Dose
block.
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Note:
With Windows NT, you can display several windows one beside the other. This allows you
to watch CFC and SFC at the same time in the test mode.

With a multi-VGA graphics card (refer to the PCS 7 catalog), you can connect up to four
monitors to a PC and display the CFC chart on one monitor and the SFC chart on another
and follow them at the same time.

To exit the test mode again, follow the steps outlined below:

3. Deactivate the "Test Mode On/Off"  button.

4. Change to the SFC editor.

5. Deactivate the "Test Mode On/Off"  button.

Note:
Before you insert/delete new interconnections compile charts or download the executable
code to the CPU you must terminate the test mode again.

Caution:
SFC charts are always compiled and downloaded as complete charts. For this reason,
when you download changes to a PLC with active SFC charts, make sure that you first
stop modified SFC charts (or those affected by the modification) so that the process is
brought to a safe state.

When you compile, all the charts (CFC and SFC) of an S7 program are compiled. If you
compile in SFC, the test mode must not be active in CFC. The same restriction also
applies to CFC.

Dynamic Display

In the Test mode, you can display the values of block and chart I/Os dynamically in
a separate window. This is possible for elementary data types (BO, W, R, ...) and
elements of structures.

The dynamic display window can be opened and arranged in the window of the
CFC editor along with any chart windows.  You can adjust the size of the window.
There is only one dynamic display window without a separate menu for all the
charts.

In this window, the values of I/Os of different charts of a CPU can be displayed and
monitored. Time-consuming switching backwards and forwards to compare or
monitor values from different CFC charts is unnecessary. The relevant chart does
not need to be open. The connection to the relevant CPU must be established.

The value display window can be toggled on and off in the CFC Editor with View >
Dynamic Display.
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10 Configuring SIMATIC Connections

Introduction

In larger industrial plants, several PLC systems are used in sections of the plant
and these share the automation tasks. This means that data must be exchanged
between the PLC systems.

This chapter outlines the functions you require to establish a connection.

10.1 Connection Types and Connection Partners

Introduction

Communication connections or simply connections are always required when you
want to exchange data in the user program using certain communication blocks
(SFBs, FBs or FCs).

What is a Connection?

A connection is a logical assignment between two partners who communicate with
each other (for example two SIMATIC stations) that allows communication services
to be executed (for example exchange of process values). A connection specifies
the following:

• The partners involved in the communication

• The type of connection (for example, S7, PtP, FDL or ISO transport
connection)

• Special properties (for example, whether a connection is permanently
established, or whether it is established and terminated dynamically in the user
program; whether status messages will be sent).
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What Happens During the Configuration of Connections?

During the configuration of connections, a unique local identifier is assigned for
each connection known as the "local ID". When assigning parameters to the
communication blocks, only this local ID is required. There is a separate
connection table for each programmable module that can be the end point of a
connection.

Special Feature

STEP 7 automatically assigns a local ID for each end point of the connection if both
communication partners are S7-400 stations or if one partner is an S7-400 and the
other is a SIMATIC PC station.

In this case, you only need to configure the connection in the connection table of a
partner, the other partner then automatically has the matching entry in its
connection table.

10.1.1 Selecting the Type of Connection

The type of connection depends on the subnet and the transmission protocol with
which the connection is established and the automation product family to which the
partners belong.

Which blocks (SFCs, FBs, FCs) you can use depends on the type of connection.
PCS 7 provides the following connection types:

• S7 connection

• S7 connection, fault-tolerant

• Point-to-point link (PtP)

• FMS connection

• FDL connection

• ISO transport connection

• ISO-on-TCP connection

• UDP connection

• E-mail connection

 Note

For further information about the connections you can establish with the various networks,
various station types and blocks and the special properties of the different types of
connections, refer to the online help.
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Selecting the Route Between Subnets

If stations are connected to more than one subnet, STEP 7 selects a route via one
subnet. This means that STEP  7 decided that a particular route or path was more
efficient than another. The order used by STEP 7 is Industrial Ethernet then
Industrial Ethernet/TCP-IP then MPI then PROFIBUS.

Example:

Two stations are interconnected both via MPI and Industrial Ethernet. STEP 7
selects a route via Industrial Ethernet.

On an S7 connection, the user can modify the route automatically set by STEP 7 in
the Properties dialog.

Number of Possible Connections

The number of possible connections that can be entered in the connection table
depends on the resources of the selected module and is monitored by STEP 7.
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10.1.2 Blocks for Different Connection Types

The following table provides you with an overview of the communication blocks
available in PCS 7.

Blocks Available for S7 Connections

 Symbolic name  Brief description

FR_USEND (USEND)
FR_URCV (URCV)

Uncoordinated data exchange via a send and receive SFB. The
blocks form a simple interface to the USEND and URCV blocks
for the user.

FR_BSEND (BSEND)
FR_BRCV (BRCV)

Exchange of blocks of data of variable length between a send
SFB and a receive SFB. The blocks form a simple interface to
the BSEND and BRCV blocks for the user.

SEND_BO (BSEND)
REC_BO (BRCV)

Exchange of up to 128 binary values between a send SFB and a
receive SFB. The blocks form a simple interface to the BSEND
and BRCV blocks for the user.

SEND_R (BSEND)
REC_R (BRCV)

Exchange of up to 32 binary values and 32 real values between
a send SFB and a receive SFB. The blocks form a simple
interface to the BSEND and BRCV blocks for the user.

GET Read data from a remote device

PUT Write data to a remote device

START Run a cold restart on a remote device

STOP Change a remote device to the STOP mode

RESUME Run a warm restart on a remote device

STATUS Check the status of a remote device

USTATUS Receive status messages from remote devices
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Blocks available for Point-to-Point Connections

On point-to-point connections, you can use the SFBs BSEND, BRCV, GET, PUT
and STATUS (refer to the table above). You can also use SFB PRINT:

 Symbolic name  Brief description

PRINT Send data to a printer

Blocks for FMS Connections

 FB  Brief description

READ Read a variable from a remote device

WRITE Write variables to a remote device

IDENTIFY Identifies the remote device to the user

ACCESS Allows coordination of write and read access (disable, enable,
consistent transmission)

OSTATUS
Provides the status of a remote device when queried by the user

REPORT Reports a variable to the remote device

Blocks for FDL, ISO-on-TCP Connections and ISO Transport Connections

 FC  Brief description

FR_AGSEN
(AG-SEND)

Sends data to the communication partner via a configured
connection

FR_AGRCV
(AG-RECV)

Receives data from the communication partner via a configured
connection

 Note

With special connection types, it is possible to select more than one partner (Broadcast and
Multicast services). These options are described in the SIMATIC NET (NCM S7) manuals.
The option of connections to all Broadcast or Multicast nodes is available in the dialog box
in which a new connection is entered.
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10.2 Entering a Connection for the "COLOR_PH" Project

Overview

In this chapter, you will create a new SIMATIC station in the "COLOR_PH" project
and configure a connection between the station already in the project and a new
SIMATIC station.

10.2.1 Communication Using the USEND and URCV Blocks

General

You use the USEND and URCV blocks when you only want to exchange small
amounts of data (a maximum of 4 values per pair of blocks). If you want to
exchange more data, use the FR_AGSEN and FR_AGRCV blocks. With this pair of
blocks, you can exchange up to 240 bytes of data per frame (see Section 10.2.2).

Follow the steps below:

1. Insert a new SIMATIC station as described in Section 4.1.1 "Steps in
Configuration" in the "COLOR_PH" project.

Make the configuration of the new station identical to that of the old station and
make sure that you do not have duplicate "MPI", "PROFIBUS" or "Industrial
Ethernet" node addresses in your project (if in doubt, check with NetPro).

2. Double-click on a "SIMATIC 400" station in your project in the
project navigation window and select the CPU. Start the network view "NetPro"
by double-clicking "Connection" in the right-hand window.

The network view with the SIMATIC stations, the corresponding ET 200 M
distributed I/O systems, the OS station and the networks that exist in your
project are then displayed. The networks that exist in your project depend on
the communications modules you configured in Chapter 4 (hardware
configuration).
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Figure 10-1    Network View of the COLOR_PH Project

3. In this network view, select the module for which you want to create a
connection. In this case, it is the CPU of the SIMATIC 400 (1).

The connection table of the selected module is shown in the lower part of the
network view.

Figure 10-2    Connection Table of the Selected CPU
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4. Double-click an empty row in the connection table or select a row and then
select the menu command "Insert > Connection".

5. Select the required partner in the "New Connection" dialog box. In this case,
select the SIMATIC 400(2).

Figure 10-3    "New Connection" Dialog Box

6. Specify the type of connection as "S7 Connection".

7. Select the "Show Properties dialog box" check box if you want to view or
modify the properties of the connection after clicking "OK" or "Add". The
content of the "Properties..." dialog box depends on the selected connection.

STEP 7 enters the connection in the connection table on the local (in other
words, the selected) node and assigns the local ID and, if necessary, the
partner ID for this connection that you require when programming the
communication function blocks (value for the block parameter "ID").

Figure 10-4    Connection Parameters in the Connection List

You can obtain help about completing the dialogs in the online help.
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8. After configuring a new connection, this must still be downloaded to the CPU of
the stations involved. To do this, select the CPU in a station in which you have
configured the connection, select the newly inserted connection in the
connection table and then select the menu command "PLC > Download >
Selected Connections".

9. Now create a new CFC chart in the plant hierarchy folder "CONN". The name
of the chart could be a reference to the source and destination station (for
example Station_1_2).

 Note

In this example, a USEND and URCV block is used for data transfer since the parameters
to be sent can be interconnected directly to USEND. The USEND is, however, only
suitable for sending very small amounts of data. With FR_USEND or FR_URCV, you can
transfer up to 440 bytes of data. FR_BSEND is used instead of FR_USEND when the
volume of data exceeds 440 bytes, consistency over the entire send data area is not
required permanently, and confirmed transmission is required.

10. Open the chart and insert a USEND block from the "System Function Blocks"
library. With a USEND block, you can send any four values to another CPU. If
you require more values then select FR_BSEND (BSEND). With this block, you
can send a data field with up to 64 Kbytes.

SFB 8 "USEND" sends data to a remote partner SFB of the type "URCV". The
data is sent following a rising edge at the REQ control input. There is no
coordination with the partner SFB. The data to be sent are referenced by the
parameters SD_1, ... SD_4 (it is not necessary for all send parameters to have
a value assigned). You must, however make sure that the areas defined with
the parameters SD_i and RD_i, 1  i  4, match each other in terms of length and
data type (RD_i belongs to the corresponding partner SFB "URCV").
Successful completion of transmission is indicated by the status parameter
DONE having the value 1.

Figure 10-5    CFC Block Structure at the Sending End

Interconnect the block as shown in the schematic. As an example, outputs of
the FC111 controller have been connected to the inputs of USEND.

The rising edge required at the "REQ" input is generated using a "NOT" block
that is interconnected with itself. By installing it in OB32
(processing every second) the USEND has a rising edge at the "REQ" input
every two seconds and sends the data to the destination station.
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Any numeric value can be selected for R_ID, make sure, however that the
corresponding receive block (URCV) has the same value for the "R_ID"
parameter (in the example "10" was selected but has no further significance).
The "ID" parameter has the value from the connection list. In the example the
value "1" was assigned to the connection from "SIMATIC 400 Station(1)" to
"SIMATIC 400 Station(2)" by PCS 7.

11. To be able to fetch the data from the URCV block on the receiving station, you
require a data block or you enter the values in bit memory previously specified
in the symbol table. In the example, a data block is used.
Create the following DB structure in the block folder of SIMATIC Station(2)
(create a new DB => open DB => enter structure => save DB).

Figure 10-6    Example: DB Structure

12. Now create a CFC chart in the new SIMATIC Station(2) to be able to configure
the receive block.

Figure 10-7    CFC Block Structure of the Receiving Block

Input "EN_R" was given the value "1". This means that the block receives data
and passes it on to the addresses interconnected with inputs RD_1 to RD_4.

In the example, the USEND block sends a binary value to the first and second
input and a digital value to the third and fourth input. The structure of the
passed on parameters therefore stipulates first two binary values (type: BOOL)
and then two digital values (type: REAL). To illustrate this, the inputs of DB1
were named BOOL1, BOOL2, REAL1 and REAL2. You can select any names
for the inputs.
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The "ID" parameter must have the value "1" since the connection list specifies
the connection between "SIMATIC 400 Station(1)" and "SIMATIC 400
Station(2)" with ID =1.

The "R_ID" parameter must have the value "10", since this value was selected
for the send block (USEND).

13. After compiling and downloading the charts, you can transfer data between the
SIMATIC stations.

The "ERROR" and "STATUS" outputs provide information about the state of
your connection:

Table 10-1    Error Information for the Communication Blocks (USEND/URCV)

 ERROR  STATUS (decimal)  Explanation

0 9 Overrun warning: Older received data will be
overwritten by newer received data.

0 11 Warning: New job not in effect, since the previous job is
not yet completed.

0 25 Communication was started. The job is currently active.

1 1 • Communications problems, for
example,
connection description not loaded
(local or remote)

• Connection broken down (for
example, cable, CPU turned off, CP in STOP)

1 4 Error in the RD_i receive area pointers (data length or
data type incorrect).

1 10 Access to local user memory not possible (for example
access to deleted DB)

1 12 When the SFB was called:

An instance DB that does not belong to SFB 9 was
specified

No instance DB, but rather a shared DB was specified

No instance DB was found (downloading a new
instance DB from the PG)

1 18 R_ID already exists in the connection ID.

1 19 SFB "USEND" is sending data faster than can be
copied to the receive areas by SFB "URCV".

1 20 Not enough work memory available
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Note:
Data consistency is assured by taking the following steps:

• After the status parameter NDR has changed to 1, you must call SFB 9 "URCV" again
with the value 0 at EN_R. This ensures that the receive area is not overwritten again
before it has been evaluated.

• Evaluate the last used RD_i receive areas completely before releasing the block for
reception again (call with the value 1 at input EN_R).

10.2.2 Communication with the FR_AGSEN and FR_AGRCV Blocks

General

The main feature of communication with the FR_AGSEN and FR_AGRCV blocks is
that they allow data exchange with a maximum of 240 bytes per frame. The
FR_AGSEN and FR_AGRCV blocks represent a simple interface to the FC5
AG_SEND and FC6 AG_RCV blocks for the user. The FC5 and FC6 functions are
already integrated and do not therefore need to be loaded separately.

The blocks send data on PROFIBUS (FDL connection) or Ethernet (ISO or ISO-on-
TCP connection). Data blocks must be used as the data source or data destination.

With FR_AGRCV, the acknowledgment at the operating system level is created
without continuous coordination with the user program. This means that the
acknowledgment of FR_AGSEN also arrives when data could not be entered in the
receiving DB, for example when the receiving CPU is in the STOP mode. The
acknowledgment can be recognized by the signal at CIW changing to 0.

The call in the connection list is the same as for communication with the USEND
and URCV blocks (see Section 10.2.1 steps 1 to 3). To set up communication
using FR_AGSEN and FR_AGRCV, follow the steps outlined below:

Follow the steps below:

14. Double-click an empty row in the connection table or select a row and then
select the menu command "Insert > Connection".

15. Select the required partner in the "New Connection" dialog box. In this case,
select the SIMATIC 400(2).
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Figure 10-8    "New Connection" Dialog Box

16. Specify the type of connection as "ISO transport connection" for
communication via Ethernet, or "FDL connection" for communication via
PROFIBUS.

17. Select the "Show Properties dialog box" check box if you want to view or
modify the properties of the connection after clicking "OK" or "Add". The
content of the "Properties..." dialog box depends on the selected connection.

STEP 7 enters the connection in the connection table on the local (in other
words, the selected) node and assigns the local ID and, if necessary, the
partner ID for this connection that you require when programming the
communication function blocks (value for the block parameter "ID").

Figure 10-9    Connection Parameters in the Connection List

You can obtain help about completing the dialogs in the online help.

18. After configuring a new connection, this must still be downloaded to the CPU of
the stations involved. Select the station in which you configured the connection
and then select the menu command "PLC > Download > Connections and
Network Transitions". Follow the same procedure with the partner station.

19. Create a new CFC chart in the plant hierarchy folder "CONN". The name of the
chart could be a reference to the source and destination station (for example
Station_1_2).



Configuring SIMATIC Connections

Process Control System PCS 7, Configuration Manual
10-14 A5E00122418-01

20. Open the chart and insert a FR_AGSEN block from the "PCS 7 Library /
Communication Blocks" library.

Figure 10-10    FR_AGSEN Block

The LADDR parameter is the module base address of the CP   443-1 (ISO) or
CP 443-5 (FDL) via which the data will be sent. This can be found in the
hardware configuration in the object properties of the CP 443-1 or CP 443-5.
The parameter is only adopted in the first call following a cold restart. Whether
you send on PROFIBUS or on Ethernet is decided with the module base
address in the LADDR parameter (either CP 443-5 (PROFIBUS) or CP 443-
1 (ETHERNET)).

The ID parameter is the connection number that can be found in the
connection programming with NetPro. It is only adopted in the first call
following a cold restart. In the example, the value "0001 A020" was assigned
for the ISO connection of the "SIMATIC 400 Station(1)" to "SIMATIC 400
Station(2)" by PCS 7. In the block, you assign the value "1" to the ID parameter
(and not 0001 A020).

The start address of the data to be sent is specified by DB_S (data block
number) and AD_S (start address in the send DB in bytes), the length of the
data field in bytes is specified by LE_S. In the example, the data to be sent are
read from data block 2 starting at relative address 0 in the data block. A total of
6 bytes are read from the DB and transferred to FR_AGRCV.

Transmission is activated by calling the block with value 1 at the COM input. If
the COM input has the value 1 permanently, a new job is started immediately
on completion of the send job.

21. Now create a CFC chart in the newly created SIMATIC Station(2) to be able to
configure the receive block.
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Figure 10-11    FR_AGRCV Block

The "LADDR" input was given the value 512 (this is automatically converted to 200
hex.). It contains the start address of the CP 443-1 or CP 443-5. You can obtain
this address in the hardware configuration from the object properties of the CP
443-1 or CP 443-5.

For the ISO connection in this example, the "ID" parameter must have the value
"1", since the connection between the "SIMATIC 400 Station(1)" and the "SIMATIC
400 Station(2)" was specified with this ID in the connection list (see also
FR_AGSEN).

The "DB_R" parameter was assigned the value "1" and the "AD_R" parameter was
assigned the value "0". This means that FR_AGRCV enters its received values in
data block "1" starting at relative address 0.

22. After compiling and downloading the charts, you can transfer data between the
stations.

The ERR (Error) and STAT (Status) outputs indicate specific error information
corresponding to FC5/FC6. If an error occurs, a new job with the current data
is triggered automatically until the transfer is successful. For the meaning of
the error information, refer to the online help of FR_AGRCV.

Note:
You can only establish one connection with FR_AGSEN and FR_AGRCV in one CPU with
one ID. If you require further connections using FR_AGSEN and FR_AGRCV, you must
create a new ID (in other words a new connection) in the connection list.
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10.2.3 Creating a Shared Data Block

General

For certain applications, you require a shared data block (for example to store
values received from another PLC). The following section shows how to create a
shared data block.

1. Open the "Blocks" folder of the "COLOR_PH" project in the component view
and insert a new data block (Insert > S7 Block > Data Block).

2. Give the data block a name, for example "DB2" and exit the dialog with the
"OK" button.

Figure 10-12    Properties Dialog for Data Blocks
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The data block is created in the block folder.

3. Open the data block by double-clicking it and specify "DB editor" as the
programming tool and select "Data block".

Figure 10-13    Setting the Programming Tool

Close the dialog with the "OK" button.

4. You obtain a new, empty DB. Now enter the following data structure. You
obtain new lines with the menu command "Insert > Declaration Line).

Figure 10-14    DB Structure for the Communication Examples
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11 Configuring Operator Stations

Introduction

This chapter contains information about how to configure operator stations (OS)
and the best order in which to configure them. The basics of the editors (for
example the Picture Tree Manager, User Administrator etc.) are also explained.
You will also create user data (pictures, archive etc.) for the "COLOR_PH" project.

11.1 Order for Configuring

Overview

You create the visualization, message and log data in the following steps:
• Create an operator station in the current project in the component view of the

SIMATIC Manager (you already did this in Chapter 5)
• Run the Split Screen Wizard and Alarm Logging Wizard (Base Data)
• Create graphics in the technological hierarchy
• Include OR logic for alarms and group displays in the pictures
• Create commonly used object groups in faceplates
• Copy faceplates into graphics
• Connect dynamic objects with tags
• Assign pictures in the Picture Tree Manager (if this has not already been done

automatically based on the plant hierarchy)
• Assign access rights in the User Administrator
• Create trends / table archives and templates
• Make project-specific settings in Alarm Logging
• Insert application windows in graphics
• Create print jobs in the Report Designer
• If necessary, make settings in the "Storage" editor
• If necessary, make settings in the "Redundancy" editor
• If necessary, create C actions with Global Script
• Activate Time Synchronization and Lifebeat Monitoring
• Download the project from the ES computer to the OS computer

The WinCC Explorer represents the highest level within the operator station. All
editors are started from here.
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11.2 Base Data

Overview

In the Base Data" editor, you will find the "Split Screen Wizard" and "Alarm Logging
Wizard" applications. The wizards adopt the basic settings of your operator station
and create data (base data) that you can use as the basis for further configuration.

Note
Operation on an OS is only possible when the Microsoft Internet Explorer 5.0 in installed (a
minimum installation is adequate). If you use the "typical" installation method, no further
settings are necessary.

Caution
In PCS 7, no blank is permitted in the computer name. You can check and edit the
computer name in "Start > Settings > Control Panel > Network > Computer Name".

Starting the Split Screen Wizard is necessary at the beginning of a new
PCS 7 project since the Split Screen Runtime requires data created by the
wizard.

11.2.1 Split Screen Wizard

Using the wizard, you configure and initialize the following monitor and display
setting in the current project:

• Screen resolution (for example 1280 x 1024)

• The number and configuration of the monitors in an OS; a multi-VGA graphics
card allows up to four monitors to be connected to one PC. An arrangement of
four monitors in series is possible only at a maximum screen resolution of 1024
x 768.

• Overwriting pictures and scripts
If you have already run the wizard, you can specify whether or not pictures and
scripts will be regenerated by selecting or deselecting the "Overwrite Pictures"
and "Overwrite Scripts" check boxes. If, for example, you have edited pictures
or scripts manually, deactivate both check boxes otherwise the pictures and
scripts will be recreated and your modifications will be overwritten.

In server/client configurations, you must run the Split Screen Wizard on the server
and on the client. If you add a further PC (client) to a multiple workstation system,
the Split Screen Wizard must be started again on the server. The settings for the
multi-VGA monitor configuration must be uniform for the project.
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11.2.2 Alarm Logging Wizard

With the Alarm Logging Wizard, you set the Alarm Logging to conform with PCS 7
and create the required base data. Previously configured data belonging to the
message system are read in and adopted when the Alarm Logging Wizard is
started. The Alarm Logging Wizard performs the following tasks:

• Creates various message windows (for example new list, old list, process
control system list etc.) with different properties for the toolbar, the status bar
and the message filter.

• Message attributes
Message classes (acknowledgment method, horn, names for various states)
and message types (colors for various states, ...)

• Audible indicator connection
In a check box, you can decide whether WinCC provides messages for the
signal module. The PC signal module outputs electrical signals when WinCC
messages are received to generate optical and acoustic signals.

• A continuous archive or short-term archive is created.

• Generating system messages

11.2.3 Generating the Basic Data for the COLOR_PH Project

You configure the structure of the PLC and the OS on the engineering station.
Following this, an OS must then be inserted in the "COLOR_PH" project. A
SIMATIC PC station was included in the project in the "Configuring Networks"
chapter. If you have already created the SIMATIC PC station in the project, you
can skip this section.

In the COLOR_PH project, insert the OS in a SIMATIC PC station. This means that
the OS already has an address in the network configuration and avoids double
assignment of addresses. Follow the steps outlined below:

1. Select the component view of the "COLOR_PH" project.

2. Right-click the project folder (for example "COLOR_PH").

3. Select "Insert New Object > SIMATIC PC Station" in the context-sensitive
menu.

The station is created in your project.

4. Click on the newly created station with the right mouse button and select
"Open Object".

5. Click on the "+" in front of "SIMATIC PC Station" in the hardware catalog (if
the catalog is not visible, select "View > Catalog").

6. Click on the "+" in front of "CP" and drag the required CP (for example a CP
1613 for Industrial Ethernet or for BCE > IE General) to the first slot in your
SIMATIC PC station.

7. In the dialog that is displayed "Properties - Ethernet Interface
Communications Card", select the MAC address you require and a subnet or
if necessary create a new subnet.
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8. Exit the CP properties dialog with the OK button.

9. Open the "HMI" folder in the SIMATIC PC Station in the hardware catalog and
drag "WinCC Application" to the second slot of your SIMATIC PC station.

10. Close the "Properties of WinCC Application " dialog with OK.

11. Save the station "Station > Save " and close hardware configuration with
"Station > Exit".

The OS is inserted in the COLOR_PH project.

Make the Assignments to the OS

The pictures and reports that you insert in your project in the plant hierarchy must
be assigned to an OS. By assigning a folder of the plant hierarchy to an OS all the
pictures and reports that you insert in this folder are also assigned to this OS. If you
also select the option "Pass on selected assignment to all underlying objects",
all the objects contained in nested hierarchy folders are also assigned to this OS.

Follow the steps outlined below:

1. Open the plant hierarchy of the "COLOR_PH" project.

2. Select the hierarchy folder "Plant1".

3. Select the "Edit > Object Properties" menu command.

4. Select the "PLC and OS Assignment" tab.

5. In the combo box "Assigned OS:" select "OS(1)".

6. Click the check box "Pass on selected assignment to the lower-level objects".

7. Close the properties of the hierarchy folder with the "OK" button.
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Setting Base Data

Before you start to configure a PCS 7 OS station, you must set the base data (see
also Section 11.2). Follow the steps outlined below:

1. Select the OS within the SIMATIC PC station in the component view of the
SIMATIC Manager and select the menu command "Edit > Open Object".

2. After a brief wait, the WinCC Explorer appears.

3. Double-click Base Data and then run the "Split Screen Wizard" (select the
Split Screen Wizard > right mouse button > Open). Set the required screen
resolution in the Split Screen Wizard. You can also simply accept the defaults
of the wizard.

Note

The screen resolution depends on the maximum possible resolution of the
monitor and must match the resolution set in the "Settings" tab in "Start >
Settings > Control Panel > Display".

4. Run the Alarm Logging Wizard. In the first dialog window, select the "Signal
Module Connection" check box so that you can later connect a signal module
for outputting horn signals for alarms, warnings etc. Otherwise, accept the
defaults of the wizard. A message box with the message "During area-specific
filtering, some messages might not be displayed due to inconsistent
configuration data" is displayed. For the meaning of this message, refer to the
section "Relationship between OS area identifier, base picture hierarchy on the
plant hierarchy, and message display in WinCC RT" (see below). Close this
window with the OK button.

Relationship between OS area identifier, base picture hierarchy on the plant
hierarchy, and message display in WinCC RT

When you run the Alarm Logging Wizard, a message is displayed "During area-
specific filtering, some messages might not be displayed due to inconsistent
configuration data". The reason for this message is as follows:

The OS area identifiers are displayed and where appropriate also configured in the
SIMATIC Manager within the plant hierarchy (object properties of the Hierarchy
Folder > Control and Monitoring Attributes > OS area ID). In the settings for the
plant hierarchy, you specify a level relevant for the "Base picture hierarchy on the
plant hierarchy" function. If you select the "Base picture hierarchy on the plant
hierarchy" function (select the check box), the OS area ID for this and all lower
levels is automatically derived from the plant hierarchy.

When you transfer the PLC-OS connection data, the hierarchy is stored according
to the settings made in the Picture Tree Manager of the OS. The OS area ID is
stored in Alarm Logging in the user text block "Area". During run-time, this text
block appears in the "Area" message window column.

If you now select the "Filter messages area-specific" in the Alarm Logging Wizard,
messages will only be displayed during run-time when:
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• the current user has the required rights for this area (user administrator)

• and the upper hierarchy level of the Picture Tree Manager matches the areas
of the "Area" user text block

• or the area ID in the "Area" user text block is empty.

Caution
If the OS area identifier is modified by the user in the plant hierarchy and the "Base picture
hierarchy on the plant hierarchy" function is deactivated (property in the plant hierarchy),
messages can no longer be displayed in run time if the "Filter messages area-specific"
function is selected (in the Alarm Logging Wizard).

You have now created the base data for the COLOR_PH project.
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11.3 Tag Browser

Overview

OS objects (for example I/O boxes, faceplates, archive variables) are linked to tags
during configuration of the OS with which the objects are updated in run time.
The tag browser integrated in the OS provides information about existing tags and
therefore allows them to be connected to OS objects.

OS-relevant process variables can originate from SFC charts, blocks in CFC
charts, instance data blocks and shared data blocks. It is also possible to assign
symbolic names to process variables in the symbol table. This information is also
provided by the tag browser. The variables of the data manager (management of
the tags located on the OS) are also displayed.

During configuration, you can select between three data sources;

• Process variables from STEP 7 (SFC charts, CFC charts etc.)

• Process variables with a symbolic name from the symbol table

• Variables (tags) from the data manager of the OS

Figure 11-1 Tag Browser

If necessary, the configuration engineer can trigger an update function to update
the information on the displayed tags. This update function can relate to all tags or
only to the currently selected group of tags.

The update function is started with the    button.
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Linking Objects to a Tag by Dragging the Tag Name

In the Graphics Designer, you can display the tag browser like a toolbar (View >
Toolbars) and can link objects with the tag names by selecting a tag name and
dragging it to the required object.

Figure 11-2    Tag Browser Visible in the Graphics Designer

Setting filters

Using the "Filter:" text box, you can specify a search condition for tag names. If
you exit the box with the tab key, only the tags that correspond to the search
criterion are displayed.

In the following section, you will use the Tag Browser for the first time to connect
the process picture tags.
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11.4 Creating Process Pictures

Overview

Process pictures represent the plant for the operator. Here, the operator can enter
commands and display plant statuses.

You insert new process pictures in a hierarchy folder in the plant hierarchy. By
assigning the folder to an OS (object properties of the hierarchy folder) the picture
is automatically created in the corresponding OS. The technological relationship is
simulated using the plant hierarchy.

A double-click opens the picture and you can insert the required static and dynamic
elements. The Graphics Designer with the required tools is opened automatically.

Note
By clicking "View > Library" in the picture, you will find a large selection of ready-made
graphic symbols (for example, piping, valves etc.). You can modify or add to these
symbols and store them in your own project libraries. These libraries are then available
when you are working in any graphic.

For a description of the Graphics Designer, refer to the "SIMATIC HMI WinCC Volume 2/2"
manual or the online help.

Including Status Displays

The status display is used to display any number of different statuses of an object.
This display is updated dynamically by connecting a tag whose value corresponds
to the particular status. You can assign any number from 0 to 2 32 -1 (bit
combination).

The status can include gaps (1,2,5,6 etc.). Statuses for which no pictures were
assigned are possible but these can be removed with "Clean List".

When displaying in run time, note the following situations:

• If no picture was configured for a status, a default picture is displayed in run
time.

• If a status occurs in run time that was not configured, the pictures of the next
status down are displayed. If there is no lower status, the next higher status is
displayed.
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Including Faceplates

A faceplate is a dynamic object consisting of several tags. By connecting to a
structure tag, all the tags in a faceplate are automatically connected to the relevant
block parameters and dynamically updated (see also Tips & Tricks for the operator
station).

PCS 7 provides you with faceplates for various block types of the PCS 7  libraries
(for example CTRL_PID, MEAS_MON etc.).

Including User Objects

A user object is produced by grouping objects together ("Edit" - "User Object"
menu command). In contrast to group objects (grouping of individual objects) in
which the properties of all the graphic objects in the group are visible and can be
interconnected in the properties box, in a user object, you can only select a subset
of the properties and interconnect them to the user interface. You make the
selection in the configuration dialog of the user object.

If you configure user objects with their own separate processing (for example C
scripts) you can produce intelligent objects that are easy to handle (copy, insert,
interconnect, etc.).

You can configure the user object (object type and attributes) as being language-
dependent. The languages installed in WinCC are available.

User objects can be modified at any time and also have further objects added.
Refer to the information on user objects in the FAQs. The Internet address for the
FAQs is listed in the Preface.

Including C Actions

You use C actions to assign certain properties to an object in your process picture.
You could, for example, specify the color of an analog value using a C action
dependent on a tag.

A C action results from performing a logic operation on an event (for example in a
binary tag) with a function formulated in ANSI-C and that is processed when the
event occurs or cyclically. Normally, you logically combine a C action directly with
the property of an object that will also be influenced by the action.

Caution

If you use large numbers of actions or extensive actions, you must expect a high
system load, that may adversely affect picture call times in run time.

Move cyclic calculations to the PLC and do not execute them on the OS!



Configuring Operator Stations

Process Control System PCS 7, Configuration Manual
A5E00122418-01 11-11

11.4.1 Configuring Process Pictures for the COLOR_PH Project

Your process pictures should have a plant assignment and be transferred
automatically from the plant hierarchy to the picture hierarchy. To allow this, insert
your process pictures in the folders of the plant hierarchy. Follow the steps outlined
below:

1. Activate the "Plant View" of the project and select the folder "RMT1".

2. Select the menu command "Insert > Technological Objects > Picture".

The picture is inserted with a default name.

3. Rename the picture "RMT1". This picture will later show you the raw material
store unit of the "COLOR_PH" project.

Note

If you base the picture hierarchy in the OS on the plant hierarchy as illustrated in
this manual, there must only be one picture in a hierarchy folder.

The process picture is now defined and you can start to configure the pictures. This
manual explains the configuration of the pictures only in outline by listing the
essential steps. For more detailed instructions on creating the RMT1 picture, refer
to the PCS 7 Getting Started manual.

Configuring the Process Pictures

You configure the process pictures in the WinCC Explorer in the "Graphics
Designer" editor. Follow the steps outlined below:

1. Double-click the picture "RMT1".

The WinCC Explorer of the OS is opened in the background. After a brief time,
the Graphics Designer is opened and displays the current picture "RMT1".

2. Enter the static picture elements from the library by dragging them with the
mouse ("View > Library").

Table 11-1    Assignment Table: Static Picture Elements in the Library

 Element  Path in the Library

Tank Global Library/Plant Elements/Tanks/Tank 4

Pipe Global Library/Plant Elements/Pipes/...
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Configuring the Status Displays

Create a status display for the valves "NK111" and "NK112" with two alternatives
(vertical), and a status display for valves "NK113" and "NK114" with two
alternatives (horizontal) and a further status display for the pump with two
alternatives.

Figure 11-3 Example: Horizontal Status Display (NK113 and NK 114)

There are two parts to creating a status display. In the first part, the symbols of the
individual alternatives are created (if they do not already exist from another source)
and in the second part the status display is configured.

Creating the Symbols for the Alternatives in the Status Displays

1. Open a new picture in the graphics designer and call it Status.pdl and create
the static boxes for Alternative 0 and Alternative 1.

2. Open a lasso around Alternative 0, group the objects and export ("File >
Export") the alternative in the emf format to the file "valve_v1_h_0" (valve,
Version 1, position horizontal, Alternative 0).

3. Open a lasso around Alternative 1, group the objects and export the alternative
in the emf format to the file "valve_v1_h_1".

Configuring the Status Display in the Process Picture

1. Open the process picture in which you want to include the status display
(RMT1.PDL). Take the "Status Display" object (Object Palette/Smart Objects)
and link it with the "QOPENED" parameter of the valve block ("Variable" list
box in the "Status Display Configuration" dialog box; for example valve block in
the CFC chart "NK 113").

2. Add Status 1 to the status display (click the "Add" button in the "Status
Display Configuration" dialog box).

3. Assign the file "valve_v1_h_0" to the basic picture of Status 0
 and the file "valve_v1_h_1" to the basic picture of Status 1.

4. Close the configuration of the status display.

5. Interconnect the status displays for the valves with the output "QOPENED" of
the VALVE block and the status display of the pump with the output "QRUN" of
the MOTOR block .

Alternative 0

Alternative 1

Color: red

Color: green
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Including the I/O Fields

1. Place an I/O field beside the valve FC 111 (Object Palette/Smart Objects) that
you interconnect with the output "LMNR_IN" of the CTRL_PID block in the "FC
111" chart. You can then control the position of the valve in runtime.

2. To input the required dosing volume (setpoint) and to check the actual volume
dosed (actual value), you require two further I/O fields that should be located
using the procedure described above beside the pipe to Reactor 2 (see Figure
11-4). Connect the setpoint with the tag Plant1/RMT1/DOSE_PARA/
PARA_DOS_RM1_ VOL.U and the actual value with Plant1/RMT1/FC111/
DOSE.PV_OUT. The default for the I/O fields is 3 places. According to the
settings, however, you dose 5000 liters (4 figures). Change the properties of
the two I/O fields accordingly.

3. Place an I/O field beside the valve NK 112. Interconnect this I/O field with the
parameter "I0"of the OP_D block "PARA_DOS_RM1_SEL". With this I/O field,
you can decide which reactor (1 or 2) will be filled (value 1 > fill tank 1; value 0
> fill tank 2).
Create all the other objects required using the static picture elements and text
fields and arrange the objects as shown in Figure 11-4.

Figure 11-4 Process Picture of Unit 1 ("COLOR_PH" Project)
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4. The tank you have inserted in your picture is raw material tank 1.
You now connect this tank with the block "Plant1/RMT1/LI111/ MEAS_MON.U
on the SIMATIC station. This provides you with the current level of the tank.

5. Save the picture with File > Save.

In the next section, you will insert the required faceplates in the "RMT1" process
picture. For this, you require two PCS 7 wizards. The PCS 7 wizards are explained
at the beginning of the next section.
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11.5 PCS 7 Wizards

General

On the OS, you have a number of wizards available (utilities for solving complex
tasks). This section introduces the special wizards only available in PCS 7.

You will find the wizards described in the Graphics Designer normally in the
"Dynamic Wizard" palette. If the dynamic wizard is not visible, you can display it
with the menu command View > Toolbars... > Dynamic Wizard".

You start the wizards by double clicking the name of the wizard in the Dynamic
Wizard palette.

11.5.1 Linking a Faceplate with a Tag

This wizard is displayed in the "Standard Dynamics" tab when you have selected
a faceplate. With this wizard, a faceplate is linked to the corresponding PCS 7 tag.
Follow the steps outlined below:

1. Start the wizard in the "Standard Dynamics" tab.

The window "Welcome to the Dynamic Wizard" is displayed with an overview
of the necessary steps. You can deselect this window with a check box so that
it no longer appears when the wizard is started.

Exit the first dialog page with "Next".

2. Browse through the tag management to the tag you want to connect ("..."
button) and select the required tag.

Figure 11-5 Step for Selecting the Tag.

If, for example, you have a faceplate of the type "CTRL_PID", only the tags
relevant to you and belonging to a CTRL_PID block on the PLC are displayed.
In the "Finished" step, the settings you have made are displayed again.
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11.5.2 Picture Selection via Measurement Point

In run time, you have the option of opening a faceplate by clicking any object. This
wizard that is displayed in the "Picture Functions" tab links a faceplate with a
corresponding structure tag and inserts the faceplate calls in any object. Follow the
steps outlined below:

1. Start the wizard in the "Picture Functions" tab.

The window "Welcome to the Dynamic Wizard" is displayed with an overview
of the necessary steps. You can deselect this window with a check box so that
it no longer appears when the wizard is started.

Exit the first dialog page with "Next".

2. Specify how you want to call the faceplate during run time. You have the
choice between holding down the "left mouse button" or "right mouse
button" on the object or "mouse click" with the right mouse button on the
object.

Figure 11-6 Step for Selecting the Operation

3. In step three, you select the structure type that will be linked to the faceplate
you want to open in step 4. If you want to open a faceplate of the type
"CTRL_PID" select the structure type "CTRL_PID".
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Figure 11-7 Selecting the Structure Type

4. Now select the tag structure to be linked to the faceplate as described in
section 11.5.1. Here, you also specify the way in which the faceplate is
displayed after the call in run time. You have three possibilities:

• Loop display in the work area
The loop display of a faceplate is displayed in the work area. It is not possible
to move the faceplate.

• Loop display in the process window
The loop display of the faceplate is displayed is the process window. It is
possible to move and close the faceplate in the work area.

• Group display
The faceplate is displayed in the process window. It is possible to move and
close the faceplate in the process window.

Figure 11-8 Selecting the Measuring Point and the Display

5. In the "Finished" step, the settings you have made are displayed again.
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11.5.3 Connect Group Display to PCS 7 Tag Structure

This wizard is displayed in the "Standard Dynamics" tab when you have selected
a group display. With this wizard, a group display is linked to the corresponding
PCS 7 tag. Process messages from the blocks on the PLC are visualized on the
OS. Follow the steps outlined below:

1. Start the wizard in the "Standard Dynamics" tab.
The window "Welcome to the Dynamic Wizard" is displayed with an overview
of the necessary steps. You can deselect this window with a check box so that
it no longer appears when the wizard is started.

Exit the first dialog page with "Next".

2. Browse through the tag management to the tag you want to connect ("..."
button) and select the required tag.

Figure 11-9 Step for Selecting the Tag.

3. In the "Finished" step, the settings you have made are displayed again.
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11.5.4 Connect Group Display with Picture

This wizard is displayed in the "Standard Dynamics" tab when you have selected
a group display. With this wizard, a group display can be linked to a picture. All the
processed messages of this picture are ORed and displayed by the group display.
Follow the steps outlined below:

1. Start the wizard in the "Standard Dynamics" tab.

The window "Welcome to the Dynamic Wizard" is displayed with an overview
of the necessary steps. You can deselect this window with a check box so that
it no longer appears when the wizard is started.

Exit the first dialog page with "Next".

Browse through the Graphics Designer to find the picture you want to connect
("..." button) and select the required picture.

Figure 11-10 Step for Selecting the Picture

2. In the "Finished" step, the settings you have made are displayed again.

11.5.5 Picture Exchange by Group Signal

This wizard is displayed in the "Picture Functions" tab when you have selected a
group display. With this wizard, the picture from which process messages are
collected is called by triggering it in the group display in run time. Follow the steps
outlined below:

1. Start the wizard in the "Picture Functions" tab.

The window "Welcome to the Dynamic Wizard" is displayed with an overview
of the necessary steps. You can deselect this window with a check box so that
it no longer appears when the wizard is started.

Exit the first dialog page with "Next".

2. Specify how you want to start the picture in run time. You have the choice
between holding down the "left mouse button" or "right mouse button" on
the group display or "mouse click" with the right mouse button on the group
display.
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Figure 11-11 Step for Selecting the Operation

3. In the "Finished" step, the settings you have made are displayed again.

11.5.6 Displaying the Faceplates for the COLOR_PH Project

The next stage is to insert a faceplate for each of the four valves ((NK 111 to NK
114) for the controller (FC111) and for the pump. Later, while the simulation is
active, these faceplates will display the properties and states of the valves, the
controller and the pump. Follow the steps outlined below:

1. Select Control in the Smart Objects of the Object Palette and then open a
field (approximately 3 cm wide and 1 cm high) while holding down the mouse
button to the right of the valve NK111.

2. From the list, select PCS7 VALVE Control and click OK.

This specifies the type of faceplate (VALVE).

The control field is still selected.

3. Move the Dynamic Wizard palette to your graphic (by double-clicking the
"Dynamic Wizard" label in the header of the palette).

If the Dynamic Wizard palette is not visible, select the menu command View >
Toolbars and click the Dynamic Wizard option.

4. Enlarge the window of the Dynamic Wizard in the process picture (mouse
pointer on the edge of the window, hold down the left mouse button and drag)
and select the Standard Dynamics tab in the Dynamic Wizard window.

5. Double-click Connect picture block to tag structure.

6. Click Next and in the next dialog, click the button beside the empty box so that
you can select the valve block directly.

7. Select the valve block Plant1/RMT1/NK111/Valve and click OK.

8. In the Set Options dialog box, click Next and in the next dialog box click
Finish.

The faceplate is now connected to the correct valve block. Now arrange the display
to suit your purposes. Follow the steps outlined below:



Configuring Operator Stations

Process Control System PCS 7, Configuration Manual
A5E00122418-01 11-21

9. Double-click the faceplate and select the "Symbol" tab in the "PCS 7 Control
Properties".

10. Set the length of the faceplate to "110" (field Width:) and the height of the
faceplate to "50" (Height:field).

11. Double-click the text "visible" after the "Tag Name". The text "invisible" then
appears and the tag name appears only during run-time. Exit the Properties
dialog with the OK button.

Note
The next faceplates are inserted in exactly the same way. When inserting the other
faceplates you will not learn anything new, however you will have the opportunity to
practice inserting faceplates. If you do not need any practice, you can move on to the next
chapter.

Insert the next OLE controls following the same steps outlined above but at the
following positions and with the following connections.

Table 11-2 Positions and Connections of the Faceplates

 Position  Control Type  Connection

To the right of valve NP111 PCS7 MOTOR Control Plant1/RMT1/NP111/
MOTOR

To the right of valve FC 111 PCS7 CTRL_PID Control Plant1/RMT1/FC111/
CTRL_PID

To the right of valve NK112 PCS7 VALVE Control Plant1/RMT1/NK112/
VALVE

Above valve NK 113 PCS7 VALVE Control Plant1/RMT1/NK113/
VALVE

Above valve NK 114 PCS7 VALVE Control Plant1/RMT1/NK114/
VALVE

Your pictures are now complete. You can save the picture RMT1 and close the
Graphics Designer.
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11.6 Picture Tree Manager

Overview
The Picture Tree Manager is used to manage a hierarchy of plants, units and
pictures. Using the Picture Tree Manager, you can create and modify the hierarchy
of the project. It supports the assignment of pictures to plants or units and creates
an assignment between the plants or units and pictures created in the Graphics
Designer It supports picture selection during run time by allowing you to navigate
through the hierarchical tree.

The hierarchy can, in some cases, have effects on the group display. The objects
of the group display can only receive messages and pass them on when these
pictures are arranged appropriately in the hierarchy.

Note

The Picture Tree Manager is described in the "SIMATIC HMI WinCC Basic
Process Control" manual and in the online help.

11.6.1 Basing the Picture Hierarchy on the Plant Hierarchy

In PCS 7, you can base the picture hierarchy completely on the configured data
from the plant hierarchy. When the picture hierarchy is transferred to the OS, any
picture hierarchy configured in WinCC with the Picture Tree Manager is deleted
and overwritten by the data created in the SIMATIC Manager.

This option is set as a default in the plant hierarchy. However, to allow you to
continue to work in the Picture Tree Manager, the function can be disabled (see
also section 6.3).

Example of a Picture Hierarchy

Overview

Key set

Overview

Key set

Overview

Key set

Overview

Key set

Overview

Key set

Overview

Key set

Area 1

Overview

Key set

Area 12

Plant overview

Figure 11-12Picture Hierarchy with the Picture Tree Manager
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11.6.2 Configuring the Picture Hierarchy for the COLOR_PH Project

In the COLOR_PH project, you have based the picture hierarchy on the plant
hierarchy (see also Chapter 6 Plant Hierarchy). This means that you do not need
any further configuration in the Picture Tree Manager.

Caution

Modifications in process pictures that are relevant to group displays (see also
Section 11.8) must be made known to the Picture Tree Manager. If such
modifications are not made known, the group displays and displays to the right
beside the areas of the overview (for example to the right of "RMT1") will not be
displayed correctly.

You inserted faceplates in the "RMT1" process picture. These are relevant for
group displays since alarms, warnings, and problems of the corresponding block
are evaluated and displayed. Follow the steps outlined below:

1. Right-click the Picture Tree Manager in the WinCC Explorer.

2. Select Open in the context-sensitive menu.

3. Select Project > Save.

4. Close the Picture Tree Manager with Project > Exit.

You have now updated the tags required internally and the dynamic displays in the
project will be correct.

Note

Make sure that any picture you are currently editing in the Graphics Designer is
saved before you call the Picture Tree Manager. The Picture Tree Manager
accesses the Graphics Designer when it saves a project. If the Graphics
Designer still has an unsaved picture, it waits until this picture is saved or
discarded by the user (message in the Graphics Designer).
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11.7 Setting up the User Administrator

Overview

In the User Administrator, you assign authorization levels for users (operators) that
allows them to use certain functions in the run time system. For example, user A
can only use the "picture change" function while user B can intervene in the
process. You can also create your own authorization levels in the User
Administrator

If the user logs on with the run-time system and the appropriate pass word (key
button in the run-time key set) the authorization levels assigned to the operator are
checked and the project areas with this authorization level are released.

Connection to the Picture Tree Manager

When new containers are created in the Picture Tree Manager, there is no
information in the User Administrator about user rights. After saving the hierarchy
in the Picture Tree Manager, these new plant sections are available in the User
Administrator and can be assigned user rights. Containers removed from the
hierarchy are also deleted in the User Administrator. When you delete these
containers, all the information about the containers is also lost in the User
Administrator. If you move objects within the hierarchy, this does not affect the
User Administrator.

11.7.1 Chip Card Reader

The chip card for user rights extends the functionality of the User Administrator.
During run time, the operator enters the chip card in the reader and is therefore
automatically logged into the system with the user rights saved on the chip card.

The functionality of the chip card reader along with the functionality of logging in
with a suitable password can be used on the operator station.

Note
The User Administrator is described in the "SIMATIC HMI WinCC Volume 1/2" manual and
in the online help.
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11.7.2 Creating Users for the COLOR_PH Project

This section explains how to create a user for the COLOR_PH project. Follow the
steps outlined below:

1. Right-click the User Administrator in the WinCC Explorer.

2. Select Open in the context-sensitive menu.

3. In the Administrator, select User > Add User.

4. A dialog is opened in which you can enter the required Login, password and
the password verification. In the Login box, you could, for example, enter the
name of the operator.

5. To enter the information, click the OK button.

6. Enable all functions for the new user (double-click the cell in the Authorization
column after the function).

7. Exit the Administrator with File > Exit.

In the "Authorization" column, you can enable a function for all areas (here only
RMT1). You can enable a function (for example process controlling) for one or
more areas by double-clicking in the column of the required area. This would mean
that the user (operator) is only authorized for process controlling in some of the
areas.

After you start run time, a dialog is displayed in which you enter the Login and
corresponding password. Operation is then enabled.
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11.8 Group Displays

Overview

To guide the operator on the OS, a picture hierarchy is required that guides the
operator to the pictures in which danger states (for example alarms) are displayed.
The picture hierarchy is created with the Picture Tree Manager. The operator is
guided to the picture in which the dangerous situation is displayed by means of
group displays. Here, there are two possible situations:

• A block on the PLC is source of the group display.

• Logic for all displays of the underlying picture is the source of the group
display.

The display of the message types by the group display object takes the form of four
display areas arranged side by side and indicated by color, flashing and text. The
default colors and flashing modes in the object are those typical in process
engineering. The following types of message are available:

• 1st display area
Alarm High, Alarm Low

• 2nd display area
Warning High, Warning Low, Tolerance High, Tolerance Low

• 3rd display area:
PLC process control problem, PLC process control fault, OS process control
problem

• 4th display area:
Operator prompt

Block is the Source of the Group Display

Group displays of group-relevant blocks are inserted into a picture via a direct
interconnection between the block status information and the group display. The
interconnection is made with the dynamic wizard "Connect Group Display to PCS 7
Tag Structure" (Standard Dynamics) in the Graphics Designer.

SIMATIC
stations

Process picture

A W S O

Group display

Overview

Key set

Source is a
block, e.g.
CTRL_PID

Figure 11-13Group Display Derived from a Block
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Nested Picture is the Source of the Group Display.

All group displays from a nested picture are logically combined via OR logic in the
picture directly above the nested picture in the hierarchy. The interconnection is
made with the dynamic wizard "Connect group display with picture" (standard
dynamics) in the Graphics Designer. If the operator clicks the group display, the
relevant picture is opened directly. To allow this functionality, the dynamic wizard
"Picture selection via group display" (picture functions) is required that itself is run
when a group display is selected in the graphics designer.
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Group
display
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Key set
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Group
display
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Key set
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Key set

A W S O

A W S O

A W S O

Overview

Key set

Figure 11-14Group Display of Nested Pictures

Considerations relating to the group display and the faceplate

The display of the message types with a block as source can be implemented as a
group display or as a faceplate (symbolic representation integrated in the picture).

The operator recognizes no difference in the display if there are no additional bit
maps shown in the symbolic display of the faceplate (optional). By clicking the
symbol during run time on the OS, the relevant group display of the block specified
as the source is called. You can also achieve this functionality by running the
"Picture selection via measurement point" wizard while the group display is
selected.

The major advantage of the group display compared with the faceplate is
performance. When a process picture is activated in run time, faceplates require
more time than group displays before they are displayed. One reason for this is the
implementation of the faceplates as Windows "OCX" objects. If you use a large
number of faceplates in a picture (more than 10), you should select a group display
to visualize the message types rather than a faceplate. This achieves faster picture
display times.

In the COLOR_PH project, the faceplate was selected (less than 10 per picture).
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11.9 Tag Logging (trend display)

Overview

With Tag Logging, you can display and archive measured values on the operator
station in the form of trends or tables.

Note

Tag Logging is described in detail in the "SIMATIC HMI WinCC Volume 2/2"
manual and in the online help.

You can create trends both in the configuration system and in run time. You
configure the display of the trends or tags in the configuration system and assign
the data (measured process values) properties for display and archiving.

Displaying Trends in Run Time

In run time, the values can be displayed in the configured form and can be
manipulated using a toolbar (display or hide trends, fill in the trend background,
page in the time axis etc.).

In run time, you can put together further trends. With the correct user permissions,
each operator can include tags of interest in a trend representation and display
these trends.

Figure 11-15Example of a Trend
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dBase Format for Tag Logging Archive

You can also store your data in the dBase-III format. This data format is particularly
suitable for storing large amounts of data. You can specify this format in the
"Project Properties" dialog box in Tag Logging.

An archive in the dBase format is always created as a ring buffer. It is therefore not
possible to swap out the data with the Storage function.

Event-driven Archiving

You can set the archiving of each measured value so that an analog process
variable is only written to the archive when it is changes. You can also set the
hysteresis that must be exceeded as an absolute value or percentage.

11.9.1 Configuring a Trend Display Online

Configuring a trend group online is largely the same as configuring a trend group
offline (see also Section 11.9.2). This is outlined briefly below:

1. In run time, click the  button to open the dialog for assembling/calling
trend groups.

2. You obtain a list of all the saved trend groups (the content and date of the last
change is displayed for each group).

Figure 11-16Dialog for Online Creation of a Trend

3. If you double-click an existing trend group, this is displayed (as an alternative
select a group and click the Display button).

4. Click the New button to create a new trend group.

5. In the "New Trend Group" dialog, enter a name for the trend group you want to
create and the source of the trend values (current values from the SIMATIC
station or values from a trend archive created in the configuration system).
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Figure 11-17Entering the Trend Name and Source of the Trend Values

6. Click the Create button.

The dialog is closed and an empty TrendControl is opened in the selected picture
template. As soon as it is opened, the TrendControl displays the configuration
dialog for configuring trends. This dialog is no different from the dialog for
configuring trend displays in the configuration dialog (offline: see following section).

11.9.2 Trend Display for the COLOR_PH Project (Offline)

For the "COLOR_PH" project, you will create the following trend display offline:

1. Start the "Tag Logging" application in the WinCC Explorer of the operator
station (click with the right mouse button and select => Open).

Tag Logging is opened.

2. Right click on "Archives" and start the "Archive Wizard"

3. Follow the instructions of the Archive Wizard and in "Step 1" enter the name
"COLOR_ARCHIVE".

Make sure that "Process Value Archive" is selected as the "Archive Type"
and click the "Next" button.

4. Click the "Select" button in "Step 2".

You display the tag browser of the operator station.

5. Select the tags "SP" and "PV_IN" of the block "Ctrl" in the chart
"FC 111" and click the "OK" button in the browser.

6. Click the "Apply" button.

The archive is created.

7. Right click on "COLOR_ARCHIVE" and open the "Properties".

8. In the properties, open the "Archive Parameters" tab and set "1000" in the line
"Number of entries". Exit the Properties with the OK button.

9. Save the modifications "File > Save" and close Tag Logging "File > Exit".

10. Open the process picture "RMT1" in the Graphics Designer

11. Open the "Controls" tab in the object palette.

12. Select "WinCC Online Trend Control".
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13. Open a field in the process picture to the right of the raw materials tank
(approximately 5 cm high and 10 cm wide).

The "Properties of WinCC Online Trend Control" is opened.

Figure 11-18Properties of the Trend Control (General)

14. In the "General" tab, enter the window title "Group 1" and in the "Display" box,
select a "Common X axis" (see Figure 11-18)

15. Open the "Elements" tab.
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Figure 11-19 Properties of the Trend Control (Elements)

16. Click the "+" button to display a further trend.

17. Select "Trend 1" and click the "Selection" button.

18. In "Color_Archive", select the tag "SP" and click "OK".

19. Select "Trend 2" and click the "Selection" button again.

20. In "Color_Archive", select the tag "PV_IN" and click "OK".

21. Exit the Properties with the OK button.

The trend display is complete.

22. Save the process picture "RMT1" (File > Save).
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11.10 Alarm Logging

Overview

Alarm logging is used to receive messages from processes, to edit them, display
them for acknowledgment, and to archive them.

Alarm logging provides the following functions:

• Comprehensive information about faults and operating states

• Early detection of critical situations

• Avoidance and reduction of downtimes

• Increased product quality

• Multiple languages in the message text

• A separate online help system

Note

Alarm Logging is described in detail in the "SIMATIC HMI WinCC Volume 2/2"
manual and in the online help.

Alarm Logging in the PCS 7 Environment
The PCS 7 user only makes modifications in alarm logging when customers have
special requirements. The Alarm Logging Wizard (see Section 11.2) has already
made all the necessary settings in Alarm Logging. The configuration engineer
assigns the message text in the PCS 7 blocks in CFC.

The transfer of the configuration data (see Chapter 12 "Connection Configuration")
generates unique message numbers in alarm logging for each individual message
and stores the texts configured in CFC.

Locking Messages

To reduce the number of message events, known, repeated messages can be
locked and unlocked again. A distinction is made between active and passive
locking/unlocking of messages. For active locking, the message source must
support locking/unlocking of messages with confirmation and a valid date/time
stamp. A general query of the source must also supply the currently locked
messages. If the message source meets these requirements, the messages are
actively locked/unlocked, otherwise the messages are unlocked/locked passively
by the OS.

• With active locking, a lock request is sent to the message source (for example
the PLC). The message is locked on the OS only when the source returns the
confirmation that the message is locked. The mechanism for unlocking locked
messages is analogous. Only messages configured in the correct
chronological sequence at the PLC level are locked/unlocked actively.

• If a message is locked passively, it is locked/unlocked in the alarm server on
the OS. The source of the message is not involved.
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"Unlock/Lock Message" Function in the Toolbar.

PCS 7 uses the function "Set Lock" in the toolbar of Alarm Logging.

If you create your own message pictures, the "Unlock/Lock Message" function 
is available (properties of WinCC Alarm Logging in the Graphics Designer >
Toolbar Tab > Lock/Unlock Message). With this function, you can do the following:

• Unlock single messagesA message selected in the lock list is unlocked with
this button.

• Lock single messagesLock a message selected in the current message list and
in the message archive lists.

This function for active locking of messages is not supported by PCS 7 and
should not be used.

With central locking of messages, a message can only be locked block-related.
This means that if you lock the alarm high on a block, no other messages will be
received from this block (alarm low, warning high, warning low etc.).

Display of a Message List

Overview

Toolbar

Message ist

Figure 11-20Display of the New List in Runtime
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11.10.1 Meaning of the Group Process Control Messages

When you transfer the PLC-OS connection data, 7 process control messages are
created. The meaning of the messages is as follows:

Table 11-3: Meaning of the Group Process Control Messages

Message
Number

Message Category Meaning

1 Synchronous PLC errors Programming error, access error

2 Asynchronous PLC errors Timeout, communication error, fault in power
supply

3 Module fault Diagnostic error, remove/insert interrupt, rack
failure

4 Stop/abort error System error, parameter assignment error,
error in firmware update, abort event

5 H/F system event Error in redundant systems

6 Communications error General communications error

7 Error not on the CPU Error in CP or FM module
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11.10.2 Meaning of the System Messages

The Alarm Logging Wizard generates approximately 140 system messages that
relate to the operator station. As an option, generating system messages can be
deactivated in the Alarm Logging Wizard. For the meaning of the messages,
please refer to the online help of the WinCC Explorer under "System Messages >
System Messages (Alarm Logging)". The following abbreviations are used in the
online help:

Table 11-4: Meaning of the Group Process Control Messages

Name Meaning

WCCRT General WinCC run time

PDLRT Picture processing run time

TLGRT Tag Logging Runtime

ALGRT Alarm Logging Runtime

NRMS7 Conversion DLL S7

RPTRT Report Runtime

TXTRT Text Library Runtime

GSCRT Global Script Runtime

SCRIPT Processing of scripts

USERT User Administrator

LBMRT Lifebeat Monitoring

STRRT Storage Runtime

STORAGE Storage

CSIG Picture Tree Manager

SYNC Time Synchronization

REDRT Redundancy Runtime

SWITCH Project Switcher

SWRED SW Redundancy

11.10.3 Configuration for the COLOR_PH Project

Within PCS 7, all the necessary settings in Alarm Logging are made by the Alarm
Logging Wizard (see Section 11.2). The messages with the corresponding
message texts are created by the transfer of the PLC-OS connection data. Further
configuration is not necessary for the "COLOR_PH" project.
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11.11 Reports

Overview

PCS 7 provides you with an integrated report system with which you can log user
data, current and archived process values, current and archived messages and
your own system documentation.

The Report Designer provides the following functions:

• Convenient and straightforward user interface with tool and graphic palettes

• Support of different types of report

• Support of the output media of windows

• Page by page display of stored (archived) reports

• Support of the OLE 2.0 interface

• Standard system layouts and print jobs

• A separate online help on page layout and line layout

Note

The Report Designer is described in the "SIMATIC HMI WinCC Volume 1/2"
manual and in the online help.

Message Sequence Report

Within the Report Designer, you can create a message sequence report. You
create a line layout and select the message fields from alarm logging that you want
to report. After connecting the line layout with a print job, the message sequence
report is available in runtime.

A message sequence report is output to an LPT port of the operator station. An
incoming message is printed immediately on a line printer, a laser printer stores the
print job until a complete page is filled before printing.

Archive and User Report

You create this type of report with a page layout. You design the layout in a
configuration dialog. The output printer and, if required, a substitute printer .

The output of an archive and user report can be controlled by different events. It
would, for example be possible to output cyclically (for example every month) or to
trigger output with a mouse click on a button or by a change in process tag.
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11.12 Time Synchronization

Overview

Time synchronization means, for example, that an operator station acting as active
time master is responsible for the synchronization of all other operator stations and
PLCs on the plant bus. This allows plant-wide chronological ordering of messages.

The source of the time on an operator station can be as follows:

• a GPS unit connected via RS-232 or

• a DCF77 unit connected via RS-232 or

• the internal PC clock

When necessary time synchronization can be implemented with masters. This
means that there can be two or more time masters in a redundant system. Each
operator station can be configured as the time master and the existence of, for
example, a DCF 77 is not absolutely necessary.

The master that first starts up sends a time frame on the network to other masters
and all slaves and then becomes the active master and all other operator stations
and PLCs on the network become time slaves. The masters are assigned
parameters using the "Time Synchronization" editor. Apart from the bus interface to
be used, the slaves do not require any particular parameter assignment.

The time master must be an operator station. It is also possible to use a "real-time
transmitter for Industrial Ethernet" or a "SICLOCK" as the time master (see also
Chapter 1 "Message Concept").

Time-of-day synchronization of multiclients
To ensure the timing consistency of PCS 7 systems, the time-of-day must be
synchronized on all multiclients/server stations. The PCS 7 software provides the
"DCF77 Receiver Service" for this purpose. After installing the program, click the
"DCF-77" icon in "Settings > Control Panel". In the "Connection" box, enter the
name of the computer that will operate as the time master (for example
\PC_TIME_MASTER).

Note

You will find a detailed example of time-of-day synchronization in the "SIMATIC
PCS 7 Tips and Tricks" manual.
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11.13 Lifebeat Monitoring

Overview

Lifebeat monitoring is performed on an operator station that is declared as the
lifebeat monitor computer. The lifebeat monitor monitors all servers and client
computers and all PLCs that are accessible on the network and that are assigned
to the lifebeat monitor.

The monitored components are operator stations (servers and clients) of PCS 7
projects and the PLCs belonging to them. A monitoring program runs on every
server that monitors the components belonging to a project and also "other"
components. To allow this, all the parts of the plant must be connected to a
network.

In runtime, the state of the monitored components is displayed in a separate
picture. You call the picture using a button in the key set. If stations fail, the
operator is also informed by a process control message (see also Chapter 1
"Message Concept".

The configuration of lifebeat monitoring of other computers in the network makes
use of an OPC connection. The "NetDDE" service is not supported. –For a detailed
description of configuration, refer to the online help of the OS under "Lifebeat
Monitoring".

Note

If you modify connections (connection entries) in the tag management of the
WinCC Explorer, you must reassign the connections in the "Lifebeat Monitoring"
editor. Otherwise, the error message "The message system could not be
activated" is displayed.

Figure 11-21Lifebeat Picture in Runtime
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11.13.1 Monitoring the PLC in the COLOR_PH Project

The SIMATIC station (PLC) in the COLOR_PH project will be monitored for station
failure. Configure this monitoring function as follows:

1. Right-click Lifebeat Monitoring in the WinCC Explorer.

2. Select "Open" in the context-sensitive menu.

3. In the first line of the Device List double-click the column Device Name and
enter the technological name of the PLC (for example PLC_RMT1).

4. In the first line of the Device List double-click the column Device Type and
select the type AS-4xx, if you are using a CPU 4xx (for example a CPU 416-2).

5. In the first line of the Device List, double-click the Connection column.

All the S7 programs (SIMATIC stations) that exist in the tag management of
the OS are displayed and can be selected.

6. Click on the S7 Program of the SIMATIC station used in the COLOR_PH
project (for example S7 program(1)).

7. Deselect the Connection field, for example, by clicking on the second line of
the device list.

8. Click the Update button.

The picture @CONFIG.PDL is created. In this picture you will see the current
status of all the devices inserted into lifebeat monitoring in the run time of the
OS. The icon of the inserted devices is displayed in the configuration dialog.

9. Click the Close button.

Lifebeat monitoring is completed.

In run time, you display the current status of the OS using the  button in the
key set of the OS.
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11.14 Storage

Overview

The Storage archiving functions support the automatic swapping out of data from
the hard disk to long-term data media and deleting of data on the hard disk (see
also Chapter 1 "Value Acquisition and Archiving").

Note

You cannot use the storage functions with short-term archives!

Storage is described in the "SIMATIC HMI WinCC Basic Process Control" manual
and in the online help.

Caution

Make sure that the sequence archives in your project are swapped out cyclically
otherwise the data media will be filled to 100%.

Figure 11-22Configuration Dialog of the "Storage" Function



Configuring Operator Stations

Process Control System PCS 7, Configuration Manual
11-42 A5E00122418-01

11.15 Global Script

Overview

Global Script is the generic term for C functions and actions that can be used
throughout a project or in more than one project depending on the type.

The Global Script editor has several tasks. On the one hand, there are the
standard and internal functions supplied with PCS 7, on the other, project and
standard functions of the user are formulated in Global Script. Actions running in
the background during runtime can also be included.

Project, standard, and internal functions can be used in object-linked C actions, in
object-linked actions (dynamic dialog) and for making process value archives, user
archives, and compressed archives dynamic.

Caution

Please note that actions are processed interpretively. If you use numerous or
extensive actions, you must therefore expect a higher system load. Lots of small
actions cause more system load than a few large actions. It is better to replace
extensive actions with your own DLLs (dynamic link libraries).

Move cyclic calculations to the PLC and do not execute them on the OS.

Note

Global Script is described in detail in the "SIMATIC HMI WinCC Volume 2/2"
manual and in the online help.

Figure 11-23Example of a Function in Global Script
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11.16 Redundancy Option

Overview

Normally, the OS servers operate parallel to each other in runtime. Each server
station has its own attachment to the process and has its own data archive. The
process data and messages from the PLCs are sent to both redundant servers and
processed there. Communication between the redundant server stations is via the
terminal bus.

The servers monitor each other in runtime to be able to detect the failure of a
partner early and to send a process control message. Control messages can be
compared constantly online.

Neither server has priority, they operate independently of each other, and both are
available to the user. If one server fails, a second server with identical capabilities
is available.

Failure of a Server

If one of the servers fails, the remaining functioning server receives and archives
the process values and messages from the PLCs. This guarantees data integrity
without omissions or gaps.

The clients are automatically switched from the failed server to the redundant
partner server. After a brief switchover time, all operator stations are available
again.

Return of the Failed Server

When the failed server becomes operational again, the Redundancy function
compares the archives for the period of failure. The gaps in the archive left by the
failure are filled in by transferring the data to the server that had failed. Two
identical servers are therefore available again.

The synchronization of the archives is implemented as a background function and
runs parallel to the Win CC process control and archiving. This ensures that the
plant can be controlled and monitored at any time.

Synchronization Following Return of a Server

After the failed server returns to operation, the message and process data archives
are compared. The failed server receives its data only after a delay resulting from
the failure.
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Synchronization following a Process Disturbance

If problems occur on the network between a server and one or more PLCs, a
synchronization is started after the problem has been eliminated providing this
function was configured.

Online Synchronization (optional)

A direct server-server synchronization (online synchronization) is made when there
are operating messages from Alarm Logging.
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11.17 Configuring the Multiclient

What is a multiclient project?

In contrast to a client that is connected to precisely one server, a multiclient can
access up to six servers. Each redundant server counts as two single servers. If all
the servers are redundant, a multiclient can therefore access a maximum of three
server pairs. A multiclient itself has no SFC charts of its own and no connection to
the process. Working at a multiclient station, it is possible to operate and monitor
the SFC charts on the servers, it is, however, not possible to modify the charts.

The data from server projects are made known to the multiclient using reference
lists (packages). The multiclient can access the server data only after the packages
have been created and downloaded.

For SFC visualization, it is also not the data themselves that are exported but
simply references to the SFC charts. This means that after modifying a chart it is
no longer necessary to create and download packages. A new package only needs
to be created and downloaded to the multiclient after deleting, adding or renaming
charts.

The following example describes the creation of a multiclient project and creating
and downloading the packages.

Multiclient 3Multiclient 2Multiclient 1

Terminal bus

Server 2-2

Engineering system

Server 2-1Server 1-2Server 1-1

Figure 11-24Sample Project with a Multiclient and Two Redundant Servers
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Creating the Packages on the Server

The project is created on the server as a "Multiple Workplace System" project type
(select the project name in the WinCC Explorer and select "Properties" in the
context-sensitive menu). The required pictures, archives, or tags are created on the
server.

The requirement for creating a package on the server is that the data have been
transferred to the data management on the OS with the "Transfer PLC-OS
connection data" function. This function transfers the process variables, the
messages and SFC charts.

For a server, you create a package by selecting "Create..." in the context-sensitive
menu of the "Serverdata" editor in the WinCC Explorer (not possible on a
multiclient). The name of the package created is displayed in the details window
and is made up of the name of the project and the computer (server) with the
extension ".pck".

Downloading Packages to the Multiclient

To download a package to the multiclient, select the "Download..." command in the
context-sensitive menu of "Serverdata".

In the "Open" dialog, you specify the computer name and then select the project
and in it the computer name followed by the "Packages" folder in the combo box.
You then select the package file (.pck) and click "Open", the server data are now
copied to the "Packages" folder and therefore made available to the multiclient.
The project data of the server are now available to the multiclient.

It is also possible to download packages in run time. Modifications made while the
system is in run time only become effective after they have been activated again.

It is not possible to configure server projects on the multiclient.

Note

You will find instructions on configuring SFC Visualization in the online help.

Specifying the Standard Server

You specify the standard servers  in the "Standard Server" dialog for individual
components such as pictures, tags, messages, archives, online trends, assembling
pictures etc. The standard server for a component is the server that processes or
manages a function if no symbolic computer name (server prefix) is included in the
configuration on the multiclient.

If there are several servers in a system, you can decide which you would like to
use as the standard server. All multiclients can use the same server as the
standard server. If there is a redundant server in a system, select this as the
standard server to achieve higher availability.

You can, for example, use the Split Screen Manager (SSM) to specify whether the
configured online trend groups will be stored locally on the multiclient
(configuration: <no standard server>) or on a server (configuration: server name).
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The results: In the first case, it is only possible to call up the trend group on the
same multiclient; in the second case, the trend group can be called up on all
multiclients that have the server set as their standard server.

If a user created in the User Administrator of the multiclient needs to be able to call
up the same online trends and screen arrangements on all multiclients the same
standard server must be set for all multiclients.

To specify a standard server for a component, activate the entry belonging to the
component (for example Alarm Logging, pictures etc.) in the symbolic computer
name column. The symbolic computer names of all the packages loaded in the
multiclient are listed. To be able to store "Trend Online" and "Put together pictures"
on the standard server, activate the "SSM" component and assign the required
standard server.

You can only select a standard server in the multiclient project after downloading
packages.

Properties in the "Serverdata" Editor

In the properties, you can specify a standard server  and in a redundant system
you can also specify its redundant computer.

The "Physical Computer Name" box contains the configured standard server. It can
be edited directly in this box.

The redundant server in the "Redundant Computer Name" box can only be edited
directly when the redundancy option has been installed on a server.

It is not possible to edit the redundant computer directly on the server. The
information about which redundant computer belongs to which physical computer is
configured with the redundancy option.

Failure of a Redundant OS Server

The same user data (project) are located on the redundant servers. If server 1-1
fails (for example specified as the standard server), the process can continue to be
operated and monitored via server 1-2.

If, for example, the operator creates new online trend groups while server 1-1 is
down, these are transferred from server 1-2 to server 1-1 as soon as server 1-1 is
in run time again. This means that the servers are synchronized.
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Preferred Server

The "Preferred Server" is the server within a redundant server pair to which the
multiclient normally connects. This means that as long as this server is redundant,
the multiclient will obtain its data from it. If no preferred server is entered in the
"Configure Preferred Server" dialog, the multiclients connect to the server identified
as the master (behavior as in a client/server system).

The preferred server can be selected separately for each multiclient so that the
multiclients can be distributed on the redundant servers to guarantee permanent
operability.
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11.18 SFC Visualization

Overview

You create sequential control systems in the engineering station by creating SFC
charts. You then transfer these SFC charts to the data management of the operator
station using the connection configuration. All other functions are handled by SFC
visualization. Without any additional configuration being necessary, you can now
call up the SFC charts with the current states in runtime and control the charts
according to the assigned permissions.

In runtime, the following procedure is necessary:

• In key set 2 (Runtime) click the button for SFC Visualization.

You will see an overview of all the transferred sequential control systems.

• Select the chart you require from the overview.
The selected chart is displayed at the overview level. You can see the currently
active step of the sequential control system marked green.

• Double-click the overview to display the detailed view of your chart.
At this level, you can control the chart (on, off, step control with transitions,
step control with condition etc.) and can display the transitions or step with the
current states and the comments configured in the engineering system.

SFC Control OCX

In addition to the procedure described above, you can also install an SFC control
OCX (status picture) in a process picture. This OCX (status picture) shows the
current state of the sequential control system and provides you with buttons for
calling up the overview or the detailed view. A further advantage is that the
operator does not need to filter out the required chart from numerous others, but
can call a process picture oriented on the actual plant and locate the required
sequential control system in this picture.

SFC Standard Picture, SFC "Icon"

As well as placing SFC status pictures in the OS pictures and linking them with an
SFC chart, it is also possible to configure an action for a graphic object (for
example a rectangle) in which an SFC chart is opened. This object then serves as
an "icon" for the SFC chart, but in contrast to the SFC status picture does not
contain any information on the current status of the SFC chart.
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11.19 Transferring the Project from the ES to the OS

You create the project (PLC and OS) on the ES. When you transfer the PLC-OS
connection data, the parts of the configuration relevant to the OS are transferred to
the data management of the OS. At this point in time, all the data of the project are
still on the ES. It is now necessary to transfer the OS section of the project to the
computers at which the operators will control and monitor the process.

There are several ways of copying the OS-relevant part of a project from the ES to
a different computer.

• Copying with the Project Duplicator of WinCC

• Copying with the SIMATIC Manager

• Copying with the Windows Explorer

Copying with the Project Duplicator

If you want to copy the OS-relevant part of a project from an engineering station to
a run time station (OS) using the OS program "Project Duplicator", start this
application as follows:

Start > SIMATIC > WinCC > Project Duplicator

After you have copied the project, the computer name in the project must be
adapted. Follow the steps outlined below:

1. Open the WinCC Explorer on the run time station (OS).

2. Select the computer and with the right mouse button select the menu
command "Properties > Computer Name".

3. Change the computer name and close the WinCC Explorer.

You can find the name of your computer as follows: "Start > Settings > Control
Panel > Network > Identification.

Copying with the SIMATIC Managers (preferred method)

To copy, follow the steps outlined below:

1. Select the OS in the left-hand window in the SIMATIC Manager (for example
SIMATIC PC Station > WinCC Application > OS(1)).

2. Open the object properties of the OS (Right Click > Object Properties)

3. Click the "Path to Run Time OS" tab and set the path to the run time station
(OS).
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Figure 11-25 Specifying the Path to the Target OS Computer

4. Close the object properties and select the OS again (if it is not yet selected).

5. Select the menu command "PLC > Download"

The OS data are copied to the specified path.

Note

You will find a detailed example of downloading a redundant OS in the "SIMATIC
PCS7 Tips and Tricks" manual.

Copying with the Windows NT Explorer

As default, the OS-relevant part of a project is stored in the following path:

Siemens\Step7\S7proj\projectname\wincproj\os(1)

Copy the "OS(1)" folder with all its subfolders to the run time station (OS) into the
path you require.

After copying the folder, you must adapt the computer name in the project on the
run time station (OS). Follow the procedure described above.
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11.20 Run Time

Overview

In run time, you control and monitor your process using the graphic user interface
of the operator station. Process displays and messages indicate the current status
of your plant at all times. With the overview picture in which all the important
statuses in your plant are displayed and the picture hierarchy of the Picture Tree
Manager, the operator is guided to the process pictures in which the current
process information is visualized.

By calling up message lists, the operator has detailed information about messages
that have occurred (for example, date, time, origin, plant area etc.). Curves in
process pictures indicate the changes in measured values over time.

You activate runtime in the WinCC Explorer using the menu command File >
Activate. All the OS-relevant data must previously have been transferred to the
data management of the OS with the transfer PLC-OS connection data function.

Online Configuration

During run time, you can make changes to your data (for example graphics). These
changes are automatically adopted and displayed in runtime when you change to a
different picture. This allows the configuration to be optimized without continual
activation and deactivation of the runtime (optimizing working time).

Caution
Make sure that the data modified directly on the OS by configuring online are also updated
in the ES! If, for example, you modify the parameter "TN" of the CTRL_PID block online
and do not make the same change in the ES, the modification will be overwritten the next
time you download to the PLC from the ES.

For this reason, configuring online should be done on the ES and not on an OS.

You stop the runtime system by clicking the button in the extended key set of the
runtime system.
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11.21 User Objects

Introduction

An example illustrates the optimized, flexible programming with user objects.

Task

It is often the case that an object in a process picture must be supplied by different
parameters of a PCS 7 block to meet the customers’ requirements. As an example,
this could be the I/O field of a controller (CTRL_PID). This I/O field displays the
current process variable and changes color if the upper warning or alarm limit is
exceeded. In addition to this, a status display shows whether the valve is open
(LMNR_IN > 5 %) or closed (LMNR_IN ≤ 5 %). This results in the following
relationships:

Table 11-5 Tag Access of Picture Objects

 Function  Source

 (Parameter of the block)

 Destination

 (Property of the object)

Display of the process
variable

PV_IN I/O field/output value

Color change if the warning
or alarm limit is exceeded

EventState I/O field/background color(C
action)

Display valve open or closed
in a status display

LMNR_IN Status display/current state
(C action)

Standard Solution with Individual Objects

To solve the task, an I/O field and a status display are normally displayed in the
process picture and supplied by the necessary process values.

Figure 11-26Tag Access of Picture Objects

SIMATIC station Operator station

0.0000

CTRL_PID

LMNR_IN
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Disadvantages of the Solution Using Single Objects

• If the name of the CTRL_PID, the name of the CFC chart, or the name of the
plant hierarchy changes, this must be adapted at three points (I/O field at two
points; status display at one point).

• When copying and pasting (multiple use in process pictures), adaptation is
once again required at three points.

• The automatic adaptation using a wizard is extremely time consuming since
the tag names within C actions must be modified.

• A lot of small C actions must be triggered and processed (involving far more
time than one large C action).

Solution with a User Object

Follow the steps outlined below:

1. Configure an I/O field in a process picture, a static valve symbol for "Valve
Open" (for example green), a static valve symbol for "Valve Closed" (for
example red) and a static text (property of the static text: Display "NO").

2. With these objects, create a user object and assign the following properties in
the configuration dialog:

- Output value of the I/O field (property tab)

- Display of the static valve symbol 1 (property tab)

- Display of the static valve symbol 2 (property tab)

- Text of the static texts (property tab)

- Object change of the I/O field (event tab)

Close the configuration dialog.

Figure 11-27Configuration Dialog: Specifying Properties and the Event

3. Open the properties of the user object and interconnect the output value of the
I/O field (property tab) with the "PV_IN" parameter of the CTRL_PID block.

0.0000

User object

text

Output value

Display1

Display2

text

Properties

Object change

Event
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4. Write the following C action in the object change of the I/O field (Event tab):
double value;
value = GetPropDouble(lpszPictureName,"User_object1","OutputValue");
if (value<5) {
SetPropBOOL(lpszPictureName,"User_object1","Visible1",1); 
SetPropBOOL(lpszPictureName,"User_object1","Visible2",0); }

5. else {
SetPropBOOL(lpszPictureName,"User_object1","Visible1",0);
SetPropBOOL(lpszPictureName,"User_object1","Visible2",1);
}

6. Write the type of user object in the static text (for example CTRL_ PID_Typ_1).
The static text is used only for documentation of your user objects. This is not
visible in run-time.

Figure 11-28   External Interconnection of the User Object

Function Description

The process variable must be interconnected with the output value of the I/O field.
This provides you with the display of this value in run-time. If the output value
changes, the C action is started automatically. With the line "value =
GetPropDouble(lpszPictureName, "User_object1","OutputValue");" you save the
process value in the temporary variable "value" to be able to check for "< 5".
Depending on the value, you then switch the valve symbol for "open" or "closed"
visible.

0.0000

User object

text

Output value

Display1

Display2

text

Properties

Object change

Event

... CTRL_PID.PV_IN

C action

Text: Type of object
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Advantages of the User Object

• If the name of the CTRL_PID, the name of the CFC chart or the name of the
plant hierarchy changes, you only need to adapt at one point (interconnection
to the output value of the I/O field).

• When you copy and paste (multiple use in process pictures), an
interconnection is only required at one point.

• Automatic modification using a wizard is extremely simple since no tag names
need to be changed within C actions.

• Only one C action is processed if the object changes (time optimized).

Caution
Data that change constantly (for example analog valves from the process) should not be
used to create a trigger. This can result in an extremely high load on the OS system.
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11.22 Faceplate Designer

Introduction

The Faceplate Designer is used to create complete faceplates for operating and
monitoring measuring points or sections of plant such as motors, valves,
controllers, measured values etc.

You create a faceplate in four simple steps:

• Adapt the group picture frame to the block type.
Here, you can use the "@PG_%Type%.PDL" template.

Figure 11-29Template for a Group Picture Frame

• Adapt the view list to the block type
Here, you can use the "@PG_%Type%_VIEWLIST.PDL" template.

Figure 11-30Template for a View List
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• Edit the type/and view-specific pictures
Here you can use the "@PG_%Type%_%VIEW%.PDL" template. Ready-made
block elements and user objects are stored in the template pictures
"@PCS7Elements.PDL".

Figure 11-31Template for Type and View-Specific Pictures

• Adapt the loop display to the block type
The "@PL_%Type%.PDL" template is available for configuration.

Figure 11-32  Template of the Loop Display Frame
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You can display the faceplate in run time by clicking a corresponding icon in the
process picture. During run time, you also have the options "Picture selection via
measuring point" and "Loop in Alarm" for opening pictures. No further configuration
is necessary.

Figure 11-33  Symbol for a Measured Value Display Block

The supplied process picture symbols have ready-made call scripts for the various
faceplate types. These scripts do not need to be adapted for specific instances.
This means that the configuration of process picture symbols can be made in one
single step by interconnecting the ready-made process picture symbol (user object)
with the PLC block. This assumes that a PLC block is linked using standard OS
structure types.

11.22.1 Components of the Faceplate Designer

The following components available in the Faceplate Designer:

• Ready-made symbols for process pictures (user objects)

• Object construction kit with user objects for creating faceplates

• Templates with the individual components of a faceplate.

The basic objects (buttons, status displays etc.) for creating faceplates and ready-
made sample templates for process picture symbols (valve, motor, controller,
measured value) are installed in the path
"Siemens\WinCC\Options\PDL\FaceplateDesigner" when you install Advanced
Process Control.

The faceplate call scripts are installed in the path
"Siemens\WinCC\Aplib\FaceplateDesigner".

Note
To be able to use the templates, the Split Screen Wizard must be started. This then copies
the objects to the "GraCS" folder in the project folder.



Configuring Operator Stations

Process Control System PCS 7, Configuration Manual
11-60 A5E00122418-01

Ready-Made Symbols for Process Pictures (User Objects)

The process picture symbols are user objects for the symbolic view of the
faceplates in process pictures. These objects are installed in the OS pictures and
linked to an instance. During run time, the relevant faceplate is opened when the
operator clicks on the symbol.

• The sample templates contain various types: valve, drive, measured value,
controller etc. The types available are stored in the file "@Template.PDL" in
"Siemens\WinCC\Options\PDL\Base_Data_Pool". When you run the Split
Screen Wizard, the file is copied to the "GraCS" folder.

• The sample templates can be edited and modified so that you can change the
shape, color, layout etc. and adapt them to blocks created for a specific
project.

• The ready-made call scripts for the faceplates are included and do not need to
be configured.

• They can be interconnected quickly and simply using the "Connect picture
block to tag structure" dynamic wizard.

Note
The symbols from the "@@PCS7Typicals.PDL" file are reserved for basing the picture
hierarchy on the plant hierarchy and must not be used manually in other OS pictures.

Object Construction Kit

All the objects contained on the OS as well as the user objects can be used to
create faceplates, for example, I/O boxes, texts etc.

The Graphics Designer picture "@PCS7Elements.PDL" installed with the program
provides a series of ready-made user objects. These ready-made user objects
make it easier to put your own faceplates together. The picture is stored in
"Siemens\WinCC\Options\PDL\FaceplateDesigner" that is copied to the "GraCS"
folder when the Split Screen Wizard is run.

The following table provides an overview of the ready-made user objects.
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Table 11-6 User Object Templates

 Object  Properties

Buttons Operator control enable buttons (with selectable
parameters or interconnectable)

Optional: Confirmation of operator input (to help prevent
operator errors)

Automatic generation of an operator input message for
the OS message system.

Write value button with selectable parameters (property
"Write Value").

Connect to variable to be written (property
"Write_Variable").

Two different button states (pressed/not pressed) each
with different color.

Controllable
Binary value

Optional: Confirmation of operator input (to help prevent
operator errors)

Automatic generation of an operator input message for
the OS message system.

Controllable
Analog value

Convenient input with operator errors prevented:

Automatic generation of an operator input message for
the OS message system.

I/O box Standard I/O box as user object with 3D effect.

Status display
for texts

Two or more different texts with different colors can be
displayed.

Status display for
freely selectable
bitmaps
(status display)

Two or more different bitmaps or emf files can be
displayed.

Combo box Selectable texts.

Operator control enable buttons (with selectable
parameters or interconnectable)

Automatic generation of an operator input message for
the OS message system.

Bars Definable standard bars.
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11.22.2 Configuring Faceplates

You create a faceplate in four consecutive steps.

• Adapt the group picture frame to the block type

• Adapt the view list to the block type

• Edit type/view-specific pictures

• Adapt the loop display frame to the block type

Adapting the Group Picture Frame to the Block Type

1. Open the template "@PG_%Type%.PDL".

2. Specify the block type.
Select the "Block Type" (%Type%) object and open the properties dialog.
Select the "I/O Field" entry in the "Properties" tab and enter the required block
type in the "Object Name" attribute, for example MEAS_MON.

3. If you do not require it, you can switch the message status display invisible by
selecting the "EventState" object and opening the properties dialog. Change
the "Display" attribute to "No" using properties/group display/miscellaneous.

4. 6SHFLI\�WKH�standard view.
Select the "@Faceplate" object and open the properties dialog. With
properties/PCS 7 tagname/texts, enter the required standard view in the "First
View" attribute, for example, "@PG_MEAS_MON_STANDARD".

5. Save the picture with a suitable type name, for example,
"@PG_MEAS_MON.PDL"

Adapt the View List to the Block Type

1. Open the template "@PG_%Type%_VIEWLIST.PDL".

A picture object with a selection of possible views of the block type is
displayed.

2. Select views you do not require and delete them from the list.

3. Arrange the views in the required order by selecting individual entries in the list
and moving them using the arrow keys.

4. Adapt the frame and picture size.
For the picture size, open the properties dialog of the
"@PG_%Type%_VIEWLIST" picture object. With properties/picture
object/geometry you can make the required changes. Open the properties
dialog of the "Comboframe" object; you can adapt the frame with
properties/rectangle/geometry.

5. Save the picture with a suitable type name, for example,
"@PG_MEAS_MON_VIEWLIST.PDL"
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Editing Type and View-Specific Pictures

1. Open the template "@PG_%Type%_&VIEW%.PDL".

2. Place the block elements in the picture and set the required parameters.
The block elements required for standard faceplates have been prepared and
can be copied directly from the templates to the picture (for example, copy the
bar from the "@PCS7Elements.pdl" template and insert it in the picture).
When the block elements are in the picture, you must then link the properties
of the block elements. If the target names are known, you can enter these
directly. Otherwise, you can establish the link using the tag browser.
Remember that the name of the PLC instance must not be included in the tag
name. For example, in the tag name "Plant1_Motor2.U_AH" the name of the
instance "Plant1_Motor2." must be deleted manually (including ".") so that the
name is then "U_AH".
The update cycles should where possible be identical to achieve better
performance (standard = 2 seconds).

3. Starting with the objects "@Level5" and "@Level6", set up a chain of direct
connections for the individual permission levels.

Example:
If you want to protect several I/O fields with permission level 6, the "Operator
Control Enable" property of the object "@Level6" must be connected directly with
the "Operator Control Enable" of the first I/O field. Select the first I/O field and open
the properties dialog. With the "Event" tab, you can now configure the direct
connection to the object "@Level6". The second I/O field must now be linked
directly to the first field etc. During configuration, remember that operator control
elements that are added are always inserted at the end of the configured
permission chain. It is advisable to document the order of the permission chain.

The change in the background color for operator control rights can be chained in
the same way.

4. Save the picture with a suitable type name, for example,
"@PG_MEAS_MON_VIEWLIST.PDL"
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Adapting the Loop Display to the Block Type

1. Open the "@PL_%Type%.PDL" template.

2. Select the "BlockType" object and enter the block type, for example,
@PG_MEAS_MON.

3. If you do not require it, you can switch the message status display invisible by
selecting the "EventState" object and opening the properties dialog. Change
the "Display" attribute to "No" using Properties/Miscellaneous.

4. Enter the required views in the "@Views" object.
Open the properties dialog and double-click the "Selected Fields" attribute. A
dialog is then opened in which you can select the required fields. The first field
has the consecutive number 1. Confirm your selection with OK.

5. Select the objects in picture @PL_%Type%.PDL you do not require and delete
them.

6. Arrange the visible elements in the order you require in the picture
@PL_%Type%.PDL.
Select the remaining objects one after the other and position them as required.

7. Adapt the picture size.
Open the properties dialog of the picture object "@PL_%Type%". You can
make the required changes with properties/picture objects/geometry.

8. Save the picture with a suitable type name, for example,
"@PL_MEAS_MON.PDL"

Testing the Faceplate

1. Check the tag connections, direct connections and scripts using the properties
display of the picture in the WinCC Explorer. To do this, select the Graphics
Designer editor in the navigation window of the WinCC Explorer and all the OS
pictures in the GraCS folder are displayed in the data window. Select the
picture you have edited and open the properties dialog. The "Dynamics" tab
lists all the dynamics that exist in the picture. By double-clicking an entry in the
list or by selecting an entry in the "Type of Dynamics" list box, you can display
details of the individual dynamics.

2. Run-time test with a PLC block

- Check that the picture opens and the group, loop display and view change

- Check that the tag name is displayed

- Check that the tags are displayed correctly
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Note
If you accidentally overwrite a template file (for example, @PG_%Type%_%View%.PDL),
you can copy the original from the Siemens\WinCC\Options\Pdl\FaceplateDesigner folder.

We recommend that you store all files you create yourself for the faceplates in the GraCS
folder of the current project. If you do not want the files to be overwritten by the originals
the next time you run the Split Screen Wizard, they must be copied to the
Siemens\WinCC\Options\Pdl\FaceplateDesigner folder.

If you want to use a project on a different computer, you can create a new folder with the
name "FaceplateDesigner" in the project folder \GraCS. The faceplates stored in this folder
are then copied to the GraCS folder of the project when you start the Split Screen Wizard.
Files with the same name are overwritten.

If required, the functions configured in your own faceplates can be protected from viewing
and modification in the "Global Script" editor. For more information, refer to the
documentation on the "Global Script" editor.

Guidelines for Use

Compatibility with the PCS 7 Faceplates

The faceplates supplied with PCS 7 (standard faceplates) cannot be modified with
the faceplate designer. It is only possible to create new faceplates with the
faceplate designer that can have the same names as the standard faceplates (for
example MOTOR, VALVE, MEAS_MON, ...). With this method, the standard
faceplates are then overwritten. The newly created faceplates can then be treated
as standard faceplates during configuration and in run time.

If standard faceplates are overwritten accidentally, they can be copied from the
library to the project again using the Split Screen Wizard.

Performance

The dynamics of the faceplates created with the Faceplate Designer can be
controlled completely during configuration. The performance of a faceplate
therefore depends to a large extent on the selection of suitable dynamics during
configuration. In this respect, an optimized, "trim" interface between the PLC and
OS functions is particularly important. This applies above all to the process picture
symbols. For more detailed information refer to the OS documentation in
"Configuration Notes, Tips and Tricks".

Caution
No C script with fixed coded instance names must be used in the dynamics of the
faceplates.

Different faceplate types must not be mixed in a picture used to create a faceplate; in other
words, a faceplate containing, for example, a valve controller and a motor controller is not
permitted.
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11.22.3 List of Template Files for the Faceplate Designer

Table 11-7 Files Supplied for the Faceplate Designer

File Name Contents

@PCS7Elements.PDL Preconfigured standard objects

@@PCS7Typicals.PDL Process picture symbols

@PCS7_ALARM.PDL Picture for displaying alarms in the faceplate

@PCS7_TREND.PDL Picture for displaying trends in the faceplate

@PCS7_BATCH.PDL Picture for displaying batch data in the faceplate

@PCS7_BinaryInput1of2.PDL Field for entering binary values

@PCS7_AnalogInputwithLimits.PDL Field for entering analog values with limits

@PG_%Type%.pdl Template picture for faceplate of group display

@PG_%Type%_%View%.PDL Template picture for view of a faceplate

@PG_%Type%_VIEWLIST.pdl Template picture for a list box of a view of the group display

@PL_%Type%.pdl Template picture for faceplate of the loop display

@PCS7_AlarmCrossed.bmp Status display: alarms doubly suppressed

@PCS7_AlarmDisabled.bmp Status display: alarms suppressed

@PCS7_AlarmEnabled.bmp Status display: alarms not suppressed

@PCS7_NotOccupied.bmp Status display: not occupied by Batch

@PCS7_Occupied.bmp Status display: occupied by Batch

@PCS7_OpenLoop.bmp Picture: button to open loop display in group display

PCS7_ChangeView.fct Open the view from within the combo box.

PCS7_CheckPermission.fct Checks whether the use has permission for the specified level
and tag.

PCS7_OpenAnalogInput.Fct Opens the field for entering the analog value

PCS7_OpenBinaryInput.Fct Opens the field for entering the binary value

PCS7_OpenGroupDisplay.Fct Opens the group display from within the process symbol

PCS7_OpenLoopDisplay.Fct Opens the loop display from within the group display

PCS7_OperationLog.fct Generates an operator input message

PCS7_SetTagBit.fct Sets a tag bit and generates an operator input message

PCS7_UpdateBarDown.Fct Modifies a bar with the direction top to bottom

PCS7_UpdateBarLimits.Fct Modifies all values of the bar display for limits

PCS7_UpdateBarLimitsUp.Fct Modifies alarm/warning low of the bar display for limits

PCS7_UpdateBarSPLimits.fct Modifies the setpoint limits

PCS7_UpdateBarStandard.Fct Modifies all values of the bar display

PCS7_UpdateBarUp.Fct Modifies a bar with direction bottom to top

PCS7_UpdateGroupPermission.Fct Sets permissions for group display

PCS7_UpdateGroupTagname.Fct Sets tag prefix, view, status display, and comment for group
display

PCS7_UpdateLoopPermission.Fct Sets permissions for loop display

PCS7_UpdateLoopTagname.Fct Sets tag prefix, view, status display, and comment for loop
display

PCS7_UpdateTagname.fct Sets tag prefix, view, status display, and comment



Configuring Operator Stations

Process Control System PCS 7, Configuration Manual
A5E00122418-01 11-67

11.23 Graphic Object Update Wizard

Functionality of the Graphic Object Update Wizard

The Graphic Object Update Wizard provides functions with which dynamic user
objects from OS pictures can be exported, imported, or updated. The dynamic
information (the interconnection to assigned tags) is retained. This makes it
possible to update objects existing in OS pictures due to a new template. It is also
possible to modify and reimport the dynamic information exported to an Excel
table. It is therefore extremely simple to copy dynamic OS pictures, change the
interconnection in the exported Excel table (for example for another unit) and then
import it again.

The Graphic Object Update Wizard provides the following dynamic wizards for
these functions:

"Export Picture Objects" dynamic wizard

This wizard exports all the user objects with a type identifier in the current picture
or in the project to an Excel table (.csv format). The export function includes the
type of the object and the interconnection information.

The object type can be recognized by the wizard from the entry in the "type"
property of the user object.

"Import Picture Objects" dynamic wizard

This wizard imports user objects into OS pictures. The required information is
normally taken from a file created previously with the "Export Picture Objects"
dynamic wizard (and possibly modified by the user). During the import, the user
objects specified in the file/Excel table are created as new objects. During the
recreation of the user objects, template objects are referenced that must be
accessible in a special template (@Template.pdl).

"Update Picture Objects" dynamic wizard

This dynamic wizard updates all the user objects with a type identifier in the current
OS picture or in the project. The object type can be recognized by the wizard from
the entry in the "type" property of the user object. During the recreation of the user
objects, template objects are referenced that are accessible in a special template
(@Template.pdl).

"Modify User Object Interconnection" dynamic wizard

This dynamic wizard is used to modify individual interconnections of existing user
objects in OS pictures (for example an interconnection to another PLC block
instance).
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Note

When you use the import/export wizards, it is assumed that valves, motors, controllers etc.
are displayed in the form of user objects.

The selection of the faceplates used for process control remains free; either you use
standard faceplates (for example the technological library of PCS 7) or specific user
objects/OS control pictures.

Configuring the Graphic Object Update Wizard

The following sections describe configuration of the Graphic Object Update Wizard.

11.23.1 Creating Object Templates

For the central storage of user objects, object templates are required in which the
designed user objects are stored.

Example:
For all valves in the flowcharts of a project, there is a common template that can be
modified centrally when necessary.

This object template is known as "Template Picture". The name of the template
picture must begin with the "@" character. The user object templates are copied to
the relevant process pictures during import and assigned interconnection
information. This assumes that the user objects existing in the process picture do
not need to be adapted for a specific instance with the exception of the tag
connection, otherwise object information would be lost due to the import. A script
used to call a picture block must, for example, be identical for all user objects of
one type. This can be achieved by the script accessing the interconnection
information as a result of a mouse click (= PLC block name) and derives the name
of the picture block from this.

The user objects must meet the following conditions:

• They have a property with the name "type". The user object type is entered
here, for example "VALVE".

• The object name of the template object is exactly the same as the object type,
in other words "VALVE" instead of "Userobject7".

It is advisable to assign a unique identifier to newly created objects. For this
purpose, there is a property with the name "tag" available. If this exists, then during
export to an Excel file the current text is also exported to the "Tag" column. The
entries can be modified in Excel. During the next import, these values are then
entered in the "Tag" property of the corresponding user object. There is also an
optional property "trend" available. This property is intended for trend group calls
and other user object-specific texts. The existing text is exported/imported to the
"Trend" column of the export file.
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11.23.2 Exporting User Object Templates

To export user object templates from an OS picture to a csv file (ASCII file), open
the OS picture with the Graphics Designer. Select the "Export Picture Objects"
dynamic wizard in the Graphics Designer in the "Picture Functions" tab. The
dynamic wizard displays a dialog in which you then create the export file. You can
make the following settings:

• Export from active or from all OS pictures
You can decide whether or not the export file is created only from the picture
currently open in the Graphics Designer or from all the OS pictures in the
project.
Template pictures with user object templates and PCS 7 system pictures are
not exported. You can recognize files of this type by the prefix "@...".

• Specify the name of the export file
Here you specify the name of the export file. As the default "Export.csv" is
proposed in the folder of the current project.

• Splitting the tag name
This option is particularly useful for PCS 7 users who work with the plant
hierarchy of the S7 Manager. The variable name is split into six individual
names separated by the "/" character to allow greater flexibility when editing in
the export file.

If all or some of the user objects of the open OS picture do not have the required
object properties, a warning is displayed. The actions executed during the export
are recorded in a log file. This is stored in the same folder as the export file, name
= name of the export file + extension .log.

11.23.3 Importing OS Pictures

To import an OS picture, open the OS picture in the Graphics Designer into which
the picture stored in the Excel file will be imported. It is advisable to create a
backup copy of pictures you are importing since the import can no longer be
undone.

Prior to import, all the objects with an entry in the "type" property are deleted in the
pictures to be imported (column 1 of the Excel table). Before importing a picture,
the current versions should therefore be exported.

The name of your template picture must start with the "@..." character.

With the "Import Picture Objects" dynamic wizard, you can now import the objects.
The wizard is called in the "Picture Functions" tab.

The following settings can be made:

• Specify the import file
Here you specify the name of the import file, as default, Export.csv is proposed
in the folder of the current project.

• Specify the name of the template picture
Here you specify the name of the template picture in which the template
objects are located; the @TEMPLATE.pdl file is proposed in the "GraCS"
folder of the current project.
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If your import file contains objects that are not found in the template picture, a
warning is displayed. These "unknown" objects are not imported. If objects were
added to the import file by copying existing lines, these are recreated.

The OS tag names of the import file are not checked for their validity or existence
in the WinCC tag management.

11.23.4 Updating OS Pictures

If editing of the export file is unnecessary, instead of exporting and then importing
the picture objects, the "Update Picture Objects" wizard can be used. In this case,
the relevant picture must be opened in the Graphics Designer. It is advisable to
make a backup copy of the picture since the procedure cannot be undone.

The objects can now be updated with the "Update Picture Objects" dynamic
wizard. The wizard is called in the "Picture Functions" tab.

The following settings can be made:

• Update active or all pictures: Here you can decide whether the picture currently
open in the Graphics Designer is updated or all the pictures in the current
project. Template pictures with user object templates and PCS 7 system
pictures are not updated. You can recognize files of this type by the prefix
"@...".

• Specify the name of the template picture: Here you specify the name of the
template picture in which the template objects are located; the
@TEMPLATE.pdl file is proposed in the "GraCS" folder of the current project.

This wizard replaces all picture objects with a "Type" property that exist in the
template picture with those from the template picture without creating an export file.
This is useful when you do not require the export file for editing. No log file is
created.

11.23.5 Modifying a User Object Interconnection

With this wizard, you can modify the dynamic link to a user object. The instance
name located before the period in the tag is replaced. Dynamics with internal tags
are not affected.

Open the picture in the Graphics Designer and select the user object. The object
can now be modified with the "Exchange User Object Interconnection" dynamic
wizard located in the "Picture Functions" tab.

The following settings can be made:

• Specify the name of the structure instance name: Here you specify or select
the new instance name. If you do not specify a name, the instance name from
the variable interconnection is used.
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File Format of the Export/Import File

The Export wizard generates a file in the .csv format as shown below (example).
When necessary, the file can be modified or extended. The import wizard creates
new objects (for example motor, valve) based on this file.

Table 11-8 Example of an Export/Import File

Picture name Object
Type

Link1 Link2 Link3 Link4

Mypict.Pdl MOTOR - - MAIN TYPICALS

Mypict.Pdl MOTOR - - MAIN TYPICALS

Mypict.Pdl VALVE - MAIN COM DT1BA1

Mypict.Pdl VALVE - MAIN COM DT1BA1

Mypict.Pdl VALVE - MAIN COM DT1BA1

Mypict.Pdl VALVE - MAIN COM DT1BA1

Table continued (further columns)

Link5 Link6 X-Pos Y-Pos Tag Trend

SA0001 SDRIVE 200 120 SA0001 Trend_2

SA0003 SDRIVE 190 230 SA0003 Trend_3

Y71 SVALVE 20 20 Y71 Trend_6

Y78 SVALVE 20 70 Y78 Trend_xxx

Y78 SVALVE 710 90 Y78 Trend_test

Y79 SVALVE 20 20 Y79 Trend_test2

Note: The name of a tag is formed by putting together the columns Link1 to Link6.

e.g.: MAIN/TYPICALS/SA0001/SDRIVE for line 1

The names used in the table must not contain blanks.
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11.24 Use of AR_SEND in PCS 7

The AR_SEND function block (SFB37 in S7-400) can be used for communication
between the PLC and OS. It is used to send data intended for archiving (tag
logging) on the OS. Since data transfer from the PLC to the OS archive is in
blocks, using AR_SEND allows a higher data throughput when archiving measured
values than if the data are requested at the initiative of the OS. In future versions of
PCS 7, it is intended to use the AR_SEND function block within the system
mechanisms in PCS 7. It can, however, already be used to increase the data rate
in specific projects today when used for archiving. The following sections describe
the basic use of AR_SEND and point out features to note. The required function
blocks must be created for each specific project.

11.24.1 Data Structure

To be able to transfer data using the AR_SEND function block from the process to
an OS measured value archive, the data must be prepared in a format suitable for
an OS. An AR_SEND block can supply one or more archive variables with data.
Since the number of AR_SEND instances depends on the CPU an AR_SEND
instance should always be used for several archive variables.

Number of AR_SEND instances:

• CPU S7-414 > 16

• CPU S7-416 > 32

• CPU S7-417 > 64

Such a data frame can be made up of one or more data blocks with each block
having two areas:

• The header contains information about the cycle and the process values and
may also contain a time stamp.

• The user data area contains the actual process values. The size of the user
data area is limited to a maximum of 16000 bytes.

Note

In the representation of the data blocks, each line represents two bytes. Process
values can be several bytes long, depending on their data type.
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Header type Header type

Cycle

AR_SEND subnumber Archive ID

Time stamp

Data type of process data
Number of following process values

First process value
Second process value

Last process value

Year

Unit (type)

Cycle
information

Information
on process values
Process values

User data
area

Header

Month
Day Hours

Minutes Seconds

Weekly

Unit (area)

Figure 11-34Data Structure for Supplying OS Archives

Header type

The header type specifies the information contained in the header.

Table 11-9 Meaning of the Header Types

 Header
type

 Meaning

0 Header without time stamp and without AR_SEND
subnumber

1 Header with time stamp and without AR_SEND subnumber

8 Header without time stamp and with AR_SEND subnumber

9 Header with time stamp and with AR_SEND subnumber

Time stamp

The time stamp contains the date and time in the SIMATIC S7 BCD format.
The weekday is not evaluated by WinCC.

Cycle

Cycle in which the process values were read, in time units. (DWORD)

Unit (type)

Table 11-10 Meaning of the Units (Type)

 No.  Meaning

1 The process values are read out in equidistant scan cycles

2 Each process value contains a time stamp.

3 Each process value contains a time difference in time units.

4 Process value contains AR_SEND subnumber (AR_SEND with
several variables - optimized)
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Unit (area)

Specifies the size of the time units used with the unit (type) = 3

Table 11-11 Meaning of the Units (Area)

 No.  Meaning

1 Reserved

2 Reserved

3 Milliseconds

4 Seconds

5 Minutes

6 Hours

7 Days

AR-SEND subnumber (AR_ID subnumber)

Establishes the assignment between the PLC user data and the OS archive
variables.
The subnumber is only relevant with header types 8 or 9. Valid values for the
subnumber are in the range 1 - 0FFF (hex).

Data Type of the Process Data

The process values are stored directly in S7 format.

Table 11-12 Data Types of the Process Data

 No.  S7 data type  WinCC data type

1 WORD WORD

2 INT SWORD

3 DWORD DWORD

4 DINT SDWORD

5 REAL FLOAT
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Number of Following Process Values

Depending on the entry in unit (type), a certain number of process values can be
transferred.

Table 11-13 Meaning of the Process Values

 Unit
(type)

 Meaning for process values

1 Process values read out in equidistant cycles:
The maximum size of the user data area is 16000 bytes. This means
that 8000 process values of the type WORD or INT or 4000 values of
the data type DWORD, DINT or REAL can be transferred.
The time stamp and the cycle must be specified in the header.

2 Process values with time stamp:
Each element of the user data area consists of a time stamp (8 bytes)
and a value. This means that 1600 process values of the data type
WORD or INT or 1333 values of the data type DWORD, DINT or REAL
can be transferred. Any time stamp contained in the header is not
evaluated.

3 Process values with time difference:
Each element of the user data area consists of a time difference (4
bytes) and a value. This means that 2666 process values of the data
type WORD or INT or 2000 values of the data type DWORD, DINT or
REAL can be transferred. A time stamp must be included in the header.

4 The process value includes AR_SEND subnumber (AR-SEND with
several variables - optimized)
With type 4, each process value consists of a word with the AR_SEND
subnumber (range of values: 1 - 0x0FFF) and a value. The date/time
stamp for the process value is the time stamp entered in the header.
The user data area therefore consists of an array of process values
preceded by the AR_SEND subnumber. Due to the data block limit of
16000 bytes, this means that 3992 process values as WORD or INT or
2660 process values as DWORD, DINT or REAL can be transferred.
The time stamp must be included in the header.
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11.24.2 Application

The AR_SEND can be used in two ways with the data structure specified above. In
both variants, several archive variables are supplied by one AR_SEND instance.

Variant 1

This is used when variables must be archived in longer cycles (in the second or
minute range). In this case, all the variables in the same cycle are scanned at the
same time (for example every 5 seconds), stored in a DB and then transferred
blocked in a frame to WinCC. This means that the updating in the trend display is
exactly within the sampling cycle on the PLC. This will probably be the most
common application.

The required data structure is as follows:

The user data consist of a data block and each process value consists of the
AR_SEND subnumber followed by a value. The data type and date/time stamp is
the same for all process values of the archive variables in this data block.

• Header type = 1 ; in other words, with time stamp and without AR_SEND
subnumber (in header)

• Unit (type) = 4 ; in other words, process value includes AR_SEND subnumber

• Unit (area) = 0 ; in other words, time stamp in header applies for all process
values, there are no relative times in the data area.

Example of a Data Area Structure

Header type = 1

process value i

Cycle = 0

AR_SEND subnumber = 0

Archive tag name
#00000123#A#00000040#00

#00000123#A#00000040#00

#00000123#A#00000040#0

Data type of process data

Da
te
nb
loc
k

Number of process values
AR_SEND subnumber for process value

process value1

AR_SEND subnumber for process value i

Year

Unit (type) = 4

Process value

Process value

Process value

AR_SEND user data
AR_ID =

Process value archive WinCC

Day
Month
Hours
Seconds

Weekday
Minutes

Unit (area) = 0

Figure 11-35  Example of a Data Structure for Variant 1

Note

If a process value contains an AR_SEND subnumber for which there is no
WinCC archive variable, this causes an entry in the WinCC diagnostic log book.
The remaining process values continue to be processed.
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Variant 2

This is used when variables need to be sampled and archived in extremely fast
cycles (for example 100 ms). In this case, the values of the variables on the PLC
are collected over the time (in other words buffered in data blocks, for example 100
values) and then blocked in a frame and sent to the OS. By collecting the values
on the PLC, fast cycles can be implemented that would not be possible when
transferring individual values via the bus. The updating of the trend display is then
somewhat "jerky" since the trend updating takes place when the variables have
been transferred. 100 Values in a 100 ms cycle means updating 100 values every
10 seconds.

The data area to be transferred consists of several data blocks.
The date/time stamp of the individual value of an archive variable is taken from or
formed from the data area depending on the specified unit (type and area) and
passed on to the OS measured value archive.

• Per AR_SEND subnumber, one data block must be set up in the data area.

• Header type = 8 or 9, in other words, with/without time stamp and with
AR_SEND subnumber

• AR_SEND subnumber = 0 is not permitted with header types 8 or 9.

• In the example, process values from equidistant cycles are assumed
(unit(type)=1), in other words, the time stamp and cycle are required in the
header. The cycle is specified in milliseconds (unit(area)=3).
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Example of a Data Area Structure

Header type = 9

Header type = 9

Cycle

Cycle

AR_SEND subnumber = 1

AR_SEND subnumber = 2

Archive tag name
#00000123#A#00000040#0001

#00000123#A#00000040#0002

Data type of process data

Da
ten
blo
ck
1

Da
ten
blo
ck
2

Da
ten
blo
ck
m

Data type of process data

Number of process values =
i

Number of process values = j

Process value 1

Process value 1

Process value 2

Process value 2

Process value i

Process value j

Year

Year

Unit (type) = 1

Unit (type) = 1

Process values 1 to i

Process values 1 to j

AR_SEND user data
AR_ID = 0x40

Process value archive WinCC

Header type =9

Cycle

AR_SEND subnumber = m

#00000123#A#00000040#000m

Data type of process data
Number of process values = k

Process value 1
Process value 2

Process value k

Year

Unit (type) = 1

Process values 1 to k

Month
Hours
Seconds

Day
Minutes

Weekday

Unit (area) = 3

Month

Seconds
Hours

Weekday

Day
Minutes

Month

Seconds
Weekday

HoursDay
Minutes

Unit (area) = 3

Unit (area) = 3

Figure 11-36 Example of a Data Structure for Variant 2
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Caution

The AR_SEND subnumbers specified in the data blocks must all be configured
on the OS. The OS stops interpretation of the user data as soon as an
unconfigured AR_SEND subnumber is recognized.

11.24.3  Configuration on the OS

In the "Properties of Process-Controlled Variables" dialog, the AR_ID and the
AR_SEND subnumber (AR_ID subnumber) are entered in the box for the
conversion DLL.

Archive variables without an AR_SEND subnumber can also be configured by
deselecting the "subnumber" check box. All archive variables configured up to
WinCC V4.02 have no AR_SEND subnumber.

How to configure the AR_ID and AR_SEND subnumber

1. Select a process archive in tag logging and select a process-controlled variable
in the data window and the "New Process-Controlled Variable".

2. With "Properties" in the context-sensitive menu, open the "Properties of
Process-Controlled Variables" dialog.

3. The entry "nrms7pmc.dll" should be displayed in the conversion DLL box. Click
the "Options" button beside this box.
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Figure 11-37 Configuration Dialogs on the OS

4. A dialog is opened in which you can enter or modify the AR_ID and the AR_ID
subnumber in hexadecimal values.
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11.24.4 AR-ID and AR_SEND Subnumber

The AR_ID and the AR_SEND subnumber (or also AR_ID subnumber) are
required for assigning the transferred data to the configured archive variables.

AR_ID:

Each instance of an AR_SEND contains and ID that is unique on the PLC, the
AR_ID. On the OS, this identifies the data transferred with this AR_SEND instance.
This AR_ID is assigned automatically by CFC (unique in the entire project), when
the corresponding input of the FB has the system attributes
"S7_server:=alarm_archiv" and "S7_a_type:=ar_send".

AR_SEND subnumber:

The AR_SEND subnumber is required when several archive variables are to be
supplied by one AR_SEND instance since the AR_ID is no longer adequate as the
only identifier.

The assignment of the data to the relevant archive variable is achieved by forming
a generic archive variable name including the AR_ID and the AR_SEND
subnumber. The name of the archive variable has the following structure:

#00000123#A#00000040#0002

In this example,

• 00000123 stands for the ID of the raw data variable in OS data manager

• 00000040 stands for the AR_ID and

• 0002 stands for the AR_SEND subnumber.

With this scheme, the OS archive system can recognize which AR_SEND
instances must be logged on during startup and which data in the frame are
assigned to which archive variable.

11.24.5 PLC Blocks

Different blocks are required on the PLC for the two different applications of
AR_SEND.

Variant 1

Here, the data are acquired per cycle and transferred directly to the OS. The data
structure in the frame is as described in Section 11.24.2 (Variant 1). All the data in
the frame are of the same data type. This means that per cycle in which the data
are to be transferred and per data type one AR_SEND frame must be created.

The block (archive block) can operate as follows:

The variables to be archived are interconnected with block inputs. Per variable
there is a second selectable input that receives the AR_SEND subnumber. The
archive block also requires a further input in which the AR_ID can be set. In each
processing cycle, the following sequences are run through:

• Acquire date/time
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• Acquire data of the interconnected inputs

• Set up the data structure with header, variables and AR_SEND subnumber
(header type = 1, unit (type) = 4, unit (range) = 0 and data type of the process
data can be programmed in the block).

• Call the AR_SEND block and transfer the data area set up in this way.

The AR_SEND block supplies information about the transmission of the frames at
outputs (DONE, ERROR, STATUS).If there are temporary problems in
communication it is possible (particularly when sending in the single second
range), that the sending of the data from the previous cycle is not yet completed. In
this case, the data area transferred with the AR_SEND block call must not be
overwritten. To avoid loss of data in such a situation, it is advisable to plan a
strategy with at least two data areas. The first data area is used to acquire and
send data when there are no problems. The second data area, on the other hand,
is intended to accommodate the data when data area 1 has not yet been released
again although data must be acquired for sending. To allow data area 2 to be sent,
however, the archive block must be processed more quickly than would normally
be necessary for the send cycle. It is advisable to process the archive block twice
as quickly as the data are acquired and archived. This means that the archive
block has a "Reserve Cycle" in which it can react to the problems described above.

Figure 11-38 Example of an Archive Block for Real Values
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The block has inputs VAL_1 to VAL_10 for the variables to be archived. These
inputs are interconnected. Each variable input is assigned to a second input for the
AR_SEND subnumber, SUBID_1 to SUBID_10. These inputs are assigned the
unique AR_SEND subnumber that is then also configured on the OS.

The block also has the input AR_ID. Here the AR_ID must be set and transferred
when the AR_SEND integrated in the block is called. This input can be assigned
the system attributes "S7_server:=alarm_archiv" and "S7_a_type:=ar_send". The
AR_ID is then assigned automatically by the system.

The return values of the AR_SEND call can be made available (for test purposes)
at the ERROR and STATUS outputs.

The block shown above is intended simply to illustrate the situation. It can also be
created in a more general form by not tailoring it to a single data type. In this case,
the inputs for the variables must be of the ANY data type and the user must make
sure that only variables of the same data type are connected to a block instance. If
the block, on the other hand, is tailored to a specific data type, CFC will make this
check.

To make the best possible use of the frames, as many variables as possible of one
data type and one acquisition cycle should be acquired and sent with one block.
The higher the number of variables per block the better the optimization in
communication. Remember, however, that further archive variables might be
added at a later point in time. You should therefore plan adequate reserves in the
user program.

You should also remember that the frame length for the user data (in other words
the data area transferred with AR_SEND) is 444 bytes with Industrial Ethernet. If
the frame is longer, it is segmented. Frame lengths slightly over 444 bytes (or
slightly over multiples of 444 bytes) are therefore not ideal from the point of view of
communication. The aim should be to manage with as few AR_SEND instances as
possible and to optimize the use of the AR_SEND instances used as far as
possible. If, for example one AR_SEND instance has 446 bytes of data to be
transferred and a second AR_SEND instance has 400 bytes, you should attempt to
shift the 2 bytes in excess of 444 bytes to the second AR_SEND. If this is not
possible, the configuration must remain as it is. Under no circumstances should a
third AR_SEND instance be configured for the 2 bytes since this would be the
worst case.

Variant 2

In this variant, the values in the PLC are collected per variable over time and then
blocked and sent to the OS. The data structure in the frame is then as explained in
Section 11.24.2 (Variant 2).

For blocks that collect and send the data on the PLC, a dual structure is ideal:

• One block that collects the data per variable (SCAN block) and

• One block that reads the collected data, packs them in a frame and sends
them (MANAGER block).

To achieve an optimum utilization of the communication, several SCAN blocks
(approximately 10) can be linked to one MANAGER block.
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SCAN Block for Data Collection

This block exists per variable and collects the data in equidistant scans in an
internal buffer. It sets up the individual blocks in the frame including the header in
its buffer. Depending on the size of the buffer, the values can be collected over
time. If the buffer is set up, for example with 1000 bytes, 250 real values scanned
at equidistant intervals can be stored. The block is executed normally in the same
cycle as the technological block from which the value is acquired. If the value is not
acquired during each execution of the technological block, it can either be called in
a slower cycle or can have an input containing the sampling time. The block also
has an input for setting the AR_SEND subnumber.

The block for data collection can either be created for a specific data type (the input
for the variable is then of the data type REAL, WORD, ...) or a general block is
created (the input for the variable must then be of the data type ANY).

The SCAN block is responsible for informing the MANAGER block when data must
be fetched and sent. Here, there are various options:

• A selectable percentage buffer level reached

• A maximum time since the last emptying of the buffer

• At least one entry in the buffer (the MANAGER block then sends at each call).

MANAGER Block for Sending Data

The MANAGER block is linked to the SCAN blocks and is installed in the same
cycle as the SCAN block or in a slower cycle. It receives the trigger to read and
send the data via the interconnection with the SCAN blocks. It reacts to a send
request by reading the data from the SCAN instances connected to it, it then
creates a contiguous data area in its own instance data and sends the data to the
OS. The MANAGER block therefore requires an input for the AR_ID.

The data on the OS are therefore updated in the same cycle in which the
MANAGER block sends the data. If the intervals between updates are too high, this
can be remedied by giving the MANAGER block and input that can be controlled
from the OS. Setting this input can then also be used to trigger the sending of data.
This allows the operator to trigger updating of the display on the OS.

The MANAGER block must also receive the information as to where the data can
be read. The input on the MANAGER block for interconnection with the SCAN
blocks must therefore be of the data type ANY. Using the ANY pointer, the DB
number of the SCAN instance can then be acquired. The buffer in the DB can be
read using a fixed offset.

The SCAN block must also be informed when the buffer has been read so that it
can write to the free buffer again. Here, it is advisable to define an interface in the
data of the SCAN block to which the MANAGER block can write and inform the
SCAN block that the data have been read.
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Figure 11-39 Example of a SCAN and MANAGER Block

Table 11-14 Inputs and Outputs of the AR_SCAN Block

 Parameter
Type

 Parameter
Name

 Data type  Comment

IN SUB_ID DWORD AR_SEND subnumber

IN Value ANY Possible data type: BYTE, WORD, INT,
DWORD, DINT, REAL

IN SCAN-TIME TIME Interval at which the value is read. If 0
is set, it is read at every call.

IN LEVEL_EVT INT When a level is reached

OUT BUFFER_OVL BOOL Buffer overflow

OUT ENTRIES INT Number of buffer process values

OUT ERR BOOL Error

OUT STATUS WORD Error status

OUT CONNECTOR WORD Connection to AR_MAN block
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Table 11-15 Inputs and Outputs of the AR_MAN Block

 Parameter
Type

 Parameter
Name

 Data type  Comment

IN AR_ID DWORD AR_Send ID

IN_OUT CON1 ANY Connection to the corresponding
AR_SCAN block

IN_OUT CON2 ANY Connection to the corresponding
AR_SCAN block

IN_OUT CON3 ANY Connection to the corresponding
AR_SCAN block

IN_OUT CON4 ANY Connection to the corresponding
AR_SCAN block

IN_OUT CON5 ANY Connection to the corresponding
AR_SCAN block

IN_OUT CON6 ANY Connection to the corresponding
AR_SCAN block

IN_OUT CON7 ANY Connection to the corresponding
AR_SCAN block

IN_OUT CON8 ANY Connection to the corresponding
AR_SCAN block

IN_OUT CON9 ANY Connection to the corresponding
AR_SCAN block

IN_OUT CONLAST ANY Connection to the corresponding
AR_SCAN block

OUT ERR BOOL Error

OUT STATUS WORD Error status

11.24.6 Comparison of Variants 1 and 2

The variants 1 and 2 each have advantages and disadvantages. The following
considerations should help to decide which variant is better in a certain situation.

Considerations from the point of view of communication

General Conditions, Assumptions:

• The following situations are compared:

- 100 REAL values with a sampling cycle of 1 second

- 100 REAL values with a sampling cycle 5 seconds

- 100 REAL values with a sampling cycle 10 seconds

• The archive block of variant 1 has 20 inputs for variables.

• The MANAGER block of variant 2 is executed in a cycle of 10s, to guarantee
updating in WinCC every 10s.

The following data are obtained for both variant 1 and 2:

• Length of the frames (header + data)

• Number of frames in 10s
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• Transferred bytes in 10s

• Relationship of process values to frame length (in other words, how high is the
proportion of process values in the frame compared to the transferred header
information)

Table 11-16 Inputs and Outputs of the AR_MAN Block

  100 REAL values / 1s  100 REAL values / 5s  100 REAL values / 10s

Variant 1 Variant 2 Variant 1 Variant 2 Variant 1 Variant 2

Frame length (bytes) 142 620 142 300 142 260

How much is header
(bytes)

22 220 22 220 22 220

How much is process
value data (bytes)

120 400 120 80 120 40

Number of frames in
10s

50 10 10 10 5 10

Transferred bytes in
10s

7100 6200 1420 3000 710 2600

Process value data rate
per frame

84% 64% 84% 27% 84% 15%

How to interpret the table:

• In short cycles, variant 1 is unsuitable since the number of frames per second
is higher than in variant 2 (and the frames are correspondingly shorter). The
use of variant 1 in cycles less than or equal to 2 seconds must be considered
as critical. If variant 1 is nevertheless used in these cycles, significantly more
than 20 variables should be processed per archive block (approximately 100 or
more) and the buffering in the block should be extended to a depth of three or
four entries to avoid loss of data.

• The user data rate gets worse and worse with variant 2 the longer the cycle
becomes (assuming that the transfer of the data is required at the latest every
10 s). The reason for this is that less and less data are buffered on the PLC in
the example.

• Variant 2 becomes less suitable the longer the data can be buffered on the
PLC. With variant 2, the longer frames can always be generated (achieving
better blocking).

• The longer the cycle, the worse variant 1 becomes since the number of frames
per second is then less than in variant 2 and the frames themselves are shorter
since the process value data rate is higher.

• In variant 1, the frame length depends on the number of variables per archive
block whereas in variant 2, it depends on the length of the buffer on the PLC.
The use of communication therefore becomes increasingly better the more
archive variables that can be processed per archive block whereas with variant
2, it is better the longer the data can be buffered on the PLC (on which, in turn,
the update time on the OS depends).

The aim of data transfer with AR_SEND must be to achieve as good a blocking of
the transferred values as possible using as few AR_SEND instances as possible.
This can be achieved better with variant 2.
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With fast cycles and/or long buffering of the data on the PLC, variant 2 is advisable,
with long cycles and transfer data within the cycle, variant 1 is advisable.

Considerations from an Engineering Point of View

The programming involved for variant 2 is higher than for variant 1 since two blocks
must be written and must be coordinated with each other (interpretation of ANY
pointers, writing the MANAGER block to the instances of the SCAN block).

The flexibility in the use of the blocks, on the other hand, is better with variant 2
since an additional archive variable can be configured by an additional SCAN block
(and, if necessary, an additional MANAGER block). This means that such an
expansion can be loaded later with the CPU in the RUN mode. If you need to
expand the archive block in the interface to add an additional archive variable in
variant 1, the change can only be downloaded to the CPU in the STOP mode. If
you use variant 1, later expansions should be planned well in advance.

Caution

When using the AR_SEND block, remember the following point: The assignment
of the trends to the archive variables is made using the names of the archive
variables. As explained above, the names of the archive variables when using
AR_SEND are generic and depend on the ID of the raw data variables in the OS
data manager. If you transfer the entire PLC-OS connection data, the raw data
variables are deleted and re-created so that the ID changes. The archive
variables must then be reconfigured and the trends reassigned to the new archive
variables.
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12 Transferring PLC-OS Connection Data

Introduction

This chapter shows you the functions involved in transferring PLC-OS connection
data (transferring OS-relevant configuration data to the operator station), explains
which configuration data are affected by the transfer, and how this data is stored
on the operator station. You will get to know the dialogs and procedures for this
transfer.

12.1 Transferring Configuration Data to the OS

Introduction

With the PLC-OS engineering transfer program, you transfer the PLC configuration
data created on the ES for operator control and monitoring to the database of the
operator station.

Which Data are Transferred?

When you transfer the configuration data, the structures and data required for
operator control and monitoring are created on the operator station.
Connection configuration must perform the following tasks:

• Create the SIMATIC S7 PROTOCOL SUITE communication driver

• Create the WinCC units, for example, Industrial Ethernet, PROFIBUS etc.

• Create a logical connection for each S7 program

• Create raw data tags for the message and archive system

• Create the structure types for the block types and shared data blocks to be
transferred to WinCC

• Create the process tags for the block parameters to be transferred to WinCC

• Create the tag list

• Create the picture tree manager data

• Create the external tags for SFC visualization

• Generate OS message numbers and transfer the messages and message
texts
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Basic Procedure

The procedure involved in transferring the configuration data for operator control
and monitoring to the database of the OS is shown below.

Note
In an OS, base data are created with the aid of the Split Screen Wizard and the Alarm
Logging Wizard. When you transfer to an OS the first time and no base data have yet
been set in the OS, the Split Screen Wizard and the Alarm Logging Wizard are started
automatically. For further information on the wizards, refer to Section 11.2 (Base Data).

You start the transfer program in the SIMATIC Manager with the menu command
"Options > PLC-OS Connection Data > Transfer ". You then obtain dialogs in
which you make your settings.

Settings that you make are stored for a specific project. If you exit the PLC-OS
Engineering application, and then start it again with the same or a new project, the
last settings of the selected project are restored.

Follow the steps outlined below:

1. Introduction
Here, you will see general information about the transfer.

2. Assignment of the S7 programs to the operator stations
Here, you assign the S7 programs to the operator stations of a project for the
selected PLC. You will see a list of operator stations and a list of all S7
programs.

This page is only displayed when there is more than one operator station and
more than one S7 program. If there is only one of each, the assignment is
made automatically.
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Figure 12-1 Assigment of the S7 programs to the operate station

3. Selection of the program and the network connection
Here you specify which program you want to transfer at this point in time to
which OS.

It is possible that program(2) is not yet ready and you want to transfer it later
(do not click the check box in front of program(2)). You nevertheless want to
transfer Program(1) now (click the in front of the program and click OS(2)).

In the right-hand window, you select the connection you require between the
PLC and OS during run time (for example, Industrial Ethernet) by selecting the
program and clicking the Connection button.
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Figure 12-2   Specifying the Network Connections

4. Selecting the transfer data and the transfer mode
Here, you select the transfer data (for example, tags and messages, SFC
Visualization, including the plant hierarchy in the Picture Tree Manager of the
OS) and the transfer mode (transfer all data or only data that has changed
since the last transfer etc.).

With the "Size of transfer" you can select between three different options:

• The "All - with Clear Operator station(s)" is the default mode. All the PLC data
on the operator station is deleted and data of the S7 programs selected for
transfer is transferred.

• The "All" mode is always a good idea when you have several assigned S7
programs and have not selected all of them for transfer. This makes sure that
data on the operator station belonging to the S7 programs not selected for
transfer is retained on the operator station.

• You should only select the "Changes only" mode when you have only inserted,
deleted, or modify a few objects relevant to operator control and monitoring (for
example, CFC blocks, SFC charts, instance data blocks, shared data blocks,
symbols).
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Note
If you want to delete all the PLC data on an operator station, select all the options in the
Transfer Data section on this page. Select the "All - with Clear operator station(s)" mode
and deactivate all the S7 programs assigned to the operator station on the page where
you select the S7 programs.

Figure 12-3 Selecting the Transfer Data and the Transfer Mode

5. Executing the transfer
Here, the settings you have made are listed and you can still change settings
(by going back to the previous pages) or you can start the transfer.

All other available options are described in the online help (click the “Help”
button).
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Note
The settings you made in the individual steps are saved following successful transfer and
are the default settings the next time you start the transfer wizard. One exception to this is
the function "Save with consistency check" of the SIMATIC Manager. After running this
function, you must make the assignment of the programs to the operator station again and
set the network connection. Afterwards, everything must be mapped again (size of
transfer > all).

Caution:
Remember that any changes you make to the data transferred to the OS will be
overwritten again the next time you transfer.
If for example you change the lower or upper value of a tag in the data manager or change
a message text in alarm logging, the next time you transfer the data, your modifications will
be overwritten.

Exception:
If you run a delta transfer and the tags or messages you have modified on the OS have
not been modified on the ES, these will be retained on the OS.

Displaying the Transfer Log

Each time you transfer PLC-OS data, a log is created that provides you with
information about existing PLC-OS connections, errors that occurred during the
transfer, and tag names etc.
If warnings or errors occurred during the transfer, a dialog is opened in which you
can decide whether or not to display the transfer log. You can also display the log
at any time with the menu command
"Options > PLC-OS Connection Data > Display Log  ".

Substitute Character Strategy

Not all the characters permitted in the PLC configuration data are permitted as part
of a tag name on the operator station. The characters are converted to the
substitute character $.
The characters [ ’ ] [ . ] [ % ] [ \ ] [ * ] [ ? ] [ : ] [ blank ] are converted to the substitute
character $.
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12.1.1 Tag Management on the Operator Station

All the channels, logical connections, process and internal tags and tag groups are
managed by WinCC in the Tag Management. The variables transferred from the
SIMATIC Manager are stored in the Tag Management of WinCC. The Tag
Management is divided up as follows:

Figure 12-4  Structure of the Tag Management
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           :
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PROFIBUS (II)
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TCP/IP
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Tag of a Connection

Within the SIMATIC S7 Protocol Suite, you will find the individual interfaces in
which the existing connections to the PLC systems are entered. The connections
contain the variable from the PLC systems. If special characters have been
assigned in the SIMATIC Manager, these are converted to the substitute character
"$" during transfer. The chart name "NK111%1" would, for example, be changed to
"NK 111$1" in the Tag Management.

Figure 12-5 Naming Scheme for a Process Variable

Plant hierarchy 1st level
Plant hierarchy 2nd level
CFC chart name

Block name

Element name

Data type

Instance data block
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Tag Management
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12.2 Transferring the "COLOR_PH" Project

You have created the hardware configuration for the "COLOR_PH" project, defined
the network configuration, created the CFC and SFC charts and the configuration
of the operator station. The last stage is to transfer the parts of the PLC
configuration data relevant for operator control and monitoring to the operator
station. Follow the steps outlined below:

6. Select the menu command "Options > PLC-OS Connection Data > Transfer"
in the SIMATIC Manager.

7. In Step 1 "Introduction" select the "Next" button.

8. The check boxes for the OS and  S7-Program(1) must be selected in the left-
hand window. Click the "Connection" button and select the network via which
the data will later be transferred in runtime between the PLC and OS. For the
example, specify the connection you have selected. Click the "Next" button.

9. Select the following transfer options:

- Transfer data: "Tags and Messages", "SFC Visualization" and "Picture
Tree"

- Transfer: "All" and "Clear operator station(s)"

- Click the "Next" button.

10. Start the transfer by clicking the "Transfer" button.

The transfer is started.

For more information on the structures created by the connection configuration,
refer to Section12.1.1

Setting the Properties of the Operator Station

You have now completed connection configuration. Before you start the run time,
you must set the properties of the computer correctly in the Control Center. Follow
the steps below:

1. Select the "Computer" in the Control Center and select the menu command
"Edit > Properties".

2. In the step "Computer List Properties", click the "Properties" button.

3. Select the "Startup" tab in the "Computer Properties" step and check whether
all the check boxes for the applications in the "Order when starting WinCC
Runtime" box are selected.

4. Complete editing of the steps with "OK".

5. Start the run-time system of the operator station "File > Activate" and check
your configuration.

If you do not get a connection to the PLC (all the process values on the
operator station are displayed in gray), check the network settings (WinCC
Explorer > Tag Management > SIMATIC S7 Protocol Suite > transferred
interface (for example, Industrial Ethernet) > Properties > Properties >
"Connections" tab).
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13 Installation Guidelines

Introduction

A PCS 7 system can only function perfectly if the installation guidelines are kept to.
This chapter contains additional information about lightning protection, grounding
and EMC-compliant installation. The basic installation guidelines can be found in
the installation manuals of the components  (for example S7-400 programmable
controller, hardware and installation).

13.1 Installation Guidelines

Introduction

The method of installation is largely determined by the components used in
SIMATIC CPS 7:

• Operator stations

• SIMATIC NET (Fast Ethernet, Industrial Ethernet and PROFIBUS)

• S7-400

• Distributed I/Os (ET 200 M and field devices)

Each component has numerous installation variations that can be adapted to meet
the requirements of a particular application.

There is also the option of installing programmable controllers and the distributed
I/O systems ET 200 M in cabinets.

For more detailed information about the installation of an entire plant (lightning
protection, grounding, etc.) refer to sections 13.1.1, 13.1.2 and 13.1.3. The options
available for connecting process signals to the CPUs are described in detail in
Chapter 1 (Structure of the I/Os).

Rack or Wall Mounting

The PCS 7 system can be mounted in racks or on a wall if the system is being
operated in an environment with low noise levels in which the permitted
environmental conditions can be maintained. To discharge voltages coupled in on
large metal surfaces, you should install rails, shields and the lightning conductive
bar on reference potential surfaces made of sheet steel.



Installation Guidelines

Process Control System PCS 7, Configuration Manual
13-2 A5E00122418-01

Cabinet Installation

With the SIMATIC PCS 7 process control system, the S7-400 programmable
controllers and the ET 200M modules can be installed in cabinets. Figure 13-1
shows the S 7-400 programmable controller and distributed I/O system ET 200 M
installed in a cabinet. The different racks can be combined as necessary to allow
you, for example, to install the distributed I/Os in separate closets (electronics
closets, wiring closets).

Figure 13-1Possible Configurations in a Cabinet

The cabinets made up of system and I/O units and modules that do not belong to
the system (basic cabinets,  supply units and optional packages) provide reliable
protection against unauthorized manipulation, mechanical influences,
contamination and corrosion. Due to the modularity and associated variability, the
cabinets can be adapted to different types of system and different sizes of system.

EMC

The SIMATIC PCS 7 system and its components comply with the EMC
requirements of European standards. These standards require that devices that
correctly installed, suitably maintained, and used of the correct purposes have a
suitable  immunity to noise during use. The emission of noise is limited so that the
normal operation of radio and telecommunication devices can be guaranteed.
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The cabinets of the SIMATIC PCS 7 system consisting of the system units, I/O
units, basic cabinets, power supply units and optional packages are CE compliant.
This means that the cabinets and the SIMATIC PCS 7 system comply with the
EMC regulations such as:

• Electromagnetic compatibility(89/336/EEC; 92/31/EEC)

• Low voltage directive (73/23/EEC; 93/68/EEC)

• Hazardous areas directive (94/9/EEC)

13.1.1 Lightning Protection

Introduction
Industrial plants and power stations must be equipped with lightning protection  to
protect people, buildings and equipment from damage resulting from lightning
strikes. Process control systems with extensive cabling networks are often at risk
since high voltages can occur between points at great distances from each other.
The destruction of electronic components due to lightning can lead to plant failure
with extremely expensive consequences.

The risk of damage by lightning can result from

• a building being struck directly

• a lightning strike in the immediate vicinity of the system

• a remote strike (in a free line)

• cloud to cloud discharge

Originating in the lightning channel, the lightning creates a cylinder-shaped
electromagnetic wave that penetrates into the building and induces voltages in
cable loops. The closer the lightning strike, the more powerful the fields created.

Both with lightning from cloud to cloud or from cloud to earth, the charges induced
in free lines (high and low power and telecommunication lines) change. These
changed charges then flow as traveling waves along the cable. If these traveling
waves reach equipment at the end of the cable they can also enter a plant or
system. Normally, however, only signal and bus cables in the vicinity of
transformers and signal and telecommunication lines are at risk.

The lightning protection for a process control system can be roughly divided into
external and internal lightning protection.
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External Lightning Protection

External lightning protection includes all the equipment used outside a building for
discharging lightning to earth.

Internal Lightning Protection

Internal lightning protection includes the measures taken to counteract lightning
and the effects of its electrical and electromagnetic fields on metallic installations
and electrical systems within the building.

Lightning Protection Concept

The principle of a lightning protection zone requires that facilities to be protected
from overvoltages, for example a part of a factory, should be divided into lightning
protection zones based on EMC considerations.

The division of the lightning protection zones is made according to the distance
from a point liable to lightning strikes and the resulting high-energy electromagnetic
fields. Lightning protection zones are as follows:

Table 13-1    Table of Lightning Protection Zones

 External lightning protection of the
building (field side)

 Lightning protection zone 0

The shielding of

- Buildings

- Rooms and/or

- Devices

Lightning protection zone 1

Lightning protection zone 2

Lightning protection zone 3

Note:
The rules for bridging the interfaces between the lightning protection zones and a sample
circuit for networked SIMATIC stations are explained in "S7-400, M7-400 Programmable
Controllers, Hardware and Installation".
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13.1.2 Electrical Installation

Introduction

The perfect interaction of PCS 7 components depends to a large extent on the
adherence to certain rules regarding electrical installation. This involves the
following aspects:

• Equipotential bonding (VDE 0100)

• Grounding

• Overvoltage protection

• Shielding

• Cabling

Equipotential Bonding

According to VDE 0100, all electrically conductive metal parts of a system (cabinet
panels, racks etc.) must be interconnected. This ensures that any potential
differences are reduced to such an extent that there is no danger for either human
beings or equipment.

Grounding

Low-resistance ground connections reduce the risk of electrical interference in
case of short circuits or faults in the system. By using low-impedance connections
for grounding and shielding cables and devices, the effects of noise on the system
and the emission of noise from the system can be reduced.

The SIMATIC S7-400 programmable controller and the distributed I/O system
ET 200M allow both grounded and ungrounded operation.

Grounded Reference Potential or Ungrounded Design

The modules used in the S7-400 are always grounded via the backplane bus of the
rack. This strategy is used usually in machines or in industrial plants and
interference currents are discharged to local earth.

In the chemical industry or in power stations, it may be necessary to operate
systems with an ungrounded reference potential due to the ground-fault detectors.
In this case, a jumper on the rack can be removed so that the reference potential is
connected to local earth via an integrated RC network.
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Overvoltage Protection

Overvoltages can occur at module outputs when inductors are turned off (for
example relays). The digital modules of the SIMATIC S7 400 have integrated
overvoltage protection. In certain situations (for example when there is an
additional contact between the module output and inductor), an external
overvoltage suppressor must be installed directly on the inductor.

Balanced Signal Circuits

In balanced signal circuits, all the signal routes have the same impedance. This
means that if there is interference, the induced longitudinal voltages in the signal
cables are of the same magnitude and no interfering current can flow. A balanced
signal circuit is typically used for highly sensitive measurement circuits and for
systems operating at high frequencies. Balanced measuring circuits have a high
degree of immunity to noise but are extremely complicated and hardly found in
process control systems. In process control systems, shielding of cables is
preferred.

Shielding

Cables are shielded to reduce the effects of magnetic, electrical, and
electromagnetic disturbances on the cables. The interference currents induced in
the shields are discharged direct to ground via low-impedance connections.

Braided shields are preferred to foil shields since foil shields can be damaged
easily and the efficacy of the shield reduced. Grounding shields via long, thin wires
also makes the shield ineffective. Due to the high inductance, interference currents
cannot flow to ground.

If the shielding effect of the cable shield is inadequate, the cables should be pulled
into metallic conduits that are grounded at both ends.

With high-frequency disturbances, it is advisable to contact the shield at both ends
of the cable, whereas for low-frequency interference, the shield should be
contacted at the start or end of the cable. The effectiveness of the shield with low-
frequencies is determined by the ohmic resistance (shield cross section), while with
high frequencies the inductance and therefore the structure of the sheath (closed
conduit better than braid etc.) decides the effectiveness.

To prevent coupling in magnetic fields, shields should, whenever possible, be
connected to an equipotential bonding system at both ends. Indoors, this is often
not done because fears of illegally high current load on the foil shields due to
power-frequency interference currents.

Grounding both ends of a shield is not permitted when strong magnetic inference
fields are present (generators, conductor bars). Connecting the shields at both
ends would form a loop into which power-frequency interference voltages could be
coupled.

To avoid the effects of induced voltages resulting from magnetic fields, signal
cables are twisted. The twisting results in a positive induces voltage in one half of
the twist and a negative voltage in the other. These voltages cancel each other out
over the length of the full twist.
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The following schematics illustrate possible shielding configurations.

Figure 13-2 Cable Shields Part 1

Figure 13-3 Cable Shields Part 2
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Contacting the Cable Shield at the Cubicle Inlet

Care must be taken that interference running along the cable shield is not allowed
to enter electronics cubicles.

If the cable shields are grounded inside the cubicle or casing, the field generated in
the shield grounding cables by the shield current is coupled not only into the
unshielded signal cables but also into the loops on the modules behind the inlet
protection circuits and generates interference voltages. For this reason, when you
ground the shield at both ends, it should be grounded directly at the point where it
enters the cabinet.

You should also make sure that the shields make large-area contact on the
grounding bar. Long thin wires between the shield and ground bar have high
inductance and are therefore unsuitable for discharging interference currents with
high frequencies.

Note the following points:

• Use short wire lengths (if possible do not use wires at all but make direct large-
area contact)

• Choose a suitable route for the shield grounding wires (do not lead them close
to sensitive electronics)

• Use a short, thick cable from the shield bar to the equipotential bonding system

If cabinets or casings are included to shield the control system, remember the
following points:

• Cabinet panels such as side panels, back panels, ceilings and floors should be
contacted at adequate intervals when cascaded.

• Doors should have extra contacts to the cabinet chassis.

• Cables leaving the shielding cabinet should either be shielded or fed via filters.

• If there are sources of strong interference in the cabinet (transformers, cables
to motors etc.), they must be separated from sensitive electronics by partitions.
The partitions should be connected with low impedance to the equipotential
bonding system via the cabinet.

All housings, cabinets etc. should be connected to the equipotential bonding
system over the shortest route possible. Often, an independent equipotential
bonding system is created that is connected to the equipotential bonding system of
the remaining plant by a single cable.

It is a mistake to connect the PCS 7 process control system to a ground point
outside the plant. The magnetic fields generated by the interference currents
flowing in the equipotential bonding system induce voltages in the additional
surface between the equipotential bonding conductors and the connection to
ground.
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Cabling

The aim of cabling is to reduce the field of interference current between the "culprit"
and the signal cable to a minimum by laying the cable directly on the conductor
carrying the interference current.

Signal and bus cables should be laid next to cables with a large diameter since the
field strength is lower here than with cables with a smaller diameter.

If the conductor carrying the interference current is a plate (for example belonging
to the building structure) lay the signal cable in the middle of the plate where the
field strength is at its lowest. The cable should be fixed to the side of the plate with
the least noise. This also applies to angles and girders.

Field lines

Cable Cable

Field lines

Figure 13-4 Field Lines around Angles and U-Shaped Structures

The lines of a signal or bus connection should be in one cable and be surrounded
by a common shield. The cable should be laid as close as possible to the exciting
cable to keep the insulation stress to a minimum.

The cable carriers (for example cable racks) should be connected to the
equipotential bonding system if there is no interference carrying part of the
equipotential bonding system is close. The cable shield can then be contacted at
both ends with the casings of the electronic equipment and in turn connected to the
equipotential bonding system.

Note:
For more detailed information on the electrical structure, refer to "S7-400, M7-400
Programmable Controllers, Hardware and Installation" .
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13.1.3 Basics of EMC-Compliant Installation of PCS 7

Introduction

Measures to counteract noise are usually only taken when the system is already in
operation and problems are encountered receiving signals.

Although the SIMATIC PCS 7 system and its components were designed for use in
an industrial environment and meet strict EMC requirements, an EMC assessment
should be performed prior to installation and possible sources of noise identified.

Possible Sources of Noise

Various electromagnetic disturbances can affect automation systems in various
ways.

• Electromagnetic fields can affect the system directly.

• Disturbances can be transported by bus cables.

• Disturbances can be transferred via the signal wiring.

• Disturbances can reach the system via the power supply or the protective
earth.

Mechanisms

Disturbances arising from various coupling mechanisms can affect the PCS 7
system. The type of coupling mechanism depends on the distance between the
source of the disturbance and the PCS 7 system and the transmission medium.

Table 13-2    Mechanisms that Couple in Disturbances

 Coupling
Mechanisms

 Cause  Sources of disturbance

Galvanic
coupling

Occurs when two circuits share a
common line

Switched mode devices; motors
starting; static discharge

Capacitive
coupling

Occurs between two cables at
different potential

Crosstalk between parallel signal
cables; contactors; static discharge
from operator

Inductive
coupling

Occurs between two cables
carrying current. The magnetic
fields of voltages induced by
currents.

Transformers; motors; parallel
power cables; cables with switched
currents; high-frequency signal
cables

Radiated
coupling

Occurs when an electromagnetic
wave meets a cable. Voltages and
currents are induced.

Adjacent transmitters (walkie-talkie);
radio links
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Rules for Maintaining Electromagnetic Compatibility

Keeping to the following rules is normally adequate to guarantee electromagnetic
compatibility:

• Protect the programmable controller from external noise by installing it in
cabinet or casing. Include the cabinet or casing in the chassis connections.

• Shield against the magnetic fields of inductors (transformers, motors, contactor
coils) using partitions (steel, highly permeable material) from the programmable
controller.

• With shielded signal and bus cables use metallic connector casings (not
metalized plastics)

• Connect all inactive metal parts together wit low impedance and making large-
area contact and also to local ground.

• Create a central connection between the inactive metal parts and ground point.

• The shield bar should be connected to chassis with low impedance and making
large-area contact.

• Divide cables into cable groups and lay them separately.

• Lay power cables, signal cables and bus cables in separate channels or
bundles.

• Lay Ex (hazardous area) and normal signal cables in separate channels.

• Only feed cables into a cabinet from one side.

• Lay signal and bus cables as close as possible to chassis surfaces (for
example support struts).

• Use twisted cables.

• Contact the shields of signal cables at both ends.

• Lay analog cable with double shields. The inner shield must be contacted at
one end and the outer shield at both ends.

• Contact cable shields with the shield bar over a large area immediately where
they enter a cabinet and secure with clamps.

• Continue the contacted shield to the module without interrupting it.

• The cable shield must not be interrupted between the function units and must
be contacted at both ends.

• Do not interconnect cable shields.

• Use only network filters with metal casings.

• Connect the filter casing over a large area; in other words with low impedance
to cabinet chassis.

• Never secure filter casings to painted surfaces (remove paint!).

• Install filters at the point where the cable enters the cabinet.

• Unfiltered cables must not be laid in cabinets.
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Glossary

A

Access

Chart elements or block I/Os can access addresses, charts, block I/Os, or run-time
groups. A distinction is made between read and write access.

Access Path

Setting in the ↑ setting the PG/PC interface tool. In the "access path" tab, you
assign a module parameter set to an access point. This means that the
applications that use this ↑ access point, access the module belonging to the
module parameter set.

Access Point

Setting in the ↑ setting the PG/PC interface tool. An access point establishes the
connection between an application, an interface parameter set, and a module

Acknowledge Tag

The "acknowledgment state" of a message is entered in the acknowledge tag. This
allows a central signaling unit to be activated using the acknowledge tag.

Acknowledgment (OS Message System)

A pending message can be confirmed in two ways:

Single acknowledgment: Messages that do not have the attribute "group
acknowledgment capability" must be confirmed individually.

Group acknowledgment: Using a group acknowledgment, all the individual
messages visible in a ↑ message window and that have the attribute "group
acknowledgment capability" are confirmed together.
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Acknowledgment Philosophy (OS Message System)

The acknowledgment philosophy is the way in which a message is displayed and
processed from "entering state" to "leading state". In the OS message system
(Alarm Logging), the following acknowledgment philosophies can be implemented:

• Single message not requiring acknowledgment

• Single message requiring acknowledgment of entering state

• Single message requiring acknowledgment of leaving state

• Initial value message with single acknowledgment

• New value message with single acknowledgment

• New value message with double acknowledgment

• Message without "leaving state" status not requiring acknowledgment

• Message without "leaving state" status requiring acknowledgment

Acoustic Indicator

Horn, bell, buzzer or similar as an acoustic indication that a new message has
arrived at the operator station (in run-time).

Action

(SFC) Actions allow the activation or deactivation of run-time groups and SFC
charts as well as modifications to blocks and shared resources by assignments to
their input parameters. The actions are formulated in the Properties dialog.

Address

An address identifies a specific address or address area, examples: Input I12.1;
memory word MW25; data block DB3. An address can be specified in either
absolute or symbolic form.

Address

An address is part of a STEP 7 instruction and tells the processor what it should
perform an operation on. It can be addressed in symbolic or absolute form. In SFC,
the address is part of an assignment (step) or condition (transition).

Addressing, Absolute

In absolute addressing, the address is the absolute memory address of the value
with which the instruction will be performed. Example: The address Q4.0 identifies
bit 0 in byte 4 of the process image output table (PIQ).
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Addressing, Symbolic

In symbolic addressing, the address to be processed is specified in a symbolic
form (instead of an absolute address). The assignment between the symbol and
address is made in the symbol table.

Alarm Logging

Editor for configuring the message system within the operator station and
application for displaying, archiving and handling messages.

Alarm Logging Wizard

Dialog-guided menu for creating default settings for the message system within the
operator station.

Alternative Sequence

(SFC) A structural element that consists of at least two sequence paths. Only the
path whose transition condition is satisfied first is processed by the PLC.

ANSI

American National Standardization Institute

ANSI-C

Part of the C programming language standardized by ↑ ANSI.

Archive

The operator station saves measured values and messages in archives so that the
data can be called up over a longer period of time.

Archive Log (OS Message System)

To log the messages, the OS message system provides the ↑ message sequence
report and the archive report. With the archive report, you can print out the status
changes of messages stored in an archive. In the run-time system of the OS for
example, the operator can set a filter for a message page (for example all alarms
since 12:00 o’clock) and then output the filtered messages to a printer by clicking
the appropriate button.

AS Interface

The actuator-sensor interface is a network system for binary actuators and sensors
at the lowest field level.
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Associated Value

Current process value that you attach to a message triggered on the SIMATIC
station (PLC). On the message page of the operator station, the message along
with the current measured value appears in a line (for example 5.5 bar pressure
too high).

Autosensing

With Fast Ethernet, ports of the DTEs are capable of both 10 Mbps and 100 Mbps.
When Autosensing is active, the maximum transmission rate of the DTE is
detected and set at the port.

B

Base Data

Base data includes the ↑ Split Screen Wizard and the ↑ Alarm Logging Wizard.

Basic Operation

Basic operations (BOPs) are objects in the system that provide simple functions
such as AND, OR etc. They are displayed as blocks in CFC.

BATCH Flexible

Software for automating recipe-controlled batch processes.

Block

Blocks are separate parts of a user program that are distinguished by their
function, their structure or purpose.

CFC operates with "off the peg" block types that can be inserted in a CFC chart.
When you insert the block, an instance of the block type is created. These block
instances and their graphic representation are blocks in the sense of CFC.

Block Attributes

See system attributes

Block Header

The upper part of a block in the display of the CFC chart containing, among other
things the name and the task assignment (run-time property).
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Block Input

Block I/O that can be interconnected with a block output and ↑ addresses of a
compatible data type or that can have values assigned to it.

Block Instance

A block instance is the implementation of a block type. A block type
inserted in a CFC chart becomes an instance. After it is inserted, the block instance
has run-time properties and a unique name within the chart.

Block Interface

Consists of the inputs and outputs of a block.

Block I/O

Block input or block output

Block Library

↑ Library

Block Output

Block I/O that can be connected to block inputs and ↑ addresses of a compatible
data type.

Block Type

The block type identifies the various implementations of blocks. Block types,
include for example data blocks (DB), function blocks (FD), functions (FC).

Block Type

Block types are ready-made program sections that can be inserted in a CFC chart
(for example controllers, multiplexes etc.). When a block type is inserted, a block
instance is created. You can create any number of block instances from a block
type.

The block type determines the characteristics (algorithm) for all implementations of
this type. The name of the block type is specified in the symbol table.

Branch&Merge

The division of a project into various subprojects (for example every PLC is a
subproject and the OS is a further subproject) so that several configuring engineers
can work on a project at the same time.
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Bus

A path for electrical systems allowing the exchange of data and control information
between various components of a computer architecture.

Bus System

Generic term for hardware components and the transmission specification for
↑ busses.

C

C Action

see ↑ scripts

Central Processing Unit (CPU)

The CPU is a central module in the programmable controller in which the user
program is stored and executed. It includes the operating system and the
communications interfaces.

CFC

Continuous Function Chart.

1. Continuous function chart (CFC chart) with the graphic interconnection of
technological functions (blocks).

2. A software package (CFC editor) for plant-oriented, graphic configuration of an
automation task. Using CFC, ready-made blocks are put together to form an
entire software structure (CFC chart).

Chart

Document in which continuous automation functions can be created with the CFC
configuration tool or sequential control systems with SFC.

Chart Element

(SFC) Chart elements are the basic elements (step, transition, text) and structure
elements (sequence, simultaneous sequence, alternative sequence, loop and
jump).

Chart Folder

Folder in the project structure; this contains the charts of a user program.
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Chart-in-Chart Technique

See ↑ nested chart

Chart I/O

You can provide a chart with I/Os to extend your options such as

• inserting the chart in a different chart (↑ nested chart) and interconnecting it
with other charts or blocks

• or to compile it as a ↑ block type.

Chart Overview

The overview of a CFC chart (partition) with its six sheets.

Chart Partition

Part of a CFC chart. A CFC chart can be divided into a maximum of 26 chart
partitions ( labeled: A to Z ) each with 6 sheets.

Chart Topology

(SFC) In the chart topology, the chart elements are represented according to fixed
syntactical rules (for example order, spacing, extent and arrangement of the
elements). The syntactical rules are kept to automatically when you create the
chart topology with the editor.

Cold Restart

During a cold restart on an S7-CPU, the organization block OB102 is executed (↑
Startup of an S7-CPU).

The following rules apply to the "Cold restart":

• Data blocks created by SFCs in the work memory are deleted, the other data
blocks have the default values from the load memory.

• The process image and all timers, counters, and memory bits are reset
regardless of whether they were set as retentive.

During a cold restart, the process image input table is read and the STEP 7 user
program is executed starting at the first instruction in OB1.

Commissioning

To support commissioning, the CFC/SFC editor has integrated test functions that
allow the sequence of events on the PLC to be monitored, influenced and if
necessary parameter settings changed.
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Compilation

Conversion of the graphic CFC to a user program
(SCL for S7 or C for M7).

Component View

Device-oriented view in the SIMATIC Manager. The project is displayed with its
components (station, module, program ...); alternative
to the ↑ plant view.

Connection Table

Table for defining communication connections between modules in a network.

Connector

(CFC) The connection point on the block with a reference to the I/O to which it is
connected. Connectors are used when no more connecting lines can be drawn on
a sheet because it is already full. The connectors allow complex CFC structures
including those extending to other sheets to be displayed completely.

Consistency Check

Checks the consistency of block types, shared addresses etc. of the chart folder.

Consistency Error

The output of an error message with detailed information following a ↑ consistency
check.

Continuous Archive

After the configured number of data records or after a configured time, the↑ archive
is overwritten cyclically beginning with the oldest data record.

Control and Monitoring Attributes

See system attributes

Control block for SFC

With the SFC control block (SFC_CTRL), you can query the status of an SFC chart
and influence its execution in CFC. The control block is inserted in the CFC chart,
interconnected, and assigned parameters. It has its own run-time properties and
can be modified (along with the SFC chart) in the run sequence. The control block
must always be installed immediately before an SFC chart in the run sequence.
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CP

Communications Processor - communications module for installation in computers
or programmable controllers.

CP 443-1

↑ CP for use in ↑ Industrial Ethernet

CP 443-5 Basic

↑ CP for use in ↑ PROFIBUS

CSV

CSV stands for "Comma Separated Value" and is an ASCII text format in which
tabular data are saved. CSV files used in the IEA must have the extension .IEA.

Cycle Time

The cycle time is the time required by the CPU for processing the user program
once.

D

Data Block (DB)

Data blocks are areas in the user program that contain user data. There are shared
data blocks that can be accessed by all logic blocks, and there are instance data
blocks that are associated with a particular function block call. In contrast to all
other types of blocks, they contain no logic instructions.

Data Type

A data type specifies how the value of a variable or constant is used at a block I/O.
"BOOL", for example, defines a binary variable; "INT" defines a 16-bit fixed-point
variable.

dBase-III

Format of the database program of the Borland company (American software
manufacturer).

DCF 77

Time transmitter in Frankfurt/Mainflingen. This provides the highly accurate official
time for Germany based on a cesium clock.
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Diagnostic Buffer

Battery backed memory area on the CPU in which all diagnostic events are entered
in the order in which they occurred.

DOCPRO

Program for creating project documentation.

Download-Relevant Change

A modification in a CFC/SFC chart is download-relevant when it causes a change
in the user program of the CPU (for example a change to an interconnection).
Modifications that are not download-relevant, for example, include CFC block
positions and comments.

DP

Distributed Peripheral I/Os - input/output modules used in a distributed
configuration and located away from the CPU. The programmable controller and
the distributed I/Os are connected via the ↑ PROFIBUS DP bus system.

DP Master

A master conforming with the PROFIBUS DP standard (EN 50170, previously
DIN E 19245, Part 3) is known as a DP master.

DP/PA Coupler

Connectivity module between ↑ PROFIBUS DP and ↑ PROFIBUS PA.
This module does not require any parameter assignment.

DP/PA Link

Hardware made up of an IM 157 interface module and several
↑ DP/PA couplers. The DP/PA link connects ↑ PROFIBUS DP with
↑ PROFIBUS PA and must be configured in hardware configuration.

DP Slave

A slave operated on PROFIBUS with the PROFIBUS DP protocol is known as a
DP slave.

Dynamic Display

Dynamic display means that the input or output values of a block in the CFC chart
or address values in the SFC chart can be updated with the values of the CPU in
the test mode.
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Dynamic Display Window

Window in CFC for monitoring selected block I/Os on CPUs.

Dynamic Wizard

Configuration dialogs for creating graphic objects, connections to graphic objects,
archives etc.

DynWizEdit

Editor for creating ↑ dynamic Wizards.

E

Edit Mode

(Alternative to the ↑ test mode)
In CFC, blocks can be inserted, copied, moved, deleted, renamed, have
parameters assigned, or be interconnected.
In SFC, the sequential control system is created in this mode. Chart elements can
be inserted, copied, moved, deleted, renamed, and assigned parameters.

EMC

Electromagnetic compatibility State in which electrical or electronic devices do not
interfere with each other.

EMSR Designation

Elektro-, Meß-, Steuerungs,- und Regelungstechnik designation. Standardized
designations for graphic symbols and identifiers in process control engineering.

Enable Attribute

The enable attribute is a run-time attribute. It activates or deactivates a run-time
group or an SFC chart. As long as it is deactivated, the group (or SFC chart) is not
executed regardless of any other conditions. The enable attribute can be set
dynamically. In this case, the output value of a CFC block or the assignment in an
SFC Action decides whether the group or SFC chart is activated or deactivated.

ET 200M

This is a modular I/O system for single-tier configuration with the degree of
protection IP 20. The ET 200M can be extended with the signal, function and
communication modules of the S7-300 programmable controller. Communication
between ET 200M and the PLC is on ↑ PROFIBUS DP.
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Ethernet

One of the earliest local area networks. Today, Ethernet is used on coaxial cable or
fiber-optic cable.

F

Faceplate

A software block written in Visual Basic or Visual C that allows a block instance to
be controlled and monitored during run-time on an operator station.

Fail-Safe Systems

Following the failure of a component, these systems change to a fail-safe state to
avoid injury to persons and damage to equipment or the environment.

FAQ

Frequently Asked Questions - information on several Internet pages with
Tips & Tricks for PCS 7 "http://www.ad.siemens.de/csinfo".

Fast Ethernet

Fast variant of ↑ Ethernet. Approximately 10 x faster data transmission.

Fault-Tolerant System

A PLC (S7 400H) in which all the essential components exist twice. If one of the
subsystems fails (for example a component failure) the other takes over
automation of the plant without any interruption.

FDL Connection

Fieldbus Data Link – Layer 2 of the ISO reference model in PROFIBUS; it consists
of Fieldbus Link Control (FCL) and Medium Access Control (MAC).

Function (FC)

According to IEC 1131-3, functions are logic blocks without memory. A function
allows parameters to be passed on in the user program. Functions are ideally
suited for programming commonly occurring complex functions, for example
calculations.
Note: As there is no memory available, the calculated values must be processed
immediately following the FC call. See also ↑ block type.
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Function Block (FB)

(FUNCTION BLOCK) According to IEC 1131-3 a function block is a logic block with
static data. An FB allows you to pass parameters in the user program. This means
that function blocks are suitable for programming complex functions that are
required frequently, for example controllers, operating mode selection. As function
blocks have a memory (instance data block) its parameters (for example outputs)
can be accessed at any time and any point in the user program. See also
↑ block type.

G

Global Script

Editor in the control center of the OS for creating ↑ actions, project functions and
standard functions.

GPS

Global Positioning System – satellite system for exact position detection on earth.
The individual GPS satellites orbit the earth at a height of approximately 20000 km
in different orbits. Each satellite has a highly accurate atomic clock.

Graphics Designer

Editor in the OS for creating plant pictures.

Group Display

Group displays are used for two purposes:

• Displaying of the status of a PCS 7 tag (for example an instance of a MOTOR
block) on a process picture on the OS.

• Implementing OR logic for all status information of all PCS 7 tags of a process
picture and displaying this information in a process picture of a higher
hierarchy level.

Group Message (OS Message System)

In the OS message system (Alarm Logging), there are two types of message:
group messages and ↑ single messages. Group messages are used to group
together several single messages. The events associated with the single
messages therefore only trigger the common group message. The triggering single
message is no longer recognizable. One group message can be set up per
message class and message type. In addition to this, group messages can also be
put together from any selection of single messages.
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H

Hardware Catalog

Catalog for selecting PCS 7 components within ↑ HW Config.

HART

Highway Adressable Remote Transducer - registered trademark of the "HART
Communication Foundation" (HCF). Standard protocol for transmission of
information between a field device and PLC.

Higher Level Designation (HID)

It is made up of the hierarchical path of the plant hierarchy.

HW Config

Hardware configuration - editor within the SIMATIC Managers for configuring
hardware and configuring networks.

I

IEA Editor

A separate application for creating and editing import/export files. When working
with the editor, the formats specified for the import/export files are supported.

IM

Interface Module

Import/Export Assistant (IEA)

Software component in PCS 7 for handling ↑ models and generating ↑ replicas of
the models.

Industrial Ethernet

↑ Bus system for industrial application based on ↑ Ethernet.

Initial Value Message (OS Message System)

On the OS, a distinction is made between an initial value message and a ↑ new
value message. Among a group of messages, an initial value message is the
message whose status changed first since the last acknowledgment.
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Interconnection

(CFC) Connection between an interface I/O and another element. The value of an
interconnected input is fetched from the other end of the interconnection during
runtime.

Interface

The interface consists of the inputs and outputs of a block (block interface) or a
chart (chart interface) that can be interconnected and assigned parameters.

Internal Block

A block within a ↑ multiple instance block.

Internet

Worldwide network of UNIX data networks; originating from the university
environment. Today, the largest data network worldwide. On the INTERNET, the ↑
TCP/IP protocol is used.

IP Address

Address of a node on the ↑ Internet or Industrial ↑ Ethernet

ISO

International Standards Organization

J

Jump

(SFC) A jump is a structured element in SFC with which the execution of the SFC
chart is continued at a different step within the same chart depending on a
transition condition.

L

Ladder Logic (LAD)

Graphic representation of the automation task with symbols from a circuit diagram
complying with DIN 19239.
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Library

A folder for objects that can be used more than once and that is not project-related.
Blocks are made available according to certain criteria (block families, alphabetical
arrangement etc.) in block libraries. Different block libraries are used depending on
the target system or particular situation.

Lifebeat Monitoring

Program belonging to the run-time system (operator station) for monitoring the
programmable controllers, ↑ OS servers and ↑ OS clients connected to an OS
server. The connected systems are visualized in a plant picture.

Local Data

Local data are the data assigned to a ↑ logic block that are listed in its declaration
section or its variable declaration.

Location Identifier

Based on a sequence of letters and numbers, the exact location of a tag within a
process plant is defined (in much the same way as a street in a street map). The
location identifier can be specified when working with the IEA.

Lock List (OS Message System)

The lock list displays all the locked messages in the system. It is structured like the
message window. Locked messages can be unlocked using a button in the toolbar.

Logic Block

A logic block in SIMATIC S7 is a block that contains part of the STEP 7 user
program. In contrast, data blocks contain only data.

The following logic blocks exist:

• ↑ Organization blocks (OB)

• ↑ Function blocks (FB)

• ↑ Functions (FC)

• System function blocks (SFB)

• System functions (SFC)

Logs

Apart from the ↑ sequential message log and the ↑ archive log, the configuring
engineer can specify a user log with static and dynamic contents in the control
center of the OS. During run-time, the log is output cyclically on a printer or as the
result of an event (for example clicking a button).
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Long-Term Archive (OS Message System)

In a long-term archive, the archive size is decided by the length of time for which
the messages are archived. A long-term archive can be set up as a first-in-first-out
archive or as a continuous archive. In a first-in-first-out archive, the oldest
messages are overwritten when the maximum number of archived messages is
reached. In a continuous archive, the messages continue to be written sequentially
until the maximum capacity of the storage medium is reached. The messages
stored in a long-term archive are displayed in a ↑ message window.

Loop

(SFC) Structure element consisting of a ↑ sequence (S sequence) and a return
branch that encloses the S sequence and contains exactly one transition.

LOOP-in-Alarm

Function in the run-time of the OS. After clicking the appropriate button within a
message line, the faceplate belonging to the loop is displayed.

M

Machine Code

The program that can run on a programmable controller. The machine code is
compiled by ↑ CFC and downloaded to the PLC.

Memory Reset

During a memory reset, the following memory is deleted on the CPU:

• work memory,

• write/read area of the load memory,

• system memory except for the MPI parameters and the diagnostic buffer.

Message Blocks (OS Message System)

Status changes of a message are displayed in run time in a message line. The
information to be displayed in the message line is specified using message blocks.
There are three different types block:

• System blocks (for example, date, time, period, comment, ...) allow predefined
and not freely usable information to be specified. With assistant blocks, the
value of the message block (for example, the time) is displayed in the message
line.

• New Sir text blocks allow you to assign up to ten different freely defined texts
to a message. With user text blocks, the content of the message block (the
user-defined text) is displayed in the message line.
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• Using process value blocks, you can display the values of variables in the message
line. You can also define the formatting used. With process value blocks, the content of
the message block (the variable value specified by the user) is displayed in the
message line.

Message Configuration

Creation of messages and their attributes and texts. Messages can be configured
within CFC/SFC.

Message Event (OS Message System)

Message events are the messages "entering state", "leaving state" and
"acknowledgment". All message events are stored in the message archive.

Message Frames (OS Message System)

Message frames originate either from the process more from the process control
monitoring. They are exchanged between the controller (or the monitoring
application) and the OS message system.

Message Line (OS Message System)

Each message is displayed in a ↑ message window in a separate message line.
The content of the message line depends on the ↑ message blocks to be
displayed. With ↑ system message blocks (for example, date, time), the value of
the message block for ↑ process and ↑ user text blocks displayed is the content of
the blocks (for example, the text you specified).

Messages

A message system is used for the chronological signaling and archiving of sporadic
events occurring in the process at a central location. The cause of a message can
be an event or a message frame.

In general, a distinction is made between operating messages, fault messages,
and system messages. Operating messages are used to indicate a status in the
process. Fault messages are used to indicate a problem in the process. System
messages are used to indicate error messages from other applications.

In the message system (Alarm Logging), messages that behave in a similar way
(acknowledgment philosophy, color scheme for message states) can be grouped
together in message classes and message types.

Message Sequence Report (OS Message System)

To log the messages, the OS message system provides the ↑ message sequence
report and the archive report. In the message sequence report, all status changes
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(entering data, leaving state, confirmed) of currently pending messages are printed
out as a single line. Message Class

The message class determines the property of the message. In SIMATIC PCS 7,
there are the message classes alarm, warning, tolerance, PLC and OS control
system message, process message, operator prompt and operating message.
Message classes differ from each other in terms of the acknowledgment
philosophy. Messages with the same acknowledgment philosophy can be put
together in one message class.

Message Status (OS Message System)

Message statuses are the possible statuses of a message: "entering state",
"leaving state", "confirmed".

Message Tag

With the bit message technique, the controller signals the occurrence of an event in
the process using the message tag. Several messages can be masked by a
message tag.

Message Technique (OS Message System)

The OS message system (Alarm Logging) supports several message techniques:
The bit message technique, the technique of chronological messages, and the
technique of analog alarms for limit value monitoring.

• With the bit message technique, the controller signals the occurrence of an
event in the process using the message tag. The time stamp (date and time) of
the message is assigned by Alarm Logging.

• With chronological messages, the controller sends a frame with the data on the
message when the event occurs. This is evaluated in Alarm Logging. The time
stamp (date and time) of the message is assigned by the controller.

• With analog alarms, the changes in an analog variable can be monitored for
upper and lower limit value violations.

Message Texts

These are configured within the blocks in ↑ CFC and transferred to the OS. When
a message is triggered, the message texts are output on the message pages.

Message Types (OS Message System)

Message types are subgroups of ↑ message classes and can differ from each
other in the color selected for the message status. You can create up to 16
message types in each message class on the OS.
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Message Window (OS Message System)

In run time, the status changes of messages are displayed in a message window.
The appearance and options for controlling the message window can be defined
freely in the Graphics Designer.

A message window contains all the messages still to be displayed in the form of a
table. Each message is displayed in its own line, the ↑ message line.

You can influence the content of the message window using definable filters.

Depending on the source of the messages displayed in the message window, a
distinction is made between three types of message window.

• Message lists are used to display currently pending messages.

• ↑ Short-term archive windows are used to display messages stored in a short-
term archive.

• ↑ Long-term archive windows are used to display messages stored in a long-
term archive.

Model

A model consists of hierarchy folders with CFC/SFC charts, pictures, reports, and
additional documents from which any number of ↑ replicas can be created.

Model Chart

↑ A CFC chart that exactly represents the model of a commonly occurring structure
within a plant configuration. The model chart of a motor controller, for example has
exactly the blocks with the corresponding interconnections that are required to
control a motor in this plant.
Using the ↑ IEA, the model charts become ↑ models.

Module

• System module
Module required to operate a system (for example programmable logic
controller). The system modules include, for example, a power supply, a
central processing unit (CPU) and also perhaps a communications module.

• I/O module
Module for acquiring or outputting process signals.

Module Driver

• Input driver
Input drivers adapt the process signals of an input module and provide the
signal in CFC for further use.

• Output driver
Output drivers adapt the value formed in CFC and transfer the value to an
output module.
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MPI Address

In an MPI network, each programmable module must have its own
MPI address assigned.

Multiple Instance Block

A block that consists of more than one internal block with a common ↑ interface
and common data storage (instance DB).

Multi-Point Interface (MPI)

Interface for linking up to 32 devices (PC, PG, PLC, AS).

Multi-User

Several configuring engineers working at the same time on one project.

N

Nested Chart

A CFC chart that is inserted in another CFC chart (nested or top chart). Nested
charts are not displayed in the SIMATIC Manager.

NetPro

Editor for graphic configuration of networks. NetPro is started within the SIMATIC
Manager or the hardware configuration ( ↑ HW Config).

Network Components

Within the ↑ NetPro, there is a catalog of network components. From this catalog,
you can take, for example single stations and interconnect them to form networks.

New Value Message (OS Message System)

On the OS, a distinction is made between a new value message and an ↑ initial
value message. Among a group of messages, new value messages are the
messages whose status has changed since the last acknowledgment.

O

Office / Works Management Level

Computer-supported enterprise-wide information system of a company.
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Online/Offline

In the SIMATIC Manager, objects of the programmable controller are displayed in
the online view and the objects of the ES in the offline view. Online, there is a data
connection between the PLC and the programming device/PC; offline there is no
connection.

Operating Message

Following a change made to a parameter on the operating station, the parameter,
the old value, the new value and if applicable the unit of the value is displayed in a
message page.

Operating Mode

1. CPU:

The following operating modes can be set with the mode selector on the CPU
module:

• RUN with access to the STEP 7 user program using, for example, the
programming device ("RUN-P"),

• RUN with access protection ("RUN"),

• STOP and

• memory reset ("MRES").

2. SFC:

The mode decides how an SFC chart is controlled.

• AUTO (process mode): Execution is controlled automatically, for example using
the control block.

• MANUAL (operator mode): Execution is controlled manually by an operator, for
example using IBS or SFV (SFC visualization in WinCC).

Operating Response

• Rejecting operating response
A command outside the permitted limits is rejected.

• Limiting operating response
A command outside the permitted limits is accepted but restricted to the
maximum permitted limit value.

Operating State

1. The SIMATIC S7 programmable logic controllers can adopt the following
operating states: STOP, STARTUP, RUN and HOLD.

2. (SFC) The sequential control system can adopt the operating states OFF,
ACTIVE and HOLD.
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Operating System

A collective term for all functions which, in conjunction with the hardware, control
and monitor the execution of the user programs, the distribution of the operational
equipment among the individual user programs, and the maintenance of the
operating mode (for example standard operating systems MS-WINDOWS, real-
time operating system M7 RMOS32).

Organization Block (OB)

In S7,organization blocks are the interface between the operating system of the
CPU and the user program. The order in which the user program is executed is
specified in the organization blocks. An organization block corresponds to a ↑ task.

OS

Operator station. A station for controlling and monitoring the process. In PCS 7, the
WinCC software system is used for the OS with which all the process monitoring
and control functions can be implemented.

Overflow Page

(CFC) An overflow page is created automatically in CFC when there are so many
sheet bar entries in a ↑ sheet that there is no longer enough space. An overflow
page consists only of the ↑ sheet bars with entries and contains no other objects.

P

Parameter

A parameter is

1. the value of a CFC block/chart I/O.

2. a variable of an S7 logic block (actual parameter, formal parameter)

PCS 7 Assistant

A multi-page dialog that supports the user when creating a new project in the
SIMATIC Manager.

PDM (SIMATIC PDM)

Process Data Manager – software for assigning parameters to DP field devices.
SIMATIC PDM is started in the SIMATIC Manager or in HW Config.
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PG/PC Interface

A configuration tool for installing/uninstalling communication modules,
adding/deleting interfaces and assigning parameters to communications modules
(for example bus profile, node number etc.).

Phase Offset

The phase offset moves the point at which the run-time group or SFC chart is
activated within the task by a defined value compared with the basic cycle. This
achieves a more uniform distribution of load on the CPU. See also ↑ scan rate.

Picture Block

see ↑ faceplate

Picture Hierarchy

The arrangement of the plant pictures on the OS. The pictures are structured at
different levels. Each level corresponds to a particular level of detail in the plant.
The deeper the level, the more detail is provided with the plant components. The
picture hierarchy is shown in the ↑ Picture Tree Manager.

Picture Tree Manager

This is used to manage a hierarchy of plants, units and pictures of the ↑ graphics
designer.

Piping and Instrumentation Flow Diagram

Here, the components required in a plant and their interconnections are specified.

Plant Hierarchy (PH)

Structure organized in the form of a hierarchy according to technological aspects.

Plant Picture

see Lifebeat Monitoring.

Plant View

View in the SIMATIC manager according to technological aspects ( plant, unit,
function ...); an alternative to the ↑ component view.
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PLC

The PLC or target system is the programmable controller or a component of the
programmable controller on which the user program runs. Target systems include
for example SIMATIC S7 and M7.

Priority Class

The ↑ organization blocks are assigned to a particular priority class. The priority
class then determines the order in which the organization blocks are called.

Process Control Point

The smallest unit in process control. This satisfies the processing functions of a
process variable, such as control, display, alarm etc. from the point of view of
process engineering.

Process Image

Reserved areas in the RAM of the CPU. The signal states of the input and output
modules are entered in this area.

Processing Phase

(SFC) A step is divided into three processing phases: Initialization, (cyclic)
execution, and termination. Each processing phase corresponds to an action with
statements.

Process Variable

A neural object in terms of resources. It is used to connect the PLC configuration
world (STEP 7, CFC ...) with the OS configuration world (WinCC). It contains
information about the location at which it exists at run-time (for example the
network address and the memory area on the PLC) as well as information about
specify OS-relevant properties.

PROFIBUS

PROcess Field Bus – a fieldbus complying with EN 50170 Vol. 2 PROFIBUS
(DIN 19245; bus system for industrial application based on PROFIBUS).

PROFIBUS DP

DP mode complying with DIN E 19245 Part 3; PROFIBUS DP is a serial bus for the
attachment of remote (distributed) peripheral I/Os developed by SIEMENS
specifically for the field area.
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PROFIBUS PA

The extension of ↑ PROFIBUS DP with optimized transmission for field devices (for
example for supplying power to field devices via the data line and for use in
hazardous areas) while retaining the communication functions of PROFIBUS DP.

Program

General term for S7 and M7 programs.

Programmable Controller (PLC)

A programmable logic controller is a programmable controller (PLC) in SIMATIC
S7, a complete device (PLC with integrated control unit)
SIMATIC C7 or a SIMATIC M7 automation system.

Programmable Logic Controller (PLC)

Programmable logic controllers (PLC) are electronic controllers whose function is
stored as a program on the controller. Programmable controller has the structure of
a computer; it consists of a CPU (central processing unit) with memory,
input/output modules, and an internal bus system. The peripherals and the
programming language are designed to meet the requirements of control
engineering.

Programming Device (PG)

Portable personal computer in a special compact design intended for use in
industry. A PG is fully equipped for programming SIMATIC programmable logic
controllers.

Project

A folder containing all the objects belonging to an automation solution regardless of
the number of stations, modules and how they are networked.

R

Reference Data

Reference data are data available to the user in addition to the graphic chart
display in the form of lists, for example the list of access to shared addresses.

Reorganization

During this reorganization, gaps in the PCS 7 project resulting from deleting are
eliminated; in other words the memory requirements of the project/library data is
reduced.
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This function optimizes data storage for the project or library in much the same way
as a defragmenter optimizes data storage on a hard disk.

Replica

When you import with the import/export assistant, replicas are created from the
models. Each line in an import file creates a replica in the destination project. A
replica differs from the model (or from a copy of the model) among other things
because instead of an assignment to an import file it has an assignment to a
model.

Report Designer

Editor in the control center on the OS for creating and editing logs.

Resources

Resources are sets of objects (FBs, FCs, DBs, OBs, bit memory, counters, timers
etc.) that can be accessed when configuring and assigning parameters in a
CFC/SFC chart.

Restart

When an S7 CPU starts up ( for example after changing the mode selector from
STOP to RUN or when the power supply is turned ON), before cyclic program
execution (OB1) is started either the organization block OB 100 ( warm restart) or
organization block OB 101 (hot restart, only on the S7-400) or OB102 (cold restart)
is executed (↑ Startup of an S7-CPU). In a warm restart the process image of the
inputs in read in and execution of the STEP 7 user program is continued at the
point at which it was last stopped (STOP, power down).

The "hot restart" is only possible when the CPU is battery-backed.

All data areas (timers, counters, memory bits, data blocks) and their contents are
retained.

Routing

Establishment of communications connections beyond the boundaries of subnets.

Runtime

Process control; the operator controls and monitors the process on the operator
station (OS).

Runtime Attribute

Each run-time group has run-time attributes that control how it is activated. The
group passes on these attributes to all the blocks it contains.
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Runtime Group

Run-time groups are used to structure or group tasks. The blocks are installed in
the run-time groups sequentially. Run-time groups activated or deactivated
separately. If a run-time group is deactivated, none of the blocks it contains will be
activated any longer.

Runtime Properties

The run-time properties of a block determine how the block is included in the
processing of the entire structure on the PLC. These properties are vital to the
performance
of the PLC in terms of reaction times, dead times, or the stability
of time-dependent structures, for example control loops.

S

S7 Program

A folder for the ↑ symbol table, the blocks, the source files, and the charts for
programmable S7 modules.

Scan Rate

The scan rate is a ↑ run-time attribute. It specifies whether a
↑ run-time group or a chart is executed every time a task is executed or only every
nth time. See also ↑ Phase offset.

SCL

High-level language complying with IEC 1131-3 and resembling Pascal for
programming complex tasks on a PLC, for example algorithms, data processing
tasks.

Script

A program written in ↑ ANSI-C for solving user tasks. Scripts run
cyclically/acyclically in the background of the OS run-time or following an event (for
example mouse click) on a picture object within a plant picture.

Sequence

(SFC) A structure element consisting of a series of steps and transitions
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Sequence Path

(SFC) A sequence is a series of chart elements (in the chart topology seen as a
vertical path). A simultaneous sequence or an alternative sequence consists of at
least two sequences arranged side-by-side and containing at least one element.

Sequential Archive

The ↑ archive is written sequentially until the configured size is reached or until the
storage medium is full (see also ↑ Continuous archive).

Sequential Control System

A sequential control system passes control from one step to the next step
dependent on conditions. In PCS 7, sequential control systems are implemented
with SFC charts.

Server Name

The server name is required often for addressing a computer (PC) in a network.
You will find the server name under "Start (Windows NT taskbar) > Settings >
Control Panel > Network > Computer Name".

SFC

An SFC chart represents a ↑ sequential control system that runs as an
independent controller in the programmable logic controller.

SFV

Visualization of the SFC chart in the run-time system of WinCC.

Shared Address

Shared addresses are objects that can be addressed by every logic block (FC, FB,
OB). These addresses are memory bits (M), inputs (I) , outputs (Q), timers (T),
counters (C) and elements of data blocks (DB). It is possible to access shared
addresses in absolute or symbolic form.

Shared Data Block

This is a block that can be accessed by all blocks in the program. Every CFC block
instance can read the shared data from such a block or can write data to the block.
Shared data blocks are created with the LAD or STL editor.
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Sheet

(CFC) Subdivision of a chart partition. A ↑ chart partition consists of 6 sheets. The
sheet is a working area (with sheet bars) on which blocks are positioned, assigned
parameters and interconnected.

Sheet Bar

(CFC) The margin at the right and left-hand edge of a sheet. The sheet bars
contain:

• The references to connected objects (block/chart interface, address, run-time
group) that are not located on the current sheet.

• the number of the connector reference when the connecting line cannot be
drawn to the sheet bar because the chart is full.

Short-Term Archive (OS Message System)

In a short-term archive, you specify the size of the archive by the number of
messages to be archived. A short-term archive can only be created as a first-in-
first-out archive. Once the maximum number of archived messages has been
reached, the oldest messages are overwritten. A maximum of 10000 status
changes of messages can be stored in a short-term archive. The messages stored
in a short-term archive are displayed in a ↑ message window.

SICLOCK

Master clock in Industrial Ethernet.

Sign of Life Monitoring

see ↑ Lifebeat Monitoring

SIMATIC Manager

Graphic user interface for the SIMATIC user under Windows NT. With the SIMATIC
Manager, for example, you create projects and access libraries.

SIMATIC Station

see ↑ Programmable logic controller (PLC)

Single Message (OS Message System)

In the OS message system (Alarm Logging), there are two types of message:
single messages and ↑ group messages. With single messages, each event is
assigned a message.
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Source File

Part of a program created with a graphic or textual editor and from which the
executable user program is produced following compilation.

Split Screen Wizard

Dialog-guided menu for creating basic data and settings within the operating
station.

Startup of an S7-CPU

The CPU distinguishes between the following startup types:↑ : cold restart, ↑ hot
restart or ↑ warm restart. This is selected using a software switch in the object
properties of the CPU (HW Config).

Statement List (STL)

Statement List is a textual programming language resembling machine code
(complying with IEC 1131–3).

Status Tag (OS Message System)

The status tag contains the "entered state/left state" status of the message type
and an ID for messages requiring acknowledgment.

Step

(SFC) The step is an element of a ↑ sequential control system and the control
instance for processing the assigned ↑ actions. Each step consists of the three
actions: Initialization, (cyclic) processing, and termination.

Step Control Mode

(SFC) Mode by which control passes from step to step:

• C (confirmation by operator)
The sequential control system runs controlled by the operator.

• T (transition only)
The sequential control system runs controlled by the process.

• T or C (transition or confirmation by operator)
The sequential control system runs process-controlled or controlled by the
operator.

• T and C (transition and confirmation by the operator)
The sequential control system runs process-controlled and controlled by the
operator.
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Step Types

(SFC) SFC recognizes different step types:

• Initial step

• Normal step

• Final step

Storage

An editor for exporting archives (process value archives, curve archives). Storage
is started and the settings are made in the control center of WinCC.

Structure

A structure is a structured ↑ data type made up of several elements. An element
can be an elementary or a structured data type.

Structure Element

(SFC) Structure elements consist of an arrangement of basic elements. These
include the following: "sequence", "simultaneous sequence", "alternative
sequence", "loop" and "jump".

Subnet

Self-contained part of a bus system.

Symbol

A symbol is a name selected by the user defined according to syntax rules. This
name can be used in programming or in operating control and monitoring once it
has been defined (for example, as a variable, a data type, a jump label, or a
block)..

Example: address: I5.0, data type: BOOL, symbol: Emer. Stop Switch.

Symbol Table

A table used to assign symbols (= name) to addresses for shared data and blocks.
Example: Symbol Address
Emer. stop I1.7,
Controller FB24

System Attributes

System attributes can be divided into two groups:

• Block attributes and
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• parameter attributes.

The attributes assigned additional properties to blocks and parameters of blocks (
for example automatic inclusion in certain processing levels, or making parameters
invisible etc.).

System Resources

When you download the user program to a PLC currently in the run mode, it is
important that the newly downloaded sections of program do not exceed the
system resources. Exceeding these resources would cause the PLC to change to
STOP. System resources include, for example, the local data, the load memory,
the work memory, the maximum number of blocks (for example, FB, DB,...), the
maximum number of communication blocks, the cycle time, etc.

T

Tag Browser

The tag browser integrated on the OS provides information on the existing tags and
allows interconnection to the OS objects (for example, I/O fields).

Tag List

List of all the measuring points in a plant section or a project. The list contains the
following information for each tag:

EMSR designation, type of tag, location, measuring range, unit, signal meaning,
comment

Tag Logging

An editor in the control center of the OS for creating and editing curves.

Task

Tasks are the interface between the operating system of the CPU and the user
program. The order in which the user program is executed is specified in the tasks.
A task corresponds to an organization block (OB) in S7 and a priority class in M7.

Task/OB

A task is the interface between the operating system of the M7 CPU and the user
program. The tasks are mapped on RMOS tasks (see ↑Task).
In S7, the tasks are implemented as ↑ Organization Blocks (OBs).



Glossary

Process Control System PCS 7, Configuration Manual
Glossary-34 A5E00122418-01

TCP/IP

Transport Control Protocol / Internet Protocol – the standard for communication
between UNIX computers and on the ↑ Internet.

Teleservice

From a central point, it is possible to investigate errors and their causes directly on
the PLC or OS of the customer. The service center is linked by a modem and
special software ( for example Laplink or
PC-Anywhere) in the customer system.

Test Mode

(Alternative to the ↑ edit mode) mode in CFC/SFC for testing and optimizing the
user program running online on the CPU.

Textual Reference

A textual reference can be used to configure access to chart I/Os inside or outside
the current chart folder and even chart I/Os that do not yet exist. After merging the
2 charts, this connection can be closed. If the charts are separated, the
connections are opened, but are retained as textual references.

Time-of-Day Synchronization.

see ↑ Time Synchronization.

Time Synchronization

An editor in the control center of the OS. Time synchronization makes sure that
all the PLCs and operating stations of the bus operate with the same time of day (
time of day synchronization).

Top Chart

CFC chart that is not inserted in another chart and that
is displayed in the SIMATIC Manager (↑ nested charts).

Topology

Physical structure of a system.

Transfer

The "PLC-OS Engineering" transfer program transfers the PLC configuration data
for operating control and monitoring created on the PLC to the data management
of the operator station. The program is started in SIMATIC manager.
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Transition

(SFC) The transition is a basic element of SFC and contains the conditions under
which a sequential control system passes control from one step to the next.

Transition/Transition and Acknowledgment (T/T and C)

(SFC) Step control mode "T/T and C". The sequential control system runs process-
controlled at steps without the T/T and C flag (just as in the T mode) and operator
controlled at steps with the T/T and C flag (just as in the T and C mode).

U

Update Cycle

In the test mode, this specifies the intervals at which the watched values of the
block I/Os are updated.

User Administrator

Editor in the control center of the OS for creating and editing access permissions
for operator control and monitoring during Runtime.

User Block

A block written by the user in SCL or Statement List in which the user formulates
the required functions. A user block consists of the program source file and the
block type from which the instances are created in CFC.

User Object

An object on the operator station made up of different single object
(I/O boxes, bars, texts etc.) that is used to display and control several parameters
of a block instance.

User Program

The user program contains all the statements and declarations and the data
required for signal processing to control a plant or a process. The program is
assigned to a programmable module (for example, CPU, FM) and can be
structured in smaller units.

In S7, the user program on the ES consists of the symbol table, the source files,
the blocks and the charts.
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V

Value Identifier

Symbolic substitute (text) for defined values of block I/Os of the data types BOOL,
BYTE, INT, DINT, WORD and DWORD.

W

Warm Restart

When a CPU starts up, the organization blocks are executed as described in ↑
Startup (↑ Startup of an S7-CPU).

The following rules apply to the "warm restart" (assuming the CPU is battery-
backed):

• All data blocks and their contents are retained

• Retentive timers, counters, and memory bits are retained; non-retentive timers,
counters, and memory bits are reset.

During a warm restart, the process image input table is read and the STEP 7 user
program is executed starting at the first instruction in OB1. In PCS 7, this is the
only startup type permitted.
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